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WELCOME to TurboCASH
Thank you for choosing the TurboCASH5 program. This 
program is easy to use, but an exceptionally powerful 
accounting program. This program allows you to set up your 
accounting system quickly and then adjust it to according to 
your own requirements.

This book is meant to be fun. Don't make a meal of it. It is 
impossible to cram 4 years of an accounting degree into a 
few hours, but we are going to try anyway. Some of the 
terminology that we use may seem obscure. This is 
intentionally so. We didn't make the rules in financial 
vocabulary, we simply follow it. 

Financial people like Bank managers, shareholders, auditors, the Receiver all use the same language 
to talk about financial concepts.  Financial people are arrogant and dismissive when they see that you
don't grasp these concepts. If you are unable to talk the talk they will immediately assume that you 
are incompetent in the business of making profit. So get with the program, its not difficult. Soon you 
could be the centre of discussion and cocktail parties. 

TurboCASH5 can be customised to accommodate virtually any business’ requirements. The program 
is so versatile, that, if your business expands and you change to another form of ownership, (e.g., 
from sole proprietor to partnership, close corporation or company) or even if need to you register or 
de-register for VAT/GST/Sales tax, TurboCASH can accommodate these changes with ease. 

Because TurboCASH can work in over 20 languages and in over 80 different tax regimes, there are many ways
to set it up. The key to the TurboCASH program is in the setting up of the parameters.  
Failure to setup the program correctly will yield incorrect results. 
Fortunately you do not have to worry about this. If this is the first time that you are using the software then it 
is best to use the EXAMPLE set of books installed for your country rather than creating your own Set of Books. 
The fewer changes you make to this the better. 

If you have never used TurboCASH before, time should be well spent doing the Handyman tutorial 
before launching into your own Set of Books. When TurboCASH is set up correctly, you, as the user, 
will enjoy the benefits of increased financial control of your enterprise. Each business entity is 
different from the next. It is for this reason that the TurboCASH program was developed with built-in 
flexibility.

In our experience 95% of all TurboCASH problems are caused by:

● Inadequate setting up of the program

● Inadequate knowledge of the program

● Inadequate computer hardware

● Most of all - inaccurate data capture (finger problems!).  

We call this the “GIGO” effect.  Garbage In - Garbage Out.



HOW TO USE THIS BOOK
The book starts with a table of contents, which can be used as a quick reference to the relevant 
page(s). This is a step by step guide to performing all the actions associated with TurboCASH. In 
order to facilitate quick referencing, the table of contents is comprehensively numbered. 

To access more detailed information, on any topic in this book, or on any other issue in the TurboCASH 
program, you may press the F1 key on your keyboard to access the Help files in TurboCASH.

The following Set of Books based on this tutorial, are installed in the “…\Bin\EN-TUTORIALS\” folder.

• HANDYMAN (No transactions) 

• HANDYMAN-A (Unposted batches and documents)

• HANDYMAN-B (Posted batches and documents)

To follow this tutorial, you need to click on the Browse icon (Open Set of Books) and select these 
Sets of Books. 

For Afrikaans users, the following Afrikaans tutorials are available:
The following Set of Books based on the Afrikaans tutorial, are installed in the “…\Bin\AF-HANDLEIDINGS\” 
folder.

• NUTSMAN (No transactions)
• NUTSMAN-A (Unposted)
• NUTSMAN-B (Posted)

To follow the Afrikaans tutorial, you need to click on the Browse icon (Open Set of Books) and select these Sets 
of Books. 
The Afrikaans book (“Rekeningkunde met Gemak”) based on this tutorial, is also available. 

This book is divided into the following modules:

• MODULE A – Introduction to accounting and accounting principles.

• MODULE B – Installing, registering and launching with TurboCASH. 

• MODULE C – A reference guide to the TurboCASH program, interface, filters, features, etc.

• MODULE D – Backing up and restoring your data in the event of mistakes or hardware 
failures.

• MODULE E – Creating a Set of Books and set up procedures.

• MODULE F – This is a work-through tutorial, providing “hands-on” knowledge to create / 
edit your chart of accounts, bank accounts, tax accounts, debtor and creditor accounts.

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South 
Africa, the South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 April
2018. 
This tutorial, VAT based on 14% tax for taxable transactions up to 31 March 2018 and 15% for 
taxable transactions as from 1 April 2018. It illustrates how TurboCASH5 is configured to manage 
and process transactions for both tax rates.

• MODULE G – This is a work-through tutorial, providing “hands-on” knowledge to create / 
edit stock items to generate documents for purchases and sales of non trading stock items 
as well as trading stock items.

• MODULE H – This is a work-through tutorial, providing “hands-on” knowledge to enter your
opening balances.



• MODULE I – This is a work-through tutorial, providing “hands-on” knowledge to enter and 
process your daily transactions in batches. This will illustrate the transactions in the 
Purchase, Sales, Payments, Receipt batches as well as the repeating batches.

In this MODULE, the taxable transactions up to 31 March 2018 is based on 14%.

• MODULE J – This is a work-through tutorial, providing “hands-on” knowledge to enter and 
process your daily transactions in the purchase and sales batches using documents for non 
trading stock items. 

In this MODULE, the taxable transactions up to 31 March 2018 is based on 14%.

• MODULE K – This is a work-through tutorial, providing “hands-on” knowledge to enter and 
process your daily transactions in the purchase and sales batches using documents for 
trading stock items. If you do trade in stock items, you need to follow this MODULE. 

In this MODULE, the taxable transactions as from 1 April 2018 is based on 15%.

• MODULE L – This is a working tutorial describing to schedule create repeating invoices for 
your debtors (customers) using the calendar. A new feature has been added where quotes 
for hours can be scheduled. Once these appointments are completed, quotes for hours may 
be converted to invoices. 

In this MODULE, the taxable transactions as from 1 April 2018 is based on 15%.

• MODULE M – This is a working tutorial describing the Bank reconciliation based on the 
data you have entered in the payments and receipts batches (journals) or the current bank 
account in MODULE I.  

• MODULE N – This is a working tutorial of how to enter budgets and to generate reports to 
view your budget figures. These budget figures are used as comparative figures on the 
budget performance report, income statement, trial balance, user reports, etc. compare your
actual income and expenses against the budgeted figures.

• MODULE O – Available reports are listed and how to generate these reports. The reports 
from the tutorials are also included with each tutorial so that you may check your reports 
after having completed the tutorials. 

• MODULE P – Open item processing and reports – The basics and features of open item 
processing and reports for open item are outlined. 

• MODULE Q – The Report designer interface and file structure of reports and layout files for
printing documents are outlined. 

• MODULE R – A list of the basic keyboard short-cuts for those users who prefers to use the 
keyboard instead of the mouse to get around TurboCASH.

The book has been structured in such a way that if you follow the step by step procedures, you will 
be able to run your company’s Set of Books with TurboCASH. The Chart of accounts represented in 
this book is a basic generalised one. It is up to you to expand and change the Chart of accounts as 
per your particular business requirements (for example, you may need an account called 
“Commissions Paid”).

Work as carefully and as accurately as possible, trying to find a mistake can be a nightmare.! 



Unless you are familiar with TurboCASH, it is recommended that you work through the tutorials 
before starting to create your own personalised Set of Books. 

As you work through the tutorials, screen shots have been supplied to ensure that you can see 
exactly what information to enter in which field. These are called “screen dumps”, and are 
appropriately placed in the text for your convenience. 

The following icons have been placed on specific places throughout the documentation:

Press the F1 key when focussed on screens to get more help.  

Note (Additional information)

Tip / Help 

Important

Warning

Next step / Proceed

Plugins

Scale –Accounting equation - Debits = Credits 

The following icons have also been placed in the text for your convenience:

 Create, edit or to perform a specific action.

 Click or select using the mouse.

 Enter or press a key on the keyboard.

 Leave a field blank. Go to the next field.
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USING A COMPUTER IN ACCOUNTING

A.1- USING A COMPUTER IN ACCOUNTING

A.1.1- INTRODUCTION 

 “I am having sleepless nights! I get summonses and demand letters from everywhere! I started my 
business with 100 000! What happened to the money? Why can't I pay my bills? Why are my sales 
dropping? What will happen if I get investigated by The Receiver? Why are my expenses getting out 
of hand? Why don’t my debtors pay me? What is the value of my stock? Who has wasted my money 
and resources? Who is mismanaging my business? I will have to close down! My business may be 
liquidated!” 

It is of utmost importance to evaluate financial information with a view to judging business 
performance accurately. Where no accurate information is kept, things quickly get out of hand.

Businesses fail, each year as a result of incorrect decisions taken. You may be surprised that some 
businesses fail because of brilliant decisions taken on incorrect or outdated financial information. 

Have you ever heard the expression: "You need to have money to make money"? Any business or 
organisation utilises money or resources to make money. This is also the reason why businesses 
exist. However, certain organisations do not wish to make a profit. These organisations exist to 
achieve certain benefits by making the most of the limited funds or resources. 

A.1.2- THE ACCOUNTING PROCESS

Imagine if you have to make decisions based on boxes and boxes of slips and documents! 

Financial information is the summary of all this financial data into the following two basic reports:

• An Income statement reflecting how well or poor the business or organisation has 
performed over a specific period.

• A Balance sheet reflecting the business' financial position as at a specific date.

Additional summarised information with respect to certain items and budgets may also be 
necessary to determine performance or financial position. TurboCASH contains many of these 
reports and includes a report writer to supplement your own reports.

A.1.3- METHODS OF RECORDING

Accounting may be done either manually (by hand) or with the aid of a computer, either way, the 
processes are basically the same:

1. Input

2. Process 

3. Output 

4. Safeguarding of records 
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It is a good idea to make a comparison between these two methods.

A.1.3.1- Manual system

In this system all the transactions are manually or physically written up by hand. The manual 
system can be illustrated as follows:

The basic processes in a manual system, is as follows:
Step Process Description 
1. Input All transaction data (i.e. cash slips, deposits, cheques, invoices, etc.) are sorted 

according to transaction type and written into specific journals by hand.
2. Process The journals are balanced, posted to the general ledger and subsidiary ledgers, 

which are in turn balanced. This process is very time consuming.
3. Output A trial balance listing all the debit and credit balances is drafted to check the 

arithmetic accuracy and financial reports and statements are then drafted. Some 
reports are:
 Income statement
 Balance sheet
 Debtor statements
 Creditor remittance advice, etc.

4. Safeguard 
records

The books of account and supporting documents need to be safeguarded from 
unauthorised access, fire, theft, etc.
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A.1.3.2- Computerised system

All records and transactions are captured or entered and processed in the accounting system via a 
computer keyboard and a mouse. Any transactions captured or entered automatically update all 
applicable records, when the transactions are posted. The computerised system can be illustrated 
as follows:

The basic processes in a computerised system, is as follows:

Step Process Description 

1. Input All transaction data (source documents i.e. cash slips, deposits, cheques, invoices, etc.) are 
sorted according to the type of transaction, physically entered into specific journals using 
a computer keyboard and / or mouse.

2. Process All the transaction data is automatically stored in the computerised accounting program 
on your system:
 The journals are balanced off, posted to the general ledger and subsidiary ledgers 

(i.e. debtor's ledger, creditor's ledger, stock records, etc.) by a mouse-click or by 
pressing a key on your keyboard.

 The general ledger and subsidiary ledgers are automatically updated and balanced 
off.

3. Output A Trail balance and a host of reports are readily available at the pressing of a few keys on
the computer keyboard or a few mouse-clicks. Some reports are:
 Income statement; Balance sheet; Debtor statements; Creditor remittance advices, 

etc.

4. Backups The books of account and supporting documents needs to be safeguarded from 
unauthorised access, fire, theft, etc.
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A.1.4- MANUAL VERSUS COMPUTERISED ACCOUNTING SYSTEMS

The steps to be followed in a hand system and a computerised system have many similarities. The 
basic steps in the accounting process for a business, is as follows:

Steps Hand system, Computerised system
1. Planning and opening an accounting system. Planning and opening an accounting system.
2. Entering of the first transactions or opening 

balances.
Entering of the first transactions or opening 
balances.

3. Preparation of source documents - to write 
them up in the auxiliary journals or books of 
first entry.

Coding of source documents - to enter them 
in the auxiliary journals or books of first entry.

4. Bank reconciliation. Bank reconciliation.
5. Closing off of the auxiliary journals or books 

of first entry and post them to the ledger 
accounts.

Posting of the auxiliary journals or books of 
first entry to the ledger accounts.

6. Compile the Trial balance. Print the Trial balance.
7. Finalising of the Accounts and Adjustments. Finalising of the Accounts and Adjustments.
8. Compiling of Financial statements and other 

reports.
Printing of Financial statements and other 
reports.

Since we have briefly compared the four basic processes and the steps to be followed in a hand 
system versus a computerised system it is apparent that using a computerised accounting system 
has much more advantages than that of a manual accounting system. 

It is apparent that the processes for both systems are basically the same. Some of the processes in 
the computerised system are automated. We can clearly see that some of the time consuming 
processes are eliminated in the computerised system. 

Furthermore, a computerised accounting system is pre-programmed and some defaults may also 
be set to eliminate human errors.

On the computerised system, any transactions or data are automatically updated and reports are 
readily available at any time. Once data is entered, retrieval or generation of reports is easy and 
can be done with a few keystrokes or clicks of the mouse. These reports can be used for analyses 
and interpretation to make decisions regarding your business financial performance and position. 

Another huge advantage is that multiple hard copies can be made very simply if necessary, they 
are not bulky, and can be conveniently stored in a safe place/s of your choosing. 

Spreadsheets are a modern variation of a manual system. Many of you may have come from a 
spreadsheet system and when, confronted with the daunting prospect of leaning accounting you 
may want to rush back to the comfort of your spreadsheet.

There are a lot more rules and restrictions on data validation in an accounting package, but the end 
result will give you a much more powerful view of your data.

Stick with TurboCASH, the end will be worth it. 

20 - TurboCASH5.1 – 2018 – Accounting Made Easy



ACCOUNTING PRINCIPLES

A.2- ACCOUNTING PRINCIPLES

A.2.1- BASIC ACCOUNTING PRINCIPLES

Many accounting systems have come and gone off the market, that pro-ported to “make 
accounting easy”. The main function of any accounting system is to present the financial reports or
statements to possible investors, bank managers, creditors, consultants, etc. They need the 
financial information be in an understandable format.

Systems that short cut these rules have all failed because the fail to communicate the information 
to Accountants. Accountants speak a language. If TurboCASH seems obscure at first, it is because 
you are not familiar with this language. You don't need to be fluent in it, but you do need to 
understand the basics.

TurboCASH is a Generally Accepted Accounting Practice (GAAP) compliant system.  Fortunately 
there are steps in TurboCASH to point you in the right direction and to minimise the need for 
accounting knowledge.

A.2.2- DUAL ENTRY SYSTEM - DEBITS AND CREDITS

A.2.2.1-  Dual entry system

For 300 years accounting systems have operated on the basic rule of the dual entry system. For 
each transaction you will have debit and credit entries, which will be of equal value. When a 
transaction is entered or processed in the accounting system a credit is entered for each debit of 
equal value, and vice versa.

A.2.2.2-  What are debits and credits?

Any transaction is based on a give and receive principle. If you give something you should receive 
something of equal value in return. 

Business transactions are always written up or entered into two accounts. The principle is to Debit 
the Receiver and Credit the Giver. If you know where your left-hand side and right-hand side is, 
you already know something about accounting. Debit is always on your left-hand side and a credit
is always on your right-hand side. 

Debit Credit
The account receiving the value is debited. The account giving the value is credited.

The following example illustrates debits and credits:

On 1 March your business sells goods to the value of 100 to a customer, Tom on credit and issues 
a sales invoice for the transaction: 
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On 1 March the customer receives the goods to the value of 100 from the business.

On 1 March the business gives the goods to the value of 100 to the customer.

The customer account debit is debited and the sales account is credited.

What happens if the customer settles his account with the business on 20 March? Your business 
will issue a receipt of 100 as a source document.

On 20 March Tom gives the money to the value of 100 to the business.

On 20 March the business receives the money to the value of 100 from Tom.

You will debit the bank and credit the customer account.

Only transactions between the business and another entity (i.e. the purchasing of a computer for office use) 
should be recorded. Any personal transactions made by the owner of a company (i.e. the purchase of a 
computer for gaming at home) should not be entered. As a rule, the owner and the business are seen as 
two separate entities in the eyes of the law.

A.2.3- TRANSACTION CYCLE

Imagine if you have to make decisions based on boxes and boxes of slips and documents!

Financial information is the summary of all this financial data into the following two basic reports:

• An Income statement reflecting how well or poor the business or organisation has 
performed over a specific period.

• A Balance sheet reflecting the business or organisations financial position as at a specific 
date.

Additional summarised information with respect to certain items and budgets may also be 
necessary to determine performance or financial position. TurboCASH contains many of these 
reports and includes a report writer to supplement your own reports.

The business sells services or goods for money and in the process the business also have to buy 
services or goods to be able to sell their services or goods. These business activities can briefly be 
illustrated in the following diagram:
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The above diagram clearly illustrates the transactions that occur frequently in a business. There are
also a number of parties involved. The affect of these basic transactions on the accounting 
equation can be illustrated as follows:

Transaction cycle:

1.  The owner invests in the business:

a) Owner invests cash: The business receives cash from the owner. The business then 
owes this amount to the owner, which is the owners interest in the business (Capital).

 ASSETS = + CAPITAL 
 DEBIT : Bank account = CREDIT : Capital account

b) Owner invests assets: The business receives an asset e.g. a motor vehicle from the 
owner and it increases the business assets. On the other hand it also increases the 
owners interest in the business (Capital). 

   + ASSETS = + CAPITAL 
 DEBIT : Vehicles Account = CREDIT : Capital account

2. Purchase of assets: 

a) Purchase of assets and pay cash: The business receives an asset e.g. a motor 
vehicle, stock; etc. from another party (the supplier) and it increases the business 
assets. On the other hand it also decreases the assets (cash in the bank). 

    + ASSETS = - ASSETS 
  DEBIT : Vehicles Account = CREDIT : Bank account

b) Purchase assets on credit: The business receives an asset e.g. a motor vehicle, etc. 
from another party (the supplier) and it increases the business assets. On the other 
hand it also increases the liabilities towards the supplier, which will then be referred 
to as the creditor. 

   + ASSETS = + LIABILITIES 
 DEBIT : Vehicles Account = CREDIT : Creditor's account
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3. Incur expenses: 

a) Incur expenses and pay cash: The business receives the value of goods and 
services, which the business will consume or use up in the normal business activities, 
e.g. placing of an advertisement, fuel for the motor vehicle, etc. and it increases the 
business nominal accounts, the expense accounts. On the other hand it also 
decreases the assets (cash in the bank).  

                          + EXPENSES = - ASSETS 
DEBIT : Advertisements Fuel & Oil Account = CREDIT : Bank account

b) Incur expenses on credit: The business receives the value of goods and services, 
which the business will consume or use up in the normal business activities, e.g. 
placing of an advertisement, fuel for the motor vehicle, etc. and it increases the 
business nominal accounts, the expense accounts. On the other hand it also 
increases the liabilities towards the supplier, which will then be referred to as the 
creditor. 

                           + EXPENSES = + LIABILITIES 
   DEBIT : Advertisements Fuel & Oil Account = CREDIT : Creditor's account

4. Purchase of stock or goods for resale:       

a) Purchase of stock or goods and pay cash: The business receives an asset (stock) 
from another party (the supplier) and it increases the business assets. On the other 
hand it also decreases the assets (cash in the bank). 

                + ASSETS = - ASSETS 
   DEBIT : Stock, Purchase account = CREDIT : Bank account

b) Purchase of stock or goods on credit: The business receives an asset (stock) from 
another party (the supplier) and it increases the business assets. On the other hand it
also increases the liabilities towards the supplier, which will then be referred to as 
the creditor (supplier). 

             + ASSETS = + LIABILITIES 
 DEBIT : Stock, Purchase account = CREDIT :  Creditor's account

5. Sell services or goods:     

a) Sell services for cash: The business receives an asset (cash) from another party (the 
customer / client) and it increases the business assets. On the other hand it also 
increases the nominal accounts (income). 

 + ASSETS = + INCOME 
  DEBIT : Bank account = CREDIT :  Sales account
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b) Sell services on credit: The business receives an asset (debtor) from another party 
(the customer / client) and it increases the business assets. On the other hand it also 
increases the nominal accounts (income). 

       + ASSETS =  +  INCOME 
DEBIT : Debtor's account = CREDIT :  Sales account

c) Sell trading stock for cash: The business gains an asset (cash) from another party 
(the customer / client) and it increases the business assets. On the other hand it also 
increases the nominal accounts (income). The business loses an asset (stock at cost 
price) and it decreases the business assets. On the other hand it also decreases the 
nominal accounts (cost of sales). 

 (Selling price of goods sold)
+ ASSETS = + INCOME 

 DEBIT : Bank account = CREDIT :  Sales account

(Cost price of goods sold) 
- COST OF SALES  = - ASSETS 

      DEBIT : Cost of sales account = CREDIT :  Stock Account

d) Sell stock on credit: The business gains an asset (debtor) from another party (the 
customer / client) and it increases the business assets. On the other hand it also 
increases the nominal accounts (income). The business loses an asset (stock at cost 
price) and it decreases the business assets. On the other hand it also decreases the 
nominal accounts (cost of sales). 

(Selling price of goods sold)
      + ASSETS = + INCOME 

  DEBIT : Debtor's account  = CREDIT :  Sales account 

(Cost price of goods sold) 
-  COST OF SALES = - ASSETS 

     DEBIT : Cost of sales account = CREDIT : Stock Account

6. Receive cash from debtors: The business gains an asset (cash) from another party (the 
customer / client) and it increases the business assets. On the other hand it also 
decreases the business assets (debtors). 

+ ASSETS = - ASSETS 
         DEBIT : Bank account = CREDIT :  Debtor's account 

7. Payment of creditors: The business decreases a liability (creditor / supplier) with the 
money paid to the other party (the creditor / supplier) and it decreases the business 
assets (cash).

- LIABILITIES = - ASSETS 
  DEBIT : Creditor's account = CREDIT :  Bank account 
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A.2.4- MAIN CLASSIFICATION OF ACCOUNTS / FINANCIAL CATEGORIES

A.2.4.1- Accounting equation - Income statement 

The income statement reflects all the income accounts and expense accounts of the business. 
These income and expense accounts are also known as the nominal accounts. It consists of two 
basic financial categories:

Financial category What do they tell us? Examples of accounts

Income accounts
(Nominal accounts)

These accounts reflect the income sources of
the business. 

Sales

Interest received

 Expense accounts
(Nominal accounts)

These accounts reflect the expenses that the 
business incurs to generate the income. 

Motor vehicle expenses

Rent 

Telephone

Salaries and wages

Water and lights

The difference between the total of the income and the total of the expense accounts will reflect 
how much profit/loss the business made. 

The profit is the return or remuneration the owner or owners of the business receives on their 
investment in the business.  This difference  (Profit / Loss) is transferred to the Balance sheet 
(Retained earnings account) as it will increase the owner / owners equity (interest) in the business.

 PROFIT =  INCOME –  EXPENSES

A.2.4.2- Accounting equation - Balance sheet 

There are three types of accounts, which are normally, reflected in the balance sheet, proprietary 
accounts, asset accounts and liabilities accounts. These accounts will reflect what the business is 
worth as at a specific date. Owner’s equity and loan accounts will also be reflected, as will monies 
owed and the value of assets held (e.g. stock, motor vehicles, plant and machinery). 
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Accounting equation - Balance sheet 

Financial category What do they tell us? Examples of accounts

 Proprietary accounts These accounts are used to enter all the personal
transactions between the owner(s) of the 
business and themselves. This reflects how much
the owner(s) has invested in the business and 
how much they have taken out of the business.

Capital

Drawings

 Retained income / 
earnings

 Asset accounts These accounts will reflect all the assets owned 
by the business, which is used in the activities of 
the business.

Vehicles

Equipment

Furniture and fittings

Debtors 

Bank

Petty cash

Trading stock 

 Liability accounts
These accounts will reflect all the liabilities of the
business, to which the business owes money.

Loans

 Bank overdrafts

 Creditors

 CAPITA L   =  ASSETS    – LIABILITIES

The balance sheet reflects a list of all the assets that the business owns and a list of how these 
assets are financed. The balance sheet is nothing more than a list of the sources used to finance 
the assets of the business and a list of the assets, which were financed.

Owner's equity or interest in the business is the capital invested by the owner in the business. 
Capital and liabilities finance all assets the business has acquired and are also known as the 
“sources of financing” or “capital employed”. On the other hand, the assets that the business owns, 
is known as the “employment of capital”. 

A.2.4.3- Accounting equation - Income statement and Balance sheet

All transactions have an influence on either the assets, liabilities, capital, income or expense items. 
Sales increase assets (the bank or debtors) and income. On the other hand expenses, such as 
advertisements, decrease the assets (cash in the bank) or increase the liabilities (creditors).  Income
will increase the profit and expenses will decrease the profit. Since most of the transactions have 
an effect on both the Income statement and the Balance sheet, we have to look at the full 
accounting equation or expand the accounting equation. The accounting equation will then be as 
follows:

          ASSETS  +  EXPENSES    =  INCOME  +  CAPITAL  +  LIABILITIES 

                             DEBITS    = CREDITS        
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A.2.5- GROUPS/CLASSIFICATION OF FINANCIAL CATEGORIES

In order to facilitate the generation proper reports, our template sets of books have been divided 
into financial categories, which may be further divided into account groups.

A.2.5.1- Account groups - Financial categories - Income statement 

Each of the Income statement Financial categories (i.e. INCOME and EXPENSES), are further 
classified or grouped as follows:

FINANCIAL 
CATEGORY

REPORTING GROUPS 
FOR ACCOUNTS DESCRIPTION DR / CR

 NET PROFIT RETAINED INCOME Income received is greater than 
incurred expenses.

CREDIT

 / NET LOSS Incurred expenses are greater than 
income received.

DEBIT

 INCOME  INCOME
 
OTHER INCOME

Revenue generated from the sale of 
goods and services.

Revenue from ventures and activities 
outside the “normal”

CREDIT

CREDIT

 EXPENSES EXPENSES Incurred in the normal business 
activities to generate income.

DEBIT

 RETAINED EARNINGS / INCOME, at the beginning of the financial year, the income/expense 
accounts are zeroed and the resulting balance transferred to the retained income account.

Income / Expense accounts created (in TurboCASH) should be assigned to an appropriate 
reporting group and linked to a financial category in TurboCASH (INCOME or EXPENSES).

The Financial results influence the net worth of a business. A profit will increase the capital value of
a business; the opposite is true for a loss.
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Account groups - Financial categories - Balance sheet

A.2.5.2- Account groups - Financial categories - Balance sheet

Each of the Balance sheet Financial categories CAPITAL, ASSETS and LIABILITIES, are further 
classified or grouped as follows: 

FINANCIAL 
CATEGORY

REPORTING GROUPS FOR 
ACCOUNTS

DESCRIPTION DR / CR

CAPITAL CAPITAL 

MEMBERS' CONTRIBUTION 
SHARE CAPITAL

The value of the owners’ equity.

Sole Proprietor or Partnership
Close Corporation
Companies

CREDIT

 ASSETS FIXED ASSETS
 
 

CURRENT ASSETS

Physical items with a value, 
e.g. Land and buildings, Plant and 
machinery, Motor vehicles, Furniture 
& fittings, Computers, etc.

Cash in the Bank, Petty cash, and 
Value of the Debtors ledger, stock 
holding and prepaid expenses.

DEBIT

 LIABILITIES
LONG-TERM LIABILITIES
 

CURRENT LIABILITIES

All amounts owed to third parties or 
financial obligations repayable 
normally more than one year.

All amounts owed by the business to 
Creditors, Taxes payable, accounts 
payable and provisions for expenses.

CREDIT

Each Balance sheet account type created in TurboCASH should be assigned to an appropriate 
REPORTING ACCOUNT GROUP and linked to a FINANCIAL CATEGORY in TurboCASH (CAPITAL, 
ASSETS or LIABILITIES).

A.2.6- CHARTS OF ACCOUNTS in TurboCASH

TurboCASH has ready created Sets of Books, (templates) for use when you create your own Set of 
Books. These Sets of Books were installed on your system along with TurboCASH. All the necessary
settings are already pre-set for your convenience. 

In TurboCASH, the chart of accounts that is created or selected may be customised to suit your 
specific needs. All accounts in your chart of accounts must be linked to either a Balance sheet or 
Income statement category. It may be a good idea to print the Chart of accounts and to check that
all the accounts necessary for your business appear. You may add/delete accounts to cater for 
your specific requirements.

In the “EN-SOUTHAFRICA” Set of Books, the chart of accounts (listed below) is split into the two 
parts i.e. Income statement Accounts and Balance sheet Accounts, for your convenience.
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A.2.6.1- Income / Expense accounts - Chart of accounts

The first part reflects the Income / Expense type of accounts, which is reported on the Income 
statement:

 NETT PROFIT / NET LOSS   = INCOME   –   EXPENSE S

Income statement Financial categories - (Income and Expenses):

Account Description Account group1 Type

G010    Sales  INCOME Inc / Exp

G050    Other Sales  INCOME Inc / Exp

G060    Bad Debts Recovered  OTHER INCOME Inc / Exp

G065    Cash Discount Received  OTHER INCOME Inc / Exp

G070    Interest Received  OTHER INCOME Inc / Exp

G075    Profit/Loss- Sale of Fixed assets  OTHER INCOME Inc / Exp

G080    Sundry Income  OTHER INCOME Inc / Exp

G100    Cost of sales  COST OF SALES Inc / Exp

G180    Delivery Charges  EXPENSES Inc / Exp

G200    Accountancy Fees  EXPENSES Inc / Exp

G205    Advertising  EXPENSES Inc / Exp

G210    Audit Fees  EXPENSES Inc / Exp

G215    Bad Debts Written-off  EXPENSES Inc / Exp

G220 Bank Charges  EXPENSES Inc / Exp

G225    Cleaning  EXPENSES Inc / Exp

G230   Commissions Paid  EXPENSES Inc / Exp

G235    Consultancy Fees  EXPENSES Inc / Exp

G240    Depreciation  EXPENSES Inc / Exp

G245   Entertainment  EXPENSES Inc / Exp

G250 Finance Charges  EXPENSES Inc / Exp

G255 Gifts and Donations  EXPENSES Inc / Exp

G260 Insurances  EXPENSES Inc / Exp

G262 Interest Paid  EXPENSES Inc / Exp

G265   Legal Fees  EXPENSES Inc / Exp

G270    Lights and Water  EXPENSES Inc / Exp

G275    Medical Expenses  EXPENSES Inc / Exp

G280    Motor Vehicle Expenses  EXPENSES Inc / Exp

G280001 Fuel  EXPENSES Inc / Exp
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Account Description Account group1 Type

G280005 Motor Repairs  EXPENSES Inc / Exp

G280010 Motor Costs - Other  EXPENSES Inc / Exp

G285    Printing Postage and Stationery  EXPENSES Inc / Exp

G290 Rent Paid  EXPENSES Inc / Exp

G295    Repairs and Maintenance  EXPENSES Inc / Exp

G300    Salaries - Directors  EXPENSES Inc / Exp

G305    Salaries - Staff  EXPENSES Inc / Exp

G310    Salaries/Wages- Employers Contrib.  EXPENSES Inc / Exp

G315    Subscriptions  EXPENSES Inc / Exp

G320    Telephone and Fax  EXPENSES Inc / Exp

G330    Travelling Expenses  EXPENSES Inc / Exp

A.2.6.2- Balance sheet accounts - Chart of accounts

The second part reflects the Balance sheet (Assets, Capital and Liabilities) type of accounts, which 
is reported on the Balance sheet:

 CAPITAL =  ASSETS –  LIABILITIES

Balance sheet Accounts – Financial categories (Capital, Liabilities and Assets):

Account Description Account group1 Type

G505    SHARE CAPITAL  CAPITAL

 G510    RETAINED INCOME  CAPITAL  Retained Income

G550    Long Term Loans  LONG TERM LIABILITIES

G560    Installment Sale - Creditors  LONG TERM LIABILITIES

G600    FURNITURE AND FITTINGS  FIXED ASSETS

G600010 Furniture and Fittings at Cost  FIXED ASSETS

G600020 Furniture/Fittings Accum. Deprec.  FIXED ASSETS

G610    OFFICE EQUIPMENT  FIXED ASSETS

G610010 Office Equipment at Cost  FIXED ASSETS

G610020 Office Equipment Accum. Depreciation  FIXED ASSETS

G620    MOTOR VEHICLES  FIXED ASSETS

G620010 Motor Vehicles at Cost  FIXED ASSETS

G620020 Motor Vehicles Accum. Depreciation  FIXED ASSETS

 G700    DEBTORS CONTROL ACCOUNT  CURRENT ASSETS  Debtors Control
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Account Description Account group1 Type

G730    DEPOSITS PAID  CURRENT ASSETS

G740 POS-Till Account  CURRENT ASSETS

G745 POS-Cheque Payments Account  CURRENT ASSETS

G750    STOCK CONTROL ACCOUNT  CURRENT ASSETS

 B810    CURRENT BANK ACCOUNT  CURRENT ASSETS  Bank account

 B820    PETTY CASH  CURRENT ASSETS  Bank account

 G900    CREDITORS CONTROL ACCOUNT  CURRENT LIABILITY  Creditors Control

G920    SALARIES CONTROL  CURRENT LIABILITY

G920001 Salaries  CURRENT LIABILITY

G920005 UIF Payable  CURRENT LIABILITY

G920010 PAYE Payable  CURRENT LIABILITY

G920015 Skills Development Levy  CURRENT LIABILITY

G950    VAT CONTROL ACCOUNT  CURRENT LIABILITY

 T950005 Output (Sales) VAT 14%  CURRENT LIABILITY  Tax account

 T950010 Input VAT (Exp) - 14%  CURRENT ASSETS  Tax account

 T950015 Zero Rated VAT - 0%  CURRENT LIABILITY  Tax account

G950100 VAT PAYMENT ACCOUNT  CURRENT LIABILITY

G999    SUSPENSE ACCOUNT  CURRENT LIABILITY
The chart of accounts may be customised to suit your specific needs. You may change descriptions, add new
accounts and sub-accounts. TurboCASH allows you to create up to 999 main accounts. For each of these 
main accounts you may also create up to 999 sub-accounts.
In a Set of Books consisting of a 4-Digit Main Accounts, you may create up to 9999 main accounts.
In a Set of books consisting of 5-digit main accounts, you may create up to 99999 main accounts.
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A.2.7- THE LEDGER

The Ledger consists of the General ledger (Chart of accounts), the Debtor's ledger; the Creditor's 
ledger and the Stock ledger. The ledger can be illustrated as follows:

1. General ledger - consists of the Income and Expense accounts 
and Capital, Assets and Liabilities (Balance sheet) accounts. 

It also includes a control account for the debtors, creditors and 
stock items.

2. Debtor's ledger - consists of the individual debtor accounts. 
Each individual debtor's account contains the contact 
information, messages and accounting information. 

The total outstanding balance of all the debtor accounts in the 
debtor's ledger is automatically updated and reported in the 
Debtor's control in the General ledger.  

3. Creditor's ledger - consists of the individual creditor accounts. 
Each individual creditor's account contains the contact 
information, messages and accounting information. 

The total outstanding balance of all the creditor accounts in the creditor's ledger is 
automatically updated and reported in the Creditor's control account in the General 
ledger.  

4. Stock ledger - consists of the individual stock item records. Each individual stock item
records contain specific information, such as quantities, cost prices, selling prices, units,
re-order levels, etc. The total outstanding cost price value of all the stock item records in
the stock ledger is automatically updated and reported in the Stock control account in
the General ledger. It also includes a control account for the debtors, creditors and stock
items.

The outstanding balances of the individual accounts and records in the Debtor's ledger, the 
Creditor's ledger and the Stock ledger is automatically updated and reported in the respective 
Control accounts in the General ledger. 

TurboCASH5.1 – 2018 – Accounting Made Easy - 33



MODULE A - INTRODUCTION TO ACCOUNTING

A.2.8- CONTROL ACCOUNTS

In the General ledger, you would only have one debtor’s account and one creditors account. If you
sell on credit to your customers, how will you keep track of each of the individual debtors’ 
accounts? If you buy on credit from your suppliers, how will you keep track of each of the 
individual creditors’ accounts? If you trade with stock items, how will all the hundreds of stock 
items fit into the General ledger? How will they fit into your Chart of accounts? Only the total of all
individual debtor's accounts and the total of all individual creditor's accounts and the total of your 
individual stock item records are listed in the Trial balance and in the financial statements.

Imagine what the size of your General ledger would be if you have 800 debtor accounts, 400 
creditor accounts and 200 stock items. If you open ledger accounts for each of your individual 
debtors and creditors and stock items in the respective subsidiary ledgers, your General ledger 
would have approximately 1400 less accounts. Now you will have three more ledgers in which you 
can manage and store specific information regarding each of the accounts for your debtors, 
creditors and stock items. 

Only the total of each of these three ledgers will be reflected in your General ledger, Trial balance 
and Balance sheet. You will also have a separate list of all your debtors, creditors and stock items.

Another benefit of control accounts is, that in large business enterprises, you may delegate the 
subsidiary ledgers to the debtor's clerk who can manage and balance the debit and credit entries 
in the individual ledger accounts and compile a list of the balances at the end of a period. These 
balances must then balance with the debtor's control account. The debtor's clerk can also use the 
ledger accounts for credit control and to collect the debt. The same principles may apply for the 
purchases department.
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General ledger – A list of your Cart of accounts, income and expenses, capital, assets and 
liabilities. In the Chart of  accounts, you would keep the control accounts regarding your debtor 
accounts, creditor accounts and the stock items (if you trade in stock items). The details are kept in
the individual subsidiary ledgers (debtor's ledger, creditor's ledger and stock ledgers). 

The subsidiary ledgers and the General ledger, is as follows:

1. Debtor's control account – This account reflects the total amount owed by all the 
individual debtor accounts. The balance of the debtor’s control account must equal the 
total of the debtors’ list, which represents the amounts owed by the individual debtors 
obtained from the individual balances in the various subsidiary ledger accounts for each 
debtor. This subsidiary ledger is known as the debtors' ledger.
In the debtors' ledger, the transaction details and additional information regarding each 
debtor such as their personal and contact information, credit limit, terms, etc. may be 
stored. This debtors' ledger is also a register of each and every transaction that you and a
specific debtor entered into.

2. Creditor's control account – This account reflects the total amount owed to all the 
individual creditor accounts. The balance of the creditor’s control account must equal the
total of the creditors list, which represents the amounts owed by the individual creditors 
obtained from the individual balances in the various subsidiary ledger accounts for each 
creditor. This subsidiary ledger is known as the creditors' ledger.
In the creditors' ledger, the transaction details and additional information regarding each 
creditor such as their personal and contact information, credit limit, terms, etc. may be 
stored. This creditors' ledger is also a register of each and every transaction that you and 
a specific creditor entered into.

3. Stock control account – This account reflects the total amount or value of all stock 
items. The balance of each of the individual stock item ledger accounts or records must 
equal the total of the stock item list, which represents the amounts or value of the 
individual stock items obtained from the individual balances in the various subsidiary 
ledger accounts for each stock item. This subsidiary ledger is known as the stock ledger.

In the stock ledger, the transaction details and additional information regarding each stock item 
such as the cost prices, selling prices, quantities, and location on the shelves, etc. may be stored. 
This stock ledger is also a register of each and every stock transaction, how many items are 
purchased, sold, etc.
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A.2.9- TRANSACTION LIST - DEBITS AND CREDITS 

The following list of most commonly used transactions illustrates the debit and credit transactions 
on the double entry accounting principle:

TRANSACTION DEBIT CREDIT

Capital - cash contribution  Assets - Bank  Capital

Sales - cash  Assets - Bank  Income

Sales - credit  Assets - Debtors  Income

Purchases - cash  Assets - applicable  Assets - Bank

Purchases - credit  Assets - applicable  Liabilities - Creditors

Expenses - cash  Expenses - applicable  Assets - Bank

Expenses - credit  Expenses - applicable  Liabilities - Creditors

Debtors - receipts  Assets - Bank  Assets - Debtors

Creditors - payments  Liabilities - Creditors  Assets - Bank
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HARDWARE AND SOFTWARE REQUIREMENTS

B.1- HARDWARE AND SOFTWARE REQUIREMENTS

In order to run TurboCASH you will need, as a minimum, the following:

• An IBM compatible computer running a 32-bit Microsoft Windows 98, Windows 2000, 
Windows ME, Windows NT, Windows XP or Vista, Windows 7 or Windows 10.

• 256 MB of RAM for a single user and 512 MB for a multi-user.

• 36 Speed or higher CD ROM

• SVGA / LCD / LED screen (1024 x 768 screen resolution or higher).

• Approximately 650MB hard disk space.

Recent decreases in the cost of hardware have made even the simplest of modern machines, 
orders of magnitude better than older machines. TurboCASH is a database. It will run more 
securely on a better machine. The costs saved by using an old machine will soon be at risk given 
the time and effort that it will take to construct a Set of Books and re-enter the data.

B.2- INSTALLING TurboCASH5 SINGLE-USER 

The TurboCASH5 installation process should only take a few minutes. During this process you may
need to select a few options.  The most important options, you may need to select is your country 
and language, reading and accepting the licence agreement. 

TurboCASH5 should, by default, install in the TCASH5 directory (e.g. C : / TCASH5. If you choose to install 
TurboCASH5 in different directory or folder on your system, DO NOT install TurboCASH in any Program 
files directories. 

This documentation will describe to do a standard installation to run TurboCASH5 locally on one computer 
for 1 user only. 

• Multi-user installation and configuration will be dealt with in separate documentation. 
• Multi-user is limited in this edition! You will need to buy a multi-user license or compile the 

source yourself. 

To install TurboCASH5 single-user:
1. Once the TurboCASH5 installation file is downloaded, select the file and open it. The 

“Select country and language” screen is displayed: 

 
2. Select your country and language. Click OK. The “Welcome to the TurboCASH5 Setup 

Wizard” screen is displayed: 
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3. Click Next. The “License Agreement” screen will be displayed. 
4. Please read the agreement carefully. If you agree with the terms and conditions of the 

license agreement, select the “I accept the agreement” option and click Next. The “Select 
Destination Location” screen is displayed: 

 
5. The default path is TCASH5 on your system's default drive, (e.g. C:/TCASH5). 

You may click on the Browse button to select any other folder than the default path where you 
wish to install TurboCASH5 on the “Browse For Folder” screen. 

6. Once finished, click Next. The “Select Components” screen, is displayed:
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7. A list of the components will be displayed. Select or deselect (remove the tick) for the 
following options, if necessary: 

a) Install Firebird Database Server (Needed to run TurboCASH5 local 1 user only) 
- If you are installing TurboCASH5 for the first time, you need to make sure that 
this option is selected. 

Select this option if you need to run TurboCASH5 locally for 1 user only. 

b) Install Firebird Database Server (Needed to run TurboCASH5 on a server or 
client). 

For the purpose of the single-user installation, do not select this option. 

c) Install FlameRobin SQL Browser Type - (Optional) - This will install the 
FlameRobin Database Admin software to manage your TurboCASH5 databases 
(Sets of Books). 

For the purpose of the single-user installation, do not select this option. 

The FlameRobin software is used to browse, check and edit data. The installation of 
FlameRobin is optional and is not required to run TurboCASH5. The use of FlameRobin 
is not recommended for users which have insufficient knowledge and expertise. 

8. Once finished, selecting the components to be installed, click Next. The “Select Start 
Menu Folder” screen is displayed: 
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9. The default name for the “Select Start Menu Folder” is TurboCASH5. 

You may over type this with your own description, if necessary. This will create an item on the 
Start → Programs menu list with items for TurboCASH5, Uninstall TurboCASH5 on your 
Windows™ Task bar. 

10. Once finished, click Next. The “Select Additional Tasks” screen is displayed: 

11. By default no options are selected. Select the following options, if you wish them to be 
installed: 

a) Create desktop icon - This will create an icon on your desktop from where you 
may start or launch the TurboCASH5 program. 

b) Create Quick Launch icon - This will create an icon on your Quick Launch 
Toolbar on your Windows™ Task bar. You may then start or launch the 
TurboCASH5 program directly from the Quick Launch Toolbar. 

12. Once finished, click Next. The “Ready to Install” screen is displayed: 
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13. Please check the following selections to be installed: 
a) Destination location 
b) Setup type 
c) Selected components 
d) Start Menu folder 
e) Additional tasks (icons) 

This is your last chance to change anything to be installed. If you are not satisfied with
your selection, click on the Back buttons to select or deselect the necessary options. 

14. Click Install. The TurboCASH5 installation process will start. Once the TurboCASH5 
installation process is finished, the “Completing the TurboCASH5 Setup Wizard” screen is 
displayed: 

 

The following Components will not be listed, if it was not selected in the “Select Components” 
screen: 

• Install Firebird 
• Install FlameRobin SQL Browser Type 
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15. If the Launch TurboCASH5 option is selected, the TurboCASH5 program will 
automatically be launched.

If you do not select this option (remove the tick), you may then launch or start TurboCASH5 from
the following options (if selected or where specified): - 

• Desktop icon. 
• Quick Launch icon (on the Quick Launch Toolbar on your Windows™ Task bar). 
• Start → Programs→ TurboCASH5 menu from the Windows™ Start button. 

16. Once finished selecting or deselecting the necessary options, click Finish. The TurboCASH
program will be started if you did not remove the tick on the Launch TurboCASH5 option.

B.3- LAUNCHING TurboCASH5 FOR THE FIRST TIME 

1. The first screen which will display after TurboCASH is launched for the first time, is the 
“Choose a Language” screen. 
The TurboCASH interface will display in the
selected language (Switch language (Start
ribbon)). Depending on your country /
language installation of TurboCASH, the specific
language / country language have already been
set for each Set of Books. (Access control
(Setup ribbon). 
When opening a Set of Books, it will
automatically load the language file. All screens,
reports and layout files are translatable via the
language files.
It will display the tax terminology for the
selected country e.g. en-South-Africa will
display VAT, af-Afrikaans will display BTW, en-
Australia and en-New-Zealand will display GST, en-American will display Sales tax, etc. 

2. Select your language and click on OK the button. 

Some languages may not display correctly if your system locale in the Regional and Language Settings 
option in the Control Panel of your system does not support the language and system locale (unicode). 

English is the default (driver language file – used as the basis for translation, and to customise language 
files). For example, the en-American and the en-UK files contain specific label, text, currency and tax 
terminology for each country. 
Should you select the incorrect language at this stage, you may change the language in the Switch 
language  (Start ribbon). 
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STARTING TurboCASH5 

B.4- STARTING TurboCASH5 

To start TurboCASH5:

1. To start TurboCASH, double-click on the  icon (if the “Create a desktop icon” 
option was selected on the “Additional tasks” screen in the “Setup” install screen).

Or select TurboCASH on the Windows Start button TurboCASH5

The following progress screen will be displayed:  

The TurboCASH program will be launched. 

Windows 10
After installing TurboCASH, the TurboCASH5, should be displayed in the Recently added list on 
the Start menu. You may click on it and drag it to the Apps space. 
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If it is not listed, click on All apps. All the Applications should be listed. Select TurboCASH5 and 
drag it to the Apps space.
Quick access and launch of TurboCASH will then be available from the Start icon in Windows. 

2. Once you have opened TurboCASH, you see a main menu bar at the top of the screen. 

At first only the items under the Start ribbon are active. Before you can select any of the menu options, you 
will need to “Open a Set of Books” (On the Start ribbon, select Open).

B.5- OPENING SETS OF BOOKS

By default, only the Set of Books will be installed for the country language selected in the “Select 
your country and language” when installing TurboCASH5. 

To open a Set of Books:

1. On the  Start ribbon, select Open.

Other Sets of Books:

If you are looking for a different Set of Books (template), not displayed in the list of the “Set of 
Books” screen, click on the Browse icon and select a Set of Books in the “…\Bin\Repository\” folder.

The “Repository” folder contains all Sets of Books (templates) which is available in TurboCASH5.
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English tutorials:

The following Set of Books based on this tutorial, are installed in the “…\Bin\EN-TUTORIALS\” 
folder.

• HANDYMAN (No transactions)

• HANDYMAN-A (Unposted)

• HANDYMAN-B (Posted)

To follow this tutorial, you need to click on the Browse icon and select these Sets of Books. 

When opening these English tutorials, the default English language file, will be initialised to display
on the TurboCASH interface, reports and document layout files. The English language file refers to 
Tax instead of VAT/GST/Sales tax. 
Should you wish to use the Tax terminology for your country, you may select the country specific 
English language file.   

 Afrikaans tutorials:
The following Set of Books based on the Afrikaans tutorial, are installed in the “…\Bin\AF-
HANDLEIDINGS\” folder.

• NUTSMAN (No transactions)
• NUTSMAN-A (Unposted)
• NUTSMAN-B (Posted)

To follow the Afrikaans tutorial, you need to click on the Browse icon and select these Sets of 
Books. 

The Afrikaans book (“Rekeningkunde met Gemak”) based on this tutorial, is also available. 

2. Select the Set of Books and click Open.
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B.6- SELECTING A LANGUAGE

The TurboCASH interface will display in the selected language (Switch language (Start ribbon). 
Depending on your country / language installation of TurboCASH, the specific language / country 
language have already been set for each Set of Books. (Access control (Setup ribbon). 

When opening a Set of Books for a specific country, it will automatically load the language file 
(containing specific currency and tax terminology). All screens, reports and layout files are 
translatable via the language files. 

It will display the tax terminology for the selected country e.g. en-South-Africa will display VAT, af-
Afrikaans will display BTW, en-Australia and en-New-Zealand will display GST, en-American will 
display Sales tax, etc. 

List of the English language files which refers to country specific currency and Tax terminology:
English VAT English GST English Sales tax / Consumption Tax

en-Bangladesh en-Australia en-American (Sales tax)

en-Barbados en-Belize en-Tonga (Consumption tax)

en-Botswana en-New-Zealand

en-Cameroon

en-Ireland

en-Isle-of-Man

en-Lesotho

en-Malawi

en-Malta

en-Mauritius

en-Namibia

en-Rwanda

en-South-Africa

en-Tanzania

en-Trinidad

en-Uganda

en-UK

en-Zambia

en-Zimbabwe
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B.6.1- Changing language files

Should the incorrect language file and / or Tax terminology be displayed, you may set the 
language files in the following options:

To choose a language (global setting):

1. On the Start ribbon, select Switch language. 

2. Select the language of your choice.

3. Click OK.

To set a language for a Set of Books:

1. On the Setup ribbon, select Access control. 

2. In the “System lang” field, select the language of your choice for the Set of Books.

3. Click Apply. Each time when the Set of Books is opened, the selected language file will 
be loaded.

B.6.2- Changing language files for debtors / creditors

Multiple language – Document layout files – Supports the automatic translation via the 
language files (Switch language (Start ribbon)) maintained in Tools→ Customise language 
menu (Setup ribbon).

Document layout files will be printed in the language set for debtor (customer / client) and 
creditor (supplier) accounts. Layout file 2 is also supported to print a copy of another layout file or 
a delivery note. 

For example, in South Africa, the language that may be selected for English speaking debtors 
(customers / clients) and creditors (suppliers) is “en-South-Africa”, and for Afrikaans speaking 
debtors (customers / clients) and creditors (suppliers) is “af-Afrikaans”.

To set a language for a Debtor or Creditor:

1. On the Action ribbon, select Debtors or Creditors. 

2. In the “Language” field, select the language for the debtor (customer / client) or creditor 
(supplier).

3. Click Save. When printing documents for the debtor (customer / client)(invoices, credit 
notes and quotes), or documents for the creditor (supplier) (purchases, supplier returns 
and orders) it will print in the selected language.
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B.6.3- Customising language files (optional)

You may edit or translate the existing labels or descriptions used in the TurboCASH to suit your 
specific needs or industry. You may also create or add a new language for a specific country or 
industry. You may also create or add a new language for a specific country or industry. 

The following languages (87 countries / tax regimes), are available: Afrikaans, Arabic, English (25), 
Croatian (3), Español (13), Français (18), German, Greek (2), Indonesian, Italian, Lithuanian, 
Netherlands, Slovenian, Swedish, Swahili, Thai, Turkish (3), and Xhôsa, etc.

Language files are prefixed with the Language code followed by the Country name (e.g. en-
American, en-Australia, en-UK, en-South Africa, etc.). 

The names of the Sets of Books (stored in the “…\Bin\Repository\” folder) are also (prefixed with 
the Language code followed by the Country name). Most of these Sets of Books are linked to the 
applicable language file (Access control (Setup ribbon)). 

The language files are stored in the *.dfm file type. The language files are located in the 
“...\Bin\Languages” directory, or other directory, where TurboCASH is installed. The default 
language for the country you have selected when installing TurboCASH will automatically be 
displayed when launching TurboCASH for the first time. 

If a Set of Books is opened, it will load the language file (Access control (Setup ribbon)).

If this is not the correct language, you may select any of the available languages. To do this, access
Switch language (Action ribbon). 

Care must be taken to ensure that existing labels in the master language are not amended. You need to 
create a new name for the file you wish to edit. 

You may at any time switch over to the master (English, Afrikaans or any other available language) 
in the Switch language (Start ribbon), and back again to your new customised language file. 

If you have created or edited a language file, it is recommended that you need to save a copy of the 
language file somewhere else on your system, in the event of uninstalling and reinstalling TurboCASH. 
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To create, edit or translate language labels or descriptions: 

1. On the Setup ribbon, select Tools → Customise language. 

2. Check in the “Select Language” field that the correct details is selected. 

3. In the “New Lang” field, Enter the name for your new language.

4. Click Create.

5. Edit or change the labels as necessary. 

6. Once finished creating or editing your language file, click E-mail your language file to 
us to send the language file to the TurboCASH developers. This will automatically launch 
your system’s default e-mail program and attach your language file in the e-mail 
message. The developers will then add your language file in the next TurboCASH release.

7. Once finished, click Close.

It is strongly recommended that the label, which is edited or entered, is not longer than the “Default 
English” labels’ length. If your label is too long, it may cause some options in the program not to function or
display properly. Do not use the Delete button to remove any of the existing edited labels. 

Unify button – So not click on the Unify button. This may change the TurboCASH programme name on the 
screens <@APPNAME@> and hyper-links <@APPURL@> to incorrect websites. 
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B.7- REGISTERING TurboCASH 

Registration of TurboCASH5 is optional. There are no limitations to the number of transactions, 
etc.  

You need to register TurboCASH5 to:

1. Webshop - To use any of the powerful Plugins, you need to purchase a license for most 
of the Plugins. Before you can Register plugins, you first need to Register TurboCASH5. 

2. Forum - On the shared forum, you may find topics (posts), post questions or issues, find 
solutions and participate in any discussions. 

B.7.1- Register create an account 

TurboCASH and osFinancials share the same codebase. So we decided to rejoin together to make 
a single place of content, forum, registrations and a global shop to purchase your products. To get
to this, all you need to visit the osFinancials website - TurboCASH page at osFinancials.

To register / create an account for TurboCASH on the website:

1. To create a new account, you need to register TurboCASH in the osFinancials website - 
TurboCASH page at osFinancials website. 

2. On the osFinancials and TurboCASH registration page (http://www.osf-boekhoudpakket-
administratie.nl/index.php/en/component/users/?view=registration), select the Create an
account option. 

3. Enter the following:

a) Name

b) Username

c) Password

d) Confirm password 

e) Email Address

f) Confirm Email Address

g) Settings – Frontend language – Select English (United Kingdom), English (USA) or 
Dutch (NL). 

4. Click Register. 
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Activate registration of TurboCASH5  

B.7.2- Activate registration of TurboCASH5  
Once you have already created an account (i.e. Username and password) on the website, you need
to enter your username and password in TurboCASH program. 

To register TurboCASH:

1. Click Register icon (or Online registration) icon) (Start ribbon). 

 

If you have not initiated the “Register your TurboCASH” screen at this stage, you may later access 
this screen from the Help → Online registration menu (Action ribbon).

2. Click Get it online (of the “Register your TurboCASH” screen), the following “Register your
TurboCASH” screen is displayed:

3. Enter the Username and password.

4. Click Send.  An information message “Registration send success!” will be displayed. 

5. Click OK. The message “You have registered successfully! Username” (email address and 
username) as well as the “Code” (Serial number) will be displayed below the “User 
password” field, Send and Reregister buttons. If you have purchased any plugins, these 
plugins will be listed in the “To register plugins, you need to register TurboCASH5 first!” 
section of the screen. 
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TurboCASH FEATURES

C.1- TurboCASH FEATURES

The TurboCASH program is an exceptionally powerful accounting program yet easy to use. 
TurboCASH5 helps you to get started quickly and automates many time consuming processes.

C.1.1- Get started easily

• Easy step-by-step installation.

• Use our templates or create your own Set of Books.

• Comprehensive manuals, tutorials and Help system.

C.1.2- Multiple language support 

Multiple language  / Country specific – Can be installed in 87 Language / Country 
configurations. Some languages / countries are; Afrikaans, Arabic, English (25), Croatian (3), 
Español (13), Français (18), Hrvatski (3) German, Greek (2), Indonesian, Italian, Lithuanian, 
Netherlands, Portuguese (9) Slovenian, Swedish, Swahili, Thai, Turkish (3), and Xhôsa, etc. 

Multiple Language Set of Books 
Multiple Language Set of Books - This makes it possible for a multi-lingual country or an international 
company to work in different languages on the same set of books. 

C.1.3- Calendar / Planner

• Create and manage general events (appointments) and events (appointments) for debtor 
(customer / client) and creditor (supplier) accounts.

• Schedule Repeating invoices. 
• Create and manage appointments for hours (labour, consulting, etc.). This will generate 

Quotes which can be confirmed and converted when the appointment is completed.
• Print a list of events (appointments) for any period or date(s).

C.1.4- Debtors / Creditors

• Quick access to websites - Double-click on the “Website” field of debtor (customer / 
client) and creditor (supplier) accounts to directly visit the websites of debtor (customer / 
client) and creditor (supplier) accounts in your system's default web-browser.

• Quick access to e-mail - Double-click on the “E-mail” field of debtor (customer / client) 
and creditor (supplier) accounts to directly insert the e-mail address of debtor 
(customer / client) and creditor (supplier) accounts in your system's default e-mail 
program.
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• Up to two (2) Reporting groups for debtor (customer / client) and creditor (supplier) 
accounts.

• Manage debtor (customer / client) accounts in nine (9) tabs (i.e. Delivery address,  
Accounting information, Contacts, Appointment, Documents, Transactions, Bank account,
Backorders and Stock items tabs.   

• Manage creditor (supplier) accounts in eight (8) tabs (i.e. Delivery address,  Accounting 
information, Contacts, Appointment, Documents, Transactions, Bank account and Stock 
items tabs.  

C.1.5- Full stock control

• Up to eleven (11) stock item types can be used to create (add), copy, stock items. 
• Up to two (2) reporting groups for stock items. 
• Financial entry stock type can be used to process invoices, from the account in the 

ledger.

C.1.6- Batch processing

• Repeating transactions. 
• Cancel / Reverse posted batches.
• Abbreviation Definitions 
• Generate multiple transactions (Charge amounts, Interest, Fixed amount, Debtors with 

balances less than a specified amount). 
• Create receipts (Receipt batches).
• Receive payment - Open item. This will automatically generate transactions in the receipt 

batch and post it to the ledger. 
• Creditors balance at date (Payments batches) – This will import the creditor (supplier) 

accounts balances into the payments batch).  

C.1.7- Document processing

• Up to two (2) reporting groups for documents. These can be changed on the context 
menu.

• Salespersons – The salesperson can be changed on the context menu. Salespersons is 
added to purchase document layout files (i.e. Purchases, Supplier returns and Orders). 
This will indicate who processes orders, purchases and supplier return documents.

• Repeating invoices – Processed in the Edit menu or the Calendar (Action ribbon).
• Quotes can be generated from the Calendar / Planner and be converted to Invoices.
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• Create documents from the context menu Convert invoices to quotes, Convert orders 
to purchases, Copy documents, Change account, etc. 

• Documents supports abbreviations to auto-complete the “Description” fields in 
document lines. 

• Change the sort sequence of transactions and / or comments on posted as well as 
unposted documents. 

• Cancel / Reverse posted documents.
• Export / Import Documents. 
• Clear / Reset a Set of Books and retain the documents as unposted. 

C.1.8- Powerful comprehensive reporting

• Up to two (2) reporting groups for Accounts, Debtors, Creditors, Stock, Documents, Cost
centres. 

• Multi-year reporting periods / dates – All transaction reports can be printed for a 
period (Month, 2 Months, Quarter (3 Months), 4 Months, Half Year (6 Months) or Year) or 
specific date(s).

• Report footers – The Data source (i.e. full system path, name of the Set of Books), User  
(i.e. System user and TurboCASH user) as well as the date time stamp and page numbers 
are printed on the report footers. 

• T-Ledger analyser 
• Budget listing and Actual figures in the Trial balance, Income statement, Balance 

(Balance sheet) and Standard column balances reports.  
• Budget vs Actual report.
• Column balances in the General ledger, Debtor's ledger and Creditor's ledger.

• T-Account viewer – Filter, Print and Export the transactions.
• Sales and Purchase analysis. 
• Report designer - In addition to the reports, you may design your own customised user 

reports with the powerful Report designer. The Report designer allows you to write your 
own external reports and documents using the data in a Set of Books in TurboCASH. 

• Batch type reports – These may be printed from various options:
• Posted batches tab of “Batch entry” screen. 
• Documents and Transactions tabs of debtor (customer / client) and creditor 

(supplier) accounts. Only the transactions applicable to the selected account will 
be listed. 
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C.1.9- Export / Import 

The following supports export and import of Accounts, Debtors, Creditors, Stock, Documents and 
Posted batches.

C.1.10- Export to spreadsheets 

The following can be exported to spreadsheets:
• Debtor (customer / client) accounts
• Creditor (supplier) accounts
• Documents 
• Stock items
• T-Ledger analyser Reports

• Budget listing and Actual figures in the Trial balance, Income / Expenses (Income
statement), Balance (Balance sheet) and Standard column balances reports.  

• Budget vs Actual report.
• Column balances in the General ledger, Debtor's ledger and Creditor's ledger.

• T-Account viewer – Transaction Reports - Filter, Print and Export the transactions. 

The T-Account viewer may be launched from the Reports → T-Account viewer menu or 
right-click (Show details). 

These transactions may also be viewed, printed and exported for specific accounts from 
the following options:

• T-Ledger analyser – Selected account or reporting group.
• Search (F3) – Selected account or batch in the search results (double-click or 

right-click).
• Documents and Transactions tabs of debtor (customer / client) and creditor 

(supplier) accounts. Only the transactions applicable to the selected account will 
be listed.  

C.1.11- Additional features

Supports the following features, if activated:
• Cost centres - Cost centre 1 and Cost centre 2 supports budgets.
• Projects.
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C.2- THE TurboCASH PROGRAM

The TurboCASH program is easy to use with a user-friendly graphical interface. When launching 
TurboCASH for the first time, the TurboCASH program will be displayed in the language selected 
when TurboCASH is launched for the first time. 

For the purpose of this documentation, the images (screen shots) are displayed in the default 
English language.

Most of the program options can be easily accessed by one or more mouse-clicks or by pressing a
few buttons on the keyboard.

TurboCASH offers many features and options. To enhance your effectiveness and efficiency to 
perform your tasks in the program, it is important that you can access the required options as 
quickly and effortlessly as possible. 
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The new design of the TurboCASH5 user-interface (UI) offers you different options, which displays 
information and / or allows you to access the different features and options:

1. Titlebar – Displays the version of the TurboCASH program, the registered user's name (if 
the program is registered) and the user logged into the Set of Books (if users and

 passwords were set in the Access control (Setup ribbon)).

2. Tool tips - When the mouse is moved over an icon on the
ribbons the name of the icon and TurboCASH is displayed. If a
short-cut key is is assigned to that icon, it will also be displayed
(e.g. Documents (F6)). It will not launch any function, but is only
a flash card. This should refresh user's memory to the short-cut
keys.

3. Tray icon - The “Tray icon notification area” of your operating system. It displays the 
name of the opened (active) Set of Books (as entered in the “Company name” field) - 
(Company info (Setup ribbon)) when the mouse is moved over the TurboCASH5 icon. It 
will also automatically display the name of the Set of Books when the Set of Books is 
opened.

Tray icon – Context menu

To launch the TurboCASH5 program's context menu:
Click on the < Tray icon on the “Windows task bar”. 
On the TurboCASH5 icon, right-click. A menu list of the 
ribbon tabs (i.e. Start, Action, Reports and Setup will be 
displayed. 
If you select one of these ribbon options, the menus (and 
sub-menus) for the selected ribbon will be available.  

4. Ribbons – The functions and features and utilities are grouped in five (5) ribbon tabs. 
These are:

a) Start - Open, Register (will be displayed until your TurboCASH5 is registered), 
Backup / Restore, Delete Set of Books, Create Set of Books, Save as (Set of Books), 
Close Set of Books, Switch language and Exit TurboCASH. 

b) Action – Documents, Debtors, Creditors, Stock items, Batch entry, Reconciliation, 
Open item link, Contacts, Calendar, Accounts, Update ledger, Help (menu list), Edit 
(menu list), Input (menu list), Search, Workflow and Projects (if activated). 

c) Reports – Reports (menu list), User reports (menu list),T-Ledger analyser 1,T-Ledger 
analyser 2, T-Account viewer, Printer and Report designer. 
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d) Setup – Company Info, Documents, Groups, Stock information, Reporting Dates, 
Access control, Batch types, Salesperson, Printer, Workflow setup, Setup (menu list), 
Report designer, Calculator, Import, Export and Tools (menu list).

e) User tab – This tab is by default not activated. The User tab is a quick menu to 
manage (customise) the menus, most frequently used. It can be grouped into up to 
six (6) groups. If users are added in the Access control (Setup ribbon), it will store 
the custom menus for each user. There are two (2) options to activate this tab, i.e.: 

i) Auto learn – Tick this option to add the last accessed options to the User tab.

ii) Edit – Add / Remove the options to be displayed in the User tab.

All options and menus on the Start, Action, Reports and Setup ribbon tabs, are available 
via a context menu. 
You may right-click anywhere in the program  (e.g. Ribbon bar, Statusbar, etc.) to access
the main context menu. 

5. Statusbar – The following is displayed in the Status-bar: 

a) User name – “Universal Administrator” will be displayed when a Set of Books with no
users and passwords. If users and passwords were set in the Access control (Setup 
ribbon), it will display User and the user's name. 

b) Name of the Set of Books - The name of the opened (active) Set of Books is 
displayed in the fourth section. 

c) Path of the Set of Books - The full path of the opened Set of Books is displayed in 
the last section.

C.2.1- RIBBONS AND MENUS 

Most of these program options are only accessible if a valid Set of Books are opened. If no Set of Books are 
opened, only the Start ribbon tab will be displayed. The Action, Reports, Setup and User tab ribbons will be 
inactive. 
On the Start ribbon, the Open, Backup / Restore, Delete Set of Books, Create Set of Books, Switch language 
and Exit TurboCASH options will be accessible.  
You need to have a Set of Books opened to access the Register and Save as options.

C.2.1.1- Start ribbon 

The Start ribbon is used to manage your sets of books, registration and language.
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The following ten (10) options are available:

1. Open - Open an existing Set of Books in any valid folder on the system.

2. Register - Register the TurboCASH5 Program. Once you have registered TurboCASH5, 
and you restart the TurboCASH5 program, it will be removed from the Start tab on the 
ribbon bar.

3. Backup / Restore - Create a backup file of your Set of Books. You may also restore the 
Set of Books from a valid backup file.

4. Delete Set of Books - This option is used to permanently delete a Set of Books.

5. Create Set of Books - This option is used to create, copy or convert a Set of Books using
the creation wizard. (TurboCASH allows you to create unlimited Sets of Books).

6. Save as - This option is used to save an exact copy of the Set of Books. 

7. Switch language - The TurboCASH5 program will by default use the language selected 
after installing TurboCASH5. You may select a different language. The program interface, 
reports and layout files will by default be printed in this language.

You may set the language for a Set of Books in the “Language” field in Access control 
(Setup ribbon).

You may also set a language in the “Language” field for debtor (customer / client) 
accounts in Debtors (Action ribbon) and for creditor (supplier) accounts in Creditors 
(Action ribbon).

8. Close Set of Books - The opened Set of Books will be closed. All other ribbon tabs will 
not be accessible. 

9. Exit TurboCASH - This will close the Set of Books and exit the TurboCASH5 program.

10. Online registration - Register the TurboCASH5 program or via the website. 

C.2.1.2- Action ribbon 

The Action ribbon is used to manage the following: 

• Master files – Ledger accounts (chart of accounts), debtors, creditors, contacts, stock 
items, appointments, tasks, etc.

• Transactions - Processing of transactions in sales documents (i.e. invoices, credit notes 
and quotes) and purchase documents (i.e. purchases, supplier returns and orders), 
batches (journals), managing open item accounts (adjust payment dates and / or process 
receipts / remittance advice for payments and / or refunds, etc.

• Periodic processing – Reconciliation, repeating transactions and invoices.

• Search – Search for data and print transactions and documents, etc.

• Help – Access the help file, websites (forum, bug reporting, webshop), support details, 
etc.
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The following seventeen (17) options are available:

1. Documents - Access, process and manage sales documents (i.e.
invoices, credit notes and quotes) and purchase documents (i.e.
purchases, supplier returns and orders).

If a document type is selected on the list of documents, the selected
documents screen will be launched as a separate floating screen. 

2. Debtors – Maintain (manage) debtor (customer / client) accounts.  You
may create, edit, delete and / or disable debtor (customer / client) accounts. 

3. Creditors - Maintain (manage) creditor (supplier) accounts. You may create, edit, delete 
and / or disable creditor (supplier) accounts.

4. Stock items – Maintain (manage) stock (inventory) items. You may create, edit, delete 
and / or disable stock (inventory) items for eleven (11) stock item types. These are, 
Default, Sales, Sales (no stock), Purchases, Purchases (no stock), Financial entry, Option 
item, Option item (no stock), BOM (Bills of Materials), BOM (production) and Linked 
items.

5. Batch entry - Enter and process transactions in batches.

6. Reconciliation - Reconcile transactions in payment and receipt batches (linked to a bank
account) with printed bank statements. 

BankImport plugin is a commercial plugin. - It allows you to import a valid bank statement file 
into TurboCASH. It will import bank transactions and save you hours of data entry. You can 
simply link transactions to your debtors, creditors or other accounts. And with a simple mouse 
click, link the payments to the right invoices. (See -  BankOnline Plugin).

7. Open item link – Process, edit, delete links for ledger accounts (income, expense, 
balance sheet, bank and tax), debtor (customer / client) and / or disable creditor 
(supplier) accounts set as Open item accounts. You may also adjust the payment dates 
for these accounts or process receipts / remittance advice for payments and / or refunds. 

8. Contact - Maintain (manage) contact persons and print a list of contacts. 

9. Calendar - The calendar (planner) allows you to manage (schedule, add, edit, delete) 
events (general appointments, debtor appointments(up to 6 categories), creditor 
appointments, repeating invoices and to generate quotes / invoices for events). It also 
allows you to (add, edit and / or delete) contacts and tasks.

10. Accounts - Create, edit, delete general ledger accounts (income / expense, bank and tax 
accounts). 

11. Update ledger - Update (post) sales documents (i.e. invoices and credit notes) and 
purchase documents (i.e. purchases and supplier returns) and batches to the ledger. 
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12. Help - Access the following eight (8) options:

a) Help - Launch the TurboCASH Help system where you may locate topics on 
TurboCASH. Context sensitive help has been implemented on most features. 

b) About TurboCASH - View the version and release date of the program and the 
version of your Operating system.

c) Support - View contact information of TurboCASH or go to the support page 
via the Internet.

d) Show welcome - By default, the “Welcome to TurboCASH” screen displays the 
website.  

If the website is updated, new content will be displayed in the “Welcome to TurboCASH” 
screen.

e) Online registration - Register the TurboCASH program.

f) Forum - Please visit our Forum to find solutions or to post comments, etc.

g) Webshop - Please visit our webshop. 

h) Bug report - View, search and report any bugs on our bug-tracking system at 
Sourceforge. 

13. Edit - Access the following three (3) options:

a) Repeating transactions – Enter and / or edit transactions in batches of a 
recurring nature.

b) Repeating invoices - Generate and process invoices of a recurring nature by 
selecting invoices to repeat from the invoice history.

c) Delete - Delete sales documents (i.e. invoices, credit notes and quotes) and 
purchase documents (i.e. purchases, supplier returns and orders).

14. Input - Access the following six (6) options:

a) Adjust stock - Launch the Stock items (Action ribbon) as a separate floating 
screen. 

b) Confirm - Confirm and convert quotes to invoices and orders to purchases.

c) Backorders - Add, edit and delete back orders for stock items.

d) Sales documents - Process / edit invoices, credit notes and quotes.

e) Purchase documents -  Process / edit purchases, supplier returns and orders.

f) POS Invoice - Run and manage a point-of-sales shift and process point-of-sale 
invoices. 

15. Search - Launch the Investigator to search and filter for data in the Set of Books.  
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16. Projects - By default, this option is inactive. Once projects is activated, you may process 
transactions for projects and print project reports. You need create groups for Projects 
(Groups (Setup ribbon)) and activate Projects  (Setup → System parameters (Setup 
ribbon)). Projects may be activated for each batch type in the Batch setup (Advanced 
tab).

17. Workflow - 

Workflow Plugin is a commercial plugin. 

C.2.1.3- Reports ribbon

The Reports ribbon is used to access and print all reports, user reports and reports from the T-
Ledger analyser 1 / 2 and T-Account viewer. It is also used to access the Printer (setup) and Report
designer.

The following seven (7) options are available:

1. Reports - List the reports in fifteen (15) menu items and groups.

2. User reports - Any other reports that are under construction. Users may add their own 
reports in the ...\plug_ins\reports\userreports folder.

3. T-Ledger analyser 1 - Trial balance, Income statement, Balance sheet, Standard column 
balances (column view of the Trial balance, Income statement and Balance sheet in one 
report), Budget versus actual, This year versus last year as well as Column balances.

4. T-Ledger analyser 2 - The same reports are available as for the T-Ledger analyser 1, but 
it gives you another option to generate different views and reports. 

5. T-Account viewer - Analyse and print transactions for specific accounts, etc.

6. Printer - Setup and configure the printers on your system.

7. Report designer - Edit, create and customise layout files for documents and reports.

 C.2.1.3.1- Reports menu

This menu lists all the standard reports, which are required to manage the information in a Set of 
Books. In addition to these standard reports, you may also create your own user or custom reports
in the Report designer.  

These reports that are stored in the ...\plug_ins\reports\systemreports folder.

If you are creating transactions from your stock file (processing documents - invoices, credit notes,
purchases and supplier returns documents), you will need to view reports in the stock ledger, 
document listing, sales analysis, purchase analysis reports. 
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To access the reports menu: 

1. On the Reports ribbon, select Reports. A list of the nineteen (19) reports or groups of 
reports will be listed. 

2. The summary of these reports, is as follows:

a) T-Ledger analyser - The T-Ledger analyser allows you to
generate six (6) different report types of your data which
may be printed and exported in various formats. These
are:

• Trial balance

• Income statement

• Balance sheet

• Standard column balances (column view of the Trial
balance, Income statement and Balance sheet in one
report)

• Budget versus actual

• This year versus last year 

• In addition to this, you may also view and export the
data in column balances (balances per period) for the
general ledger, debtors and creditors.

• Transactions may also be printed from the T-Account
viewer.

b) Point-of-Sale - The Cash-up and Sales analysis report for
the built-in point-of-sale (if you use point-of-sale).

c) Ledger - The following reports are available to manage all
the accounts in the general ledger:

• Budget vs actual (3 periods) – Compare budget vs actual figures for any 3 
periods.

• Graph - Profit / Loss per week - Net profit and loss per week in a bar chart.

• Listing - List the General ledger accounts (Chart of accounts).

• Transactions - Transactions, Transactions - Standard and Transactions - Extra 
details.

d) Debtors - The following reports are available to manage the accounts in the 
debtor's ledger:

• Graph - Debtors per week - Invoices and Debit transactions, Credit notes and 
Credit transactions as well as the difference per week in a bar chart.

• Age analysis - Various age analysis reports.
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• Listing - Contacts, Listing, List delivery address, List postal address, List details, 
Tax and company registration numbers and the Credit control listing (Credit 
limit vs current balance and available balances as at the date and time of 
printing).

• Print labels - Postal and Delivery address labels.

• Transactions - Transactions – Open item, Transactions - Standard and 
Transactions - Extra details.

• Outstanding – Debtor statements, Debtor statements – Outstanding, Due date 
and Outstanding at date.

e) Creditors - The following reports are available to manage the accounts in the 
creditor's ledger:

• Graph - Creditors per week - Supplier returns and Debit transactions, 
Purchases and Credit transactions as well as the difference per week in a bar 
chart.

• Age analysis - Various age analysis reports.

• Listing - Contacts, Listing, List delivery address, List postal address or List 
details, Tax and company registration numbers and the Credit control listing 
(Credit limit vs current balance and available balances as at the date and time of
printing) report.

• Print labels - Postal and Delivery address labels.

• Transactions - Transactions - Open item, Transactions - Standard and 
Transactions - Extra details.

• Outstanding – Remittance advices, Remittance advices – Outstanding, Due date
and Outstanding at date.

f) Sales - Various reports are available to analyse your sales documents. Print Graphs, 
Debtors, Sales and Items reports for Invoices, Credit notes and Quotes. 

g) Plugins – Price agreement report for the Price agreement plugin.

h) Stock - The following reports are available to manage the stock items:

• Reorder - Stock reorder report to list only those stock items that needs to be 
reordered. The Current stock levels report lists all the current stock levels. 

• Print barcodes – Print the Barcodes or the Yagoda barcodes. 

• Listing - Print lists of All selling prices (Selling price 1 / 2 / 3) and the Stock item
listing (Quantities and Cost prices). You may select to print extra details for 
these reports.  You may also print the Stock - Tax class listing report.

• Backorder - Print a list of backorders. 
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• Stock In / Out - The following two (2) reports: 

• Stock In / Out - Documents - Displays a summary of sales and purchase 
documents for each stock item. The “Show details” option will list and 
display the document dates and document numbers for each stock item. 

• Stock In / Out - Displays a list of the stock items and the quantities in and 
out as well as the total prices. The “Show details” option will list and display 
the document dates and document numbers for each stock item.

i) Point-of-Sale - Sales and Receipt reports for the plugin point-of-sale systems (if you
purchased and use the HorecaPOS or RetailPOS point-of-sale systems). 

j) Contacts - Lists the details of all your contacts. To list only the contacts for debtor 
(customer / client) accounts, you need to print it in the Debtors → Listing - 
Contacts menu. To list only the contacts for creditor (supplier) accounts, you need to
print it in the Creditors → listing - Contacts menu. 

k) Calendar - Print the appointments (events) (i.e. Appointment, Debtor appointment, 
Hours and Creditor appointment) that was scheduled in the Calendar / Planner. 

l) Batch entry - Print the transactions of posted invoices, credit notes purchase and 
supplier return documents as well as posted batch transactions (i.e. sales journal, 
purchase journal, payments journals, receipts journals, general journals, etc.).

m) Purchases - Various reports are available to analyse your purchase documents. Print 
Graphs, Creditors, Purchases and Items reports for Purchase and Supplier return 
documents as well as Orders. 

n) Company info – 

• Bank accounts - List of Banking details (for up to two (2) bank accounts) as 
entered in Company info (Setup ribbon).  

• Information – List of Lists the details of the following:

• Document heading and messages (up to 3 lines) as entered in the Documents
setup (Setup ribbon) for each of the Sales documents (i.e. Invoices, Credit 
notes and Quotes tabs) as well as Purchase documents (i.e. Purchases, 
Supplier returns and Orders tabs). This information is standard and will be 
printed on all documents. 

• Global statement message (up to 3 lines) as entered on the Statement setup 
tab on Documents setup (Setup ribbon). This information will print standard on
all Statements (Reports → Debtors – Outstanding (Reports ribbon)). This is in
addition to the specific messages (up to 4 lines) that can be entered in the 
Delivery address tab individual debtor accounts (Debtors - Action ribbon).

• Selling price descriptions – The descriptions of Selling price 1, Selling price 2 
and Selling price 3 as entered in the Selling price descriptions (Stock 
information (Setup ribbon).
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• Cost of Sales – 

• Create Cost of Sales - 

• Yes - Cost of Sales is activated.  

• No - Cost of Sales is not activated.

• Average cost - 

• Yes – Average Cost of Sales is activated.

• No – Latest Cost of Sales is activated. 

o) Currencies – List of the Currencies added in Setup → Currencies (Setup ribbon). 
These currencies can be selected when processing documents, such as invoices, 
credit notes, purchases, supplier returns documents, orders and quotes.

p) Documents - Lists your documents, such as invoices, credit notes, purchases, 
supplier returns documents, orders and quotes or a selection of documents or for a 
selected period. 

q) Sales analysis -

• Sales documents for each document type (i.e. Invoices, Credit notes and 
Quotes) - You may print reports for five (5) reporting groups (i.e. Debtor group 
1, Debtor group 2, Document group 1, Document group 2 and Salespersons).

• Invoices and Credit notes - You may print reports for five (5) reporting groups 
(i.e. Creditor group 1, Creditor group 2, Document group 1, Document group 2 
and Salespersons).  

• Sales per product - Stock group 1 and Stock group 2 are also available to 
analyse the sales (invoices) and returns (credit notes of trading stock items 
(default stock type). 

r) Tax - If you are registered as a VAT/GST/Sales tax vendor, you need to print and 
view reports for a specific period for all your Tax (VAT/GST/Sales tax) or for a specific
tax code such as Input VAT/GST/Sales tax, Output VAT/GST/Sales tax, Zero-rated 
VAT/GST/Sales tax, etc.

s) Purchase analysis - 

• Purchase documents for each document type (i.e. Purchase, Supplier return 
documents and Orders) - You may print reports for five (5) reporting groups 
(i.e. Creditor group 1, Creditor group 2, Document group 1, Document group 2 
and Salespersons).

• Purchase and Supplier return documents - You may print reports for five (5) 
reporting groups (i.e. Creditor group 1, Creditor group 2, Document group 1, 
Document group 2 and Salespersons).  

• Purchases per product - Stock group 1 and Stock group 2 are also available 
to analyse the purchases and returns for trading stock items (default stock type).
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 C.2.1.3.2- User reports menu

Any other reports that are under construction. Users may add their own reports in the 
...\plug_ins\reports\userreports folder.

C.2.1.4- Setup ribbon

The Setup ribbon tab is used to access the Setup and Tools.

The following sixteen (16) options are available:

1. Company info - Enter the company information (name, address telephone, fax numbers 
e-mail address) and registration numbers for the Company and VAT/GST/Sales tax, if 
applicable.

a) You also may to set the default tax method and output method for reports (to 
“screen, printer, file, e-mail” or “fax”).

b) Load your logo or picture, which you wish to be displayed on the documents.

c) Set the default currency format and date format in your Windows Operating System.

2. Documents setup - Settings for sales documents (i.e. invoices, credit notes and quotes) 
and purchase documents (i.e. purchases, supplier returns and orders). Set the defaults for 
documents, such as the numbers, batch types, headings and messages and document 
layout files. 

On the Statement setup tab, you may enter a global message to be printed on Debtor 
statements (Reports → Debtors → Outstanding menu).

3. Groups - Set up to 2 Groups for Accounts, Debtors, Creditors, Stock items and 
Documents for printing reports.

4. Stock information - The following settings are available:

a) Default - 

i) Selling prices - Enter (edit) the descriptions for up to 3 selling prices. You may 
set the default selling price 1 / 2 / 3 which will be used globally when processing
documents. 

ii) Cost of sales - Set the parameters for Cost of sales (account, batch type, 
whether you will be using average cost or latest cost). 

iii) Documents setup - This also contains various settings when processing 
documents and / or working with stock.

b) Units - Specify the unit descriptions and sizes to be displayed in the “Stock item” 
screens and reports. 
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The unit description is implemented on the Test Invoice (LanguageID906190), Delivery note 
(no code) (LanguageID906181) and Delivery note (LanguageID906182) layout files. 

Launch the Help file. - Copy this text “Add unit descriptions to layout files” to the Search tab 
and click on the List topics button. 
Follow the steps (procedure) to add this to your own customised layout files. 

c) Tax classes – Create, add, edit Tax classes (Account classes) to which you may select 
Input Tax codes, Output Tax codes, Sales, Cost of sales and Stock control accounts. 

5. Reporting dates - Set the start date of your financial year and the periods in a financial 
year. You may also close a specific period or year for posting transactions to the ledger.

6. Access control - Set the passwords, users and access to certain menus for each of your 
users.

7. Batch types - Create or delete batch types or journals in which you wish to enter 
transactions. Batch types also need to be linked to sales documents (i.e. invoices and 
credit notes) and purchase documents (i.e. purchases and supplier returns) on Setup 
Documents.

8. Salesperson - Add or remove any salespersons, which will be processing sales 
documents (i.e. invoices, credit notes and quotes) and purchase documents (i.e. 
purchases, supplier returns and orders) or cashiers operating Point-of-Sale. 

9. Printer - Select the default settings for printing reports and documents.

10. Workflow setup - 

Workflow Plugin is a commercial plugin. 

11. Setup - Access the following seven (7) options:

a) Financial categories - Link your Ledger Account groups to Assets, Capital, Expenses,
Income or Liabilities. 

b) Backup path - Set the default backup drive and folders on your system on which 
you wish to create backup files or disks.

c) System parameters - Select the indicators for debit and credit, number of decimals 
to be displayed on reports and documents as well as the number of decimals to be 
stored. You may also select to display the default system currency symbol.

Select 1 of 2 methods for reconciling bank statements with the transactions in your 
cash-book (receipts and payments batches). If you have purchased the BankImport 
plugin, you need to change the setting import the transactions from your bank 
statement and allocate these transactions to the accounts.

d) Internet - Configure your Internet, e-mail accounts to send reports, lists and 
documents via the internet or to configure a network server.

e) Point-of-Sale - Set Point-of-Sale parameters, configure printers, peripherals, etc.
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f) Currencies - You may add / edit currencies and the exchange rates. When 
processing documents, you may select the currency. This will automatically calculate 
the prices for that currency.

g) Theme - Select Classic or Ruby theme to be displayed in the program. You may also 
add your own favourite background pictures.

12. Report designer - Edit existing reports and layout files for documents. You may also 
create and edit your own reports and layout files.

13. Calculator - Access the Calculator. 

14. Import - Import accounts, debtors, creditors, documents and stock from specific file 
formats. 

15. Export - Export accounts, debtors, creditors, documents, stock and posted batches to 
specific file formats.

16. Tools- Access the following seven (7) options:

a) Global processes - The following four (4) options are available:

i) Clear / Reset - This option allows you to clear all the transactions and balances 
in a Set of Books. This will clear or reset the Set of Books and delete all the 
transactions and balances. You may also select to retain all documents and set 
them to unposted. 

ii) Do year end - This option allows you to close off all the nominal accounts 
(income and expense accounts) and transfer the balances for the financial year 
to the Retained Earnings account. The start date and the reporting dates for the 
financial year will also be created for the new financial year.

iii) Copy from a Set of Books - This option allows you to copy the data from a 
selected Set of Books into the active (open) Set of Books. This will replace all the
data in the active Set of Books. 

iv) Reverse posted document / batch - This feature allows you to reverse or 
cancel the transactions in posted documents and batches.

• Reverse posted batch (journal) - The transactions entered or imported in 
batches (journals) which are already updated (posted) to the ledger, may be
reversed or cancelled. This option will cancel all the transactions already 
updated (posted) to the ledger, remove it from the transaction file, and 
import the transactions to the selected batch (journal). 

You may then erase or delete the entire batch (journal) as well as the 
transactions, edit or correct the transactions, balance the batch, print the 
batch list and post it to the ledger.

• Reverse posted document - The documents as well as any transactions 
generated by the documents (invoices and credit notes, purchase 
documents and supplier returns documents) when the documents were 
updated (posted) to the ledger, will be reversed or cancelled. 
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The selected reversed document will be available as an unposted document.

You may edit the document in Documents (Action ribbon) and then post 
(update) it to the ledger. If you do not need to update (post) the document 
to the ledger, you may delete the document in Edit → Delete – Documents
menu (Action ribbon).

b) Data integrity check - Run a Data integrity check and print a Data integrity check 
report.

c) Customise language - Customise (edit, change and translate) language files. 

d) Close active forms - Close any open forms (e.g. “Documents, Debtors, Creditors, 
Stock items” screens, etc.)

e) Activate plugins - By default, no plugins is activated when TurboCASH5 is installed. 
This option allows you to activate / deactivate all plugins, registered plugins or 
specific plugins. The Activated plugins will be available from the Plugins menu.  

f) Plugins - By default, no plugins are listed on this menu. 

Only activated plugins will be listed. 

g) Others - Not used.

Most of these plugins are licensed under commercial licenses. You need to purchase a license on which a 
registration code and instructions will be mailed to you to unlock the full features of these plugins. 
Plugins needs to be registered in the Tools→ Plugins → Extra→ Register plugins menu (Setup ribbon).

C.2.1.5- User tab ribbon

The User tab ribbon is a custom quick menu. It is used to manage user navigation in a Set of 
Books. You may select (tick) the “Auto-learn” feature to add the last accessed options in up to six 
(6) groups.  

By default, when opening the Set of Books, the Action ribbon will be displayed. 

If the User tab ribbon, is activated, the User tab ribbon will automatically be displayed when 
opening the Set of Books.
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There are two (2) ways to add menus to the User tab ribbon, i.e.:

• Auto-learn - You may select this option to automatically add your accessed functions 
(menu items) to the User tab ribbon. 

• Edit – Manually add functions (menu items) to the User tab ribbon. 

Edit you may use this option to add, delete and link items to six (6) groups.
The User tab ribbon may also be edited and accessed in the User tab on Access control (Setup 
ribbon).

C.3- WORKING WITH TurboCASH RIBBONS AND SCREENS

C.3.1- Show / Hide ribbon options

Hide ribbon

You may need some extra space when working with, Documents, Stock, Debtors, Creditors, T-
Ledger analyser, etc. 

To “Auto hide” the ribbons options, double-click on any of the ribbon tabs. This will hide the 
options on the ribbon and only display the ribbon tabs and auto-resize (larger) the screens in 
TurboCASH5. You may then click on a ribbon tab to select and access the options. Once you have 
selected an option, the ribbon options will auto hide and only display the ribbon tabs. 

Show ribbon

To “Show” the ribbon options and resize the screens (smaller), you may double-click on a ribbon 
tab. 

C.3.2- Menu lists

You may right-click basically anywhere on the program to access menus (and sub-menus, where 
applicable) for each of the ribbon tabs. 

C.3.3- Dock / Undock sections of screens

By default, all sections of screens are docked (maximised). If you see the following button on a 
screen, you may click to undock (maximise) resize a screen or to dock (minimise) the screen:

C.3.4- Dragging / Resizing sections of screens

When the mouse is moved over some areas of a screen, you may drag the area of the screen to 
resize it. 
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C.4- FILTERS AND SEARCH FEATURES

C.4.1- Filter options in column headings

The grid (implemented in TurboCASH5) is very powerful because of its sophisticated easy to use 
filter and sort features does this quicker than any other way. It has the ability to group, sort and 
filter any data column(s) on most screens in a Set of Books with only a view mouse clicks. 

If you need to view or find specific data, there are various options available to locate and find your
data. 

Some of the options are: 

1. Sort - Click on a column heading to sort and list the data ascending or
descending sequence. All the data is by default displayed ascending; from
the smallest to the highest value (e.g. a-z or 0-9) according to the record
number (e.g. line number in a batch, etc.) To change the sort order from
ascending (e.g. a-z or 0-9) to descending (e.g. z-a or 9-0) select a column
and click on it. If you click on it again it will change back to ascending
sequence.

2. Drag and drop columns - You may click on a column and drag it to the left
or to the right to change the sequence your data is displayed on screens.

3. Filter - Click in the arrow to list the data in a specific column. A list
displaying the data, as well as an “All” option and a “Custom...” option in the selected 
column will be displayed. For example, if amounts are entered in a “Batch entry” screen, 
all the amounts will be listed. By adding a tick next to a specific amount, only 
transactions, matching that amount will be listed. 

4. Custom - You can easily build customised filters according to your needs. These filter 
files can be saved and opened for future use. 

TurboCASH5.1 – 2018 – Accounting Made Easy - 77



MODULE C - WORKING IN TurboCASH 

C.4.2- Custom filters

Once you have selected an option on a list, the your selection will be displayed at the bottom 
section of the “Batch entry” screen as follows:

You may click on the “Customise...” option on a column list or click on the Customise button to:

1. Make a filter (add or delete conditions and groups).
2. Save a filter.
3. Open a filter.

C.4.2.1- Make a custom filter

To make a filter:

1. Click on the “Customise...” option on a column list or click on the Customise button.

2. Select an operator (i.e. and, or, and not, or not). 

3. Click on the Filter button (or on the … button) and select one of the following options 
on the context menu: 

4. New condition – Create a new condition.

5. New group – Create a new group.

6. Delete row (If you click on the Filter button, you may delete all rows (conditions and 
groups)).

7. Select a column from the list of available data applicable to the screen. In this example, 
the Date is selected. 
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8. Select a filter condition. In this example, the Between is selected. Another field is opened
to select another date.

9. Once you have created your conditions or groups, click on the Apply button.

10. Click on the OK button to close and exit this “Make filter” screen. 

C.4.2.2- Conditions

The values of conditions, is as follows:

1. Equal to - list or display all values which is the same as the specified value.

2. Not equal to - list or display all values which is not the same as the specified value.

3. Less than - list or display all values smaller than the specified value.

4. Less than or equal to - list or display all values smaller or equal to the specified value.

5. Greater than - list or display all values greater than the specified value. 

6. Greater than or equal to - list or display all values greater or equal to the specified 
value.

7. Is null - excludes any value entered, will not be listed or displayed.

8. Is not null - is not zero - any value which is not equal to zero will be listed or displayed. 

9. Between - Specify specific values, etc. to include only matching values. (For example, 
between reference numbers 105 and 111 will exclude any lower numbers than 105 and 
higher numbers than 111). 

10. Not between - Specify specific values, etc. to exclude values. (For example, Not between 
reference numbers 105 and 111 will exclude these numbers and will list any lower 
numbers than 105 and higher numbers than 111). 

11. In - In a specified value.

12. Not in - Not in a specified value.

If a Date for a column condition is selected, additional conditions will be available (i.e. is this month, is this 
year, is next 7 days, is next week, is next 14 days, is next two weeks, is next 30 days, is next month, is future, 
is this week, is yesterday, is today, is last 7 days, is last week, is last 14 days, is last two weeks, is last 30 days,
is last month, is last year, is past, is this week, etc.

C.4.2.3- Save custom filter files

To save a custom filter file:

1. Once you have sorted or filtered your data with the Make filter utility, click on the Save 
as... button. The “Save active filter as” screen will be displayed.

2. Select a directory in which you wish to save the custom filter file. 

3. Enter a file name.

4. Click on the Save button to save the Filter in a (*.flt) Filter File format. You may then at 
any later stage open the saved *.flt file. 
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C.4.2.4- Open custom filter files

To open a saved a custom filter file:

1. Once you have sorted or filtered your data with the Make filter utility, click on the Open...
button. The “Open saved filter as” screen will be displayed.

2. Select a directory in which you have saved the custom filter file. 

3. Select a valid filter file.

4. Click on the Open button. The selected filter file's name will be displayed in the titlebar of
the “Make filter” screen. 

C.5- LOOKUPS

C.5.1- Accounts lookup 

When the cursor is in various fields on a screen of the TurboCASH program, TurboCASH will 
automatically display the lookup screen for that specific field. A lookup screen is basically a list of 
all the valid master records in a Set of Books from which you need to select one item from the list.

 

You may right-click on any area of the lookup to enable or disable the filter.

If the Use filter is enabled, the Use filter context menu will display a tick as follows -  
To disable the filter, click on the menu to remove the tick. If the filter is enabled, you may locate and select 
accounts, stock items, periods, etc. on the lookup screen with ease. 

80 - TurboCASH5.1 – 2018 – Accounting Made Easy



Stock item lookup

C.5.2- Stock item lookup

When processing documents you need to select the stock item in the document lines section. 
There are basically three (3) options to select stock items in any open / unposted document:

1. Lookup - Click on the “Item no.” column of document line or when proceeding to a new 
line, the Lookup will automatically be launched. To edit / select an existing Item, you 
need to double-click on the selected item in the document line. 

2. Open fast add - The icon will launch the lookup as a part of the “Document entry” screen
(replace the header section of the document). Once finished selecting stock items, you 
may click on the Close fast add icon. 

You may enter a valid stock code, barcode or serial number and press the Enter key in the “Fast 
add item (stock code / barcode / serial)” field in the footer section of the “Document entry” 
screen. This will insert the stock transaction in the document line.

3. Button lookup - This will launch a graphical image view of Stock group 1 and Stock 
images. 

The default “Stock lookup” screen, is as follows:
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The values and fields, are as follows:

1. Code - “Code” is the default option. You may select the “Description, Barcode, Description
and Extra description” or “Code, Description and Extra description” option. This will allow 
you to enter any valid values for a stock item. If you click on the Search button, it will list 
only those stock items matching the value entered. 

2. Operator - None is the default. You may select an operator (i.e. and / or). These 
operators will add another field where you may enter values to filter the stock items. If 
you click on the Search button, it will list only those stock items matching the values 
entered in the first search values field and / or the values entered in the second search 
values field. 

3. Stock group 1 - You may select a stock group 1 (created / added in Groups - Stock 
group 1 (Setup ribbon) and linked to the stock item). This will only list those stock items 
linked to Stock group 1. 

4. Stock group 2 - You may select a stock group 2 (created / added in Groups - Stock 
group 2 (Setup ribbon) and linked to the stock item). This will only list those stock items 
linked to Stock group 2. 

5. Search by: Code, Description and Barcodes is the default options. If any of these are 
selected (ticked), it will change the sort sequence in which the stock items are listed. 

The Auto-select tick box will only be displayed when the   (right-click) is 
selected (ticked). The “Auto-select” option allows you to enter any keys to filter by stock code, 
description, barcode, etc.

6. Statusbar - This bar is located right at the bottom of the lookup screen. It will display the
following details for the selected stock item: 

a) Cur: This displays the current actual quantities on hand for the selected stock item. 
This is the totals of the “Quantity on hand” field of the “Values” section on the 
Ledger tab of the Stock items (Action ribbon), (as updated by posted documents) 
PLUS any unposted purchase documents. 

b) Quote: This displays the quantities of any open / unconfirmed quotes which have 
not yet been converted to invoices. 

c) Order: This displays the quantities of any open / unconfirmed orders which have not
yet been converted to purchase documents. 

d) Exp: This displays the expected quantities on hand for the selected stock item. This is
the current quantities on hand for the selected stock item. This is the totals of the 
“Quantity on hand” field of the “Values” section on the Ledger tab of the Stock 
items (Action ribbon) LESS the quantities of any open / unconfirmed quotes which 
have not yet been converted to invoices PLUS the quantities of any open / 
unconfirmed orders which have not yet been converted to purchase documents. 
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e) P1: This displays the “Selling price 1” field of the “Selling prices” section on the 
Ledger tab of the Stock items (Action ribbon). The price is displayed as exclusive of
tax (VAT/GST/Sales tax) and the price is displayed as inclusive of tax (VAT/GST/Sales 
tax) between brackets. 

f) P2: This displays the “Selling price 2” field of the “Selling prices” section on the 
Ledger tab of the Stock items (Action ribbon). The price is displayed as exclusive of
tax (VAT/GST/Sales tax) and the price is displayed as inclusive of tax (VAT/GST/Sales 
tax) between brackets. 

g) P3: This displays the “Selling price 3” field of the “Selling prices” section on the 
Ledger tab of the Stock items (Action ribbon). The price is displayed as exclusive of 
tax (VAT/GST/Sales tax) and the price is displayed as inclusive of tax (VAT/GST/Sales 
tax) between brackets. 

h) LP: This displays the Latest cost (last cost price) field of the Values section on the 
Ledger tab of the Stock items (Action ribbon). The price is displayed as exclusive of 
tax (VAT/GST/Sales tax) and the price is displayed as inclusive of tax (VAT/GST/Sales 
tax) between brackets.

C.5.3- Batches lookup

The lookup in the “Batch entry” screen automatically filter the code or the description. When the 
Account or Tax columns are focused, you may type the code or description. In this example, the 
description is typed as “fu” and it lists only those accounts with the starting with the typed 
characters, e.g. Fuel and Oil and Furniture...  
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You may configure the Account types to be included in the Account lookup. On the F10:Setup - Advanced 
tab, you may set the Account lookup type to:

• All (default) all account types, 
• General ledger – All account types, except Debtors, Creditors.
• Debtors (only Debtor accounts), 
• Creditors (only Creditor accounts).
• Open item – Only those General ledger, Debtor and Creditor accounts for which Open item is 

activated.

C.5.4- Tax lookup

The Tax authorities may impose changes in the Tax (VAT/GST/Sales tax) rates. For example, in 
South Africa, the South African Revenue Services (SARS), changed the VAT rate from 14% to 15% 
on 1 April 2018. 

During the transition period, you may need to use both the tax rates, i.e. 14% or 15%, depending 
on whether the transaction(s) is taxable on or before 31 March 2018 at 14%; or from 1 April 2018 
at 15%. 

If you have a Zero-rated VAT – 0% Tax account, in the 14% structure (e.g. “T850040 Zero-rated VAT – 
0%”), you also need to disable Zero-rated VAT – 0% Tax account.

In TurboCASH, the VAT accounts need to accommodate two VAT rates. An invoice may even 
reflect a rate of 14% and 15% depending if the goods were supplied or services rendered on or 
before 31 March 2018 or from 1 April 2018. 

An example would be where a service provider charges subscriptions in advance April 2018 at 
15%, but usage (e.g. calls) are charged in arrears March 2018 at 14%.

By default, all accounts is “Enabled”. All Tax / VAT codes are listed in the Tax lookup in the “Tax” 
column. Once the transitional period where all the transactions up to 31 March 2018 at 14% is 
posted (updated) to the ledger, you may disable the 14% Tax / VAT accounts (Accounts on the 
Action tab). The 14% rate Tax / VAT accounts will not be listed on the Tax lookup screens. 
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C.5.4.1- Batches - Tax lookup

When processing transactions in Batch entry on the Action tab, you need to make absolutely 
sure that the correct Tax (VAT/GST/Sales tax) code is selected. 

The 14% VAT rate (e.g. “850000” account range) are normally applicable to transactions up to 31 
March 2018, in the “Date” column. 

The 15% VAT rate (e.g. “860000” account range) is normally applicable to transactions as from 1 
April 2018, in the “Date” column. 

You need to have a Zero-rated VAT – 0% Tax account, in the 14% structure (e.g. “850040 Zero-rated VAT 
– 0%”) and in the 15% structure (e.g. “860040 Zero-rated VAT – 0%”). Please ensure that the correct Zero-
rated VAT – 0% Tax account is selected.
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C.5.4.2- Documents - Tax lookup

When processing transactions in Documents on the Action tab in purchase documents (i.e. 
Purchases, Supplier returns and Orders), as well as sales documents (i.e. Invoices, Credit notes and 
Quotes), you need to make absolutely sure that the correct Tax (VAT/GST/Sales tax) code is 
selected.

If you have a Zero-rated VAT – 0% Tax account, in the 14% structure (e.g. “T850040 Zero-rated VAT – 
0%”), you also need to disable Zero-rated VAT – 0% Tax account.

The 14% VAT rate (e.g. “G850000” account range) are normally applicable to transactions up to 31 
March 2018, in the “Date” field. 

The 15% VAT rate (e.g. “T860000” account range) is normally applicable to transactions as from 1 
April 2018, in the “Date” field. 

You need to have a Zero-rated VAT – 0% Tax account, in the 14% structure (e.g. “T850040 Zero-rated VAT
– 0%”) and in the 15% structure (e.g. “T860040 Zero-rated VAT – 0%”). Please ensure that the Zero-rated 
VAT – 0% Tax account is selected.
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C.6- WORKING WITH OTHER WINDOWS / SCREENS

C.6.1- Minimise, restore and closing of programs or screens

The following buttons are found on the right side of the titlebar:

 – Minimise - Click on this button to minimise the program in the Windows Task bar. 

 – Maximize - Click on this button to display the TurboCASH screens as a larger screen on 

your desktop. This button will change to the  Restore Down button. When you click on 
this button, the TurboCASH screens will be restored to its original size.

If the Restore button is displayed in a titlebar, you may double-click anywhere on the titlebar
to display the screen in the full size of your desktop and double-click again to return to it’s original size.

 – Close - This button will exit the TurboCASH screens. On the TurboCASH program's titlebar,
it has the same function as the Exit TurboCASH (Start ribbon).

C.6.2- Resizing of screens on your desktop

Pressing  on the titlebar, will re-size TurboCASH to the full screen option. On the bottom 
left corner of the TurboCASH program will change to . 

You may resize the screen to any size on your desktop by moving the mouse pointer to any place 
on the edge of the TurboCASH or window. When the mouse pointer changes to a double-sided 
arrow, click on the mouse and drag the edge of the screen to desired size.

C.6.3- Switching to other programs on your desktop

Sometimes you may work in TurboCASH and in other programs, such as word processors or 
spreadsheets at the same time. Instead of minimising TurboCASH using the Minimise button on 
the titlebar and restoring another program from the Windows Task bar, you may easily switch to 
another program as follows:

1. Press the Alt-Tab keys simultaneously on your keyboard and the following screen, listing 
all the active programs on the Windows Task bar, is displayed:
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2. Repeat releasing and pressing the Tab key until the desired program is selected.

3. While keeping the Alt key down you may release the Tab key and press it again to select 
the next program.

4. Release the Alt-Tab keys and the selected program will be restored and ready to work in.

C.6.4- Windows 10 - Task View and Multiple Desktops

The Task View feature in Windows 10 may be used to work in TurboCASH and other programs in 

multiple Desktops.  On the Windows 10 Task bar., click on the  Task View icon.

All the opened programs on your Desktop will be listed. You may right-click on a selected 
program, and move the selected program to a new desktop or an existing desktop. The desktops 
will display only those active programs in the Windows Task bar. 
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C.6.5- Accessing menu options using short-cut keys 

For your convenience, a list of the short-cut keys are listed in MODULE R at the end of this book.

C.7- NAVIGATION IN TurboCASH

C.7.1- Yes / No, OK / Cancel, Back / Next and Finish buttons

These options may be selected with a mouse click, or, by pressing the key corresponding to the 
first letter of the command, e.g.:

Yes = Y or  Enter
No = N or Esc
Next = N
Back = B
Cancel = C, etc. 

C.7.2- Moving between fields on screens when entering data

Once data has been entered, pressing Tab or Enter, will shift the cursor to the next field, this can 
also be achieved by clicking with the mouse cursor. To move to the previous field, use the mouse 
or press the Shift and Tab keys simultaneously. 

C.7.3- Arrow keys

Whenever a lookup is listed on your screen, and you need to select an account, use the mouse or 
the Up and Down keys to scroll through the accounts. To select the required account, click with 
your mouse or simply press the Enter key on your keyboard. 

C.7.4- Drop-down lists

A Drop-down list is represented by a small block, with a down arrow or three dots (…) on the 
right-hand side of the respective field. By clicking on this button, a list will be displayed. Examples 
are reporting groups, selling prices, salespersons, etc. 

C.7.5- Tick boxes

You will come across many fields where you have to place tick to select certain options. An 
example of a tick box, is as follows: 

 

The Space bar on your keyboard allows you to toggle between a tick and a blank space in the tick
box. 
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C.8- GETTING HELP IN TurboCASH

To access the help file, you have three (3) options:

1. Click on the  icon on the right-hand side of the Ribbon tabs bar.

2. Press the F1 key on your keyboard for context sensitive help. On most screens, the 
relevant topic will be launched.

3. Click on the Help → Help menu (Action ribbon).

4. Online help – This is similar to the Help file included in the release. This help file may be 
updated from time to time as the existing documentation are improved and topics 
added. 
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D.1- OPTIONS TO MAKE BACKUPS OF BOOKS

In addition to the Backup / Restore feature you may also create exact copies from existing sets of 
books, templates (installed in your TCASH5/Books directory or other sets of books in the 
TCASH5/Bin/Repository directory). The following options are available:

• Start → Backup / Restore.

• Start → Save as.

• Start → Create Set of Books (“Copy from a Set of Books” option on the Creation wizard).

• Tools → Global processes → Copy from a Set of Books (Setup ribbon).

D.2- CREATING A BACKUP FILE ONTO A DISK OR HARD DRIVE

The Backup / Restore option will backup your data onto disk or your hard drive in a Compressed 
*.zip file or an Executable *.exe file.  

Backup files are used to Restore a Set of Books to the set of data from which the Backup File was 
created. Backups are copies of your data that you make on a regular basis. 

You will need backups in case of file corruption, hardware failures and other errors. 

TurboCASH also allows you to create a backup file and send it directly via e-mail. You may also 
select to create the self-executable (*.exe) or a Compressed file (*.zip) file format. 

The zip backup file format allows you to send a backup file via e-mail in cases where your Internet 
firewall settings will not allow you to send and receive *.exe files.

As a general rule, it is good practice to back up often, preferably upon closing the program. 
Backing up can be to CD-ROM, USB-Drive, etc. Backing up to your hard disk is also a good 
practice but the best backup is not stored on your computer. (In case of a hard drive failure!!) 

It is also recommended that you complete a BACKUP in the following instances:

 Prior to performing any major processes, such as Delete a Set of Books and Global 
processes (Clear / Reset Set of Books, Do year end, Copy from a Set of Books, Cancel / 
Reverse posted batches / documents, etc.). 

 Old data on your previous version of TurboCASH or other accounting package prior to 
conversion to TurboCASH. 

 On a regular basis: Depending on your need and volume of work. The following 
minimum is recommended: 

 2 - 3 sets daily re-used weekly or every 3rd to 4th day.

 2 weekly sets - re-used every 3rd week. 

 12 Monthly sets - done at the end of each month, and re-used each year. 

 1 set prior to year-end and kept permanent. 
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The very same backup disks or backup files on your hard drive are used to restore your data in 
your Set of Books. In this version of TurboCASH, you may also restore a Set of Books from a valid 
Backup file stored on a Network Server, if a Network Server has been set up and configured on 
your system. If you do not make regular backups, you may have to re-enter thousands of 
transactions and general ledger, debtor, creditor and stock information.

To create a backup file:

1. On the Start ribbon, select Backup / Restore. If a Set of Books is open on your system, 
TurboCASH will automatically close the Set of Books and the “Backup Set of Books” screen
is displayed:

2. Select the Backup option, if not already selected. 

3. Select the Set of Books you wish to backup. 

4. You may over type the Backup file name with a name of your own. 

 
The date and time of your operating system is automatically inserted in the file name (e.g. 
MYBOOKS201803200643.exe) after the default backup file name.
(In this example, the date and time format is YYYYMMDD, followed by the Hour and Minutes).  
The format may differ if your operating system's short date style or format is set different.) It is 
recommended that this date and time not be over typed, if you enter a name for your backup 
file. You may then later select that file name to restore a Set of Books from. TurboCASH will by 
default create a Backup file in the *.exe file format. 
If you need to create the Backup file in the *zip file format remove the tick in the “Executable exe”
file field.
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5. Select the drive or folder to backup to. 

 
The default backup path (drive or folder) for a Set of Books as set in the Setup → Backup path 
(Setup ribbon) will be displayed. If you have not set the default backup path, the default system 
drive will be displayed. You may select any other drive or folder on your system. 

6. Click on the Backup button to start the backup process. While the Backup process is 
running, the files are backed up from and added on your backup disk or location on your 
hard drive or network drive will be displayed. When the backup process is completed, an 
information message “The Backup process is completed!” will be displayed. 

7. Click on the OK button and click on the Cancel button on the “Backup Set of Books” 
screen. You may also press the Esc key on your keyboard to exit the “Backup Set of 
Books” screen.

D.3- CREATING AN E-MAIL BACKUP FILE 

To use this option, your computer system must be properly set up and the Internet account with 
your Internet Service Provider. The process to create a backup file must be followed.

To send a backup file via e-mail:

1. Select the E-mail backup option on the “Backup Set of Books” screen. When the backup 
process is finished, your e-mail program will automatically be launched.

2. The e-mail address of TurboCASH will automatically be entered in this field. Should you 
wish to change it to a different e-mail address, (e.g. that of your auditor or consultant), 
you may enter a valid e-mail address to that field. 

3. Add a description to the subject if you wish (e.g. your company name).

4. The file is automatically attached to the e-mail message. You may attach another 
document to the e-mail. 

Your Internet Service Provider may limit your e-mail message (e.g. including attachments to 
1.2MB). If the message is larger than the allowed message, your message may not reach the 
recipient and may be returned.

5. Enter your message.

6. Click on the Send button.
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D.4- ACTIVATING / DEACTIVATING THE AUTO-BACKUP 
FEATURE

By default, the Auto Backup setting is not activated (set to FALSE). The Auto-Backup feature will 
automatically create backup file of your set of books to the default backup directory (set in the 
Setup → Backup path (Setup ribbon)) when exiting or closing TurboCASH5 if a Set of Books is 
open. 

The Auto-Backup feature should only be used for single-user installations where TurboCASH5 is installed 
on a single machine. 

It is only available if TurboCASH is closed exited using the following options:

• Click on the Close   button on the top right-hand
corner of the TurboCASH titlebar.

• Right-click on the TurboCASH5 icon in the Windows task
bar. and click X Close window.

To activate (enable) the Auto-Backup feature:

1. Locate and open the Tcash.ini file (located in the TCASH5 installation directory) using 
Windows Explorer (File browser). 

2. Open it with Notepad, Wordpad or any other text file editor of your choice. The setting in
the [BACKUP] section of the Tcash.ini file is set as follows: 

AUTOBACKUP=FALSE 

3. Change FALSE to TRUE. The value should read as follows:  

AUTOBACKUP=TRUE 

4. Save the Tcash.ini file.
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D.5- RESTORING A SET OF BOOKS

This option will restore your data for a specific Set of Books or your hard drive or in a valid folder 
on your system. 

To restore a Set of Books from a backup, a valid backup (tcBackup.exe or tcBackup.zip) file must 
exist. 

Use the Backup / Restore (Start ribbon) - Restore option to select the Backup file.
Do not click on the OK button of the TurboCASH5 Backup file (opened using the File Browser) to restore 
the Set of Books. It will add a TCASH5 (name of your installation folder) inside the Set of Books. This will 
increase the size of future backups.

If your data becomes corrupt for some reason, restoring from backup will fix this. 

It will be necessary to re-enter all the data from the date of the last backup to the present. It can 
be seen that backing up often is a good habit that can potentially save a lot of work. If you do not 
make regular backups, you may have to re-enter thousands of transactions and general ledger, 
debtor, creditor and stock information. 

It is also important to keep record of your backup disks or files or to label your backup disks to 
prevent restoring a Set of Books from an incorrect backup disk or file. It is recommended that you 
keep a record of which data is backed up and which is not, to prevent re-entering data that is 
already on your backup disks. 
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To restore a Set of Books:

1. On the Start ribbon, select Backup / Restore. If a Set of Books is open on your system, 
TurboCASH will automatically close the Set of Books. 

2. Select the Restore option. The “Backup Set of Books” screen will change to the “Restore 
Set of Books” screen. 

3. Click on the icon next to the “File name” field and select the backup file on the 
“TurboCASH select backup file” screen. 

 
The default backup path (drive or folder) for a Set of Books as set in Setup → Backup path (Setup 
ribbon) will be displayed. If you have not set the default backup path, the default system drive 
will be displayed.
You may select any other drive or folder on your system. You could also choose to Restore from 
your hard drive or any available drive on your network. TurboCASH also allows you to restore 
from a CD/DVD, provided that you have a CD/DVD writer installed on your system and the 
backup is correctly done. 

4. Click on the Restore button. A confirmation message “This will seriously affect your Set of
Books! Are you sure you want to clear this Set of Books?” will be displayed.

5. If you are absolutely sure, tick the "I have read this instruction and understand the action!"
field. The Yes and No buttons will be available on this screen. 

6. Click on the Yes button. The confirmation message "This will seriously affect your Set of 
Books! Are you sure you want to clear this Set of Books?" will be displayed. 
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7. If you click on the No button, the process will be cancelled. Click on the Yes button, if 
you are absolutely sure. The information message "Your Set of Books will be restored in: 
C:\TCASH5\books\MY-BOOKS\ Do you wish to continue?" will be displayed.

8. Click on the Yes button, to start the restore process. If you click on the No button, the 
process will be cancelled. When the restore process is completed, an information screen 
“The Restore process is completed!” will be displayed.  

9. Click on the OK button and click on the Cancel button on the “Backup Set of Books” 
screen. You may also press the Esc key to exit the “Backup Set of Books” screen.
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E.1- OPTIONS TO CREATE A SET OF BOOKS

In addition to the “Creation wizard” feature you may also create exact copies from existing sets of 
books, templates (installed in your TCASH5/Books directory or other sets of books in the 
TCASH5/Bin/Repository directory). The following options are available:

• Start → Save as.

• Start → Create Set of Books (“Copy from a Set of Books” option on the Creation wizard).

• Tools → Global processes → Copy from a Set of Books (Setup ribbon).

E.2- CREATING A SET OF BOOKS USING THE CREATION WIZARD

To create a Set of Books only takes a few minutes. The “Creation wizard” will help you to create a 
new Set of Books.

To create a Set of Books:

1. On the Start ribbon, select Create Set of Books (F10). The “Creation wizard” is displayed 
giving you three (3) options to create a Set of Books.

2. Check that it is selected and click on the Next button. On the next screen, (“Which Chart 
of Accounts you wish to use?”) you need to select a template (existing Set of Books). 

The “Download books” screen will automatically be launched. It is recommended to close 
the “Download books” screen.
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You may access the  “Download books” screen, when clicking on the Online button on the “Which 
Chart of Accounts you wish to use?” screen.
Updated versions of these Sets of Books (except the Netherlands) are included in the install of Build
969.
You may click the Browse button, to select another Set of Books in the ...\Bin\Repository folder. 

3. For the purpose of this tutorial, select “HANDYMAN” and click on the Next button. On 
the next screen, TurboCASH will ask you to enter the “Name for a new Set of Books”. 
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4. For the purpose of this tutorial, type in your own name.  

5. Click on the Next button, or press the Enter key on your keyboard. On the following 
screen TurboCASH, will give you the following options to select:

6. For the purpose of this tutorial, see that “Documents setup” option is selected. 
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7. Click on the Finish button. A confirmation message  “Are you sure you want to create the 
MY-BOOKS  Set of Books?” will be displayed. MY-BOOKS is the name of the Set of Books 
entered in the Creation wizard. 

8. Click on the Yes button to confirm. 

9. TurboCASH will automatically launch the following screens from the Setup ribbon as 
selected to enable you to set the basic information and defaults for the Set of Books: 

a) Company info (See Paragraph E.4.1 of this MODULE)

b) Reporting dates (See Paragraph E.4.2 of this MODULE)

c) Batch types (See Paragraph E.4.3 of this MODULE)

d) Groups (See Paragraph E.4.4 of this MODULE)

e) Documents setup (See Paragraph E.4.5 of this MODULE)

f) Stock information (See Paragraph E.4.6 of this MODULE)

g) Salespersons (See Paragraph E.4.7 of this MODULE)

E.3- COMPLETING YOUR SETUP PROCEDURES

It is good practice to check all the available menus in Setup, before moving to the next step. This 
will take a few minutes of your time, but it will save you problems in future. We will therefore 
discuss the Setup menu options briefly. Before you may start with this process you need to Open 
your Set of Books.

To open your Set of Books:

1. On the Start ribbon, select Open (Alt + O).

2. Select the Set of Books, which you were creating, and click on the Open button. 

E.4- SETUP

E.4.1- Company info

This option allows you to enter all your business' details such as the address, e-mail address, 
contact numbers, company and tax registration numbers. These will be displayed on all reports, 
statements and lists. You may also select the applicable Tax method, and the default output 
options for reports, statements and lists. It is also important to set the Windows default date and 
currency formats. 

You may also load a logo picture to be displayed on your documents and / or statements. For 
documents you need to select to print the logo on documents, or not, in Documents setup 
(Setup ribbon). 

TurboCASH5.1 – 2018 – Accounting Made Easy - 103



MODULE E - CREATING A SET OF BOOKS AND SETUP

To enter and set the company information and defaults:

1. If the “Company info” screen is not automatically displayed, go to the Setup ribbon, and 
select Company info.

2. Enter the relevant details of your company in the available fields.
Company reg. no.: If you are registered as a company, a close corporation or a non-profit 

organisation, the relevant registration number must be.
Tax reg. no.: If you are registered as a VAT/GST/Sales tax vendor, the VAT/GST/Sales tax 

registration number must be entered.
For the purpose of this manual, the relevant company details are already entered in the 
“HANDYMAN” Set of Books we have selected.

3. Click on the Options button. The “Company info - Options” screen is displayed:
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4. The “Tax method” is by default set to “Invoice based”. 

5. Select your default output options for “screen, printer, file, fax” or “e-mail”. For the 
purpose of this tutorial, select “Screen”.

6. Leave the “Company logo” blank, for the purpose of this tutorial.

If you have a company logo or picture, which includes the address, you may right-click on the 
Company logo to load the logo from a valid file format on your system. 
This logo can be selected to display on documents (invoices, etc.) and statements.

7. Click on the Set Windows date format/style button to set the date format of your 
operating system.

You may also click on the DateTime settings button on Setup → System parameters (Setup ribbon)
to open the Regional and language settings in the Control Panel.

This option does not work on Linux or Apple operating systems. The settings for this, should be 
done via the specifics of that operating systems.

If the Set Windows date format/style button does not launch your operating system's (version of 
Windows™), Regional Settings, you need to open the Regional and language settings in the 
Control Panel to set the format of the Short date and the correct Currency symbol.
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It is important to check your Windows date format, since this format will determine the format in 
which you will enter your dates for your transactions. It will also determine the format dates are 
displayed on screens and reports.
It will also determine the format in which your dates will be displayed in the lookup screens, 
screens, reports, debtor statements, etc.
The date for 1 March 2018 may be displayed in one of the following formats:

• YY/MM/DD     - 18/03/01
• DD/MM/YY     - 01/03/18
• YYYY/MM/DD  - 2018/03/01
• DD/MM/YYYY  - 01/03/2018
• The YYYY/MM/DD (2018/03/01) is the format, which is used in this tutorial. 

8. Click on the OK button to save your changes.

E.4.2- Reporting dates (Periods)

To set the start of the financial year:

1. If the “Reporting dates” screen is not automatically displayed, go to the Setup ribbon, and
select Reporting dates.

2. Select the following options for the Set of Books:

a) Number - Number of reporting dates (financial periods) for which you can enter 
transactions and view reports. Usually the number 12 for each calendar month in a 
financial year  is used. 

b) Start date - The starting date of your financial year. For the purpose of this tutorial, 
it is set to 2018/03/01.
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c) Post to other years - If this box is not ticked, you will not be able to post any 
transactions, budgets, etc. to the financial year preceding the financial year entered 
in the “Start date” field.

d) Open for posting - If this box is not ticked, you will not be able to post any 
transactions, budgets, etc. to the financial period, which ends on the specified “Ends 
on” field.

e) Previous year – This option allows you to block posting to any closed financial years
older than last year periods.

3. Click on the OK button.

E.4.3- Batch types

This option allows you to create batch to capture and enter your transactions. The Sales, 
Purchases, Receipts, Payments and General journal are standard defaults.

You can create any additional batches by adding them to this list. If you have more than one Bank 
account, you need to create a payments and receipts batch for each one. If you were initially short 
of batch types, you may enter additional batch types to accommodate your reporting 
requirements. These will not be retroactive, so thorough setting up is preferable.

Batch types Lookup type Contra account lookup type Debit / Credit

Sales Debtors General ledger Debit

Sales returns General ledger Debtors Credit

Purchases General ledger Creditors Credit

Purchase returns Creditors General ledger Debit

Payments All All Debit

Receipts All All Credit

General journal All All Allow both / Debit / Credit

You can also set the batch defaults to reduce incorrect capturing of transactions. For example, in a 
Sales journal, only debit entries may be entered. Batch defaults such as “contra accounts”, “contra 
account per line”, “inclusive” (of VAT/GST/Sales tax) or “exclusive” capture and increment reference 
numbers, and can only be set from within the batch.
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To check and add batch types:

1. If the “Batch types” screen is not automatically displayed, go to the Setup ribbon, and 
select Batch types.

2. Check that the basic batches “Petty cash Pay.” and “Petty cash Rec.” (for the Petty cash 
account) “Sales jnl., Purchase jnl.”, and “General jnl.” is added.  

3. If the “Payments jnl” and “Receipt jnl” (for the Current Bank account) is displayed, rename 
them to “ABC-Payments” and “ABC-Receipts”, for the purpose of this tutorial – (See 
Paragraph F1.3.1 of MODULE F).

You may click on the Edit button to set the options for this batch. 
You may also click on the F10:Setup button on the “Batch entry” screen) Batch entry (Action 
ribbon).

4. Click on the Close button.

E.4.4- Groups

This option allows you to set up to 2 reporting groups for your general ledger accounts, debtors 
and creditors, stock and documents. These reporting groups will allow you to select the applicable
reporting category within the available reporting groups. When you generate reports or 
documents, you may also select these groups to print reports or to filter for specific reporting 
groups. 

For the purpose of this tutorial, the basic settings for reporting groups 1 are already set in the 
“HANDYMAN” Set of Books we have selected.

E.4.4.1- Account groups

This option allows you to set up to two (2) reporting groups for your general ledger accounts, 
debtors and creditors, stock and documents. These reporting groups will allow you to select the 
applicable reporting category within the available reporting groups. 

When you generate reports or documents, you may also select on some of the “Report options / 
parameter” screens to generate reports or documents for specific reporting group(s). 
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To set the groups:

1. If the “Groups” screen is not automatically displayed, go to the Setup ribbon, and select 
Groups.

You may click on the Print button to print a list of the groups.

Select the groups and use the Move up and Move down buttons to change the sequence. For 
the purpose of the tutorial, move the groups to display Income, Cost of sales, Expenses, Capital, 
Longterm liabilities, Current liabilities, Fixed assets and Current assets, if necessary.
This will determine the sequence in which your Groups are listed on the Accounts  (Action 
ribbon) and on the T-Ledger Analyser1 / 2 (Reports ribbon) is displayed, when Reporting group 1 
is selected.

2. Check the “Account groups” and click on the OK button. 

For the purpose of this tutorial, the basic settings for reporting groups 1 are already set in the 
“HANDYMAN” Set of Books we have selected.

You may set colours (Background and Font colours) to be displayed on the T-Ledger analyser. 
To add colours for account groups:

1. Click on the Back colour button and select the colour.  
2. Set the Font colour (if necessary).   
3. Click on the OK button of the “Color window.
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E.4.4.2- Creditor groups

To illustrate the colours on the “Creditors – List view” screen, add the following two (2) groups for 
Creditor group 1:

• Creditor group 1A

• Creditor group 1B

Set the Background and Font colours for these groups.

E.4.4.3- Debtor groups 

To illustrate the colours on the “Debtors – List view” screen, add the following two (2) groups for 
Debtor group 1:

• Debtor group 1A

• Debtor group 1B

Set the Background and Font colours for these groups.

E.4.4.4- Stock groups

To illustrate the colours on the “Stock items – List view” screen, add the following two (2) groups 
for Stock group 1:

• Stock group 1A

• Stock group 1B

Set the Background and Font colours for these groups. 

You may also add images for Stock group 1 to be displayed on the Button lookup, if activated on Stock 
information. (Setup ribbon).
Images may be added for each Stock item in the Images tab on the “Stock items” edit screen (Action ribbon).

E.4.4.5- Document groups

To illustrate the colours on the “Documents – List view” screen, add the following two (2) groups 
for Document group 1:

• Document group 1A

• Document group 1B

Set the Background and Font colours for these groups.
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E.4.5- Documents setup

This option allows you to set up defaults for your documents. The defaults for all document 
numbers to begin with 000001 (prefixed by 2 alphabetical characters IN for Invoices, CR for Credit 
notes, PU for Purchase documents, SR for Supplier returns documents, OR for Orders and QU for 
Quotes), but you may change this to suit your needs. Thereafter the document numbers will 
automatically allocate the document numbers in the numerical sequence they were generated. 

The default Batch types have been pre-set for each document type (i.e. Invoices, Credit notes, 
Purchases and Supplier returns). 

You may also specify the heading, message for each document type.

To set the defaults for documents:

1. If the “Documents setup” screen is not automatically displayed, go to the Setup ribbon, 
and select Documents setup.

For the purpose of this tutorial, the relevant settings for documents are already set in the 
“HANDYMAN” Set of Books we have selected.

2. Click on each of the tabs and check or change the following, if necessary:
Layout file point-of-
sale:  Leave as is.

Print standard logo:  Remove tick.
Next batch no.  Leave as is.
Auto-post on print:  Leave blank.
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Next invoice no.:  For the purpose of this tutorial, all documents should start with 
000001 prefixed by 2 characters (i.e. IN000001 for Invoices, 
CR000001 for Credit notes, PU000001 for Purchases, SR000001 for 
Supplier returns, OR000001 for Orders and QU000001 for Quotes).

Invoice batch:  Select the “Sales jnl.” for Invoices. 

 Select the “Sales returns” for  Credit notes.

 Select the “Purchase jnl.” for Purchases.

 Select the “Supplier returns” for Supplier returns.
You cannot select a batch type for Orders and Quotes, since they need to 
be confirmed and cannot be posted (updated to the ledger).

Layout file:  Select “Invoice (15 code)”. Select “Credit note (15 code)”, “Purchase (15 
code)”, “Supplier return (15 code)”, “Order (15 code)” and “Quote (15 
code)” on the other tabs. These are the global default settings for 
each document type. 

Layout file2  Leave blank.
Invoice heading:  For the purpose of this tutorial, the headings are already set.
Invoice message:  For the purpose of this tutorial, the messages for each of these 

documents are already entered.

3. Click on the Statement setup tab to enter up to 3 Statement message lines to print 
globally on all Debtor statements (Reports → Reports → Debtors → Outstanding 
menu).

4. Click on the OK button to save your changes and close / exit this screen.

Selecting Layout files: 
The default layout files is set for the maximum stock code length (15 characters) and description (up to 35 
characters). 
If you do not wish to print stock codes on documents, you may select the following:

• The “Invoice (no code)”. Select “Credit note (no code)”, “Purchase (no code)”, “Supplier return (no 
code)”, “Order (no code)” and “Quote (no code)” does not print the stock code.

If you wish to print smaller stock codes and descriptions on documents, you may select the following:
• Stock Codes - (less than 10 characters) and description (less than 25 characters), you may select 

the “10 code” series of documents. 
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E.4.6- Stock information

This option should be used if you need to generate sales documents (quotes, invoices and credit 
notes) and / or purchase documents (i.e. purchases, supplier returns and orders). The “Stock 
information” screen consists basically of five (5) sections (i.e. “Units, Selling prices, Cost of sales, 
Documents setup” and “Tax classes”). 

To set the stock information and cost of sales parameters:

1. If the “Stock information” screen is not automatically displayed, go to the Setup ribbon, 
and select Stock information. 

2. Units - Check that “Each” and “Hours”, is displayed. If not; enter these and click on the 
Add button.

3. Selling price descriptions – 

a) Selling price descriptions – The Default (Selling price 1, Selling price 2, Selling 
price 3) is displayed. You may over-type these with your own. 

b) Default – The default selling price as the global setting. Select Selling price 1 for the
purpose of this tutorial.

You may set a different selling price for specific debtor (customer / client) accounts on 
the Debtor  - Accounting information tab (Action ribbon).
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4. Cost of sales - settings – This is applicable to the Default (trading stock) stock type only.
Select the following: 

a) Create Cost of sales – Select (tick).

b) Cost of sales batch – Select the Cost of sales batch.

c) Use “Average cost” or “Latest cost” option. For the purpose of this tutorial, the 
“Average cost” option is selected.  

This setting is very important for calculating the value of your stock. If you are not sure 
whether to use “average cost” or “latest cost”, please consult with your accountant. The 
value of your stock can affect your profit and loss figures.

5. Documents setup – The rest of the options (tick boxes) are used to set and configure 
document processing. Deselect (remove the tick) for all these options; if necessary.

See Chapter J2 of MODULE J – SETTINGS / CUSTOMISE DOCUMENT PROCESSING – Setup stock 
information.

6. Click on the OK button to save your changes and close or exit this screen.

E.4.7- Salespersons

This option allows you to add / delete the salespersons, who sell your stock items or services. 
Salespersons may be selected on sales documents (quotes, invoices and credit notes). 

You may select the default salesperson for each debtor account. When sales documents are generated and 
the debtor (customer / client) account is selected, the default salesperson will be displayed for the document 
or you may select any available salesperson.

This feature makes it easy to see who made the most sales or did not make target. It is also a 
useful tool if it is necessary to pay commission on those sales. 

Salespersons may also be selected for purchase documents (i.e. purchases, supplier returns and orders). This 
allows you to see who handled the purchase document.

To check the salespersons:

Salespersons may also be added or deleted in the Groups (Salespersons) (Setup ribbon).

1. If the “Salesperson” screen is not automatically
displayed, go to the Setup ribbon, and select 
Salesperson. 

2. Check “Tracy” and “Russell” are displayed as
salespersons. 

3. Click on the Close button.
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For the purpose of this tutorial, we have included Tracy and Russell as the salespersons. 
To add a salesperson:

1. Select the Salesperson on the Description list where you need to add a new 
Salesperson.

2. Click on the Add button. An entry displaying “Change name” will be inserted above the
selected Salesperson.

3. Over-type the “Change name” on the list with the name for your Salesperson. 
4. Click on the Close button.

E.4.8- Printer

This option allows you to select the default printer. You may set and configure up to two (2) 
Reporting printers and Ticket printers and up to nine (9) user printers. Other printers that may be 
configured, are:

• Plain text printer

• Full plain text printer

• Character-based printer

• Graphics printer

It is recommended that you select the printer with which you intend to print most of your reports 
and / or documents.

E.4.9- Access control (Optional)

This option allows you to set the default language and security options for a specific Set of Books. 
User passwords and access levels may also be set. You may have as many users to work on a Set 
of Books as you wish. You may set differing passwords for each user, in order that they are 
enabled to perform only the function(s) assigned to them. 

Multi-user plugin
This version of TurboCASH, may be configured and set up a Network server for multi-users. To enable the 
full multi-user functionality, you need to purchase a multi-user license and register TurboCASH5 as a 
multi-user product.

E.4.10- Setup menu

E.4.10.1- Financial categories 

This option allows you to link your available reporting groups (which you have already set up on 
the Account groups tab) to one of the Assets, Capital, Expenses, Income, or Liabilities categories. It
is important to base this linkage, to the respective categories, on the accounting equation.

Once your reporting groups for Account groups 1 and / or 2 is added, you need to link each of 
these to a financial category (i.e. Assets, Capital, Expenses, Income or Liabilities). 
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It is important to base this linkage, to the respective categories, on the accounting equation. Please refer to 
MODULE A – INTRODUCTION TO ACCOUNTING for more information. 

The following two (2) options are available to link the financial categories:

1. Setup → Financial categories (Setup ribbon).

2. Accounts (Action ribbon).

To link groups to financial categories:

1. On the Action ribbon, select Accounts. 

2. Select Reporting group 1. The Groups as created on “Account groups” screen “Reporting 
group 1” will be listed in the “Accounts” screen: 

3. Select a Group and select a Financial Category (i.e. Assets, Capital, Expenses, Income or 
Liabilities) from the list. 

4. Click on the Save button to save your changes. 

5. Repeat the process for all the Account groups. 

6. Once finished with Reporting group 1, select Reporting group 2 and repeat the link 
process. 

The Save button will only be displayed (next to the “Name” field of the Financial Category ), once any 
changes are made. 
You need to click on the Save button to save the changes. If you do not do this, your changes will be lost.
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Account groups - Reporting group 1 and 2 – The sequence in which the groups and accounts are listed, may 
be changed in Groups. (Setup ribbon) This is done by selecting the groups on the list and use the Move up or
Move down buttons.
In this tutorial, we have created Accounts - Reporting groups 1 and 2 which is set to different sequences:

Reporting group 1 Reporting group 2 

This will enable you to generate general ledger reports (i.e. Trial balance, Income statement, Balance sheet, 
Chart of accounts, to list accounts and balances to be listed according to Reporting group 1 or according to 
Reporting group 2 sequences.  

E.4.10.2- Backup path

This option allows you to select the drive and / or the folders on which you wish to make your 
Backups. This is normally your CD-drive, but you could also make backups in any available folder 
or directory on your hard drive. 

The “Backups” folder have been included in the TCASH5 installation directory for your convenience. You 
may create all your backup files to that directory (e.g. C:/TCASH5/Backups). 
Please remember to copy backup files in this folder on external media and store it in a safe place.     

The Auto-Backup feature have also been added to automatically create backup files when you exit 
TurboCASH5. 
By default the Auto-Backup feature is not activated. 
See Backups for more information to enable / disable this feature.

E.4.10.3- System parameters

This option allows you various options to configure your Set of Books. These are:
1. Report amounts with – This is not applicable to TurboCASH5.   
2. Data storage - Set the rounding of decimals or no rounding (real numbers). 
3. Reporting decimals - 

• Number - Set the number of decimals to be displayed on screens, reports and 
documents. For most Sets of Books these should be set to “2”.

• Date/Time Settings - This will launch the “Regional and language” options in 
which you may configure or set the formats of your operating system. (See – 
Company info – Options in Chapter E.4.1 of MODULE E).

• Use currency symbol - You may also select to display the default currency 
symbol of your Windows operating system on screens, reports and documents.
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• Dutch text numbering - This setting is used when creating receipts from the 
“Create receipts” (F9:Process option in receipt batches) or the “Receive payment”
option in Open item link (Action ribbon). For most languages, this option 
should not be selected. If you wish to create and print a receipt in the Dutch 
language, select this option. It will display (print) the number to words for the 
Dutch language correctly.

4. Speed – Do not calculate batches - This is not applicable to TurboCASH5.
5. Special settings - 

• Show calendar - By default, this option is not selected. If you select (tick) this 
field, the Calendar will be the default view when opening the Set of Books. 

• No warning unposted: - This option is not applicable to TurboCASH5.  
• Contra ref as account reference - By default, this option is not selected. This is 

the global settings for batches. 
• Strict tax on account - By default, this option is not selected. This is the global 

settings for batches. 
• Projects - By default the Projects feature is not enabled. If this option is 

selected, it will activate the Projects (Action ribbon).
• Default bank reconciliation method - by default, this option is selected 

(ticked). The bank transactions are manually entered from source documents in 
the Payments and Receipts batches. The bank reconciliation using the default 
method is discussed in this tutorial. 

The Online Bank Plugin allows you to import the transactions from your bank 
statement and allocate these transactions to the accounts. This will be dealt with in 
separate documentation. 

• Log Level – “Off” is the default setting. It may be set up to level 7. You may print the log 
report in Access control (Setup ribbon).

6. General ledger differences – You may create a general ledger account (Accounts 
(Action ribbon)) and select that account in this field. If there any rounding differences, it 
will be posted to this account. 

E.4.10.4- Internet (Optional)

You to set your Internet in order to send reports, statements and lists to any person or institution 
by e-mail. You need to specify your e-mail's outgoing mail server as your Internet Service Provider
has set up your e-mail account on your computer system. You may also test your e-mail server, 
and view the test log file from this option. 

If you have set up any users on the system, the user's User ID and his/her e-mail address, that is 
logged on in the Set of Books and his/her e-mail address will be displayed in this screen. 
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This option will only be available to the users that have been granted access for System Setup under Access
control, but all users, with a valid e-mail address will be able to send reports, statements and lists on the 
Internet.

In this version of TurboCASH, you may configure and set up a Network Server. You may also 
update the data and transactions to the Network Server and restore a Set of Books from a remote 
Network Sever. 

E.4.10.5- Currency (Optional)

Multi-currency is implemented when processing documents. On the Setup → Currencies (Setup 
ribbon), you may add currencies. When processing documents, you may select the currency. The 
document layout files for sales documents (i.e. Quotes, Invoices and Credit notes), and / or 
purchase documents (i.e. Purchases, Supplier returns and Orders) will print in that currency.  

E.4.10.6- Point-of-Sales (Optional)

Point-of-Sale can be set up if you are selling stock items. Improved security and access control has
been added for users to access or start a Point-of-Sale session or shift. You may now link the 
salespersons (cashiers)  added in the Salespersons (Setup ribbon) to users on the Others tab of 
the Access control (Setup ribbon). This feature will add more security when users access or start a
Point-of-Sale invoicing session.

E.4.10.7- Theme

This option allows you to choose between Classic, Classic-large, Ruby and Random themes. 

The Classic theme is used for screen captures in this book.

You may change the default Background1.jpg with your own image (photo, logo, products), etc. 
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F.1- SETTING UP GENERAL LEDGER ACCOUNTS 

F.1.1- PLANNING YOUR CHART OF ACCOUNTS

A Chart of accounts or the list of accounts consists of the account numbers. Each of these 
accounts is linked to a certain account type. It is important to note the types of accounts, which 
will be reflecting in your List of Accounts (Chart of accounts) as you will create, edit and delete 
them in Accounts (Action ribbon):

Account type Brief description of the Account type 

 Bank accounts Bank accounts should be linked to a Receipts and Payment journal (batch).

 General ledger 
accounts

Accounts are aligned to either an  Income /   Expense or  Balance sheet 
type.

The  Balance sheet account type, needs to include the following 3 control 
accounts;

•  Retained earnings / income.

•  Creditor's control account.

•  Debtor's control account.

 Tax accounts Accounts containing the Tax percentages. These are the Output Tax and Input Tax 
codes.
These are country specific and should contain the VAT / GST / Sales tax terminology 
and codes as prescribed by the tax authority of your specific country. 

Creditor (supplier) and debtor (customer / client) accounts, are created, edited or deleted in the 
Action ribbon. 

Menu option Brief description of the account type 

 Creditors Creditor (supplier) accounts containing the details of the creditors, remittance advice 
messages, contacts, land terms. It also contains detail of processed transactions and a list of 
purchase documents (i.e. Purchases, Supplier returns and Orders). 
The total of all individual accounts in the Creditor's ledger will be displayed as the Creditor's 
control account in the General ledger. 

 Debtors Debtor (customer / client) accounts containing the details of the debtors, statement messages
and terms. It also contains detail of processed transactions and a list of sales documents (i.e. 
Invoices, Credit notes, Quotes and Point-of-Sale invoices). 
The total of all individual accounts in the Debtor's ledger will be displayed as the Debtor's 
control account in the General ledger. 

Plan your chart of accounts according to the following guidelines:

• Increment each account number by either 5 or 10 to cater for future additions.

• If possible, list your accounts in alphabetical order.

• Group similar accounts in similar predefined ranges e.g. 600 - 699 for “Fixed assets”.

• List your accounts in the order in which you would like them reported. 
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TurboCASH allows for 999 main accounts. Each account may also have up to 999 sub-accounts. This 
should be enough for most businesses.
The Chart of accounts should be carefully planned so that the accounts fall in the required ranges.
Some Sets of Books may contain 4-digit main, and 5-digit main accounts. The option to “Customise your 
own Set of Books (Advanced)?” on the Creation wizard (Create Set of Books  (Start ribbon)), allows you to 
create your own Set of Books from scratch. This will then ask you to specify the number of digits for 
accounts (from 3 to 8-digits). You need to enter the following 3 control accounts;

•  Retained earnings / income.

•  Creditor's control account.

•  Debtor's control account. 

The following ranges (based on the 3-digit main account codes) are an example that you should 
try to follow. It is NOT the Chart of accounts you will be using - it is merely a guide as to the 
ranges.

Description Range Group

Total chart 001-999

 Income 001-099  Income

 Expenses 200-499  Expenses

 Capital 500-599  Capital

 Fixed assets 600-699  Fixed assets

 Current assets 700-899  Current assets

 Current liabilities 900-999  Current liabilities

 Tax Codes for Tax main account 850-860  Current liabilities

 Bank account + Positive balance 810  Current assets

 Bank account – Negative balance (O/D) 910  Current liabilities

F.1.2- EDITING YOUR CHART OF ACCOUNTS

In the Accounts (Action ribbon) you may create, edit, delete accounts (general ledger, bank and 
tax) as well as enter and edit budget figures for accounts.

When creating or editing accounts you need to link the accounts to Account groups 1 and / or 
Account group 2. These Account groups must be linked to Financial categories. 

For the purpose of this tutorial, the Account groups, have already been created and linked to Financial 
categories.

The Accounts (Action ribbon) allows you to create Reporting Groups and link these Account 
groups to Financial categories for the Balance sheet (i.e. Assets, Capital, Liabilities) and Financial 
categories for the Income statement (i.e. Income and Expenses). 
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In addition to this, you may create Account group 1 and / or Account group 2 in Groups (Setup ribbon) and 
link them to the Financial categories. These Account groups may also be linked to Financial categories in 
the Setup → Financial categories  (Setup ribbon).

To create a new ledger account: 

1. On the Action ribbon, select Accounts. 

2. You may filter and search for accounts and account groups as follows:
Search/Filter option Description 
Sort: The default is “None”. - This will list all accounts according to the account 

number (code).  
You may select to sort / list accounts according to Reporting group 1 or 
Reporting group 2 or Financial categories.

Account starts with: Filter your accounts by entering the first digit of the account number 
(code). For example entering 2 will list only those account numbers 
starting with 2 (e.g. 200 to  299).  To filter the list further, you may, for 
example, enter 21 to list only those accounts from 210 to 219.

Description: Enter any character in the account description. Only those accounts 
containing that character will be listed (e.g. “B” will list all accounts 
containing the character “b”. By typing “BANK” in this field, only the 
accounts containing bank in the account description field will be listed.

Expand after refresh: If this field is selected, the expanded list of accounts will be displayed 
(when clicking on the Refresh icon (or clicking on the “Refresh” option on 
the context menu).
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The icons indicates the following: 
Account groups Financial categories

Account groups - Reporting group 1 and 2 – The sequence in which the groups and accounts are listed, may 
be changed in Groups. (Setup ribbon). This is done by selecting the groups on the list and use the Move up 
or Move down buttons.
In this tutorial, we have created Accounts - Reporting groups 1 and 2 which is set to different sequences:

Reporting group 1 Reporting group 2 

This will enable you to generate general ledger reports (i.e. Trial balance, Income statement, Balance sheet, 
Chart of accounts, to list accounts and balances to be listed according to Reporting group 1 or according to 
Reporting group 2 sequences.  

Icons for accounts:
Icon Account type Reported on Description 

Income /  Expense Income statement Income – Expenses = Net Profit / Loss

Assets / Liability Balance sheet What you own = Assets 
What you owe to others = Liabilities

Bank Balance sheet Current assets 

Tax Balance sheet Current liabilities (Output Tax – Input Tax) 

Retained earnings / income Balance sheet Capital  (Profit / Loss – Previous Years)
Debtor's control Balance sheet Debtor's control = Current assets

Creditor's control Balance sheet Creditor's control = Current liabilities
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Processing Icons and Context menus:
Account groups

Add Group.

Delete a selected Group / Account / Sub-account.

Move  selected Group up 1 entry.
Move  selected Group down 1 entry. 
Move selected Group to the left.

Add new Account / Sub-account.

Refresh the items on the Groups / Accounts list.
Collapse the expanded Groups / Accounts list.
Expand the short list of Accounts and Groups. 

The   Delete icon (option) will not be 
available for the following accounts: 

• Accounts which has any 
transactions processed (posted). 
The “Posted” field display a value 
of more than 0. 

• The  Retained earnings / 
income account. 

• The   Delete icon (option) is 

available for  Debtor's control 

and  Creditor's control 
accounts. Trying to delete these 
control accounts, will produce an 
error message “You cannot delete 
a control account!”.
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Field Description 

Account type: Select the following options:

1. Ledger   Income /  Expense ,  Asset / Liability / Capital 

accounts,  Retained earnings (Retained income),   Debtor's control 

and  Creditor's control accounts.

2.  Bank account will allow you to link a Payments and Receipts batch on 
the Bank tab. 

3.  Tax  will allow you to set the tax percentage for (VAT/GST/Sales tax) 
and specific tax settings.

This field may only be selected for a new account. For existing accounts; this field will be
disabled.

Account number: This consists of 2 parts. The first  block is for the main account; and the second block for
the sub-account. 

Description: The description for the account which will be used to lookup (select) accounts. This is 
also the description which will be displayed on reports.

Account group1: This is used to group and classify the accounts on reports.

Account group2: This is used to group and classify the accounts on reports.

Type: Balance sheet accounts – (i.e. Capital, Liabilities and Assets) or Income statement 
accounts (i.e. Income or Expense). 
Balance sheet accounts retains the balances of the previous financial year (opening 
balances).  
Income statement accounts – these accounts are closed off during the Year-end process
and the balance (Net Profit / Loss) is transferred to the Retained Earnings / Income 
account.

Sub-accounts: Select this option to create a main account.  Once this option is selected, you first need 
to click on the Save button before you are allowed to create sub-accounts for that main
account. You may then create sub-accounts for this main account. 
You will not be allowed to process (post) any transactions; or enter / edit any budget 
figures to the main account. All transactions and budget figures are entered on sub-
accounts. The total of these individual sub-accounts will add up to the main account. 
To delete a main account, you first need to delete all sub-accounts. 

Status: By default, all accounts are enabled (active). Once you have any transactions processed
(posted) to an account, you may not delete the account. 
You may then select the “Disabled” option to block a selected account or sub-account.
This will disable; or set the selected account's status to inactive. This will produce error 
messages to remind you that the account or sub-account is disabled, when trying to 
process (post) transactions to the disabled account or sub-account.    
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Field Description 

Open item account: By default all accounts are set to “No”. If you select the “Yes” option, you may select to 
link (match) a receipt transaction to a debit transaction; or a payment transaction to a 
credit transaction, etc. 
This feature is useful when, for example, you need to control specific payments to 
specific transactions and specific receipts to specific transactions. 

Posted: This field indicates the number of transactions processed (posted) for the selected 
account. Once any transactions have been processed (posted) (the value is more than 
0), you will not be allowed to delete the account.  

Link tax: Link a Tax account to a ledger account. This will then be the default tax account when 
selecting the ledger account when processing transactions in the payments journal, 
receipts journal or other journals (batches). 

Only the “Account type, Account number, Description, Group 1” and “Group 2” fields will be displayed for 

control accounts; i.e.  Retained Income and for  Debtor's control and  Creditor's control.

The Save button will only be displayed (next to the “Description (Account name)” field), once any account is 
created or any field of an existing selected account is changed. 
You need to click on the Save button to save the changes. If you do not do this, your changes will be lost.

F.1.3- CREATING / EDITING BANK ACCOUNTS 

You will be using this option whenever you wish to create a new bank account, change the 
descriptions of an existing account, or to delete an existing account.

You may have more than one Bank account and wish to add this to your Chart of accounts. 
TurboCASH will have set up a Bank account for you in your selected template. (We have used 
account number “810-000 - Current Bank account”).

If you wish to add another Bank account remember that in planning your Chart of accounts you 
would like accounts of a similar nature to be grouped together.

Bank accounts must be linked to a unique Payments and Receipts batch. 
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F.1.3.1- Renaming an existing bank account 

To rename an existing bank account:

1. On the Action ribbon, select Accounts. 

2. Select the “810-000 - Current Bank account” (Current assets – Reporting group), if not 
already displayed as “ABC – Bank”.

3. Replace (over-type) “Current Bank account” with “ABC – Bank” in the “Description” field.

4. Enter “ABC-Payments” and the “ABC-Receipts” batches.

5. Click on the Save button.

It is recommended to type your own Payments and Receipts batch names in the Bank tab of the 
Bank account when creating a Bank account. 
If you have edited the Payments jnl. and Receipts jnl. in Batch types (Setup ribbon), the 
descriptions would be available to select from the list (See Chapter E4.3 of MODULE E). You may 
delete these Payments jnl. and Receipt jnl. in Batch types (Action ribbon).

F.1.3.2- Creating a new bank account 

To create a new bank account:

1. On the Action ribbon, select Accounts. 

2. Select the last Bank account (e.g. “B820000 - Petty cash”) (Current assets – Reporting 

group) and click on the  Add:Account icon (or select the  Add on the Context 
menu). An Entry for the new Ledger account is displayed as “B821000 - Account name” on
the account list.
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3. Enter or select the following:
Account type:  Select “Bank account”.
Account No.:  Replace “821” with “830”.
Description:  Replace “Account name” with “XYZ-Bank”.
Account group 1:  Select “Current assets”.
Account group 2:  Select “Current assets2”.
Type:  See that “Balance sheet” is selected, since the Bank account needs to be

reported on the Balance sheet. 
Sub-accounts:  Do not tick. You cannot create sub-accounts for bank accounts.
Status:  “Enabled” (default) should be selected.
Open item account:  “No” (default) should be selected.
Link Tax:  “Empty” (default) should be selected.

4. Click on the Bank tab. 
5. Enter “XYZ-Payments” and the “XYZ-Receipts” batches.

When saving the bank account, the “XYZ-Payments” and the “XYZ-Receipts” batches will 
automatically be created. You may edit these batches in the Batch types (Setup ribbon).

If the  “Default bank reconciliation method” option is not selected (tick removed) on Setup → 
System parameters menu (Setup ribbon); the “Payments” and “Receipts batch” fields will be 
combined. You may then select either the Payments journal or the Receipts journal. 
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Once any transactions is posted  (updated to the ledger) for a selected bank account; you cannot 
change the Payments or Receipts batches.

6. Click on the Save button.

F.2- CREATING / EDITING TAX ACCOUNTS

You use this option whenever you wish to create a new tax account for VAT/GST/Sales tax where 
you have to charge a percentage of Tax on your sales (Output Tax) and may claim some 
percentage on your purchases (Input Tax). 

Being registered for VAT/GST/Sales tax, you will have two basic accounts, i.e. Output Tax that is 
charged when selling services or goods (not trading stock), and Input Tax when you purchase from
another registered VAT/GST/Sales tax vendor. 

Within these Tax types you may need to create additional sub-accounts to accommodate the various 
classifications and / or tax percentages to assist you in completing your VAT/GST/Sales tax returns and 
make correct payments to the Tax authorities. 

Basic Output Tax (VAT/GST/Sales tax and Input Tax (VAT/GST/Sales tax) accounts as sub-accounts 
of the Tax - Control account (in the Current liabilities account group) are already included in the 
templates. 

F.2.1- Change of Tax Rates

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South 
Africa, the South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 
April 2018. 

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South Africa, the 
South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 April 2018. 

For the purpose of this tutorial, we will be using VAT based on 14% tax for taxable transactions up to 31 
March 2018 and 15% for taxable transactions as from 1 April 2018. 

See – Tax lookup (Chapter C5.4 of MODULE C).
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F.2.1.1- Change the Descriptions of existing Tax Accounts to 14% 

Add or Change the Descriptions of the Tax Accounts (i.e. Output - VAT Control, the VAT Payment 
account, as well as all Tax accounts to 14%) to reflect the existing percentage applicable (until 31 
March 2018). 

To change the Descriptions of Output and Input tax accounts to 14%: 

1. On the Action ribbon, select Accounts. 

2. Select a Tax account. 

3. In the “Description” field, add “- 14%” to “Output VAT - 14%”.

4. Click the Save button to save the changes. After all the account descriptions is changed, 
the 14% accounts should display as follows:

See – Tax lookup (Chapter C5.4 of MODULE C).

F.2.1.2- Add new VAT  - Control and VAT - Payments - 15% accounts

This is only applicable if a new Structure is set for the Tax accounts (i.e. VAT - Control, the VAT - 
Payment account (as Ledger accounts), as well as all Tax accounts to 15%) to reflect the 15% 
percentage applicable (as from 1 April 2018). 
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 F.2.1.2.1- Add new VAT - Control account at 15% as a Ledger Main account  

The VAT – Control – 15% account is the Main account under which the VAT – Payment – 15% as a 
Ledger account type as well as Tax account type for each Tax codes (VAT codes) at 15% as well as 
the Zero-rated Tax codes (VAT codes) will be processed, managed and reported on. Transactions 
on which the 15% VAT rate is applicable from 1 April 2018, are selected and posted (updated to 
the ledger).  

To Add a new VAT Control as a Ledger Main account for 15%: 

1. On the Action ribbon, select Accounts.

2. Select the “REPORTING GROUP ROOT” and click on the  (Add:Account) icon (or select
the  Add on the Context menu). An entry for the new ledger account is displayed as 
“G000 000 Account name” on the Account list. 

3. Enter or select the following:

a) Account type - Select “Ledger”.

b) Account no. -  Change “100” in the sub accounts field of the “Account no.” field to 
“860”. 
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c) Description - Replace “Account name” with “VAT Control – 15%”.

d) Account group 1 - If you have set up “Account group 1”, select your account group 
e.g. “Current liabilities”. 

e) Account group 2 - If you have set up “Account group 2”, select your account group 
e.g. “Current liabilities2”. 

f) Type - “Balance sheet” should be displayed.

g) Sub accounts - Select (tick) this option. This is the new main account under which a 
Ledger sub account for the Tax payments and Tax accounts for each of VAT accounts
will be added for the 15%. 

h) Status -“Enabled” (default) should be selected.

i) Open item account - “No” (default) should be selected.

j) Link tax - “Empty” (default) should be selected.

4. Click on the Save button. When you save the “VAT - Control - 15%” account, if will 
automatically be listed after the 14% Tax accounts. 

 F.2.1.2.2- Add new VAT Payment account at 15% as a Ledger Sub account 

The VAT – Payment – 15% as a Ledger account type on which the payment to SARS is recorded. 
All payments to SARS for transactions, on which the 15% VAT rate is applicable from 1 April 2018, 
should be paid and recorded in the  from this VAT – Payment – 15% account. 

All payments to SARS for transactions, on which the 14% VAT rate is applicable on or before 31 
March 2018, should be paid and recorded in the VAT – Payment – 14% account.  

To Add a new VAT Payment - Ledger Sub account for 15%: 

1. On the Action ribbon, select Accounts.

2. Select the “G860000” VAT Control – 15%” account and click on the  (Add:Account) 
icon (or select the  Add on the Context menu). An entry for the new ledger account is 
displayed as “G860 000 Account name” on the Account list. 
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3. Enter or select the following:

a) Account type - Select “Ledger”.

b) Account no. -  The main account “860” in the of the “Account no.” field cannot be 
changed. Change the “Sub accounts” field from “000” to “100”. 

c) Description - Replace “Account name” with “VAT - Payment – 15%”.

d) Account group 1 - If you have set up “Account group 1”, select your account group, 
e.g. “Current liabilities”. 

e) Account group 2 - If you have set up “Account group 2”, select your account group, 
e.g. “Current liabilities2”. 

f) Type - “Balance sheet” should be displayed.

g) Sub accounts - This option cannot be selected, since this is a sub account of the 
VAT - Control - 15% main account. 

h) Status -“Enabled” (default) should be selected.

i) Open item account - “No” (default) should be selected.

j) Link tax - “Empty” (default) should be selected.

4. Click on the Save button. 
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F.2.2- Add new Tax codes (Tax accounts) for Each Tax type at 15%.

Your Set of Books in TurboCASH need to be configured to is able to accommodate the different 
rates. Transactions need to be processed at the new VAT rate of 15% as from 1 April 2018, and at 
VAT rate of 14% as up to 31 March 2018. 

All “Enabled” Tax / VAT codes are listed in the Tax lookup in the “Tax” column. Transactions are 
taxable at the VAT rate of 14% up to 31 March 2018, and transactions as from 1 April 2018 are 
taxable at the VAT rate of 15%.    

 

To Add VAT accounts – Tax Sub accounts for 15%: 

1. On the Action ribbon, select Accounts.

2. Select the Tax Control Account (as in this case, “G860-000 VAT Control Account”) and 

click on the  (Add:Account) icon (or select the  Add on the Context menu). An entry 
for the new ledger account is displayed as “G860 000 Account name” on the Account list. 
The reason for this is that we need to create a Tax code, which is a Sub-account for the 
Tax main account (i.e. “VAT Control – 15% account”.
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3. Enter or select the following:

a) Account type - Select “Tax (VAT/GST/Sales tax)”.

b) Account no. - The Main account “860” is displayed and the sub accounts number 
field enter “010”. 

c) Description - Replace “Account name” with “Output VAT – 15%”.

d) Account group 1  - If you have set up “Account group 1”, select your account group,
e.g. “Current liabilities”. This is the Account group which is linked to the main 
account.

e) Account group 2 - If you have set up “Account group 2”, select your account group, 
e.g. “Current liabilities2”. This is the Account group which is linked to the main 
account.

f) Type - “Balance sheet” should be displayed. This field cannot be selected, since the 
main account is a Balance sheet type account. 

g) Sub-accounts - This field cannot be selected, since this is a sub-account. 

h) Status - “Enabled” (default) should be selected.

i) Open item account - “No” (default) should be selected.

j) Link tax - “Empty” (default) should be selected.
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4. Click on the Tax tab. 

a) Percentage - Enter the percentage as “15”.

b) Use link tax - Do not select this option.

c) Show tax in documents – Leave the option as “All” for the purpose of this tutorial.

5. Click on the Save button. 

6. Add new Tax type accounts at 15% similar to the 14% tax type accounts, including the 
Zero-rated tax type accounts.  

An example of the Tax accounts - 14% as well as the Tax accounts - 15%, in the Chart of accounts, 
is as follows: 
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F.3- CREDITOR (SUPPLIER) ACCOUNTS

You will be using this option whenever you wish to create a new creditor (supplier) account, 
change the name, contact details addresses, messages, accounting information and terms of an 
existing account, or to delete an existing account.

To add a creditor (supplier) account, the only fields which is needed to fill in is the Creditor code and a 
description (account name (description)). The rest of the fields are optional. 
It is recommended to enter as much information about creditor (supplier) as possible (and to keep it 
updated as regularly as possible).
You may read the “Working with Creditor accounts” section in the Help file and / or press the F1 key when 
focussed on the following eight (8) tabs:

• Delivery address - Delivery address, Address 2, Address 3, Postal code, Country, Message, 
Message 1, Message 2 and Message 3 and Layout files for purchase  documents (i.e. Purchases, 
Supplier returns and Orders).

• Accounting information - Account disabled, Open item account, Due days (Payment date), Credit
limit, Charge amount, Bank account (i.e. Bank account type, Bank account no., Bank name and 
Branch code), Use default account and Use default tax.

• Contacts - Any contacts linked to the creditor (supplier) account will be listed. You may also add, 
edit, delete and search for contacts. The “Auto-copy info” feature allows you to copy the searched
contacts details, which may be edited if required. 
Contacts may also be maintained (managed) in the in the Contacts and Calendar  – Contacts 
(Action ribbon).

• Appointments - Any events or appointments have been scheduled in the Calendar (Action 
ribbon) for that creditor (supplier) account will be listed.

• Documents - Any Purchase, Supplier returns and / or Orders processed for the creditor (supplier) 
account will be listed on this tab. You may print these documents or a posted batches report for 
these documents. 

• Transactions - Any debit and credit transactions (in batches and / or documents) posted 
(updated) to the ledger will be listed on this tab. You may print a posted batches report for these 
transactions or view and print the transactions in the T-Account viewer.

• Bank accounts – This is used for the BankImport plugin.
• Stock items – This tab will list all the posted as well as unposted purchase documents (i.e. 

Purchases, Supplier returns and Orders) for the selected creditor (supplier) account. 

F.3.1- CREATING / EDITING CREDITOR (SUPPLIER) ACCOUNTS

For this example, create one creditor, “A-ONE Suppliers”.
• If you have selected the HANDYMAN Set of Books, you may follow this procedure.
• If you have selected the HANDYMAN-A or HANDYMAN-B Set of Books, you can click on the Edit 

button to check the settings.
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To create a new creditor (supplier) account:

1. On the Action ribbon, select Creditors (F5). 

2. To create a new account, click on the New button.  If the new (blank) creditor account 
screen is launched, you may need to enter the details, as necessary. To edit a creditor 
account, select the account and click on the Edit button to check / edit the details. 

3. Enter and / or select the following options: 
Creditor code:  Enter “2AONES” (or over-type with your own code) and press the Enter 

key. 
It is important to prefix the account code for creditors to start with 2 
and debtors to start with 1.
This will make it easier to select accounts, in some features, for 
example, selecting a Contra account in Batch setup. 
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Name:  Enter “A-ONE Suppliers”
Address, Address 2,
Address 3 and 
Postal code:

 Enter “PO Box 31318, Marshalltown, Johannesburg, 2000”

Country:  Leave “Empty”.
Phone 1:  Enter “(011) 838-9221”.
Phone 2:  Enter “(011) 838-9222”.
Fax:  Enter “(011) 838-9223”.
Website:  Enter “turbocash.net”. 

You may double-click on the “Website” field to launch the web page of
the creditor (supplier) in your operating system's default web browser.

E-mail:  “aone@pinksoft.co.za”.

You may double-click on the “E-mail” field to launch a blank e-mail 
message in your operating system's default e-mail program with the 
e-mail address of the creditor (supplier).

Tax reference:  Enter “906012345”.
Company reg. no.:  Enter “123459060”.
Contactperson: No contact person will be available at this stage. You may click on the 

Contacts tab to create a contact person and enter the necessary contact 
information, if the contact has different Fax, Telephone numbers or an E-mail 
address as entered on the Creditor accounts default screen.
Should you already have entered a contact person in the Contacts  or in the 
Calendar (Action ribbon), you may select the Contact person.

Creditor group 1:  Select “Creditor group 1A”.
Creditor group 2:  Leave  “Unallocated”.

Language: The default language when TurboCASH is launched for the first time will be 
selected. 
You may select a different language; provided that your system's Regional 
and language settings supports the locale for the language.
If the language is selected, it will print translatable document layout files 
(purchases, supplier returns and orders) in the selected language of the 
creditor (supplier) account.
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4. Enter and / or select the following on the Delivery address tab:
Delivery address and
Postal address:  You may wish to enter the physical address of the creditor (supplier) if 

different from the postal address.
Layout file 1:  Select “Purchase (15 code)”
Layout file 2:  Select “Supplier return (15 code)”
Layout file 3:  Select “Order (15 code)”
Statement message 
1 / 2 / 3:  You may enter the message to be displayed on the Remittance advices,

e.g. “Less 2.5% early settlement discount”.
Country:  Leave “Empty”.

5. Click on the Accounting information tab.
Account disabled:  Do not tick.
Open item account:  Leave blank. 

 Read the explanation of open item accounting in Debtor receipts if you 
wish to change this option. If you leave this blank, the Balance will be 
brought forward when posting. 

Due days  Enter “30”.  This is the number of days as agreed upon to pay the 
creditor (supplier).

Credit limit:  Enter “12000”.
Charge amount:  Leave blank.
Bank account type:  Leave blank.
Bank account no.:  Leave blank.
Bank name:  Leave blank.
Use default account:  Do not tick.
Use default tax:  Do not tick
Debtor code:  Leave blank.

6. Click on the Save button. TurboCASH will ask you to confirm if you wish to “create this 
account?” 

7. Click on the Yes button.
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F.3.2- CREATING A CREDITOR ACCOUNT FOR OPENING BALANCES

2COPEN - Opening balances – Creditor has already been created. 
If you have selected the HANDYMAN Set of Books, you may follow this procedure.

If you have selected the HANDYMAN-A or HANDYMAN-B Set of Books, you can click on the Edit 
button to check the settings.

To create a new creditor account for opening balances:

1. On the Action ribbon, select Creditors (F5). The “Creditor accounts” screen will displayed.

2. Click on the New button. Enter “2COPEN” as the account code.

It is important to prefix the account code for creditors to start with 2 and debtors to start with 1.
This will make it easier to select accounts, in some features, for example, selecting a Contra 
account in Batch setup. 

3. Enter the Name for the Account (i.e. “Opening Balances – Creditor”). 

4. Select a Creditor group 1 (if created in Setup Creditor group1). 

5. Click on the Save button or OK button. TurboCASH will ask you to confirm if you wish to 
“create this account?” 

6. Click on the Yes button.

One finished processing the opening balances, you may disable the Opening balances account 
(tick the “Disabled” field on the Accounting information tab).   

F.4- DEBTOR (CUSTOMER / CLIENT) ACCOUNTS

You will be using this option whenever you wish to create a new debtor (customer / client) 
account, change the name, contact details addresses, messages, accounting information and terms
of an existing account, or to delete an existing account.

To add a debtor (customer / client) account, the only fields which is needed to fill in is the Debtor code and a 
description (account name (description)). The rest of the fields are optional. 
It is recommended to enter as much information about debtor (customer / client) as possible (and to keep it 
updated as regularly as possible).
You may read the “Working with Debtor accounts” section in the Help file and / or press the F1 key when 
focussed on the following nine (9) tabs:

• Delivery address - Delivery address, Address 2, Address 3, Postal code, Country, Message, Message
1, Message 2 and Message 3 and Layout files for sales documents (i.e. Quotes, Invoices and Credit 
notes).

• Accounting information - Account disabled, Open item account, Due days (Payment date), Credit 
limit, Charge amount, Customer discount percentage, Monthly interest percentage on overdue 
amounts, Selling prices, Bank account (i.e. Bank account type, Bank account no., Bank name and 
Branch code), Use default account and Use default tax.
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• Contacts - Any contacts linked to the debtor (customer / client) account will be listed. You may 
also add, edit, delete and search for contacts. The “Auto-copy info” feature allows you to copy the 
searched contacts details, which may be edited if required.
Contacts may also be maintained (managed) in the in the Contacts and Calendar  – Contacts 
(Action ribbon).

• Appointments - Any events or appointments have been scheduled in the Calendar (Action ribbon) 
for that debtor (customer / client) account will be listed.

• Documents - Any Invoices, Point-of-Sale Invoices, Credit notes and / or Quotes generated for the 
debtor (customer /client) account will be listed on this tab. You may print these documents or a 
posted batches report for these documents.  

• Transactions - Any debit and credit transactions (in batches and / or documents) posted (updated)
to the ledger will be listed on this tab. You may print a posted batches report for these 
transactions or view and print the transactions in the T-Account viewer.

• Bank accounts – This is used for the BankImport plugin. 
• Backorders – This tab will list all backorders for the debtor (customer / client) account. 
• Stock items – This tab will list all the posted as well as unposted sales documents (i.e. Quotes, 

Invoices and Credit notes) for the selected debtor (customer / client) account. 

F.4.1- CREATING / EDITING DEBTOR (CUSTOMER / CLIENT) ACCOUNTS

For this example, create a debtor (customer / client), “Mr. Mike Davies”.
If you have selected the HANDYMAN Set of Books, you may follow this procedure:

If you have selected the HANDYMAN-A or HANDYMAN-B Set of Books, you can click on the Edit button to
check the settings.

To create a new debtor (customer / client) account:

1. On the Action ribbon, select Debtors (F4). The “Debtor accounts” screen is displayed:

2. To create a new account, click on the New button.  If the new (blank) debtor account 
screen is launched, you may need to enter the details, as necessary. To edit a debtor 
account, select the account and click on the Edit button to check / edit the details. 
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3. Enter and / or select the following options: 
Debtor code:  Enter “1MDAVI”  (or over-type with your own code) and press the Enter 

key. 
It is important to prefix the account code for creditors to start with 2 
and debtors to start with 1.
This will make it easier to select accounts, in some features, for 
example, selecting a Contra account in Batch setup.

Name:  Enter “Mr. Mike Davies”.
Address, Address 2,
Address 3 and 
Postal code:

 Enter “PO Box 333, Halfway House, 1685”.

Country:  Leave “Empty”.
Phone 1:  Enter “(011) 315-1225”.
Phone 2:  Enter “083 286-8763”.
Fax:  Enter “(011) 315-1226”
Website:  Enter “turbocash.net”. 

You may double-click on the “Website” field to launch the web page of 
the debtor (customer / client) in your operating system's default web 
browser.
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E-mail:  “mike@pinksoft.co.za”

You may double-click on the “E-mail” field to launch a blank e-mail 
message in your operating system's default e-mail program with the e-
mail address of the debtor (customer / client).

Tax reference:  Enter “336012345”.
Company reg. no.:  Enter “543212345”.
Contactperson: No contact person will be available at this stage. You may click on the 

Contacts tab to create a contact person and enter the necessary contact 
information, if the contact has different Fax, Telephone numbers or an E-mail 
address as entered on the Debtor accounts default screen.
Should you already have entered a contact person in the Contacts or on the 
Calendar  (Action ribbon), you may select the Contact person.

Salesperson:  Select “Russell”.
Debtor group 1:  Select “Debtor group 1B”.
Debtor group 2:  Leave “Unallocated”.
Language: The default language when TurboCASH is launched for the first time will be 

selected. 
You may select a different language; provided that your system's Regional and
language settings supports the locale for the language.
If the language is selected, it will print translatable document layout files 
(invoices, credit notes and quotes) in the selected language of the debtor 
(customer / client) account.

4. Enter and / or select the following on the Delivery address tab:
Delivery address and Postal 
code:  You may wish to enter the physical address of the debtor 

(customer / client); if different from the postal address.
Country:  Leave “Empty”.
Layout file 1:  Select “Invoice (15 code)”
Layout file 2:  Select “Credit note (15 code)”
Layout file 3:  Select “Quote (15 code)”
Statement message and 
Statement message 1 / 2 / 3:  You may enter the message to be displayed on the Debtor 

statements, e.g. “Please refer any queries to our accounts 
department”.

5. Click on the Accounting information tab.
Account disabled:  Do not tick.
Open item account:  Tick. 
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 Read the explanation of open item accounting in Debtor receipts if you 
wish to change this option. If you leave this blank, the Balance will be 
brought forward when posting. 

Due days:  Enter “30”.  This is the number of days as agreed upon to to receive 
payment from the debtor (customer / client).

Credit limit:  Enter “10000”.
Charge amount:  Leave blank.
Customer discount:  Leave blank.
Monthly interest on 
overdue amounts:  Leave blank.

Selling price:  Select “Selling price 1”
Bank account type:  Leave blank.
Bank account no.:  Leave blank.
Bank name:  Leave blank.
Use default account:  Do not tick.
Use default tax:  Do not tick

6. Click on the Save button or OK button. TurboCASH will ask you to confirm if you wish to 
“create this account?” 

7. Click on the Yes button.

F.4.2- CREATING A DEBTOR ACCOUNT FOR OPENING BALANCES

1DOPEN - Opening Balances – Debtor has already been created. 
If you have selected the HANDYMAN Set of Books, you may follow this procedure.

If you have selected the HANDYMAN-A or HANDYMAN-B Set of Books, you can click on the Edit button 
to check the settings.

To create a new debtor account for opening balances:

1. On the Action ribbon, select Debtors (F4).  The “Debtor accounts” screen will displayed. 

2. Click on the New button. Enter “1DOPEN” as the account code.

It is important to prefix the account code for creditors to start with 2 and debtors to start with 1.
This will make it easier to select accounts, in some features, for example, selecting a Contra 
account in Batch setup. 

3. Enter the Name for the Account (i.e. “Opening Balances – Debtor”). 

4. Select a Debtor group 1 (if created in Setup Debtor group1). 
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5. Click on the Save button or OK button. TurboCASH will ask you to confirm if you wish to 
“create this account?” 

6. Click on the Yes button.

One finished processing the opening balances, you may disable the Opening balances account 
(tick the “Disabled” field on the Accounting information tab).   

ONCE YOU HAVE ENTERED ALL YOUR DEBTORS (CUSTOMERS), CREDITORS (SUPPLIERS) AND ADDED 
THE EXTRA GENERAL LEDGER ACCOUNTS YOU NEED, YOU HAVE COMPLETED THE SET-UP AND CHART 
OF ACCOUNTS IN ORDER FOR TurboCASH TO RUN YOUR SET OF ACCOUNTS.

F.5- PRINTING LISTS OF ACCOUNTS, DEBTORS AND CREDITORS

We recommend that you print your Chart of accounts and Debtors and Creditors details to check that 
everything you have setup is, in fact, correct. In accounting it is best to follow the rule: check, recheck and 
check again. It is easier to find and fix any mistakes at this stage, rather than when you have captured 
transactions.

F.5.1- PRINTING ACCOUNTS LISTING (CHART OF ACCOUNTS)

To print a list of your accounts:

1. On the Reports ribbon, select Reports → Ledger → Listing.
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2. Select the following options:
From account:  Select the first account.
To account:  Select the last account.

Sequence:  Select “Account”, if not selected. You may also select “Description, Type, 
Reporting group1” or “Reporting group2”. 

3. Click on the OK button to print your Chart of accounts.

It is important to check that the VAT based on 14% tax for taxable transactions up to 31 March 2018 is 
replicated for the VAT based on 15% for taxable transactions as from 1 April 2018. 
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Check that all the reporting groups are correct and that all the types are correct. The following needs special
attention  i.e. 

•  Income and  Expense account types should be prefixed with an asterisk e.g. *G010000"

•  Bank account type should be "Bank account" - Code prefixed with a B and Bank account in 
the Type column. 

•  Tax (VAT/GST/Sales tax) sub-accounts type should be "Tax account" - Code prefixed with a T
and Tax account in the Type column.

F.5.2- PRINTING DEBTOR LISTING

The Debtor listing allows you to print the following seven (7) reports:

1. Contacts - This report will list the Name of the Contact, Telephone 1 / 2 and the debtor 
(customer / client) account code and name (description) linked to the contact. 

2. Listing - This report will list the Account code, Name of the Debtor (account description),
Delivery address, Telephone 1 / 2, Fax, E-mail address and Website. 

3. List - Delivery address - This report will list the Account code, Name of the Debtor 
(account description), Delivery address, Telephone 1 / 2, Fax, E-mail address and Website.

4. List - Postal address - This report will list the Account code, Name of the Debtor 
(account description), Postal address, Telephone 1 / 2, Fax, E-mail address and Website. 

5. List details - This report will display the Contact details, Registration details, Banking 
details, Reporting details, Accounting terms and information for each debtor (customer / 
client) account. 

6. Tax and company registration numbers – List the registration numbers as entered on 
the Debtor accounts (edit screen) (Action ribbon).

7. Credit control listing - Credit limit vs current balance and available balances as at the 
date and time of printing. 
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To print a list of your debtors (customers / clients): 

1. On the Reports ribbon, select Reports → Debtors → Listing. The “Contacts” (default 
report) will be displayed.

2. Select the “List details” report.

3. Select the following options:
From account:  Select the first account.
To account:  Select the last account.
Reporting group 1  Do not tick. You may select to print only those accounts that are 

linked to specific Debtor group(s) 1. 
Sequence:  Select “Debtor code”. You may also select “Description, Reporting 

group1” or “Reporting group2”. 
New page per account:  Tick this option for this report. 

4. Click on the OK button to print a list of your debtor (customer /client) accounts.

The “List details” report will display the following information:

1. Contact details - Contactperson, Telephone 1 / 2, Fax, E-Mail, Website, Postal address, 
Delivery address and Language of the debtor (customer / client). 

2. Registration details - Company Registration number and Tax registration number.

3. Banking details - Bank account type, Name of Bank account, Bank account number and 
Branch code. 

4. Reporting details - Reporting group 1 / 2, Layout file 1 (Invoices), Layout file 2 (Credit 
notes) and Layout file 3 (Quotes).  If no layout files are selected, the documents will be 
printed for the global settings in Documents setup (Setup ribbon).

5. Accounting terms and information - Statement message, Credit limit, Monthly interest 
rate, Customer discount rate, Due days (payment terms), account settings (i.e. Open 
item / Balance B/F), Account disabled, Default selling price and Salesperson.
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F.5.3- PRINTING CREDITOR LISTING

The Creditor listing allows you to print the following seven (7) reports:

1. Contacts - This report will list the Name of the Contact, Telephone 1 / 2 and the creditor 
(supplier) account code and name (description) linked to the contact. 

2. Listing - This report will list the Account code, Name of the Creditor (account 
description), Delivery address, Telephone 1 / 2, Fax, E-mail address and Website. 

3. List - Delivery address - This report will list the Account code, Name of the Creditor 
(account description), Delivery address, Telephone 1 / 2, Fax, E-mail address and Website.

4. List - Postal address - This report will list the Account code, Name of the Creditor 
(account description), Postal address, Telephone 1 / 2, Fax, E-mail address and Website.

5. List details - This report will display the Contact details, Registration details, Banking 
details, Reporting details, Accounting terms and information for each creditor (supplier 
account). 

6. Tax and company registration numbers List the Registration numbers as entered on the 
Creditor accounts (edit screen) (Action ribbon).

7. Credit control listing - Credit limit vs current balance and available balances as at the 
date and time of printing. 

To print a list of your creditors (suppliers): 

1. On the Reports ribbon, select Reports → Creditors → Listing. The “Contacts” screen will 
be displayed.

2. Select the “List details” report.

152 - TurboCASH5.1 – 2018 – Accounting Made Easy



PRINTING CREDITOR LISTING

3. Select the following options:
From account:  Select the first account.
To account:  Select the last account.
Reporting group 1  Do not tick. You may select to print only those accounts that are 

linked to specific Creditor group(s) 1. 
Sequence:  Select “Creditor code”. You may also select “Description, Reporting 

group1” or “Reporting group2”. 
New page per account:  Tick this option for this report. 

4. Click on the OK button to print a list of your creditor (supplier) accounts.

The “List details” report will display the following information:

1. Contact details - Contactperson, Telephone 1 / 2, Fax, E-Mail, Website, Postal address, 
Delivery address and Language of the creditor (supplier). 

2. Registration details - Company Registration number and Tax registration number.

3. Banking details - Bank account type, Name of Bank account, Bank account number and 
Branch code. 

4. Reporting details - Reporting group 1 / 2, Layout file 1 (Purchases), Layout file 2 
(Supplier returns) and Layout file 3 (Orders).  If no layout files are selected, the 
documents will be printed for the global settings in Documents setup (Setup ribbon).

5. Accounting terms and information - Statement message, Credit limit, Due days 
(payment terms), account settings (i.e. Open item / Balance B/F) and Account disabled.

YOU ARE NOW READY TO ENTER YOUR OPENING BALANCES AND TO PROCESS TRANSACTIONS.
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INTRODUCTION

G.1- INTRODUCTION

In the HANDYMAN Set of Books, we have included eleven (11) Stock items. The following Stock 
item types are used in this tutorial: 

1. Default (Trading stock): These Stock items are for retail industries which purchase stock 
items for resale.

For the purpose of this tutorial, we will be purchasing and selling Compressors and Drill Presses.  
- (See MODULE K). 

2. Financial entry: This Stock item type allows you to select a General ledger account. This 
may be used for services or any other purchase or sales which is not trading stock items.

For the purpose of this tutorial, orders and purchase documents are used for purchases of non 
trading stock, (e.g. service and fitting of tyres on a delivery van as well as installing of office 
equipment). - (See Chapter J.3 of MODULE J). This will illustrate similar transactions than in the 
Purchase journal. - (See Chapter I.3 of MODULE I).

3. Sales (no stock): – Used for selling of non-trading stock – Need to select a Sales account
only and an Output Tax (VAT / GST / Sales tax) account.

For the purpose of this tutorial, quotes and invoices are used for selling of non-trading stock, (e.g. 
service and fitting of shelves). - (See Chapter J.4 of MODULE J). This will illustrate similar 
transactions than in the Sales journal. - (See Chapter I.4 of MODULE I).

You may create, add, copy, delete and / or disable up to eleven (11) stock item types. 
You may read the “Working with Stock” section in the Help file and / or press the F1 key when 
focussed on the following stock item’s “Type” fields:

• Default – Used for trading stock – Need to select the Sales, Cost of sales and Stock 
control accounts. It can also be linked to the Input and Output Tax accounts. For the 
purpose of this tutorial, we will be using two (2) trading stock items (i.e. Compressor 
and a Drill press).

• Sales – Used for non-trading stock – Need to select a Sales account only. It can only be 
linked to the Output Tax account.

• Sales (no stock) – Used for non-trading stock – Need to select a Sales account only. It 
can only be linked to the Output Tax account.

• Purchases – Used for non-trading stock – Need to select the Cost of sales and the Stock
control or Purchase account. It can only be linked to the Input Tax account. No Selling 
prices can be entered.

• Purchases (no stock) – Used for non-trading stock – Need to select the Cost of sales 
and the Stock control or Purchase account. It can only be linked to the Input Tax 
account. No Selling prices can be entered.

• Financial entry – Cannot select the Sales, Cost of sales and Stock control accounts. This
allows you to select a ledger account on the Accounts lookup when processing 
documents. Once you select this stock item type when processing documents, the 
Accounts lookup will be displayed. You may then select any general ledger account on 
the Accounts lookup. You need to select the Input as well as Output Tax accounts for 
this stock type. The Selling prices may also be entered. 

TurboCASH5.1 – 2018 – Accounting Made Easy - 155



MODULE G - CREATING / EDITING STOCK ITEMS

You need to create a financial entry stock item for each Tax Type (different rates).
• Option item – This stock type allows items that are a combination of options (like 

colour and size) options can be defined in Stock information. (Setup ribbon). These 
options are then linked to the Options Stock type (Stock items on the Options tab 
(Action ribbon)). When processing documents, the available options (options list) will be
launched from the “Quantity” fields when selecting documents.

• Option item (no stock) – This is similar to the Option item with stock, but does not 
allow every entry to have a sales price, cost price, quantity and minimum stock level. 
This will also be used in generating purchases on supplier 1.

• BOM – Bill of Materials – allows you to add other stock items or products consisting of 
various other stock items (components) and / or some services, etc. to the BOM list. The
BOM stock item is the finished product. You may only select the Sales account and the 
Output Tax account. For trading stock, the cost of sales and stock control accounts are 
controlled via the default stock items linked to the BOM item. An example would be the
components (Stock items) of a computer system which are used to make the complete 
system, which is then sold as a finished product.

• BOM (Production) – This is similar to the BOM stock type. It has a feature where you 
may assemble (specify the quantities) of finished items or disassemble a specified 
quantity of finished items.

• Linked item - To be advised.

G.2- ADDING TAX CLASSES

This option allows you to create and maintain account / tax classes. Tax classes are a set of five (5) 
accounts which are linked to the Ledger tab of the “Stock item” screen (Action ribbon) for a 
selected stock item. 

When a stock item is linked to a tax class, it will disable the Lookup button on the Ledger tab of 
the “Stock item” screen (Action ribbon) for a selected stock item. It will automatically set the Input 
and Output Tax accounts, Sales account, Cost of sales accounts without having to select them for 
each stock item.

You need to create tax classes for each of your tax codes applicable to stock items. For the purpose of this 
tutorial, we create a Tax class – Standard rate. If you have Stock items applicable to, for example, Zero-rated
Tax (VAT / GST / Sales tax), you need to create them.
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 To set stock tax classes:

1. On the Setup ribbon, select Stock information. 

2. Click on the Tax classes tab.

If “English” as the default language is used, Tax classes will be displayed. 
If you have selected, “en-South-Africa” the Tax classes description, will reflect VAT classes.

3. Select the existing Tax class and add 14% to the Name field, if not reflected. 

4. Click  to save the changes.

5. Click  to add a new Tax class.

6. Enter the Name (description) e.g. Standard rate 15% for the tax class.

7. Select the following accounts:

a) Input Tax - Select the Input Tax account (860-020).

b) Output Tax - Select the Output Tax account (860-010).

c) Sales account - Select the Sales account (010-000).

d) Cost of sales - Select the Cost of sales account (100-000).

e) Stock control - Select the Stock control account (750-000).

8. Click  to save the changes.

9. Click on the OK button to close the “Stock information” screen.

G.2.1.1- Printing a report for Tax classes

When a stock item is linked to a tax class, it will disable the Lookup button on the Ledger tab of 
the Action → Stock items screen for a selected stock item. It will automatically set the Input tax 
and Output tax, Sales, Cost of sales and Stock control account fields without having to select them
for each stock item. 
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To print Stock item listing - Tax classes reports: 

1. On the Reports ribbon, select Reports → Stock → Stock item listing. 

2. Select "Tax classes" report. 

3. Select the Sequence (i.e. “ID” (record Id) or “Description”) for the sequence to list the
tax classes.

4. Click on the OK button. 

An example of the Stock item listing - “Tax class - Listing” report, is as follows:

The next step is to link the accounts to the stock items. 

G.2.1.2- Linking Tax classes to Stock items

To change Input and Output tax accounts from 14% to 15%: 

1. On the Action ribbon, select Stock items. 

2. Select a Stock item.

3. Click on the Ledger tab. 
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4. Tax class, select “Standard rate 15%”.

5. Click on the Save button. The inclusive amount will automatically be updated with the 
new tax rate.

6. Repeat the process for all the stock items.

You may also change the tax classes on the grid view. In this example, the Tax class column was 
dragged from the Right to the Left. 
Select the Stock item and Tax class Standard rate 15% and click on the Save button.
Repeat the process for all the stock items.
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G.3- SETTING UP A STOCK ITEM FOR FINANCIAL ENTRY

When a Financial entry stock item type is selected, when processing documents, the Accounts 
lookup will be displayed. You may then select any general ledger account on the Accounts lookup.

Examples of accounts that may be selected on documents: 

• Sales documents (i.e. Invoices, Credit notes and Quotes) 

◦  Income accounts - Selling miscellaneous services and goods not trading stock. 

• Purchase documents (i.e. Purchases, Supplier returns and Orders) 

◦  Expense accounts - e.g. Purchasing of Stationery (Consumables) 

◦  Asset accounts – Purchasing of Fixed assets 

To set up a stock item for financial entry:

1. On the Action ribbon, select Stock items (F12). 

2. Click on the New button. A blank “Stock item” screen will be displayed. 

3. Enter and / or select the following options:

a) Main 
Option Description
Stock code:  Enter a stock code. For the purpose of this tutorial, “GL-CODE” was 

entered.
Description:  For the purpose of this tutorial, “General ledger” was entered.
Disabled:  Leave blank.
Apply invoice discount:  Leave blank.
Expected quantity:  Field disabled – The values in this field should be 0 at this stage.
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Stock code – Since the document layout files supporting 10 stock codes (10 code) is selected 
in the Documents  setup (Setup ribbon)and on the Delivery address tabs of Creditors and 
Debtors  (Action ribbon) were selected, were selected, it is recommended that the Stock code
be limited to a maximum of 10 characters.
(See Chapter E4.5 of MODULE E).   

b) Stock information 
Option Description
Barcode:  Leave blank.
Manufacturer:  Leave blank.
Extra description:  Leave blank.
Type:  Default is the standard Stock item type. Select “Financial entry”. This will 

disable the “Sales, Cost of sales” and “Stock control” accounts as well as 
the “Latest invoice” fields.

Units:  Click on this field and select “Each”.

c)  Reports
Option Description
Stock group 1:  Select “Labour”.
Stock group 2:  Leave blank.

d)  Preferred suppliers 
Option Description
Preferred supplier 1:  Leave blank.
Supplier stock code:  Leave blank.
Preferred supplier 2:  Leave blank.
Supplier stock code:  Leave blank.

4. Click on the Ledger tab; if not displayed by default.
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5. Select and / or enter the following options:

a)  Tax class / Tax / Ledger 
Option Description
Tax class:  Select “Standard rate 15%” – It will automatically link the 

• Input Tax to “T860-020 Input VAT – Standard rate - 15%”
• Output Tax to “T860-010 Output VAT - 15%”
• Sales account to “G010-000 Sales”
• Cost of sales to ”G100-000 Cost of sales” 
• Stock control to “G750-000 Stock control”

Last invoice:  Option inactive. The date of the last purchase or other document generated 
on which the service Stock item was selected. This field will not display any 
date if it is a new item, or if no Stock items have been selected on any 
documents.

b) Cost centre / Weight 
Option Description
Cost centre:  Disabled. 
Nett weight:  Leave blank. 
Gross weight:  Leave blank. 

c)  Selling prices
Option Description
Selling price 1:  Leave blank. 
Selling price 2:  Leave blank. 
Selling price 3:  Leave blank. 
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d) Value 
Option Description
Average cost:  Leave blank. 
Total cost:  Leave blank. 
Quantity on hand:  Leave blank. 
Latest cost:  Leave blank. 
Re-order level:  Leave blank. 
Reorder at:  Leave blank. 
Minimum:  Leave blank. 

6. Click on the Save button to save changes.

G.4- SETTING UP A STOCK ITEM FOR SALES (NO STOCK)

The disabled and inactive options for the Sales (no stock) Stock item type is the same. If you select
this Sales or the Sales (no stock) Stock item type on an invoice or a credit note, no Cost of sales 
transactions would be generated. You will also not be allowed to specify the re-order level and 
select the Cost of sales, Stock control and Input Tax accounts. 

Should you need to generate invoices and credit notes to customers (debtors / clients) for 
services, fees, charges or other sales which is not trading stock, you may create a Sales or Sales (no
stock) Stock item type. You may generate invoices and credit notes for these non trading Stock 
items only or add these item codes to an invoice or credit note containing physical Stock items. 

Some examples where you would create a Sales or Sales (no stock) Stock item type, is the 
following: 

• Invoicing services such as labour, consulting fees, etc. 

• Invoicing carting fees, delivery fees, other charges, etc. 

For the purpose of this tutorial, we will be selling 2 services (i.e. Install - Built-in cupboards and Paint Exterior
(outside of houses)) at 500,00 per hour to our debtors / clients).

The “Sales (no stock)” Stock item type is already created and added in the HANDYMAN, HANDYMAN-A or 
HANDYMAN-B Sets of Books.
You may select the “Sales (no stock)” Stock item type and click on the Copy from item and only need to 
change a few details for the new services item. 
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To set up a stock item for sales (no stock) for services:

1. On the Action ribbon, select Stock items (F12). 

2. Select the “Sales (no stock)”. 

3. Click on the Copy from item button. The “Stock item” screen with all the data as entered 
in the original “Stock item” screen (except the Stock code) is displayed:

4. Enter and / or select the following:

a) Main 
Option Description
Stock code:  Enter “4L-PAINT-E”. 
Description:  Enter “Paint Exterior”.
Disabled:  Leave blank. 
Apply invoice discount:  Leave as is. 

b) Stock information 
Option Description
Barcode:  Leave blank. 
Manufacturer:  Leave blank. 
Extra description:  Leave blank. 
Type:  Default is the standard Stock item type. Select “Sales (no stock)”. This will 

disable the “Input Tax, Cost of sales” and “Stock control” accounts as well
“Last invoice” fields.

Units:  Click on this field and select “Hours”.
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c) Reports
Option Description
Stock group 1:  Select “Labour”.
Stock group 2:  Leave blank.

d) Preferred suppliers
Option Description
Preferred supplier 1:  Leave blank.
Supplier stock code:  Leave blank.
Preferred supplier 2:  Leave blank.
Supplier stock code:  Leave blank.

5. Click on the Ledger tab; if not displayed by default.

6. Select and / or enter the following options:

a) Tax class / Tax / Ledger 
Option Description
Tax class:  Select “Standard rate 15%” – It will automatically link the 

• Input Tax to “T860-020 Input VAT – Standard rate - 15%”
• Output Tax to “T860-010 Output VAT - 15%”
• Sales account to “G010-000 Sales”
• Cost of sales to ”G100-000 Cost of sales” 
• Stock control to “G750-000 Stock control”

Last invoice:  Option inactive. The date of the last purchase or other document generated on 
which the service Stock item was selected. This field will not display any date if it
is a new item, or if no Stock items have been selected on any documents.
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b) Cost centre / Weight 
Option Description
Cost centre:  Disabled. 
Nett weight:  Leave blank. 
Gross weight:  Leave blank. 

c) Selling prices 
Option Description
Selling price 1:  Enter “500” exclusive or “570” as inclusive of VAT/GST/Sales tax.
Selling price 2:  Enter “550” exclusive or “627” as inclusive of VAT/GST/Sales tax.
Selling price 3:  Enter “600” exclusive or “684” as inclusive of VAT/GST/Sales tax.

d) Value 
Option Description
Average cost:  Leave blank. 
Total cost:  Leave blank. 
Quantity on hand:  Leave blank. 
Latest cost:  Leave blank. 
Re-order level:  Leave blank. 
Reorder at:  Leave blank. 
Minimum:  Leave blank. 

7. Click on the Save button to save changes.

Select the Paint Exterior “4L-PAINT-E” Stock item and click on the Copy from item button.
1. Enter “4L-INSTCUP” as the stock code.
2. Enter “Install - Built-in cupboards” in the “Description” field. 
3. All other fields and the selling prices should be the same as for the Paint Exterior Stock 

item.
4. Click on the Save button. 

G.5- CREATING A TRADING STOCK ITEM

The Default Stock item type is used for Trading stock items. The Cost of sales settings for these are
important as these may have an impact on your gross profit.  
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For the purpose of this tutorial, we will be selling 2 items, i.e. compressors drill presses:

For this example, we will create one stock item, “Drill press”.
If you have selected the HANDYMAN Set of Books, you may follow this procedure.
If you have selected the HANDYMAN-A or HANDYMAN-B Set of Books, you can click on the Edit button to 
check the settings.

To create and edit stock items:

1. On the Action ribbon, select Stock items (F12). The “Stock item” screen is displayed.    

2. Click on the New button. A blank “Stock item” screen will be displayed. “Default” is the 
standard “Stock item type”. 

3. Check that “Default” is selected for the purpose of this tutorial.

4. Enter and /or select the following options:

a) Main 
Option Description
Stock code:  Enter “3DRILL”.
Description:  Enter “Drill press”.
Disabled:  Leave blank.
Apply invoice discount:  Leave blank.
Expected quantity:  Field disabled – The values in this field should be 0 at this stage.
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b) Stock information 
Option Description
Barcode:  Enter “1234567890”.
Manufacturer:  Enter “Bosch”.
Extra description:  Enter “850 Watts + 6 drill bits”.
Type:  Default is the standard Stock item type. Check that “Default” is selected 

for the purpose of this tutorial.
Units:  Click on this field and select “Each”.

c) Reports
Option Description
Stock group 1:  Select “Power tools”.
Stock group 2:  Leave blank. 

d) Preferred suppliers 
Option Description
Preferred supplier 1:  Leave blank. 
Supplier stock code:  Leave blank. 
Preferred supplier 2:  Leave blank. 
Supplier stock code:  Leave blank. 

5. Click on the Ledger tab; if not displayed by default.

Stock can be categorised into groups by the prefix of the code. The Sales, Cost of sales and Stock 
accounts can also be split into sub-accounts per stock category. 
Each stock item can then be linked to the appropriate Sales, Cost of sales and Stock sub-account 
for its particular category.  
Each stock item can also be linked to different tax types catering for varied VAT/GST/Sales tax 
rates.
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6. Select and / or enter the following options:

a)  Tax class / Tax / Ledger 
Option Description
Tax class:  Select “Standard rate 15%” – It will automatically link the 

• Input Tax to “T860-020 Input VAT – Standard rate - 15%”
• Output Tax to “T860-010 Output VAT - 15%”
• Sales account to “G010-000 Sales”
• Cost of sales to ”G100-000 Cost of sales” 
• Stock control to “G750-000 Stock control”

Last invoice:  Option inactive. The date of the last purchase or other document generated on 
which the service Stock item was selected. This field will not display any date if it
is a new item, or if no Stock items have been selected on any documents.

b) Cost centre / Weight 
Option Description
Cost centre:  Disabled. 
Nett weight:  Leave blank. 
Gross weight:  Leave blank. 

c) Selling prices 
Option Description
Selling price 1:  Enter “1000” exclusive or “1140” as inclusive of VAT/GST/Sales tax.
Selling price 2:  Enter “1100” exclusive or “1254” as inclusive of VAT/GST/Sales tax.
Selling price 3:  Enter “1200” exclusive or “1368” as inclusive of VAT/GST/Sales tax.

d) Value 
Option Description
Average cost:  Leave blank. 
Total cost:  Leave blank. 
Quantity on hand:  Leave blank. 
Latest cost:  Leave blank. We will enter the Cost price when we do the Stock take-on 

(entering Quantities on hand and Cost prices).
Re-order level:  Enter “10”.
Reorder at:  Enter “5”.
Minimum:  Enter “4”.

7. Click on the Save button to save changes.
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G.6- PRINTING STOCK ITEM LISTING

To print a stock item listing report:

1. On the Reports ribbon, select Reports → Stock → Stock item listing. The “All selling 
prices” report options will be displayed.

2. Select the “Stock item listing” from the list of reports. 

3. Select the following options: 
From:  Select the first Stock item i.e. “3COMP” on the list.
To:  Select the last Stock item i.e. “SALES-NS” on the list.
Show details:  Select to view additional details for the stock items.
Reporting group 1:  Leave blank.
Show details:  Leave blank.
New page per account:  Leave blank.

4. Click on the OK button.  

If you click on the “Power tools” Stock group 1 only these 2 items linked to “Power tools” Stock 
group 1 (i.e. Compressor and Drill press) should be displayed.

It is good practice to retrieve a detailed report to check that you have entered all the details and 
information correctly. To view additional information, select the “Show details” option. This will list 
the Extra description, Manufacturer, Units, Net and Gross weight, Selling prices 1 / 2 / 3, Barcode 
and Reporting group 1 / 2.  

It is also recommended that the All selling prices Stock item listing report is printed to check your 
selling prices, before you start invoicing.
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H.1- ENTERING OPENING BALANCES

FOR THIS TUTORIAL; WE WILL USE THE HANDYMAN SET OF BOOKS.
TO BEGIN THE TUTORIAL PLEASE GO TO THE MAIN SPEED TOOLBAR - CLICK ON THE OPEN ICON AND

SELECT THE “HANDYMAN” SET OF BOOKS. 
(It is in the “TCASH5/ Bin/Tutorials/EN-TUTORIALS” directory on your system).

We advise you to follow this tutorial carefully when setting up your new Set of Books, expanding 
on the Chart of accounts, adding your debtors and creditors to suit your particular company.

TurboCASH may be started at any point (not necessarily the same day as you start your business). 
You will, possibly, need to enter the balances for all your existing ledger accounts from your 
manual Set of Books. These balances are called opening balances. It is advisable to enter your 
opening balances at the time of setting up the system. 

Opening balances are obtained from your latest trial balance or balance sheet. If your company 
has been running for some time, it is a good idea to enter the balance sheet or trial balance 
figures from the previous year into the system. For example, if your financial year starts on 
2018/03/01, enter your opening balances into the system using the date 2019/02/28. This will give
you a prior year to this year comparison.   

If you enter your trial balance figures from your previous financial year, TurboCASH will calculate 
your net profit/loss, putting it to the Retained income account. (It will not carry the expense 
figures over to the current year.)

If you do not enter any opening balances, your set of accounts will not be complete. However, if it 
is a brand new business you are starting, it will obviously not be necessary to enter any opening 
balances, as you will not have any. 

The opening balances are captured in the General journal. 

H.2- DEBTOR / CREDITOR ACCOUNTS FOR OPENING BALANCES

H.2.1- Creating a debtor account for opening balances

See Chapter F.3.2 of MODULE F.

H.2.2- Creating a creditor account for opening balances

See Chapter F.2.2 of MODULE F.
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H.3- CAPTURING OPENING BALANCES

If you have started to use TurboCASH5, and you already have balances in a hand system or any 
other computerised accounting system, you need to enter the balances from your previous 
accounting system. 

For the purpose of this tutorial, the following examples will be used to illustrate the opening 
balances: 

General ledger : The Trial balance: 

Control accounts: 
Individual balances needs to be taken on 
separately for the following Control accounts: 
• Debtor's control (G700).
• Creditor's control (G900).
• Stock control (G750)

Control accounts in the General ledger must 
always be in balance with the total of the sub-
ledgers.

Debtor's ledger : The balances of the individual Debtor accounts: 

Debtor's ledger: 
Individual balances may be taken on for the 
following: 
• Outstanding amount.
• Each period separately.

Each period separately will allow you to use the 
Ageing feature.

Creditor's ledger : The balances of the individual Creditor accounts: 

Creditor's ledger: 
Individual balances may be taken on for the 
following: 
• Outstanding amount.
• Each period separately.

Each period separately will allow you to use the 
Ageing feature.

Stock ledger: The balances (Quantities and Cost prices) of the individual Stock items: 

Stock ledger: 
Only the total value (cost price of stock) is entered as the 
opening balance of your stock items. 
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The opening balances for your trading stock items (Default stock type) must be entered for each individual 
stock item - you cannot simply enter the total from the trial balance. You need to inform the program of the 
quantities on hand and the cost prices for each stock item. See Chapter K.3 of MODULE K.

TurboCASH will calculate the value of each stock item by multiplying the quantities on hand by the cost 
price. After all the quantities and cost prices of your stock items are entered, the total value of all stock items
should be equal to the control figure (stock control account), as per your financial statements.

H.3.1- Capturing opening balances for general ledger accounts

To enter opening balances from your trial balance:

1. On the Action ribbon, select Batch entry (F2). 

2. Select General jnl., and click on the Open button. 

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''OpenBalances'' to indicate that the Opening balances was entered in this General jnl. 
batch.  

The alias option allows you to identify a batch by a unique name. You will be able to select the 
batch by alias or batch name if you need to reverse the posted batch or import a posted batch. 

4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen is 
displayed:

The first time you enter transactions in a General journal, you should set it up according to your 
requirements. This should be done for each journal, but only need to be done once, unless your 
requirements change.

5. Set up the General journal as follows:
Contra account: The relevant contra account for the batch (i.e. the account to which 

TurboCASH will create a balancing entry).  

 Click on the Lookup button and select the suspense account, i.e. 
“999 - Suspense Account”. 

No tax:  Select this option, as no VAT/GST/Sales tax (Output VAT/GST/Sales 
Tax and Input VAT/GST/Sales tax) is applicable to the opening 
balance transactions.
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Increment reference:  If you tick this field, TurboCASH will increment the reference number
by 1 on each subsequent line. DO NOT tick this option.

Consolidate balancing:  If you tick this field, TurboCASH will consolidate all balancing entries
into 1 entry, if you have used an account more than once. As for the 
take-on of opening balances, it is NOT necessary to tick this option, 
since you will be entering both debits and credits from your Trial 
balance and will not be asking TurboCASH to balance the batch.

Contra account per line:  If you tick this field, TurboCASH will ask to allocate a contra account
for each transaction. As this will be a batch in which you wish to 
enter both debits and credits DO NOT tick this field.

Inclusive mode:  If you tick this field, TurboCASH will treat all amounts as inclusive of
VAT/GST/Sales tax. Tick this option.  

Repeat details:  If you tick this field, TurboCASH will repeat the detail entered in the 
Description column on each subsequent line. Tick this option to 
repeat the details for the next transactions.

Amount entry:  Set to “Allow both”, since you will enter amounts in both the debit 
and credit column.

Opening balance – This 
year  Tick this option. 

If you do not tick this option, you will not be allowed to
post to the Retained earnings / income account. An 
error message (similar to this error message “This 
batch does not validate! Line JNL1 Opening balance - 
Take-on retained income must be adjusted in opening 
balance batch! See F10 in batch for setup.” will be 
produced.

6. Click on the Advanced tab.

7. Leave all fields blank, and make sure that the default option, “Account lookup type”, is set 
to “All” and the “Contra account lookup type” is set to “General ledger”. 

8. Click on the OK button.

9. Capture the first transaction as follows: 

Reference: JNL1
Date: 2018/02/28
Description: Opening balance - Take-on
Account: Select - “G505 Capital”
Amount: 11 500,00 CR

Use the same reference number, date and details for all the entries. 

Tax
Since No tax (VAT/GST/Sales tax) is applicable, to the opening balance transactions in this tutorial,
we have selected to hide the Tax column in the Setup options or this batch.
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10. Repeat as above for capturing the rest of the Trial balance. After capturing the Trial 
balance, the transactions should reflect as follows:

If you are not selling trading stock: 
When entering the opening balance for the Stock control account (Account number G750-000), 
TurboCASH, you may use the Suspense Account (Account number G999-000) for the purpose of 
this tutorial.

When entering the opening balance for the Debtor's control account (Account number G700-000),
TurboCASH will not allow you to select the Debtor's control account. 
The same applies to the Creditor's control account (Account number G900-000).
The reason for this is that you cannot post any transactions to the Debtor's control account in the 
General ledger. You need to select the individual Debtor accounts in the Debtor's ledger, to take 
on each individual Debtor's opening balance. When posting the transactions for the opening 
balances in the General journal, the Debtor's control account in the General ledger will 
automatically be updated with the total of all the individual transactions posted to the Debtor's 
ledger.

It is not necessary to "balance" your batch, as your Trial balance should already be in balance. 
You will note that there is an amount indicating the difference between the debit and credit entries
at the end of the Debit Amount column. 
This amount (and the Reference total at the top right corner) should reflect a zero after entering 
all your transactions.  

11. Click on the F8:List icon to print a list of the transactions in the batch. 

176 - TurboCASH5.1 – 2018 – Accounting Made Easy



Capturing opening balances for general ledger accounts

12. The batch list is displayed as follows:

It is recommended that the source document (e.g. trial balance or balance sheet and income 
statement, etc.) be attached to this List of the transactions (take-on of opening balances) and that
it be retained for record and audit purposes.

13. Click on the F6:Post icon. A confirmation message “Do you want to continue posting? 
Batch contains transactions posting to last year!” will be displayed.

14. Click on the Yes button. A confirmation message “Do you wish to post on the retained 
earnings account?” will be displayed.

15. Click on the Yes button to continue posting. The transactions will be posted (updated to 
the ledger).

Confirmation: Post to last year 
If you click on the No button, the transactions will not be posted. 
Confirmation: Retained earnings 

• If you have not ticked the “Opening Balances – This year” field on the F10: Setup 
Standard tab, you will not be allowed to post to the Retained earnings / income 
account.

• If you click on the No button, the transactions will not be posted. 

The debit and credit transactions is entered and posted in 28 February 2018. 
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Leap years:
If a leap year is, for example, February 2016, the transactions may be entered and posted on 29 
February 2016. If the Opening balance batch is posted with transactions entered for 29 February 
2016, the transactions are automatically converted to 28 February 2016. 

H.3.2- Capturing opening balance for debtors (customers / clients)

To enter opening balances for your debtor accounts:

1. On the Action ribbon, select Batch entry (F2). 

2. Select General jnl., and click on the Open button. 

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''DOpenBalances'' to indicate that the opening balances for debtor (customer / client) 
accounts was entered in this General journal batch.   

4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen will 
be displayed. The settings are basically the same as for the opening balances of the 
General ledger account. Change the batch settings as follows: 

• Standard tab – Select the “Contra account” - “D1DO-PEN Opening balances – 
Debtors” and set “Amount entry” to “Debit”.  

The tick in the “Opening balances – This year” field must not be selected (not ticked) for 
opening balances for debtors (customers / clients).

• Advanced tab – Set the “Account lookup type” and “Contra account lookup type” 
both to “Debtors”. 

5. Once setup, click on the OK button. 

6. Enter the following transactions:

The Opening Balances – Debtor account should reflect the total of all Debtor accounts (in the 
Debtor's control account). You only need to list (select) the individual debtor accounts and enter 
their balances.  
You may enter only the total outstanding balance (i.e. 1 800,00 as per this example) as at 28 
February 2018 for each debtor account (2 entries). 
If you wish to optimise the ageing feature in TurboCASH, you may enter the balances for each 
debtor account as at the end of each period, e.g. 28 February 2018 – 1 100,00, 31 January 2018 – 
400,00 and 31 December 2017 – 300,00.

7. After entering the individual balances, for each period, the transactions should be 
displayed as follows:
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8. Click on the F5: Balance icon. TurboCASH will generate balancing entries for each period 
(i.e. Feb2018, Jan2018 and Dec2017), as follows: 

You may click on the F9: Process icon and select the “Totals per period” option. This will list the 
totals of all the Debit entries and all the Credit entries for each period. The difference should be 
zero. 

9. Click on the F8:List icon to print a list of the transactions in the batch. 
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The batch list is displayed as follows:

It is recommended that the source document (e.g. trial balance or balance sheet and income 
statement, etc.) be attached to this List of the transactions (take-on of opening balances) and that
it be retained for record and audit purposes.

10. Click on the F6: Post icon. A confirmation message “Do you want to continue posting? 
Batch contains transactions posting to last year!” will be displayed.

11. Click on the Yes button. 

TurboCASH will post the entries for each period to the ledger. 

The “Opening balances – Debtor” account should have a zero balance after balances were debited 
to the individual debtor (customer / client) accounts.
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Click on the Print button.

H.3.3- Capturing opening balances for  creditors (suppliers)

To enter opening balances for your creditor accounts:

1. On the Action ribbon, select Batch entry (F2). 

2. Select General jnl., and click on the Open button. 

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''COpenBalances'' to indicate that the opening balances for creditor (supplier) accounts 
was entered in this General journal batch.   
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4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen will 
be displayed. The settings are basically the same as for the opening balances of the 
General ledger account. Change the batch settings as follows: 

• Standard tab – Select the “Contra account” - “Opening balances – Creditors” and set 
“Amount entry” to “Credit”.  

The tick in the “Opening balances – This year” field must not be selected (not ticked) for 
opening balances for creditors (suppliers).

• Advanced tab – Set the “Account lookup type” and “Contra account lookup type” 
both to “Creditors”. 

5. Once setup, click on the OK button. 

6. Enter the following transactions:

The Opening Balances – Creditor account should reflect the total of all Creditor accounts (in the 
Creditor's control account). You only need to list (select) the individual creditor accounts and 
enter their balances.  
You may enter only the total outstanding balance (i.e. 1 000,00 as per this example) as at 28 
February 2018 for each creditor account (2 entries). 
If you wish to optimise the ageing feature in TurboCASH, you may enter the balances for each 
creditor account as at the end of each period, e.g. 28 February 2018 – 500,00, 31 January 2018 – 
300,00 and 31 December 2017 – 200,00.

7. After entering the individual balances, for each period, the transactions should be 
displayed as follows:
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8. Click on the F5: Balance icon. TurboCASH will generate balancing entries for each period 
(i.e. Feb2018, Jan2018 and Dec2017), as follows:

You may click on the F9: Process icon and select the “Totals per period” option. This will list the 
totals of all the Debit entries and all the Credit entries for each period. The difference should be 
zero. 

9. Click on the F8:List icon to print a list of the transactions in the batch. 
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The batch list is displayed as follows:

It is recommended that the source document (e.g. trial balance or balance sheet and income 
statement, etc.) be attached to this List of the transactions (take-on of opening balances) and that
it be retained for record and audit purposes.

10. Click on the F6: Post icon. A confirmation message “Do you want to continue posting? 
Batch contains transactions posting to last year!” will be displayed.

11. Click on the Yes button. 

TurboCASH will post the entries for each period to the ledger. The “Opening balances – Creditor” 
account should have a zero balance after balances were credited to the individual creditor 
(supplier) accounts. 
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Click on the Print button.

H.4- PRINTING A TRIAL BALANCE 

It is good practice to print a Trial balance in TurboCASH at this point and check it with the Trail 
Balance of your previous accounting records from which you have entered your transactions. 

It is recommended that this printed Trial balance be retained with your working papers and the previous 
trial balance for record and audit purposes.
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To print a trial balance from the T-Ledger analyser:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.

If you need to check the individual balances of the Debtor's accounts in the Debtor's control 
account (G700), you need to generate Debtor's age analysis report.
If you need to check the individual balances of the Creditor's accounts in the Creditor's control 
account (G900), you need to generate Creditor's age analysis report.
If you need to check the opening balances of the individual stock items in the Stock control 
account, you need to generate a Stock item listing report. 

2. Select the following:

a) Periods – On the default “Per period” tab, select “Year” and Period “2018/03/01-
2019/02/28”.

b) Report type – Select “Trial balance”.

c) Reporting group – The following options are available:

i) None – Select this option. This will list the accounts according to the 
Account code (account number).

ii) Reporting group 1 – This will list the accounts according to the Account 
Group 1 (Groups - Account group1) (Setup ribbon). 

iii) Reporting group 2 – This will list the accounts according to the Account 
Group 2 (Groups (Account group2) (Setup ribbon). 

d) Ignore zero balances – Tick – This will list only those accounts for which 
opening balances was entered.

e) Viewer Debtors / Creditors – If this option is not ticked, it will list only the 
balances of the Debtor's control account and the Creditor's control account. 
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Tick this option to show the break down of the Debtor accounts in the Debtor's control
account and the break down of the Creditor accounts in the Creditor's control account.

f) Include opening balances – Tick this option to include the opening balances.

g) Opening balances only – Leave this option blank, if no other transactions are 
entered and posted for the selected period. 

If any transactions is posted for the selected period, you need to tick this option to list 
only the accounts for which opening balances have been entered.

3. Click on the Report button. You may change the sequences, and click on the Print 
button to print the report. 

An example of the “Trial balance” (account code sequence), is as follows:

The totals should balance with the previous financial year. Check that the totals are in balance and 
that the correct balances correspond with the balances on your source trial balance.

AT THIS POINT YOU HAVE COMPLETED YOUR SETUP, CHARTED YOUR ACCOUNTS, CAPTURED
YOUR DEBTORS AND CREDITORS; AND ENTERED YOUR OPENING BALANCES INTO TurboCASH.
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PURCHASE AND SALES TRANSACTIONS – BATCHES OR DOCUMENTS

I.1- PURCHASE AND SALES TRANSACTIONS – BATCHES OR 
DOCUMENTS

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South Africa, 
the South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 April 2018. 

This MODULE, VAT based on 14% tax for taxable transactions up to 31 March 2018.

If you generate documents from your stock item code file in TurboCASH, transactions will 
automatically be generated when documents are updated or posted to the ledger as follows: 

• Sales documents (Invoices and Credit notes) in the Sales journal (as linked to the 
“Batch type” field of the Invoices and Credit notes tabs in Documents setup (Setup 
ribbon). 

• Purchase documents (Purchases and Supplier returns) in the Purchase journal (as 
linked to the “Batch type” field of the Purchases and Supplier returns tabs in 
Documents setup (Setup ribbon).

In addition to the Sales and Purchase journals for transactions generated by documents, you also 
need to enter transactions in other batches (journals) (i.e. Payments Jnl, Receipts Jnl, 
Petty cash Jnl, General Jnl, etc.). These are the books of prime entry in which you need to 
capture payments, receipts, opening balances, etc. and post or update it to the ledger.
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I.2- CAPTURING YOUR CASHBOOK

For this tutorial, assume that you purchase some fixed assets, such as a desk at 570,00 (inclusive of
VAT/GST/Sales tax) and 2 chairs at 342,00 (inclusive of VAT/GST/Sales tax) for your office on 1st of 
March 2018. The owner also handed a cheque of 5 000,00 from his personal bank account which 
you need to deposit into the current account of the business in order increase his Capital.

You will need to issue the following cheques on 1 
March 2018:

• Cheque 105 - Office Decorators to 570,00 
(Inclusive of VAT/GST/Sales tax) for 1 desk.

• Cheque 106 - Office Suppliers to 342,00 
(Inclusive of VAT/GST/Sales tax) for 2 
chairs.

The cheque counterfoils (cheque requisitions) will be used to capture the transactions in the 
Payments journal of the bank account from which the cheque is issued.    

The invoices or slips received from the supplier also need to be retained for Tax and VAT/GST/Sales tax 
purposes.

An amount of 5 000,00 is received from the owner, for 
which the following receipt is issued:  

Receipts are usually issued for all moneys received in cash
and cheques received.

Receipts may also be created using the “Create receipts” 
option (F9: Process) in the Receipts batch and the 
“Receive payment” option on Open item link (Action 
ribbon) feature.  

A deposit number D5000 of 5 000,00 - Capital Contribution will be used to capture the 
transactions in the Receipts journal of the bank account in which the owner's cheque is 
deposited. 
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The Cashbook consists of a Payments journal and 
a Receipts journal. 

• Cheques issued will be captured in the 
Payments journal. 

• Deposits will be captured in the Receipts 
journal.

In this tutorial, the payments transactions are manually entered from source documents in the 
payments batch and the receipts (deposits) are manually entered in the receipt batch. These 
transactions may also be entered manually from bank statements.  

BankImport plugin is a commercial plugin. - It allows you to import a valid bank statement file into 
TurboCASH. It will import bank transactions and save you hours of data entry. You can simply link 
transactions to your debtors, creditors or other accounts. And with a simple mouse click, link the payments 
to the right invoices.
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I.2.1- Entering your payments

To enter your payment transactions:

1. On the Action ribbon, select Batch entry (F2).

2. Select the ABC-Payments journal and click on the Open button. 

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''ABCPayments1803'' to indicate that the payments of March 2018 was entered in this 
Payments batch for the “ABC-Bank” account.

The alias option allows you to identify a batch by a unique name. You will be able to select the 
batch by alias or batch name if you need to reverse the posted batch or import a posted batch. 

4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen is 
displayed: 

The contra account is by default set
to the Bank account. 

You cannot change this in the 
Payments journal or Receipts 
journal.

The first time you enter a transaction in the Payments journal you should set it up according to 
your requirements. This should be done for each journal, but only need to be done once, unless 
your requirements change.

5. Set up the Payments journal as follows:
No tax:  Leave blank for the purpose of this tutorial. You may at a later stage 

select this option, if there are no tax (Input VAT/GST/Sales tax) 
applicable to all the transactions you need to enter in the payments 
batch (e.g. payment of creditor accounts).

Increment reference:  Tick.
Consolidate balancing:  Do not tick. 
Inclusive mode:  Tick.  
Repeat details:  Leave blank.
Amount entry:  Tick on “Debit”.

6. Once setup; click on the Advanced tab.
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7. Leave all fields blank, and make sure that the default option, “Account lookup type”, is set 
to “All” for this exercise. 

8. Once setup; click on the OK button. You are now ready to record your first cheque.

9. Capture your cheques from your cheque stubs in your chequebook or from your cheque 
requisitions (or the supporting documents), using the payment (cheque) number as the 
reference number.

Reference: 105
Date: 2018/03/01
Description: 1 x Desk
Account: Type "fur" for furniture and select the correct sub-account – 

G600-010 - Furniture & fittings @ cost.
Tax: Input VAT/GST/Sales tax - Capital goods - 14%
Amount: 570,00 DR 

The amount is a debit as it is the amount for the fixed asset account. When you balance the 
batch, TurboCASH will create the credit to the Bank account.

Ensure that the F7:Inclusive icon is reflecting “inclusive”. This should be so as we set the batch 
to inclusive mode. 

When you select a VAT/GST/Sales tax type, always check the bottom right-hand corner for the
inclusive and exclusive amounts. Based on the 14% VAT rate, the amount of 570,00 will 
change to 500,00. 
This is because the cost of the desk is 500,00 and should be posted to the furniture and 
equipment account. The VAT/GST/Sales tax amount (70,00) must be posted to the Input 
VAT/GST/Sales Tax account.    

10. You are now ready for cheque no. 106.

Reference: 106
Date: 2018/03/01
Description: 2 x Chairs
Account: G600-010 - Furniture & fittings @ cost.
Tax: Input VAT/GST/Sales tax - Capital goods - 14%
Amount: 342,00 DR
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11. After capturing your first two payments (cheques), the Payments journal is displayed as 
follows:

“F7: Inclusive” icon - Amounts in the regular or regular font indicate that it is entered Inclusive of
VAT/GST/Sales tax.
If the “F7: Exclusive” icon is selected, the amounts are entered as Exclusive if VAT/GST/Sales tax 
and will be displayed in the bold font. 
In Payments and Receipt batches the amounts are displayed as Exclusive of VAT/GST/Sales tax 
when the cursor is not in the amount field (after the batch is balanced).

You can enter transactions in a batch daily and only post at the end of the month. Your 
transactions will not be lost when you exit a batch or close TurboCASH. You may also choose to 
post after every balanced entry.

For the purpose of this tutorial, DO NOT balance or post the batch at this point.

I.2.2- Entering your receipts

To enter your receipts transactions:

1. On the Action ribbon, select Batch entry (F2).

2. Select the ABC-Receipts journal and click on the Open button. 

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''ABCReceipts1803'' to indicate that the receipts (deposits) for March 2018 was entered in 
this Receipts batch for the “ABC-Bank” account.

The alias option allows you to identify a batch by a unique name. You will be able to select the 
batch by alias or batch name if you need to reverse the posted batch or import a posted batch. 
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4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen is 
displayed:

The contra account is by default set to the
Bank account. 

You cannot change this in the Payments 
journal or Receipts journal.

From the first transaction, the Receipts 
journal should be setup according to your 
requirements. You only need do this once, 
unless your requirements change.

5. Set up the Receipts journal as follows:
No tax:  Select this option for the purpose of this tutorial. This will hide the tax 

column and tax lookup. You may at a later stage deselect this option, 
if there are any tax (Output VAT/GST/Sales tax) applicable to any 
transaction or all the transactions you need to enter in the receipts 
batch (e.g. cash sales accounts).

Increment reference:  Tick.
Consolidate balancing:  Do not tick. 
Inclusive mode:  Tick.  
Repeat details:  Leave blank. You may select this option if you need to enter many 

transactions of the same nature (e.g. Payment received - Thank you). 
This will repeat the details to the next line or transaction.

Amount entry:  Tick on “Credit”.

6. Once setup; click on the Advanced tab.

7. Leave all fields blank, and make sure that the default option, “Account lookup type”, is set 
to “All” for this exercise. 

8. Once setup; click on the OK button. You are now ready to record your first deposit.

9. Capture deposits from the deposit book or slips. Number each page of the deposit book 
separately and use this number as your reference number. 

It is important that this reference does/will not coincide with your cheque numbers. If you have 
pre-numbered deposit slips, it is wise to prefix your deposit number with D. You may also prefix 
your cheque numbers with C.
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Reference: D5000
Date: 2018/03/01
Description: Cash from owner.
Account: Type "cap" for capital and select - G505-000 – Capital.
Amount: 5 000,00 CR

Tax
Since No tax (VAT/GST/Sales tax) is applicable, to the receipt transactions in this tutorial, we 
have selected to hide the Tax column in the F10:Setup – Standard tab.

The amount is a credit for the capital account. When you balance the batch, TurboCASH will 
create the debit to the bank account.

10. After capturing your first receipt, the Receipts journal is displayed as follows:

You can enter transactions in a batch daily and only post at the end of the month. Your 
transactions will not be lost when you exit a batch or close TurboCASH. You may also choose to 
post after every balanced entry.

For the purpose of this tutorial, DO NOT balance or post the batch at this point.

I.3- CAPTURING YOUR PURCHASES IN BATCHES

You need to capture all the supplier invoices you have received for purchases on credit, from your 
creditors (suppliers). 

In addition to the Purchase journal in the Batch entry mode, you may also use the Document entry to create
Purchases using the following stock item types: 

• Financial entry – Use the Accounts lookup to select General ledger accounts.
• Sales (no stock) – Create a Stock item for services only (e.g. consulting, labour, etc.)

Purchases are also usually linked to the Purchase journal in the Documents setup (Purchases tab) (Setup 
ribbon).
Using the Document entry, Purchases may be printed by TurboCASH5, which will generate similar 
transactions as the Purchase journal batch entry as discussed here. 
You may also create, print orders and convert these to Purchase documents.
For the purpose of this tutorial, the similar transactions as in the Purchases Batch are also replicated for 
Purchase documents – See (Chapter J.3 of MODULE J). 
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I.3.1- Entering supplier invoices (Purchase journal)

To enter purchase transactions: 

1. On the Action ribbon, select Batch entry (F2).

2. Select the Purchase Jnl and click on the Open button. 
If no contra account is displayed on the “Batch type selection” screen, you need to set up the 
options for the batch. If you have not yet set the Purchase journal, or if your requirements should 
change, click on the F10:Setup icon. 

If you have a few supplier credit notes, you may enter a negative (minus sign), followed by the 
amount in the credit column. These amounts will be transferred to the debit column. 

If you have many supplier credit notes to capture, you need to set the amount entry to debit in 
the F10:Setup – Standard tab for the Purchase journal, before entering supplier credit notes in the
Purchase journal. Alternatively, you may enter the supplier credit notes in the Purchase returns 
journal. 

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''Purchases1803'' to indicate that the Purchases for March 2018 was entered in this 
Purchase batch. 

This will help you if you wish to identify a specific batch to generate a batch type report, or if you 
wish to export posted batches to a file. 

4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen is 
displayed: 

5. Set up the Purchase journal as follows:
Contra account:  Click on the Lookup button and select “750-000 - Stock 

control”.
No tax:  Leave blank.
Increment reference:  Leave blank. 
Consolidate balancing:  Leave blank. 
Contra account per line:  Tick.  
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Inclusive mode:  Tick.  
Repeat details:  Leave blank. 
Amount entry:  Tick on “Credit”.
Opening balance - This year:  Leave blank. 

6. Once set up; click on the Advanced tab.

Select the “Creditors” option for the “Account lookup type”, since you only need to select 
“Creditors” accounts when you enter transactions for purchases on credit to creditor 
(supplier) accounts.

7. Once set up; click on the OK button. 

8. Enter the following supplier invoices in the Purchase journal:

9. Enter and / or select the following: 
a) Reference - Enter the purchase or other applicable number you allocate to the 

supplier invoice. 
b) Date - Enter or select the date of the transaction. 
c) Description - Enter a brief description for the transaction. 
d) Account - Select the creditor account. 
e) Contra account - Select the account to be debited with the credit purchase 

(expense or asset). 
f) Tax - Select the applicable Input Tax account for the expense or purchase. 

This is only applicable if Input VAT/GST/Sales tax is allowed on a transaction, and if 
you are registered as a VAT/GST/Sales tax Vendor. If no VAT/GST/Sales tax is 
applicable to the transaction, select the No tax code. 

You may also select to hide the Tax column, and lookup in the F10:Setup – Standard 
tab for the Purchase journal, if no VAT/GST/Sales tax is applicable to all transactions in 
this batch; or if you are not registered as a VAT/GST/Sales tax Vendor. 

g) Amount - Enter the amount of the transaction (Inclusive or Exclusive of 
VAT/GST/Sales tax) in the Credit amount column.
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10. After entering the supplier invoices in the Purchase journal, the transactions will be 
displayed as follows:

You have now captured all your supplier invoices for the month and may proceed with posting.

I.3.2- Updating supplier invoices to the ledger 

Once you have completed entering these supplier invoices, and you are sure they are correct, you 
may proceed to finalise the batch. The recommended process, is as follows: 

1. Click on the F5:Balance icon to balance the batch. 

2. Click on the F8:List icon to list the batch. 

It is a good idea to list the batch, and check the entries on the batch thoroughly. If there are any 
errors, you may edit the batch, before posting the batch. 

3. Click on the F6:Post icon to post (update) the batch to the ledger. 
It is not necessary to post (update) the transactions at the end of each day. You may add and / or 
post the transactions on a daily, or weekly basis, or at the end of a month. When you have entered
a few transactions, you may close or exit the batch. The data will not be lost. 
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I.3.3- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.
To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. Creditor account ABC-Service Centre). Double-click on the 

selected account; or right-click and select Show details on the context menu. 
3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10035 automatically generated). This will list only the 
transactions for a specific batch (journal).

• Account code (e.g. G210-020 Maintenance, G210-030 Repairs, G610-010 
Furniture & fittings, T850-020 Input VAT/GST/Sales tax-Standard rate  - 14%, 
C2ABCOS ABC-Office Supplies, C2ABCSC ABC-Service Centre). This will list the 
transactions for a specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the transactions in the Purchase journal, the transactions should display as follows in
the T-Account viewer:

Batch view  
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Account view
 Accounts in the Creditor’s ledger:

 ABC-Office-Supplies

 ABC-Service-Centre

Accounts in the General ledger:

 Motor vehicles - Maintenance

 Motor vehicles - Repairs

 Furniture & fittings @ cost

 

 Input Tax – Standard rate  - 14 %

Debits = Credits

Debit transactions in the General ledger (i.e. Purchases   Furniture +  Expenses +  Input Tax
(VAT/GST/Sales Tax) accounts).

              =

Credit transactions in the Creditor's ledger (i.e. individual    Creditor accounts).
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I.4- CAPTURING YOUR SALES

In addition to the Sales journal in the Batch entry mode, you may also use the Document entry to create 
Invoices using the following stock item types: 

• Financial entry – Use the Accounts lookup to select General ledger accounts.
• Sales (no stock) – Create a Stock item for services only (e.g. consulting, labour, etc.)

Sales are also usually linked to the Sales journal in the Documents (Invoices tab) (Setup ribbon).
Using the Document entry, Invoices may be printed by TurboCASH5, which will generate similar transactions
as the Sales journal batch entry as discussed here. Using the documents feature to record sales transactions 
in the Sales journal, you do not have to write out hand written invoices as in this example.

You may also create, print quotes and convert these to Invoices.

For the purpose of this tutorial, the similar transactions as in the Sales batch are also replicated for Invoices -
(See Chapter J.4 of MODULE J). 

I.4.1- Entering your invoices

You need to capture the invoices you have manually issued for sales to your debtors (customers). 

For the purpose of the sales journal this tutorial, assume that you will be writing out your invoices 
manually. You simply need to capture the details such as the invoice number, date of the invoice, 
details of the services or goods sold, the amount and VAT/GST/Sales tax (if you are registered as a 
VAT/GST/Sales tax vendor) in the Sales journal.

The hand written invoices in this Chapter are only applicable to the selling of services and items, which does 
not constitute your trading stock items to debtors customers / clients). In this case, you need to manually 
produce hand-written invoices, which are captured in the Sales journal.
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Capture the following four (4) hand-written invoices: 

To enter your sales transactions:

1. On the Action ribbon, select Batch entry (F2).

2. Select the Sales Jnl and click on the Open button.

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter ''Sales1803''
to indicate that the Sales for March 2018 was entered in this Sales batch. 

This will help you if you wish to identify a specific batch to generate a batch type report, or if you 
wish to export posted batches to a file. 

4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen is 
displayed: 
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5. Set up the Sales journal as follows:
Contra account:  Click on the Lookup button and select “010-000 - Sales”.
No tax:  Leave blank.
Increment reference:  Tick.
Consolidate balancing:  Leave blank. 
Contra account per line:  Leave blank.
Inclusive mode:  Tick.  
Repeat details:  Leave blank. 
Amount entry:  Tick on “Debit”.
Opening balance - This year:  Leave blank. 

6. Once set up; click on the Advanced tab.

Select the “Debtor” option for the “Account lookup type”, since you only need to select 
“Debtors” accounts when you enter transactions for sales on credit to debtors (customer /
client) accounts.

7. Once set up; click on the OK button. 

If you wish to allocate different transactions to different sales accounts, setup one contra account 
per line.

8. You are now ready to capture the first invoice.

Reference: INV001
Date: 2018/03/07
Description: Paint - Exterior
Account: D1AB-GRE (Mr. AB Green)
Tax: Output VAT/GST/Sales tax - 14%
Amount: 1 140,00 DR (Ensure that the F7:Inclusive icon is reflecting 

the Inclusive mode)
9. After capturing your first invoice, the “Batch entry” screen for the Sales journal should 

reflect as follows:

204 - TurboCASH5.1 – 2018 – Accounting Made Easy



Entering your invoices

“F7: Inclusive” icon - Amounts in the normal or regular font indicate that it is entered Inclusive of 
VAT/GST/Sales tax.
If the “F7: Exclusive” icon is selected, the amounts are entered as Exclusive if VAT/GST/Sales tax 
and will be displayed in the bold font.  

10. Capture the other 3 invoices in the same way.
Reference: INV002 INV003 INV004
Date: 2018/03/09 2018/03/10 2018/03/12
Description: Install - Built-in 

cupboard
Paint - Exterior Install - Built-in cupboard

Account: MAC Shop Decor  
Specialists

Mr. AB Green Mr. Mike Davies

Tax: Output Tax - 14% Output Tax - 14% Output Tax - 14% 
Amount: 1 710,00 DR (Inclusive) 1 140,00 DR (Inclusive) 1 710,00 DR (Inclusive)

11. After capturing all your invoices, the “Batch entry” screen for the Sales journal should 
reflect as follows:

You have now captured all your sales invoices for the month and may proceed with posting.
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I.4.2- Updating sales to the ledger 

Once you have completed entering these invoices, and you are sure they are correct, you may 
proceed to finalise the batch. The recommended process, is as follows: 

1. Click on the F5:Balance icon. The balancing entries should reflect as follows:

2. Click on the F8:List icon to print a list of the transactions in the batch. 

It is recommended that the source documents (e.g. sales invoices, etc.) be attached to this List of 
the transactions and that it be retained for record and audit purposes.

3. Click on the F6:Post icon to post (update) the batch to the ledger.

I.4.3- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.

To access the T-Account view of the transactions:
1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. Debtor account Mr. AB Green). Double-click on the selected 

account; or right-click and select Show details on the context menu.

3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10036 automatically generated). This will list only the 
transactions for a specific batch (journal). 

▪ Account code (e.g. G010-000 Sales, T850-010 Output VAT/GST/Sales tax - 14%, 
D1MD-AVI Mr. Mike Davies, D1AB-GRE Mr. AB Green, DMA-SDS MAC Shop 
Decor Specialists). This will list the transactions for a specific account.
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• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the transactions in the Sales journal, the transactions should display as follows in the 
T-Account viewer:

Batch view

Account view
 Accounts in the Debtor’s ledger:

 Mr. AB Green

 MAC Shop Decor Specialist

 Mr. Mike Davies

 Accounts in the General ledger:

 Sales

 Output Tax - 14%
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 Debits = Credits

Debit transactions in the Debtor’s ledger (i.e. individual   Debtor accounts)
=

Credit transactions in the General ledger  (i.e.   Sales and   Output Tax (VAT/GST/Sales tax) accounts).

I.5- RECEIVING PAYMENTS FROM YOUR DEBTORS

I.5.1- Entering payments from your debtors (customers / clients)

Mr. AB Green paid 2 000,00 (1 140,00 for INV001 and 860,00 for INV003) for which receipt number
0002 was issued, and MAC Shop Decor Specialists paid 1 000,00 for which receipt number 0003 
was issued. An example of the receipts, is as follows:

Receipts may also be created using the “Create receipts” option (F9: Process) in the Receipts batch 
and the “Receive payment” option on Open item link (Action ribbon) feature.  

Both amounts were deposited on 16 March 2018 using deposit slip no. D5001. The total amount 
deposited is 3 000,00. An example of the deposit slip, is as follows, and must be entered in the 
Receipts journal:

All the deposits on one deposit slip must 
have the same reference. 
This is very important. If this is not done, 
bank reconciliation will be difficult, if not 
impossible.

208 - TurboCASH5.1 – 2018 – Accounting Made Easy



Entering payments from your debtors (customers / clients)

To enter your receipts transactions:

1. On the Action ribbon, select Batch entry (F2).
2. Select the ABC-Receipts journal and click on the Open button. 
3. Enter the receipt for Mr. AB Green.

Reference: D5001
Date: 2018/03/16
Description: Payment received - Thank you
Account: Mr. AB Green
Amount: 2 000,00 CR

Tax
Since No tax (VAT/GST/Sales tax) is applicable, to the receipt transactions in this 
tutorial, we have selected to hide the Tax column in the F10:Setup – Standard tab.

4. An “Open item selection” screen will appear listing all invoices (both in batches as well as 
documents, if any). If any opening balances were entered for Mr. AB Green, it will be 
listed too. You need to select the invoice which, he is paying, i.e. INV001 and press the 
Enter key. This links his payment to that invoice. 

Press the Enter key again to link the rest of his payment (860,00) to INV003.
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You may select (tick) the “Not open item batch” field (F10:Setup - “Options for this batch” - 
Advanced tab) to de-activate the open item feature in batches. 

If a transaction for a debtor in the receipts journal is linked to a transaction on the “Open item 
selection” screen, the transaction will be displayed in a yellow background colour.

5. Now capture the deposit from MAC Shop Decor Specialists. As MAC Shop Decor 
Specialists is not an open-item debtor, you won't need to link the payment to an invoice.

Reference: D5001

Date: 2018/03/16

Description: Payment received - Thank you

Account: MAC Shop Decor Specialists

Amount: 1 000,00CR

Tax
Since No tax (VAT/GST/Sales tax) is applicable, to the receipt transactions in this 
tutorial, we have selected to hide the Tax column in the Setup options.

It is important to type something similar to "Payment Received" in the detail column, as this will appear on 
the debtor statement and it must be useful information for the debtor.

Do not charge tax on this transaction as you have already charged Output VAT/GST/Sales tax when you 
captured the sale to the debtor.

You have now captured all your receipts for the month and may proceed with posting.

I.5.2- Posting the receipts batch

Once you have completed entering these receipts, and you are sure they are correct, you may 
proceed to finalise the batch. The recommended process, is as follows: 

1. Click on the F5:Balance icon. 

 

2. Click on the F8:List icon to print a list of the transactions in the batch. 
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It is recommended that the source documents (e.g. deposit slips and /or copies of receipts, etc.) be 
attached to this List of the transactions and that it be retained for record and audit purposes.

3. Click on the F6:Post icon to post (update) the batch to the ledger. 

I.5.3- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.

To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. B810-000 ABC – Bank). Double-click on the selected account; or 

right-click and select Show details on the context menu. 

3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10037 automatically generated). This will list only the 
transactions for a specific batch (journal). 

• Account code (e.g. G505-000 Capital account, B810-000 ABC - Bank, D1AB-GRE 
Mr. AB Green, D1MA-CDS MAC Shop Decor Specialists). This will list the 
transactions for a specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the transactions in the Receipts journal, the transactions should display as follows in 
the T-Account viewer:

Batch view 
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Account view
 Accounts in the Debtor's ledger: 

 Mr. AB Green

 MAC Shop Decor Specialists

Accounts in the General ledger:

 Capital

 ABC - Bank 

 Debits = Credits

Debit transactions in the General ledger (i.e. .  Bank account).
=

Credit transactions in the General ledger (i.e.   Capital account) +   Debtor’s ledger (i.e. individual Debtor
accounts).

I.6- CAPTURING THE REST OF YOUR PAYMENTS

I.6.1- Entering the rest of your payments 

Capture the following cheques issued on 30 March 2018 in the payments journal:
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To enter your payments transactions:

1. On the Action ribbon, select Batch entry (F2).

2. Select the ABC-Payments journal and click on the Open button. 

3. Enter the following transactions:
Ref. no. Date Description Account Tax Dr
107 2018/03/30 Rent - April Rent Input Tax- 14% 570,00
108 2018/03/30 ABC-Office-Supplies Payment 

on Account
No tax 750,00

109 2018/03/30 Petrol - Mercedes-Benz Fuel & Oil No tax 150,00
110 2018/03/30 Waltons - Paper and pens Stationery Input Tax - 14% 285,00
111 2018/03/30 Petty cash - Increase float Petty cash No tax 100,00

4. An “Open item selection” screen will appear listing all purchase documents for ABC-
Office-Supplies. You need to select the purchase document which, is paid, i.e. PU002. 
Select the correct amount and press the Enter key. This links this payment to that 
purchase.

You may select (tick) the “Not open item batch” field (F10:Setup - “Options for this batch” - 
Advanced tab) to de-activate the open item feature in batches. 

If a transaction for a creditor in the payments journal is linked to a transaction on the “Open item 
selection” screen, the transaction will be displayed in a yellow background colour.
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5. After entering all your payments (cheques), it should reflect your transactions as follows:

“F7: Inclusive” icon - Amounts in the bold font indicate that it is entered Inclusive of VAT/GST/Sales
tax.
If the “F7: Exclusive” icon is selected, the amounts are entered as Exclusive if VAT/GST/Sales tax 
and will be displayed in the normal or regular font.  

You have now captured all your payments (cheques) for the month and may proceed with 
posting.
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I.6.2- Posting the payments batch 

Once you have completed entering these cheques, and you are sure they are correct, you may 
proceed to finalise the batch. The recommended process, is as follows: 

1. Click on the F5:Balance icon. The balancing entries should reflect as follows:

2. Click on the F8:List icon to print a list of the transactions in the batch. 
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An asterisk (*) is displayed before the description of a transaction, indicates that it is a balancing 
transaction.

It is recommended that the source documents (e.g. payment requisitions and / or invoices, slips, 
etc. received from suppliers, etc.) be attached to this List of the transactions and that it be retained
for record and audit purposes.

3. Click on the F6:Post icon to post (update) the batch to the ledger. A confirmation 
message “You are putting cash from a bank/cash directly to a bank/cash account. Do you 
wish to continue?

Line : 111 Petty cash - Increase float 810000 ABC - Bank to 820000 Petty cash” will be 
displayed. 

4. Click on the Yes button.
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I.6.3- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.

To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. B810-000 ABC – Bank). Double-click on the selected account; or 

right-click and select Show details on the context menu. 

3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10038 automatically generated). This will list only the 
transactions for a specific batch (journal). 

• Account code (e.g. B810-000 Current Bank account, G610-010 Furniture & 
fittings @ cost, G210-010 Fuel & Oil, B820-000 Petty cash, G220-000 Rent, 
C2AB-COS ABC-Office-Supplies, T850-020 Input Tax - Standard rate- 14% or 
T850-030 Input Tax - Capital goods- 14%). This will list the transactions for a 
specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the transactions in the Payments journal, the transactions should display as follows 
in the T-Account viewer:

Batch view
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Account view
 Debit transactions in the Creditor’s ledger:

 ABC-Office-Supplies

 Debit transactions in the General ledger:

  Furniture & fittings @ cost

 Motor vehicles - Fuel & oil

 Rent

 Stationery

 Petty cash

 Input Tax – Standard rate - 14%

  Input Tax – Capital goods - 14%
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Credit transactions in the General ledger:

 ABC – Bank

Debits = Credits

Debit transactions in the General ledger (i.e.    Petty cash +  Furniture & fittings +  Expenses + 

Tax (Input VAT/GST/Sales  tax)) and   Creditor's ledger (i.e. individual Creditor accounts.  
=

Credit transactions (i.e. payment transactions from the   Bank account).

THE NEXT STEP IS TO RECONCILE YOUR BANK. TURN TO MODULE M TO DO THIS.

I.7- PETTY CASH PAYMENTS

Petty cash payments should be used as a bank account. If it is used as a normal General ledger – Balance 
sheet Account, it could cause problems on the Tax Reports (Input VAT/GST/Sales tax).   

You may also reconcile your Petty cash Payments and Receipt Batches. See  MODULE M – BANK 
RECONCILIATION.

I.7.1- Entering your petty cash payments

For the purpose of this tutorial, we assume that you have paid the following expenses from your 
petty cash:
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To enter your petty cash payment transactions:

1. On the Action ribbon, select Batch entry (F2).

2. Select the Petty cash Pay. and click on the Open button. 

3. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''PCPayments1803'' to indicate that the Petty cash of March 2018 was entered in this 
Petty cash payments batch.

The alias option allows you to identify a batch by a unique name. You will be able to select the 
batch by alias or batch name if you need to reverse the posted batch or import a posted batch. 

4. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen is 
displayed: 

The contra account is by default set 
to the Bank account. 

You cannot change this in the 
Payments journal or Petty cash 
Payments journal. 

5. Set up the Petty cash payments journal as follows:
No tax:  Leave blank for the purpose of this tutorial. You may at a later stage 

select this option, if there are no tax (Input VAT/GST/Sales tax) 
applicable to all the transactions you need to enter in the Petty cash 
payments batch.

Increment reference:  Tick.
Consolidate balancing:  Leave blank.
Inclusive mode:  Tick.  
Repeat details:  Leave blank.
Amount entry:  Cannot change this at this stage. This is set to “Allow Both”. You need 

to enter payments in the Debit column of the Petty cash Payments 
batch.

6. Once setup; click on the Advanced tab.

Leave all fields blank, and make sure that the default option, “Account lookup type”, is set 
to “All” for this exercise. 
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7. Once setup; click on the OK button. You are now ready to record your first petty cash 
payment.

8. Capture your petty cash vouchers from your petty cash voucher book or from your 
requisitions. Use your petty cash voucher number as the reference number.

Ref. no. Date Description Account Tax Amount
PCV001 2018/03/31 Paper - Waltons Stationery Input Tax - 14% 57,00
PCV002 2018/03/31 Fix puncture ABC 

Service Station
Maintenance No tax 10,00

10. You are now ready to capture your first petty cash voucher.

Reference: PCV001
Date: 2018/03/31
Description: Waltons - Paper
Account: G230-000 - Stationery
Tax: Input VAT/GST/Sales tax - Standard goods - 14%
Amount: 57,00 DR 

The amount is a debit as it is the amount for the expense account. When you balance the batch, 
TurboCASH will create the credit to the Petty cash account.

Ensure that the “F7:Inclusive” icon is reflecting “inclusive”. This should be so as we set the batch to 
inclusive mode. When you select a VAT/GST/Sales tax type, always check the bottom right-hand 
corner for the inclusive and exclusive amounts. The amount of 57,00 will change to 50,00. 
This is because the cost of the paper is 50,00 and should be posted to the Stationery expense 
account. The VAT/GST/Sales tax amount (7,00) must be posted to the Input VAT/GST/Sales tax 
account.    

11. You are now ready to capture your second petty cash voucher.

Reference: PCV002

Date: 2018/03/31

Description: ABC – Service Station – Fix Puncture

Account: Maintenance (motor vehicles).

Tax: No tax

Amount: 10,00 DR
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12. After capturing your first two petty cash payment vouchers, the Petty cash payments 
journal is displayed as follows:

You can enter transactions in a batch daily and only post at the end of the month. Your transactions
will not be lost when you exit a batch or close TurboCASH. You may also choose to post after every 
balanced entry.

For the purpose of this tutorial, we will post the batch.

I.7.2- Posting the petty cash batch 

Once you have completed entering these petty cash payments, and you are sure they are correct, 
you may proceed to finalise the batch. The recommended process, is as follows: 

1. Click on the F5:Balance icon. 

2. Click on the F8:List icon to print a list of the transactions in the batch.

It is recommended that the source documents (e.g. petty cash vouchers and / or invoices, slips, etc. 
received from suppliers, etc.) be attached to this List of the transactions and that it be retained for 
record and audit purposes.

3. Click on the F6:Post icon to post (update) the batch to the ledger. 
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I.7.3- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, exported and analysed.
To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. B820-000 Petty cash). Double-click on the selected account; or 

right-click and select Show details on the context menu. 
3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10039 automatically generated). This will list only the 
transactions for a specific batch (journal). 

• Account code (e.g. B820-000 Petty cash, G210-020 Maintenance G230-000 
Stationery, T850-020 Input Tax Standard - 14%). This will list the transactions for 
a specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the transactions in the Petty cash journal, the transactions should display as follows 
in the T-Account viewer:

Batch view
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Account view
 Debit transactions in the General ledger:

 Motor vehicles - Maintenance

 Stationery

 Input VAT – Standard rate - 14%

 Credit transactions in the General ledger:

 Petty cash

Debits = Credits

Debit transactions (i.e.  Expenses +  Tax (Input VAT/GST/Sales  tax)).  
=

Credit transactions (i.e. payment transactions from the   Petty cash account).

You may also reconcile your Petty cash payments and receipt batches. See  MODULE M – BANK 
RECONCILIATION.

I.8- REPEATING TRANSACTIONS

TurboCASH has a Repeating Transactions feature available to enable you to enter transactions, 
which occur on a periodic basis. They may be weekly, monthly, quarterly or annually, etc. 
You may enter the transactions once and, when due, copy them into the normal batch, edit (if 
amounts have changed), delete or add an entry. This feature will save you lots of time. You may 
identify those transactions in your business and enter them in this feature. 
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A few examples of these entries are:
• For entry in the General journal or alternative batch type.

◦ Depreciation of fixed assets
◦ Payroll Journals or integration

• For entry in the Payments journal 
◦ Debit orders to third parties.

• For entry in the Receipts journal
◦ Debit orders from third parties

Repeating transactions may be processed via the following options:
• Edit → Repeating transactions (Action ribbon) – Enter the transactions once in the 

“Repeating batch entry” screen. You may then Import the transactions into the normal 
“Batch entry” screen using the “Repeating transactions” option on the F9:Process 
(”Process the batch”) list.

• Import a posted batch option on the F9:Process options - Batch entry (Action 
ribbon). Once you have entered and posted a normal batch, you may import the batch, 
edit it, as required, and then post it.  

For the purpose of this tutorial, assume that you will write-off some depreciation on your fixed 
assets. Enter the following entries for your depreciation on 2018/03/31:

Furniture & fittings: 50,00 per month.
Motor vehicles: Mercedes-Benz 75,00 per month.
Motor vehicles: Delivery van 25,00 per month. 

I.8.1- Entering repeating transactions

To enter repeating transactions:  
1. On the Action ribbon, select Edit → Repeating transactions. 
2. Select the General jnl. batch type and click on the Open button.

To indicate that you have selected a Repeating Batch or Journal, note the following:

a) ***Repeating transactions*** is displayed after the name of the batch type. 

b) No alias for the batch will be displayed in the screen heading (titlebar). 

c) The alias will not be saved, as only one Repeating transactions batch can be set for a 
specific batch type.    
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3. Click on the F10:Setup icon to set your batch up. The “Options for this batch” screen is 
displayed:

4. Set up the repeating transactions General journal for depreciation transactions as follows:
Contra account:  Click on the Lookup button and select - “205-000 - Depreciation”. 
No tax:  Tick.
Increment reference:  Leave blank.
Consolidate balancing:  Leave blank.
Contra account per 
line:  Leave blank.

Inclusive mode:  Tick.  
Repeat details:  Tick.  
Amount entry:  Tick on “Credit”.
Opening balance - This
year:  Leave blank. 

5. Once setup; click on the Advanced tab. 
6. Select the “General ledger” option for both the “Account lookup type” and “Contra 

account lookup type”, since you do not need to select “Debtors” or “Creditors” accounts 
when you enter transactions for depreciation.

7. Once setup; click on the OK button.
8. You are now ready to capture your repeating transactions.

Ref. no. Date Description Account Credit
DE1803 2018/03/31 Depreciation-Furniture & Fittings 600-020 Furniture & fittings 

- Accumulated depreciation
50,00

DE1803 2018/03/31 Depreciation-Motor vehicles-Merc 610-020 Motor vehicles - 
Accumulated depreciation

75,00

DE1803 2018/03/31 Depreciation-Motor vehicles-Delivery 
van

610-020 Motor vehicles - 
Accumulated depreciation

25,00
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9. The repeating transactions for “General journal” screen should reflect as follows: 

10. Click on the F5:Balance icon. Balancing entries will be generated to the Depreciation 
Contra account.

11. Click on the F8:List icon to print a list of the transactions in the batch. 

You may wish to print the list of repeating transactions for record purposes.

The Batch list will not display an alias (batch name); since you cannot change the alias. 
The alias for a normal batch (journal) will be displayed as (for example in this case) Alias (batch 
name): General jnl..  

12. Press the Esc key to exit this repeating batch.

I.8.2- Updating repeating transactions

To post or update the repeating transactions batch:

1. On the Action ribbon, select Batch entry (F2).

2. Select the General jnl. and click on the Open button. Note that there will be no alias 
displayed on the screen titlebar as this is a normal batch.

3. Click on the F9:Process icon. The “Process the batch” screen will be displayed.

4. Select the “Repeating transactions” option and click on the OK button. The following 
screen on the “Batch entry” screen, will be displayed:

If you enter a reference number into the “New
Reference” field, the reference numbers will 
not be incremented. 

The reference number entered, will apply to 
all repeating transactions which will be 
imported or generated into the batch 
(journal).
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5. Select and / or enter the following options: 
Year:  Select “This year”. 
Period:  Select “March 2018”.
Add this to descriptions:  Leave blank, for the purpose of this tutorial.
New reference:  Leave blank, for the purpose of this tutorial.

6. Click on the OK button. All the transactions you have entered in the repeating batch 
entry for the General journal will be imported (copied) into the normal batch. 

7. Enter the alias (batch name) in the “Change alias” field. In this example, enter 
''Depreciate1803'' to indicate that the Depreciation transactions for March 2018 was 
entered in this General journal batch.

The alias option allows you to identify a batch by a unique name. You will be able to select the 
batch by alias or batch name if you need to reverse the posted batch, import a posted batch or 
print a posted batch from the Batches tab of the Batch entry – Posted batches - Details tab. 

8. Click on the F5:Balance icon to re-balance the batch.   

Always check that the amounts are the same before posting this batch. For instance if you have 
sold your Mercedes-Benz, you may need to delete the entry for the next months. 
If you have purchased new assets you may change the amount or add a new entry.  
You may do it on this screen, but it is recommended that you edit your repeating transactions in 
the Edit → Repeating transactions menu (Action ribbon) to avoid having to change the same 
issues every time you wish to update a repeating batch. 

9. If the batch is not balanced or in balance, click on the F5:Balance icon to balance the 
batch. 

10. Click on the F8:List icon to print a list of the transactions in the batch.
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It is recommended that the source documents (e.g. working papers, calculation of depreciation, 
etc.) be attached to this List of the transactions and that it be retained for record and audit 
purposes.

11. Once you are satisfied that all the entries are correct, click on the F6:Post icon.

I.8.3- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, exported and analysed.
To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. G205-000 Depreciation). Double-click on the selected account; or 

right-click and select Show details on the context menu. 
3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10042 automatically generated). This will list only the 
transactions for a specific batch (journal). 

• Account code (e.g. G205-000 Depreciation, G600-020 Furniture & fittings - 
Accumulated Depreciation, G610-020 Motor vehicles - Accumulated 
depreciation). This will list the transactions for a specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the transactions in the Depreciation transactions in the General journal, the 
transactions should display as follows in the T-Account viewer:

Batch view
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Account view
 Debit transactions in the General ledger:

 Depreciation

 
 Credit transactions in the General ledger:

 Furniture & fittings - Accumulated depreciation

 Motor vehicles - Accumulated depreciation

Debits = Credits

Debit transactions (i.e.  Depreciation expense account)  
=

Depreciation Account for each Fixed Asset (e.g. for   Furniture & fittings and Motor vehicles)).
Since you have updated your batches, you may generate any of the reports to view what your profits and 
losses are and any detailed transactions, etc. and evaluate your business on any of these reports.
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SALES AND PURCHASES TRANSACTIONS

J.1- SALES AND PURCHASES TRANSACTIONS

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South Africa, the 
South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 April 2018. 

This MODULE, VAT based on 14% tax for taxable transactions up to 31 March 2018.

The Purchases and Sales of Trading stock items (Default) stock type are dealt with in MODULE K.

J.1.1- Purchases

The following options are available to enter Purchase transactions: 

1. Batch entry – Hand-written purchases and supplier returns (supplier credit notes) may 
be entered in the Purchase Jnl. 

These are dealt with in Chapter I.3 of MODULE I. 

2. Documents – If you wish to generate purchase documents (i.e. Purchases, Supplier 
returns and Orders), you may enter transactions in Documents (Action ribbon). To do 
this, you need to create stock item codes for the following stock types:

a) Financial entry – You only need to set the Tax accounts (Input and Output Tax 
accounts). When selecting this item, it will allow you to select the general ledger
account on the Accounts lookup. Purchase prices may also be maintained for 
the Financial entry stock item type. 

For the purpose of this tutorial, we will be purchasing services (i.e. Tyres and Service to
Delivery Van and Installation of Office Equipment from creditors (suppliers).

b) Purchases (no stock) – Pre-set the Input Tax account and pre-set purchase 
(expense / asset) account as well as purchase / cost prices.

c) Purchases – This is similar to the Purchases (no stock) stock type. - It will also 
allow you to keep track of stock item quantities, etc. by updating the stock 
transaction table. 

Purchases could also be used for any purchases other than trading stock. Non-trading stock items
could be captured through the Batch entry - Purchase journal (Action ribbon). These may now be 
entered using the different stock types. An example of a non-stock item could be the purchase of 
consumables such as stationery, etc.
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J.1.2- Sales 

The following options are available to enter Sales transactions: 

1. Batch entry – Hand-written invoices and credit notes may be entered in the Sales Jnl. 

These are dealt with in Chapter I.4 of MODULE I.  

2. Documents – If you wish to generate sales documents (i.e. Invoices, Credit notes and 
Quotes), via TurboCASH, you may enter transactions in Documents (Action ribbon). To 
do this, you need to create stock item codes for the following stock types:

a) Financial entry – You only need to set the Tax accounts (Input and Output Tax 
accounts). When selecting this item, it will allow you to select the general ledger 
account on the Accounts lookup. Selling prices may also be maintained for the 
Financial entry stock item type. 

b) Sales (no stock) – Pre-set the Output Tax account and Sales account as well as 
selling prices. 

For the purpose of this tutorial, we will be selling 2 services (i.e. Install - Built-in 
cupboards and Paint - Exterior (outside of houses)) at 500,00 per hour to our debtors /
clients).

c) Sales – This is similar to the Sales (no stock) stock type. It will also allow you to 
keep track of stock item quantities, etc. by updating the stock transaction table. 

Invoices could also be used for any sales other than trading stock. Non-trading stock items could be captured
through the Batch entry - Sales journal  (Action ribbon). These may now be entered using the different stock 
types. An example of a non-stock item could be the sale of old or obsolete furniture, which your business 
does not use any longer.
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J.2- DOCUMENTS / STOCK SETTING AND PARAMETERS

It is important that the required accounts and settings be absolutely correct before you proceed 
with purchasing and selling of stock items in a Set of Books. If this is not done, you may find 
incorrect results in TurboCASH. For example, the Cost of sales transactions may not be generated 
when documents are posted to the ledger or the cost of sales may be calculated at average cost in
stead of latest cost, etc.
Setup of Documents is a once off process:

1. Documents setup (Setup ribbon) – Check document numbers, messages, set layout files,
etc. - (See Chapter E.4.5 of MODULE E). 

2. Groups (Setup ribbon) – Add the Cost of sales reporting group under Account group 1 
(Reporting group 1). Add Reporting groups 1 and 2 for Document groups and Stock 
group 1 /2, where applicable. - (See Chapter E.4.4 of MODULE E). 

3. Salesperson (Setup ribbon) – Add Salespersons. - (See Chapter E.4.7 of MODULE E). 
4. Setup → Batch types – Add Cost of sales Batch (only to be used with Cost of sales 

settings for the Default Stock type). - (See Chapter E.4.3 of MODULE E). 
5. Stock information (Setup ribbon) – Unit prices, Selling price descriptions, Default selling

price. - (See Chapter E.4.6 of MODULE E).
6. Accounts (Action ribbon) – Create a Cost of sales account for Trading stock. - (See 

Chapter F.1 of MODULE F). 
7. Creditors (Action ribbon) – Create a Sundry Supplier account. - (See Chapter F.2 of 

MODULE F).  
8. Debtors (Action ribbon) – Create a Cash Customer and Linking Debtors to a Salesperson.

- (See Chapter F.3 of MODULE F). 

You may print a Company information (Reports → Company info – Information) report to check the 
selling price descriptions. This report will also display the default headings and messages that will print 
on document layout files (i.e. Invoices, Quotes, Credit notes, Purchases, Supplier returns and Orders).

Your Set of Books should be set up to process documents for the purchase and selling of stock items. 
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J.3- PROCESSING CREDITORS - ORDERS AND PURCHASES

The similar Purchase transactions may be entered in the normal “Batch entry” screens as above 
(See Chapter I.3 of MODULE I). Using the batch option, will not generate any purchase 
documents (i.e. Orders, Purchase documents and / or Supplier return documents). These 
documents need to be manually written in purchased stationery. 

Using the Documents option, the transactions in the Purchase journal will automatically be 
generated and these documents will be automatically be generated via the layout files as set in as 
follows:

• Global Settings – As selected on the “Layout file” fields of Documents setup 
(Purchases, Supplier returns and Orders tabs) (Setup ribbon).

• Creditor (Supplier) Specific  Settings – As selected on the “Layout file” fields of the 
Creditors - Delivery address tab) (Action ribbon) – (“Layout file 1” = Purchases, “Layout 
file 2” = Supplier returns and “Layout file 3”= Orders fields). 

• The Default setting on the layout file should always revert to the Global settings unless 
another layout file have been set for a specific creditor (supplier) account. In addition to 
these two (2) settings layout files may be changed or other formats may be selected as 
follows:

▪ Documents  (Action ribbon) – Sidebar for Purchase document types (i.e. 
Purchases, Supplier returns and / or Orders).

▪ Creditors – Documents tab (Action ribbon) of a selected creditor (supplier) 
account.

Purchase documents must be used for trading stock items. Please refer to MODULE K of this tutorial. 

The transactions will automatically be generated when documents are updated or posted to the 
ledger. It will automatically generate and update (post) the transactions to the ledger in the batch 
types as set (linked) in the Documents setup (Setup ribbon) - Purchases and Supplier returns 
tabs.

236 - TurboCASH5.1 – 2018 – Accounting Made Easy



Creating an order

J.3.1- Creating an order

You may need to place an order with any of your creditors (suppliers). When the Goods are 
received you may confirm the order against the actual goods received and the original order. You 
will do this by converting the Order to a Purchase document. 

Orders cannot be updated (posted) to the ledger and it generates no transactions. But, once the Order has 
been converted to a Purchase document, it can be updated (posted) to the ledger.

Order the following services and goods (NON-TRADING STOCK ITEMS) from ABC-Service 
Centre:

ORDER: OR000001  -  2018/03/01
ABC-Service-Centre
Service - Delivery van                            400,00
5 x New Tyres - Fitting and balancing    600,00
Total                                                  1 000,00      
Input Tax - 14%                                    140,00
Total                                                  1 140,00

To create an order:

1. On the Action ribbon, select Documents (F6). 

2. Select “Orders” in the “Documents” field; if “Orders” is not selected. 

3. Click on the New button. The “Creditor accounts” screen is displayed:

4. Select the Creditor (supplier) account (“ABC-Service-Centre”).

5. Click on the Open or OK button. The screen for “Orders” is displayed:
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6. Enter and / or select the following options:
Your reference:  Enter “AAB234GP” as the registration number of the vehicle.

This will allow you to track down the vehicle's history when entering 
the registration number in the Search (Investigator) on the Action 
ribbon. All documents matching that registration number will be listed.

Salesperson:  Select “Russell”. Salespersons are optional for orders. This field is to 
show who handled the order.

Document group 1/2:  Select “Document group 1A”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups. (Setup ribbon)

Date:  Select “2018/03/01”, for the purpose of this tutorial. By default, the 
system date will be displayed.

Due date:  This date will be automatically be calculated. It is the “Date” plus the 
number of days set in the Accounting information tab of the selected 
creditor account.  

 Press the Enter key until you get to the transaction details screen (skip 
the “Address, Delivery address” and “Message” fields).

Item no.:  Select “GL-CODE”. 
The “Accounts lookup” screen will be displayed.  

 Select the Account “G210-020 – Maintenance” for the Service of the 
Delivery Van.  The description of the selected account is displayed. 
You may over-type this. 
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If Abbreviation definitions were set in the Batch entry (Action 
ribbon) (F9:Process), you may enter a character (or more) to 
auto-complete a description in the document line. 

 For the purpose of this tutorial, click on the F9:Comment icon or press 
the F9 key. Enter “Service Delivery Van - AAB234GP“ and click on the 
OK button. 

 Enter the Unit price (Exclusive of VAT/GST/Sales tax, if the F7:Exclusive 
icon is active - or Inclusive of VAT/GST/Sales, tax if the F7:Inclusive 
icon is active). 

 Select “GL-CODE”. 
The “Accounts lookup” screen will be displayed.  

 Select the Account “G210-030 – Repairs” for the 5 new tyres and fitting.
The description of the selected account is displayed. You may over-
type this.

 For the purpose of this tutorial, click on the F9:Comment icon or press 
the F9 key. 

 Enter “5 x New Tyres Fitting and balancing” and click on the OK 
button. 

 Enter the Unit price (Exclusive of VAT/GST/Sales tax, if the F7:Exclusive 
icon is active - or Inclusive of VAT/GST/Sales, Tax if the F7:Inclusive 
icon is active). 

7. Click on the OK button. A confirmation message “Do you wish to print this order?” will be 
displayed.

8. Click on the Yes button to print the order.  
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An example of the printed order, is as follows:

This example is based on the Order (15 code). You may also select the following available order layout 
files:
- Order (10 code)
- Order (no codes)
- Order A4 (10 code)
- Order A4 (15 code)
- Order A4 (no codes)
- Order A4 Plain (10 code)
- Order A4 Plain (15 code)
- Order A4 Plain (no codes)
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J.3.2- Confirming / Converting an order to a purchase document 

We have already placed an order with our ABC-Service-Centre - and the delivery van are fixed 
(serviced and 5 new tyres have been fitted and balanced) on 14 March 2018. The order needs to 
be checked and converted into a Purchase document. 

Convert invoice to order
If you have already created invoices (whether they are updated to the ledger (posted) or not), you may 
convert the Invoice to an Order. To do this, select the Invoice on the documents list and right-click and select
the “Documents → Convert invoice to order” option from the context menu.
You may then edit the order and convert it to a purchase document.

To convert an order to a purchase document:

You may also convert Orders to Purchase documents from the Input → Confirm (Action ribbon). 

1. Access the “Orders” in the “Documents” field; if “Orders” is not selected.

2. Select the order to convert and right-click.

3. On the context menu, select the “Confirm quotes and orders” option. A confirmation 
screen “Do you wish to continue?” will be displayed.

4. Click on the Yes button to proceed. Another confirmation screen “Do you wish to delete 
this Order?” will be displayed.

5. Click on the No button not to delete the order. 

If you click on the Yes button, the order will be deleted from the “Orders” list of the “Document 
entry” screen.  
Should you click on the No button the order will still be available on the “Orders” list of the 
“Document entry” screen. You may then Copy the order, change the account, edit the account, etc.
before converting it to a purchase document.  

You may delete Orders in Edit → Delete → Documents (Action ribbon).
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J.3.3- Creating a purchase document 

Once an Order is converted to a Purchase document, it must be checked to see that the correct 
stock was received. When we access the Purchase documents screen from the Documents → 
Purchases menu (Action ribbon) and the Creditor is selected, all available unposted Purchase 
documents for that supplier are listed. 

J.3.3.1- Editing a purchase document confirmed from an order

To edit a purchase document converted from an order:

1. On the Action ribbon, select Documents (F6). 

2. Select “Purchases” in the “Documents” field; if “Purchases” is not selected. 

The Purchase document, listed on the “Document entry” screen, was automatically created when 
you have confirmed and converted the Order to a Purchase document.

3. Select the Purchase document on the list and click on the Edit button. The screen for 
Purchases is displayed:

The Order number “OR000001”, which was converted to this Purchase document, is displayed in 
the very last line in the “Message” field.
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4. Enter and / or select the following options:
Your reference:  Check that “AAB234GP” is displayed.
Date:  The system date should be displayed. Select “2018/03/14”, as it is the date on 

which the order was fulfilled. 
This is the date on which the Order need to be converted to a Purchase 
document). 

Due date:  This date will be automatically be calculated. It is the “Date” plus the number 
of days set in the Accounting information tab of the selected creditor account.

5. The items and details of the order will be displayed on the respective fields. Check the 
details and that the purchase price is correct. You may edit it, if necessary.

6. Click on the OK button. A confirmation screen “Do you wish to print this purchase?” will 
be displayed.

7. Click on the Yes button. 

An example of the printed purchase document, is as follows:

This example is based on the Purchase (15 code). You may also select the following available 
purchase layout files:
- Purchase (10 code)
- Purchase (no codes)
- Purchase A4 (10 code)
- Purchase A4 (15 code)
- Purchase A4 (no codes)
- Purchase A4 Plain (10 code)
- Purchase A4 Plain (15 code)
- Purchase A4 Plain (no codes)
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You are now ready to enter the rest of your Purchases.

J.3.3.2- Creating a new purchase document

We have also purchased the following services: 
PU000002  - 2018/03/15
Invoice IN0014 from
ABC-Office-Supplies
Installation of office equipment                            1 500,00
 Input Tax – 14%                                                    210,00   
Total                                                                   1 710,00

To create a new purchase document:

1. On the Action ribbon, select Documents (F6).

2. Select “Purchases” in the “Documents” field; if “Purchases” is not displayed.

3. Click on the New button. 

Only select “New” when you are actually creating a new Purchase document. Remember that 
you will only be able to edit Purchase documents as long as they have not yet been updated to 
the ledger.

The “Creditor accounts” screen is displayed:

4. Select the Creditor (supplier) account (“ABC-Office Supplies”).

5. Click on the Open or OK button. The screen for “Purchases” is displayed:
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6. Enter and / or select the following options:
Your reference:  Enter “IN0014” as the reference of the creditor.
Salesperson:  Select “Tracy”. Salespersons are optional for purchases. This field is to show 

who handled the purchase.
Document 
group 1/2:  Select “Document group 1A”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups (Setup ribbon).

Date:  Select “2018/03/15”.
Due date:  This date will be automatically be calculated. It is the “Date” plus the number 

of days set in the Accounting information tab of the selected creditor account.
 Press the Enter key until you get to the lines (skip the “Address, Delivery 

address” and “Message” fields).
Item no:  Select the account “G600-010 – Furniture & fittings @ cost” for the 

Installation of office equipment.  The description of the selected account is 
displayed. You may over-type this.  

Order / Ship:  Enter “1”. 
Tax:  The default Input Tax account for the stock item will be displayed. Confirm 

that it is correct by pressing the Enter key.
Unit excl.  Enter the Unit price (“1 500,00” - Exclusive of VAT/GST/Sales tax, if the 

F7:Exclusive icon is active - or “1 710,00” - Inclusive of VAT/GST/Sales, Tax if 
the F7:Inclusive icon is active). 

Discount:  Press the Enter key to keep it at the default 0% discount rate.
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Comment:  Click on the F9:Comment icon or press the F9 key. Enter “Installation of office 
equipment“ and click on the OK button.

7. Click on the OK button. A confirmation screen “Do you wish to print this purchase?” will 
be displayed.

8. Click on the No button. 

J.3.4- Updating purchases  to the ledger

Since we have not selected the “Auto-post documents on print” option on the Documents setup (See 
Chapter E4.5 of MODULE E) we need to post the purchases manually.

To post or update your purchases: 

1. On the Action ribbon, select Update ledger (F3). The “Update Invoice” screen will be 
displayed. 

2. Select “Purchases” and its name will change to “Update purchases” - listing all your 
unposted purchases.

Purchases in rows with a cream background (i.e. PU000001), have been printed. 
Purchases in rows with a plain white or grey or peach background (i.e. PU000002), have not yet 
been printed. 

3. Click on the “From... to” field and select -
From purchase: PU000001
To: PU000002

4. Click on the Update button. TurboCASH will now write up your Purchases journal for you,
as well as update your stock, creditors and Input VAT/GST/Sales tax. The following journal
entries are passed:

DR Expense / Asset Purchase account 
DR VAT/GST/Sales tax (net amount)

CR Creditor (total amount)
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J.3.5- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.

To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. Creditor account C2AB-CSC ABC-Service Centre). Double-click on 

the selected account; or right-click and select Show details on the context menu. 

3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10043 or 10044 automatically generated). This will list only 
the transactions for a specific batch (journal). 

• Account code (e.g. G210-020 Maintenance, G210-030 Repairs, T850-020 Input 
Tax account, C2AB-CSC ABC-Service Centre). This will list the transactions for a 
specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the Purchase documents, the transactions should display as follows in the T-Account
viewer:

Batch view
Batch 10043 – PU000001 – ABC-Service-Centre

Batch 10044 – PU000002 – ABC-Office-Supplies
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Account view
 Accounts in the Creditor’s ledger:

 ABC-Service-Centre

 ABC-Office-Supplies

  Accounts in the General ledger:

 Furniture & fittings @ cost

 Motor vehicle – Maintenance

 Motor vehicle - Repairs

 Input Tax – Standard rate

 

Debits = Credits

Debit transactions in the   Expenses (i.e. Maintenance and Repairs) and  Fixed assets accounts (i.e.

Furniture & fittings @ cost) and   Input Tax (VAT/GST/Sales tax). 
=

Credit transactions in the Creditor’s ledger (i.e. individual   Creditor accounts).
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J.4- PROCESSING DEBTORS - QUOTES AND INVOICES

The similar Sales transactions may be entered in the normal “Batch entry” screens as above (See 
Chapter I.4 of MODULE I). Using the batch option, will not generate any sales documents (i.e. 
Quotes, Invoices and / or Credit notes). These documents need to be manually written in 
purchased stationery. 
Using the Documents option, the transactions in the Sales journal will automatically be generated 
and these documents will be automatically be generated via the layout files as set in as follows:

• Global Settings – As selected on the “Layout file” fields of Documents setup (Invoices, 
Credit notes and Quotes tabs) (Setup ribbon).

• Debtor (customer / client) Specific settings – As selected on the Layout fields of the 
Debtor - Delivery address tab) (Action ribbon) – (“Layout file 1” = Invoices, “Layout file 
2” = Credit notes and “Layout file 3”= Quotes fields). 

• The Default setting on the Layout file should always revert to the Global settings unless 
another layout file have been set for a specific debtor (customer / client) account. In 
addition to these two (2) settings layout files may be changed or other formats may be 
selected as follows:

▪ Documents (Action ribbon)– Sidebar for Sales document types (i.e. Invoices, 
Credit notes and / or Quotes).

▪ Debtors – Documents tab (Action ribbon) of a selected debtor (customer / 
client) account.

Sales documents must be used for trading stock items. Please refer to MODULE K of this tutorial.

J.4.1- Creating a quote

Your debtors (customers / clients) may ask you for a quotation on your products for various 
reasons. TurboCASH allows you to create a quote on the system. When the debtor (customer / 
client) accepts the quote, you may confirm the Quote and Convert it to an Invoice. 
Note will not be able update the Quotation to the ledger and it generates no transactions. But 
once the Quote has been converted to an Invoice, it can be updated or posted to the ledger.
On 1 March 2018 Mr. AB Green asked for a quote for painting outside of his house. 
To create a quote:

1. On the Action ribbon, select Documents (F6).   
2. Select “Quotes” in the “Documents” field; if “Quotes” is not selected.
3. Click on the New button. 

Only select “New” when you are actually creating a new invoice. Remember that you will only be 
able to edit invoice as long as they have not yet been updated to the ledger.

4. The “Debtor accounts” screen is displayed:
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5. Select the Debtor (customer / client) account (“Mr. AB Green”).

6. Click on the Open or OK button.

7. Enter and / or select the following options:
Your reference:  Leave blank.
Salesperson:  Select “Russell”; if not already selected. As Russell was set as the default 

salesperson, his name should automatically be displayed. (You may select 
any other salesperson if Russell is not doing this quote).

Document 
group 1/2:  Select “Document group 1A”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups. (Setup ribbon).

Date:  Select “2018/03/01”.
Due date:  This date will be automatically be calculated. It is the “Date” plus the number

of days set in the Accounting information tab of the selected debtor account. 
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 Press the Enter key until you get to the invoice details screen (skip the 
“Address, Delivery address” and “Message” fields).

Item no.:  Select “4L-PAINT-E”. The description, Quantity (default 1),  Output Tax 
account, Unit selling price (Exclusive of VAT/GST/Sales tax if the F7:Exclusive 
icon is active - or Inclusive of VAT/GST/Sales tax if the F7:Inclusive icon is 
active) will be displayed. 

 The default selling price for the Debtor account will be displayed. Make sure 
that Selling price 1 (i.e. “500”) is selected for the purpose of this tutorial.

Quantity:  The default quantity is displayed as “1”. Enter “2” as the quote is for 2 hours. 
Tax:  The default Output Tax account for the stock item will be displayed. When 

the cursor is in this field, the Tax accounts lookup will be displayed. Confirm 
that it is correct by pressing the Enter key.

Discount:  Press the Enter key to keep it at the default 0% discount rate.
F9:Comment:  Click on the F9:Comment icon.  

 Enter “Paint - White” as a comment.

 Click on the OK button.

8. Click on the OK button. TurboCASH will ask you if you wish to print the Quote now.

9. Click on the Yes button. 

An example of the printed quote, is as follows:
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This example is based on the Quote (15 code). You may also select the following available quote 
layout files:
- Quote (10 code)
- Quote (no codes)
- Quote A4 (10 code)
- Quote A4 (15 code)
- Quote A4 (no codes)
- Quote A4 Plain (10 code)
- Quote A4 Plain (15 code)
- Quote A4 Plain (no codes)

J.4.2- Confirming a quote - Converting a quote to an invoice

On 13 March 2018, Mr. AB Green confirms that he wishes to repair his roof as quoted on 1 March 
2018. We need to check or confirm the quote and convert it to an invoice. 

If you have already created invoices (whether they are updated to the ledger (posted) or not), you may 
convert the Invoice to an Order. To do this, select the Invoice on the documents list and right-click and select
the “Documents → Convert invoice to order” option from the context menu.

You may then edit the order and convert it to a purchase document.

To convert a quote to an invoice:

You may also convert quotes to invoices from the Input → Confirm (Action ribbon). 

1. Access “Quotes” in the “Documents” field; if “Quotes” is not selected.
2. Select the quote to convert and right-click.

3. On the context menu, select the “Confirm quotes and orders” option. A confirmation 
screen “Do you wish to continue?” will be displayed.
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4. Click on the Yes button to proceed. Another confirmation screen “Do you wish to delete 
this Quote?” will be displayed.

5. Click on the No button not to delete the quote. 

If you click on the Yes button, the quote will be deleted from the quotes list of the “Document 
entry” screen.  
Should you click on the No button the quote will still be available on the quote list of the 
“Document entry” screen. You may then Copy the quote, change the account, edit the account, 
etc. before converting it to an invoice.  

You may delete Quotes in Edit → Delete → Documents (Action ribbon).

6. Click on the Yes button to proceed. An information message “Document(s) created 
IN000001 D1ABGRE Mr. AB Green” will be displayed.

7. Click on the OK button to close the information message. 

8. Access the “Invoices” screen and edit the converted invoice, if necessary. 

J.4.3- Creating an invoice 

Once a Quote is converted to an Invoice, check that all the items on the quote are accepted. When
accessing the Invoice documents screen from the Documents - Invoices (Action ribbon) and the 
debtor (customer / client) is selected, all available unposted Invoices for that debtor (customer / 
client) are listed. 

J.4.3.1- Editing an invoice confirmed from a quote

To edit an invoice converted from a quote:

1. On the Action ribbon, select Documents (F6).    

2. Select “Invoices” in the “Documents” field; if “Invoices” is not selected.  

The Invoice, listed on the “Document entry” screen, was automatically created when you have 
confirmed and converted the quote to an invoice.

3. Select the invoice on the list and click on the Edit button. 

TurboCASH5.1 – 2018 – Accounting Made Easy - 253



MODULE J - PROCESSING DOCUMENT TRANSACTIONS - NON TRADING STOCK

The Quote number “QU000001”, which was converted to this Invoice, is displayed in the very last 
line in the “Message” field.

4. Enter and / or select the following options:
Your reference:  Enter “AB-IN110” as the reference supplied by Mr. AB Green.
Salesperson:  Check that “Russell” is displayed.
Date:  “2018/03/13” (should be displayed, as it is the date on which the quote was 

converted to an invoice).
Due date:  This date will be automatically be calculated. It is the “Date” plus the number

of days set in the Accounting information tab of the selected debtor account. 

5. The items and details of the quote will be displayed on the respective fields. Check the 
quantity and selling price for the paint and the hours is correct. You may edit it, if 
necessary.

The quantity ordered is the number of stock items the customer requested. The quantity shipped is
the number of items actually supplied. If the quantity ordered and the quantity shipped are not the
same, the difference will appear on the back order report.

6. Click on the OK button. A confirmation screen “Do you wish to print this invoice?” will be 
displayed.

7. Click on the Yes button. 
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An example of the printed invoice, is as follows:

This example is based on the Invoice (15 code). You may also select the following available invoice layout 
files:
- Invoice (10 code)
- Invoice (no codes) 
- Invoice A4 (10 code)
- Invoice A4 (15 code)
- Invoice A4 (no codes)
- Invoice A4 Plain (10 code)
- Invoice A4 Plain (15 code)
- Invoice A4 Plain (no codes)

If you need to print a Delivery note, you may select the Delivery note (15 code) - (TRN-906182) layout file, 
or the Delivery note (no codes) - (TRN-906181) layout file.
In this tutorial, a Delivery note (15 code) - (TRN-906182) layout file, will
automatically be printed after the invoice is printed.
To turn-off (disable) the Delivery notes, select the blank line in the “Layout
file 2” field.
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J.4.3.2- Creating a new invoice

Enter the rest of your sales:
Salesperson - Tracy Salesperson - Russell Salesperson - Tracy

2018/03/14   Invoice IN000002 2018/03/15  Invoice IN000003 2018/03/16   Invoice IN000004

To: MAC Shop Decor Specialists To: Mr. AB Green To: Mr. Mike Davies

Reference: IB-101 Reference: PH-101 Reference: IB-102

Comment: 3 White cupboards with 6 
drawers

Comment: Paint - Green Comment: Install 6 cupboards

Install - Built-in cupboard        1 500,00     Paint outside of house           1 000,00    Install - Built-in cupboard      1 500,00    

Output Tax - 14%                       210,00     Output Tax - 14%                     140,00    Output Tax - 14%                     210,00 

Total                                       1 710,00      Total                                     1 140,00     Total                                     1 710,00     

To create a new invoice:

1. On the Action ribbon, select Documents (F6).   

2. Select “Invoices” in the “Documents” field; if “Invoices” is not selected.

3. Click on the New button. The “Debtor accounts” screen is displayed:

4. Select the Debtor (customer / client) account (“MAC Shop Decor Specialists”).

5. Click on the Open or OK button. 
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If you would like to include a longer description than the description field, you can press the F9 
key for a comment and type in a comment on that line.

6. Enter and / or select the following options:
Your reference:  Enter “IB-101”.
Salesperson:  Select “Tracy”; if not already displayed.
Document 
group 1/2:  Select “Document group 1A”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups. (Setup ribbon).

Date:  Select “2018/03/14”.
Due date:  This date will be automatically be calculated. It is the “Date” plus the 

number of days set in the Accounting information tab of the selected debtor 
account.  

 Press the Enter key until you get to the invoice details screen (skip the 
“Address, Delivery address” and “Message” fields).

Item no.:  Select “Sales (no stock)”. The description, Quantity (default 1), Tax account, 
Unit selling price (Exclusive of VAT/GST/Sales tax if the F7:Exclusive icon is 
active - or Inclusive of VAT/GST/Sales tax if the F7:Inclusive icon is active) 
will be displayed. 

Quantity order
Quantity ship:

 Enter “1”. 
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Tax:  The default Output Tax account for the stock item will be displayed. When 
the cursor is in this field, the Tax accounts lookup will be displayed. Confirm 
that it is correct by pressing the Enter key.

Discount:  Press the Enter key to keep it at the default 0% discount rate.

7. Click on the OK button. A confirmation screen “Do you wish to print this invoice?” will be 
displayed.

8. Click on the Yes button. 

9. Enter your sales to create invoices IN000003 and IN000004.

Once you have completed all your invoices, check to see that you are:
• Selling to the right person.
• Selling at the right date.
• Selling the right item requested.
• Selling the right quantity requested.
• Selling at the right price.
• Selling at the correct tax rate.

Once all your invoices are correct, you may post or update them to the ledger.

J.4.4- Updating your invoices to the ledger

Since we have not selected the “Auto-post documents on print” option on the Documents setup (See 
Chapter E4.5 of MODULE E) we need to post the invoices manually.

Check all your Purchases (Goods Received Notes) to see that they are correct and have been updated to the 
ledger, before you update the Invoices to the ledger.
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To post or update your invoices: 

1. On the Action ribbon, select Update ledger (F3). 

2. Invoices are displayed by default - listing all your unposted invoices. If not, select 
“Invoices”.

Invoices in rows with a cream background (i.e. IN000001), have been printed. 
Invoices in rows with a plain white or grey or peach background (i.e. IN000002 to IN000004), have
not yet been printed. 

3. Click on the “From... to” field and select -

From invoice: IN000001

To: IN000004 

4. Click on the Update button. TurboCASH will automatically write up your Sales journal. It 
will control Sales, Output VAT/GST/Sales tax and Stock. The following journals are passed:

DR Debtor (total amount)

CR Sales (net amount - selling price)

CR VAT/GST/Sales tax (net amount)

J.4.5- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.

To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. Debtor account Mr. AB Green). Double-click on the selected 

account; or right-click and select Show details on the context menu. 
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3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10045, 10046, 10047 or 10048 automatically generated). 
This will list only the transactions for a specific batch (journal). 

• Account code (e.g. G010-000 Sales, T850-010 Output Tax - 14%, D1AB-GRE Mr. 
AB Green). This will list the transactions for a specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the Invoices, the transactions should display as follows in the T-Account viewer:         

Batch view
Batch 10045 – IN000001

Batch 10046 – IN000002

Batch 10047 – IN000003

Batch 10048 – IN000004
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Account view 
 Accounts in the Debtor’s ledger:

 Mr. AB Green

 MAC Shop Decor Specialists

 Mr. Mike Davies

  Accounts in the General ledger:

 Sales

  Output Tax - 14%  

Debits = Credits

Debit transactions in the Debtor’s ledger (i.e. individual   Debtor accounts). 
=

 Credit transactions in the General ledger  (i.e.   Sales and   Output Tax (VAT/GST/Sales  tax accounts)).
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DOCUMENTS / STOCK SETTING AND PARAMETERS

K.1- DOCUMENTS / STOCK SETTING AND PARAMETERS

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South Africa, 
the South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 April 2018. 

This MODULE, VAT based on 15% tax for taxable transactions as from 1 April 2018.
It is important that the required accounts and settings be absolutely correct before you proceed 
with purchasing and selling of stock items in a Set of Books. If this is not done, you may find 
incorrect results in TurboCASH. For example, the Cost of sales transactions may not be generated 
when documents are posted to the ledger or the cost of sales may be calculated at average cost in
stead of latest cost, etc.
Setup of Documents is a once-off process:

1. Documents setup (Setup ribbon)– Check document numbers, messages, set layout files, 
etc. - (See Chapter E.4.5 of MODULE E). 

2. Groups (Setup ribbon) – Add the Cost of sales reporting group under Account group 1 
(Reporting group 1). Also add Reporting groups 1 and 2 for Document groups and Stock 
group 1 /2, where applicable. - (See Chapter E.4.4 of MODULE E). 

3. Salesperson (Setup ribbon) – Add Salespersons. - (See Chapter E.4.7 of MODULE E). 
4. Batch types (Setup ribbon) – Add Cost of sales batch (only to be used with Cost of sales 

settings for the Default Stock type). - (See Chapter E.4.3 of MODULE E). 
5. Stock information (Setup ribbon) – Unit prices, Selling price descriptions, Default selling

price. 
For the purpose of this tutorial, we need to activate and set the cost of sales parameters, 
if the Cost of sales were not set correctly when you created your Set of Books. - (See 
Chapter E.4.6 of MODULE E).

You also have the option of ticking “use average cost” - if you wish you may leave this field not 
ticked in which case, “latest cost” will be used for calculating the value of your stock. Consult with 
your accountant as to which method you should use. The value of your stock can affect your 
profit and loss figures.

6. Accounts (Action ribbon) – Create a Cost of sales account for Trading stock. - (See 
Chapter F.1 of MODULE F). 

7. Creditors (Action ribbon) – Create a Sundry supplier account. - (See Chapter F.2 of 
MODULE F).  

8. Debtors (Action ribbon) – Create a Cash customer and Linking Debtors to a Salesperson.
- (See Chapter F.3 of MODULE F). 

You may print a Company information (Reports → Company info – Information) report to check 
the Cost of Sales settings (Average cost or Latest cost) Selling price descriptions. This report will 
also display the default headings and messages that will print on document layout files (i.e. 
Invoices, Quotes, Credit notes, Purchases, Supplier returns and Orders).
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Your Set of Books should be set up to process documents for the purchase and selling of trading 
stock items. 

K.2- BASICS OF TRADING STOCK

Before you start with this Chapter in the Tutorial, you need to be absolutely sure that all settings for Stock 
items, Cost of sales and Documents are correct. 
Please refer to (See Chapter E.4.6 of MODULE E) - Setup Stock information (with particular attention to 
Cost of sales). 

When you first set up TurboCASH, it is important that you either enter a purchase or do a stock take-on for
each stock item, before entering any invoices. By doing this you are giving TurboCASH the cost price of the 
stock item. 
The cost price is used to update the Cost of sales and Stock accounts, when an invoice is created. Therefore,
if TurboCASH does not have a cost price, the cost of sales account will be updated with a zero amount. This
will cause your gross profit to be over inflated.

It is important that the required accounts and settings be absolutely correct before you proceed with 
purchasing and selling of trading stock items in a Set of Books. 
If this is not done, you may find incorrect results in TurboCASH. For example, the Cost of sales transactions 
may not be generated when documents are posted to the ledger or the cost of sales may be calculated at 
average cost in stead of latest cost, etc.

If you generate documents from your stock item code file in TurboCASH, transactions will 
automatically be generated when documents are updated or posted to the ledger as follows: 

• Sales documents (Invoices and Credit notes) in the Sales journal (as linked to the 
“Batch type” field of the Invoices and Credit notes tabs in Documents setup (Setup 
ribbon). 

• Purchase documents (Purchases and Supplier returns) in the Purchase journal (as 
linked to the “Batch type” field of the Purchases and Supplier returns tabs in 
Documents setup (Setup ribbon).
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The transactions for the Default (Trading stock) stock type, is as follows:

Trading stock items (Default stock type)

Purchases (Purchase journal) Invoices (Sales journal)

DR - Stock item (net cost price - Input Tax excluded)
DR - Input Tax (% of purchase price)
     CR - Creditor (full amount - Input Tax included)

DR - Debtor (full amount - Output Tax included)
     CR - Sales (selling price - Output Tax excluded)
     CR - Output Tax (% of selling price)

Cost of sales journal

DR - Cost of sales (cost price)
     CR  - Stock (cost price)

The transactions for Supplier returns (Credit notes received from creditors (suppliers)) are exactly 
the opposite than those of purchase documents (Invoices received from creditors (suppliers)). 

The transactions for Credit notes (issued to debtors (customers / clients)) are exactly the opposite 
than those of Invoices. 

Trading stock items (Default stock type)

Supplier returns (Purchase returns journal) Credit notes (Sales returns journal)

DR - Creditor (full amount - Input Tax included)
     CR - Stock item (cost price - Input Tax excluded)
     CR - Input Tax (% of purchase price) 

DR - Sales (selling price - Output Tax excluded)
DR - Output Tax (% of selling price)
     CR - Debtor (full amount - Output Tax included)

Cost of sales journal

DR - Stock (cost price)
     CR - Cost of sales (cost price)

All other stock types (excluding the Bills of Materials (BOM) stock type), have no cost of sales 
transactions.  

The Bills of Materials (BOM) and the Bills of Materials (Production) (BOM (Production)) stock types, are 
usually linked to trading stock items (components).

K.3- TAKING ON TRADING STOCK ITEMS

The opening balances for your stock items must be entered for each individual stock item - you 
cannot simply enter the total from the trial balance. You need to inform the program of the 
quantities on hand and the cost prices for each stock item. 

TurboCASH will calculate the value of each stock item by multiplying the quantities on hand by the
cost price. After all the quantities and cost prices of your stock items are entered, the total value of
all stock items should be equal to the control figure (stock control account), as per your financial 
statements.
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K.3.1- Entering opening quantities on hand and cost prices

In practice you would now do a stock take and inform TurboCASH as to the numbers of each item 
you have in stock. Unless your opening balances are actually entered into the system, TurboCASH 
would never know how many items you had in stock to start with. For the purpose of this tutorial, 
we have 5 drill presses and 4 compressors to take on.

Example: List of stock items in the Stock ledger, is as follows:

Only the total value (cost price of stock) is entered as the opening balance of your stock items. 
To take on opening balances for your stock items:

1. On the Action ribbon, select Stock items (F12). 
2. Click on the Advanced mode button. The Advanced mode button's caption will change 

to Default. 

3. Select the Stock take-on the “Update type” field (on the sidebar). 

You may click on any column heading and drag it. For example, to enter the Average cost (in the 
“Avg Cost” column), simply click on the column heading and drag it next to the “On Hand” 
column. 

You may select (tick) the “Power tools” in Reporting group 1, and click on the Search button to list 
only the stock items linked to “Power tools”. 
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4. Select “COMPRESSOR” to take on the compressors. Enter “4” for the Quantity on hand (in 
the “On hand” column) and “1000” for the Average cost (in the “Avg. cost” column). 

5. Select the stock code for the “DRILL PRESS” to take on the drills. Enter “5” for the 
Quantity on hand (in the “On hand” column) and “500” for the Average cost (in the “Avg. 
cost” column). 

6. Click on the Save button.

K.3.2- Printing stock item listing reports

To print a stock item listing report:

1. On the Reports ribbon, select Reports → Stock → Stock item listing. The “All selling 
prices” report options will be displayed.

2. Select the “Stock item listing” from the list of reports. 

3. Select the following options: 

From:  Select the Stock item i.e. “3COMP” on the list.

To:  Select the Stock item i.e. “3DRILL.” on the list.

Reporting group 1:
 Click on the “Power tools” tick box to view only those Stock items linked 

to this Stock group1. You may also remove the tick to view all items, if 
the last Stock item is selected. 

Show details:  Leave blank.

New page per item:  Leave blank.

4. Click on the OK button. 
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The report is displayed as follows: 

You should have 6 500,00 of Stock on hand. This amount should balance with the stock records 
and the stock control account in your previous accounting records.

It is recommended that the source document (e.g. stock item list, etc.) be attached to this Stock 
item List (take-on of opening balances) and that it be retained for record and audit purposes.

This report only reflect the Quantities and value at cost price (Quantity x Cost price as in this case
the number and amount entered in the “Avg. cost” column for the Stock items).
It is good practice to retrieve a detailed report to check that you have entered all the details and 
information correctly. To view additional information, select the “Show details” option. This will 
list the Extra description, Manufacturer, Units, Net and Gross weight, Selling prices 1 / 2 / 3, 
Barcode, Reporting group 1 / 2 and preferred supplier 1 / 2.  

It is also recommended that the All selling prices Stock item listing report is printed to check your 
selling prices, before you start invoicing.

5. After viewing the report, click on the Close button to close the report preview screen. 
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K.4- PROCESSING CREDITORS - ORDERS AND PURCHASES

The transactions will automatically be generated when purchase documents are updated or 
posted to the ledger. It will automatically generate and update (post) the transactions to the 
ledger in the batch types as set (linked) in the Documents setup (Setup ribbon) - Purchases and 
Supplier returns tabs.

It the Tax (VAT/GST/Sales tax) rate increased (as in South Africa, from 14% to 15%), make absolutely sure 
that the correct Tax (VAT/GST/Sales tax) rate is selected. 
If the 14% Tax (VAT/GST/Sales tax) rate is still reflecting on the Tax lookup, it is recommended that the 14%
Tax (VAT/GST/Sales tax) rate be set to “Disabled” (once the 14% transactions are finalised) in the “Status” 
field of Accounts on the Action ribbon.

K.4.1- Creating an order

You may need to place an order with any of your creditors (suppliers). 

When the Goods are received (or services are rendered), you may confirm the order against the 
actual goods / services received.  

Orders cannot be updated (posted) to the ledger and it generates no transactions. But, once the Order has 
been converted to a Purchase document, it can be updated (posted) to the ledger.

Order 3 x Drill presses from A-ONE Suppliers:
ORDER: OR000001  -  2018/04/01
A-ONE Suppliers
3 Drill presses at                    1 500,00
 Input Tax - 15%                       225,00  
Total                                     1 725,00

To create an order:

1. On the Action ribbon, select Documents (F6).

2. Select “Orders” in the “Documents” field; if “Orders” is not selected. 

3. Click on the New button. The “Creditor accounts” screen is displayed:

4. Select the Creditor account (“A-ONE Suppliers”).

5. Click on the Open or OK button. 
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6. Enter and / or select the following options:
Your reference:  Enter “4562” as the reference for the order. 
Salesperson:  Select “Russell”. Salespersons are optional for orders. This field is to show 

who handled the order.
Document 
group 1/2:  Select “Document group 1B”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups. (Setup ribbon).

Date:  Select “2018/04/01”.
Due date:  This date will be automatically be calculated. It is the “Date” plus the 

number of days set in the Accounting information tab of the selected 
creditor account.  

 Press the Enter key until you get to the transaction details screen (skip the 
“Address, Delivery address” and “Message” fields).

Item no.:  Select “3DRILL”. The description, Quantity (default 1), Tax account, Unit 
Purchase or Cost price (Exclusive of VAT/GST/Sales tax if the F7:Exclusive 
icon is active - or Inclusive of VAT/GST/Sales tax if the F7:Inclusive icon is 
active) will be displayed. 

Quantity:  Enter “3”. 
Tax:  The default Input Tax account for the stock item will be displayed. When the

cursor is in this field, the Tax accounts lookup will be displayed. Confirm that
it is correct by pressing the Enter key.

Discount:  Press the Enter key to keep it at the default 0% discount rate.
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7. Click on the OK button. A confirmation screen “Do you wish to print this order?” will be 
displayed.

8. Click on the Yes button.

K.4.2- Confirming / Converting an order to a purchase document 

We have already placed an order with our A-ONE Suppliers - and the three drills are received on 7 
April 2018. The order needs to be checked and converted into a Purchase document or a Goods 
received note. 

If you have already created invoices (whether they are updated to the ledger (posted) or not), you may 
convert the Invoice to an Order. To do this, select the Invoice on the documents list and right-click and 
select the “Documents → Convert invoice to order” option from the context menu.
You may then edit the order and convert it to a purchase document.

To convert an order to a purchase document:

You may also convert Orders to Purchase documents from the Input → Confirm (Action ribbon). 

1. Access “Orders” in the “Documents” field; if “Orders” is not selected.

2. Select the order to convert and right-click.

3. Right-click and select the “Confirm quotes and orders” option on the context menu. A 
confirmation screen “Do you wish to continue?” will be displayed.

4. Click on the Yes button to proceed. Another confirmation screen “Do you wish to delete 
this Order?” will be displayed.

5. Click on the No button not to delete the order. 

If you click on the Yes button, the order will be deleted from the “Orders” list of the “Document 
entry” screen.  
Should you click on the No button the order will still be available on the Orders list of the 
“Document entry” screen. You may then Copy the order, change the account, edit the account, 
etc. before converting it to a purchase document.  
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You may delete Orders in Edit → Delete → Documents (Action ribbon).

K.4.3- Creating a purchase document

Once an Order is converted to a Purchase document (Goods received note), it must be checked to 
see that the correct stock was received. 

K.4.3.1- Editing a purchase document confirmed from an order

To edit a purchase document converted from an order:

1. On the Action ribbon, select Documents (F6).  

2. Select “Purchases” in the “Documents” field; if “Purchases” is not selected. 

The purchase document, listed on the “Document entry” screen, was automatically created when 
you have confirmed and converted the order to a purchase document.

3. Select the purchase document on the list and click on the Edit button. 

The order number “OR000002”, which was converted to this purchase document, is displayed in 
the very last line in the “Message” field.

4. Enter and / or select the following options:
Your reference:  Enter “4562” as the reference of the creditor.
Date:  2018/04/05 (should be displayed, as it is the date on which the order was 

converted to a purchase document).
Due date:  This date will be automatically be calculated. It is the “Date” plus the number 

of days set in the Accounting information tab of the selected creditor account.
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5. The items and details of the order will be displayed on the respective fields. Check the 3 
drills and the purchase or cost price is correct. You may edit it, if necessary.

6. Click on the OK button. A confirmation screen “Do you wish to print this purchase?” will 
be displayed.

7. Click on the Yes button.

You are now ready to enter the rest of your purchases.

K.4.3.2- Creating a new purchase document

We have also purchased two (2) compressors: 
PU000004  - 2018/04/06
Invoice 3532 from
BEST Suppliers
2 Compressor                          2 000,00
 Input Tax - 15%                         300,00
Total                                       2 300,00

To create a new purchase document:

1. On the Action ribbon, select Documents (F6).

2. Select “Purchases” in the “Documents” field; if “Purchases” is not displayed.

3. Click on the New button. The “Creditor accounts” screen is displayed:

4. Select the Creditor account (“BEST Suppliers”).

5. Click on the Open or OK button.
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6. Enter and / or select the following options:
Your reference:  Enter “3532” as the reference of the creditor.
Salesperson:  Select “Russell”. Salespersons are optional for purchases. This field is to 

show who handled the purchase.
Document group
1/2:  Select “Document group 1A”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups (Setup ribbon).

Date:  Select “2018/04/06”.
Due date:  This date will be automatically be calculated. It is the “Date” plus the 

number of days set in the Accounting information tab of the selected 
creditor account.  

 Press the Enter key until you get to the invoice details screen (skip the 
“Address, Delivery address” and “Message” fields).

Item no.:  Select “3COMP”. The description, Quantity (default 1), Tax account, Unit 
price (Exclusive of VAT/GST/Sales tax if the F7:Exclusive icon is active - or 
Inclusive of VAT/GST/Sales tax if the F7:Inclusive icon is active) will be 
displayed. 

Quantity:  Enter “2”. 
Tax:  The default Input Tax account for the stock item will be displayed. When the

cursor is in this field, the Tax accounts lookup will be displayed. Confirm 
that it is correct by pressing the Enter key.

Discount:  Press the Enter key to keep it at the default 0% discount rate.
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7. Click on the OK button. A confirmation screen “Do you wish to print this purchase?” will 
be displayed.

8. Click on the Yes button.

TurboCASH defaults to an average costing basis. Please ask your accountant whether to use this option or 
to check the “use latest cost” option.

K.4.4- Updating purchase documents to the ledger

Since we have not selected the “Auto-post documents on print” option on the Documents setup (See 
Chapter E4.5 of MODULE E) we need to post the purchases manually.

To post or update your purchases: 

1. On the Action ribbon, select Update ledger (F3). The “Update Invoice” screen will be 
displayed. 

2. Select “Purchases” and its name will change to “Update purchases” - listing all your 
unposted purchases.

Purchases in rows with a cream background (i.e. PU000003) have been printed. 
Purchases in rows with a plain white or grey background (i.e. PU000004), have not yet been 
printed. 

3. Click on the “From... to” field and select -

From purchase: PU000003

To: PU000004

4. Click on the Update button. TurboCASH will now write up your Purchases Journal for you,
as well as update your stock, creditors and Input VAT/GST/Sales tax. The following journal
entries are passed:

DR Stock (net amount)

DR VAT/GST/Sales tax (net amount)

CR Creditor (total amount)
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K.4.5- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.

To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. Creditor account A-ONE Suppliers). Double-click on the selected 

account; or right-click and select Show details on the context menu. 

3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10049 or 10050 automatically generated). This will list only 
the transactions for a specific batch (journal). 

• Account code (e.g. G750-000 Stock control, T850-020 Input Tax - 15%, C2AO-
NES A-ONE Suppliers). This will list the transactions for a specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the Purchase documents, the transactions should display as follows in the T-Account
viewer:

Batch view
Batch 10049 – PU000003 – A-ONE Suppliers

Batch 10050 – PU000004 – BEST Suppliers
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Account view
 Accounts in the Creditor’s ledger:

 A-One Suppliers

 BEST Suppliers

 Accounts in the General ledger:

 Stock control

 Input Tax – Standard rate 15%

Debits = Credits

Debit transactions in the  Stock control account (i.e. Stock ledger) and  Input Tax (VAT/GST/Sales tax) 
=

Credit transactions in the Creditor’s ledger (i.e. individual   Creditor accounts)

K.5- PROCESSING DEBTORS - QUOTES AND INVOICES

If you are selling stock to a customer or debtor, it is best to create an Invoice using the 
Documents – Invoices and not in the Batch entry - Sales Journal. By creating an Invoice 
TurboCASH will automatically write up your Sales journal for you, credit the stock, credit the 
Output VAT/GST/Sales tax and debit the debtor. 

Invoices could also be used for any sales other than stock. Non-stock items could be captured through the 
Batch entry - Sales journal (Action ribbon). An example of a non-stock item could be the sale of old or 
obsolete furniture, which your business does not use any longer.

It the Tax (VAT/GST/Sales tax) rate increased (as in South Africa, from 14% to 15%), make absolutely sure 
that the correct Tax (VAT/GST/Sales tax) rate is selected. 
If the 14% Tax (VAT/GST/Sales tax) rate is still reflecting on the Tax lookup, it is recommended that the 14% 
Tax (VAT/GST/Sales tax) rate be set to “Disabled” (once the 14% transactions are finalised) in the “Status” 
field of Accounts on the Action ribbon.
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K.5.1- Creating a quote

Your Debtors or Customers may ask you for a quotation on your products for various reasons. 
TurboCASH allows you to create a quote on the system. When the Debtor (customer / client) 
accepts the quote, you may confirm the Quote and Convert it to an Invoice.  You will not be able 
update the Quote to the ledger, since it generates no transactions. But once the Quote has been 
converted to an Invoice, it can be updated or posted to the ledger.

On 1 April 2018 Mr. Davies asked for a quote on a drill press. 

To create a quote:

1. On the Action ribbon, select Documents (F6).

2. Select “Quotes” in the “Documents” field; if “Quotes” is not displayed. 

3. Click on the New button. The “Debtor accounts” screen is displayed:

4. Select the Debtor account (“Mr. Mike Davies”)

5. Click on the Open or OK button. 
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6. Enter and / or select the following options:
Your reference:  Leave blank.
Salesperson:  Select “Tracy”; if not already selected. As Russell was set as the default 

salesperson, his name should automatically be displayed. (You may select 
any other salesperson if Tracy is not doing this quote).

Document 
group 1/2:  Select “Document group 1B”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups.(Setup ribbon).

Date:  Select “2018/04/01”.
Due date:  This date will be automatically be calculated. It is the “Date” plus the 

number of days set in the Accounting information tab of the selected debtor
account.  

 Press the Enter key until you get to the invoice details screen (skip the 
“Address, Delivery address” and “Message” fields).

Item no.:  Select “3DRILL”. The description, Quantity (default 1),  Output Tax account, 
Unit selling price (Exclusive of VAT/GST/Sales tax if the F7:Exclusive icon is 
active - or Inclusive of VAT/GST/Sales tax if the F7:Inclusive icon is active) 
will be displayed. 

 The default selling price for the Debtor account will be displayed. Make sure 
that Selling price 1 is selected for the purpose of this tutorial.

Quantity:  Confirm “1”. 
Tax:  The default Output Tax account for the stock item will be displayed. When 

the cursor is in this field, the Tax accounts lookup will be displayed. Confirm 
that it is correct by pressing the Enter key.

Discount:  Press the Enter key to keep it at the default 0% discount rate.

7. Click on the OK button. A confirmation screen “Do you wish to print this quote?” will be 
displayed.

8. Click on the Yes button.
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K.5.2- Confirming a quote - converting a quote to an invoice

On 7 April 2018, Mr. Davies confirms that he wishes to take the Drill press as quoted on 1 April 
2018. We need to check or confirm the quote and convert it to an invoice.  

To convert a quote to an invoice:

You may also convert Orders to Purchase documents from the Input → Confirm (Action ribbon). 

1. Access “Quotes” in the “Documents” field; if “Quotes” is not selected.

2. Select the quote to convert and right-click.
3. On the context menu, select the “Confirm quotes and orders” option. A confirmation 

screen “Do you wish to continue?” will be displayed.
4. Click on the Yes button to proceed. Another confirmation screen “Do you wish to delete 

this Quote?” will be displayed.
5. Click on the No button not to delete the quote. 

You may delete Quotes in Edit → Delete → Documents (Action ribbon).

If you click on the Yes button, the quote will be deleted from the Quotes list of the “Document 
entry” screen.  

Should you click on the No button the quote will still be available on the “Quotes” list of the 
“Document entry” screen. You may then Copy the quote, change the account, edit the account, 
etc. before converting it to an invoice.  

6. An information message “Document(s) created IN000005 D1MD-AVI Mr. Mike Davies” will 
be displayed.

7. Click on the OK button to close this screen. 
8. Access the “Quotes” screen and edit the converted invoice, if necessary. 
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K.5.3- Creating an invoice 

Once a Quote is converted to an Invoice, check that all the items on the quote are accepted. When
accessing the Invoice documents screen from the Documents - Invoices (Action ribbon) and the 
debtor (customer / client) is selected, all available unposted Invoices for that debtor (customer / 
client) are listed. 

K.5.3.1- Editing an invoice confirmed from a quote

To edit an invoice converted from a quote:

1. On the Action ribbon, select Documents (F6).

2. Select “Invoices” in the “Documents” field; if “Invoices” is not selected. 

The Invoice, listed on the “Document entry” screen, was automatically created when you have 
confirmed and converted the quote to an invoice.

3. Select the Invoice on the list and click on the Edit button. The screen for “Invoice entry” is 
displayed:

The quote number “QU000002”, which was converted to this invoice, is displayed in the very last 
line in the “Message” field.

4. Enter and / or select the following options:
Your reference:  Enter “D-101” as the reference number. 
Salesperson:  Check that “Tracy” is displayed.
Date:  “2018/04/07” (should be displayed, as it is the date on which the quote was 

converted to an invoice).
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Due date:  This date will be automatically be calculated. It is the “Date” plus the number
of days set in the Accounting information tab of the selected debtor account. 

5. The items and details of the quote will be displayed on the respective fields. Check the 
quantity and selling price for the drill is correct. You may edit it, if necessary.

The quantity ordered is the number of stock items the customer requested. The quantity shipped is
the number of items actually supplied. If the quantity ordered and the quantity shipped are not the
same, the difference will appear on the back order report.

6. Click on the OK button. A confirmation screen “Do you wish to print this invoice?” will be 
displayed.

7. Click on the Yes button.

You are now ready to enter the rest of your invoices.

K.5.3.2- Creating a new invoice

Enter the rest of your Sales:
Salesperson - Tracy Salesperson - Russell Salesperson - Tracy
2018/04/09  
Invoice IN000006

2018/04/10  
Invoice IN000007

2018/04/11  
Invoice IN000008

To: Mr. Smith To: Mr. Davies To: Mr. Smith
2 Compressors             3 000,00 1 Compressor            1 500,00 2 Drill presses              2 000,00
Output Tax – 15%           450,00 Output Tax – 15%         225,00 Output Tax – 15%           300,00
Total                            3 450,00 Total                         1 725,00 Total                            2 300,00

To create a new invoice:

1. On the Action ribbon, select Documents (F6).

2. Select “Invoices” in the “Documents” field; if “Invoices” is not selected. 

3. Click on the New button. The “Debtor accounts” screen is displayed:

4. Select the Debtor account (“Mr. Roger Smith”).

5. Click on the Open or OK button. 
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If you would like to include a longer description than the description field allows you can press  
the F9 key for a comment and type in a comment on that line.

6. Enter and / or select the following options:
Your reference:  Enter “C-102” as the reference for the debtor.
Salesperson:  Select “Tracy”; if not already displayed.
Document 
group 1/2:  Select “Document group 1B”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups.(Setup ribbon).

Date:  Select “2018/04/09”.
Due date:  This date will be automatically be calculated. It is the “Date” plus the 

number of days set in the Accounting information tab of the selected debtor 
account.  

 Press the Enter key until you get to the invoice details screen (skip the 
“Address, Delivery address” and “Message” fields).

Item no.:  Select “3COMP”. The description, Quantity (default 1), Tax account, Unit 
selling price (Exclusive of VAT/GST/Sales tax if the F7:Exclusive icon is active 
- or Inclusive of VAT/GST/Sales tax if the F7:Inclusive icon is active) will be 
displayed. 

Order / Ship 
(Quantities):

 Enter “2”. 

Tax:  The default Output Tax account for the stock item will be displayed. When 
the cursor is in this field, the Tax accounts lookup will be displayed. Confirm 
that it is correct by pressing the Enter key.

Discount:  Press the Enter key to keep it at the default 0% discount rate.
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7. Click on the OK button. A confirmation screen “Do you wish to print this invoice?” will be 
displayed.

8. Click on the Yes button.

9. Enter your sales to create invoices IN000007 and IN000008.

Once you have completed all your invoices, check to see that you are:
• Selling to the right person.
• Selling at the right date.
• Selling the right item requested.
• Selling the right quantity requested.
• Selling at the right price.
• Selling at the correct tax rate.
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K.5.4- Updating your invoices to the ledger

Since we have not selected the “Auto-post documents on print” option on the Documents setup (See 
Chapter E4.5 of MODULE E) we need to post the invoices manually.

Check all your Purchases to see that they are correct and have been updated to the ledger, before you 
update the Invoices to the ledger.

To post or update your invoices: 

1. On the Action ribbon, select Update ledger (F3). 

2. Invoices are displayed by default - listing all your unposted invoices. If not, select 
“Invoices”.

Invoices in rows with a peach background (i.e. IN000008), have been printed. 
Invoices in rows with a plain white or grey background (i.e. IN000005 to IN000007), have not yet 
been printed. 

3. Click on the “From... to” field and select -

From invoice: IN000005

To: IN000008 

4. Click on the Update button. TurboCASH will automatically write up your Sales journal. It 
will control Sales, Cost of sales, Output VAT/GST/Sales tax and Stock. 

The following journals are passed:

DR Debtor (total amount)

CR Sales (net amount - selling price)

CR VAT/GST/Sales tax (net amount)

DR Cost of sales (cost price)

CR Stock (cost price)
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K.5.5- T-Account view of transactions

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, printed, exported and analysed.
To access the T-Account view of the transactions:

1. On the Reports ribbon, select T-Ledger analyser 1 or 2.
2. Select an account (e.g. Debtor account Mr. Mike Davies). Double-click on the selected 

account; or right-click and select Show details on the context menu. 
3. Click on the following to get specific views of transactions:

• Batch number (e.g. 10051, 10053, 10055 or 10057 for Sales transactions 
automatically generated). This will list only the transactions for a specific batch 
(journal). 

If the Cost of sales is activated, TurboCASH will generate the following 2 batches for 
each Invoice:

1. Sales batch – This is the journal (batch type) linked to the Invoices in 
Documents setup (Setup ribbon) (e.g. Batch number 10051, 10053, 10055, 
and 10057).

2. Cost of sales batch – This journal (batch type) selected on Stock information 
(Setup ribbon). The Cost of sales account is selected on the Ledger tab for 
Stock items (e.g. Batch number 10052, 10054, 10056 and 10058).

• Account code (e.g. G100-000 Cost of sales account, G750-000 Stock control, 
T850-010 Output Tax -15%, D1MD-AVI Mr. Mike Davies). This will list the 
transactions for a specific account.

• Date – This will list the transactions for a specific date. If you double-click on a 
date, the “From date” and “To date” will be changed to the selected date.

After posting the Invoices, the transactions should display as follows in the T-Account viewer:

Batch view
Sales (Selling prices)

Cost of sales (Cost prices)
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TurboCASH calculates Cost of sales according to either Average cost or Latest cost, depending on your 
selection on Stock information. (Setup ribbon).
Cost prices and Quantities are determined by the following: 

• Opening stock balances entered.
• Purchase documents posted (updated).

If the Cost of sales is activated, TurboCASH will generate the following 2 batches for each Invoice:
• Sales batch – This is the journal (batch type) linked to the Invoices in Documents setup (Setup 

ribbon).
• Cost of sales batch – This journal (batch type) selected on Stock information (Setup ribbon).

Account view (Selling prices)
 Accounts in the Debtor’s ledger:

 Mr. Mike Davies

 Mr. Roger Smith

  Accounts in the General ledger: 

 Sales

 Output Tax - 15%

 

Debits = Credits

Debit transactions in the Debtor’s ledger (i.e. individual   Debtor accounts).
=

 Credit transactions in the General ledger (i.e.   Sales and  Output Tax (VAT/GST/Sales tax) Accounts).

The Cost of sales transactions are not applicable to those Stock types dealt with in MODULE J.
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Account view – Cost of sales (Cost prices)
 Accounts in the General ledger:

 Cost of sales 

 Stock control

Debits = Credits

Debit transactions in the   Cost of sales account 
 =

Credit transactions in the  Stock control account (i.e. Stock ledger). 

Any quantities and cost prices will automatically be updated for all stock items on the invoices.
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INTRODUCTION TO THE CALENDAR

L.1- INTRODUCTION TO THE CALENDAR

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South Africa, 
the South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 April 2018. 

This MODULE, VAT based on 15% tax for taxable transactions as from 1 April 2018.

In TurboCASH, you may use the Calendar to perform various actions. For example, you may record
appointments with your debtors (customers) and creditors (suppliers), set and process repeating 
documents (Invoices and Purchases). This will allow you to optimise your planning and generate 
Invoices for hours registered with your debtors (customers / clients). 

In addition to this, you may also add any tasks, events and manage your contacts. 

You may set the reminder, to allow a pop up screen to remind you of these actions well in advance. 
You may then click in the Open item button of the “Reminder” screen to perform this action, as scheduled. 
If the Reminder was not activated; or if you wish to adjust the reminder, select the “Event”, and select the 
“Edit event...” option on the context menu. 

To launch the calendar and add an event: 

1. On the Action ribbon, select Calendar. 

You may set the Calendar to launch by default when opening a Set of Books. To do this; select 
the “Show calendar“ option on Setup → System parameters (Setup ribbon).

These events in the Calendar are available on 2018/05/02 in HANDYMAN-B Set of Books.
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The context menu (right-click) allows you to select the following:

a) Add event – create new appointments for creditors (suppliers) or for debtor 
(customer / client) appointments (up to six (6) categories). You may also 
generate documents (Repeating invoices or Quotes “Hours”). 

b) Edit event – Edit / change or reschedule any of these events.

c) Delete event – Permanently delete / remove a selected event. 

d) Create Invoice – Create invoices for any of the six (6) categories of debtor 
(customer / client) appointments.  

Multi-user Calendar plugin may also be purchased for Multi-user versions.   

2. Select a date and right-click on a time slot. On the context menu, select the “Add event...” 
option. The “Untitled – Event” screen is displayed:

3. To register (create) an appointment; you need to select one of the categories to use the 
different functions. The categories, are as follows: 

Category Description / Function
Appointment This allows you to create general appointments and set reminders for 

these appointments (events).
Repeating invoices This allows you to set repeating invoices for debtors (customers / clients). 

You may create repeating invoices for a specific debtor or a debtor group.
Debtor appointment (up
to six (6) categories)

This allows you to set appointments (events) for debtors (customers / 
clients). You may also add notes, etc. and set reminders. You may create 
up to 6 categories of appointments for your debtors (customers / clients). 

Creditor appointment This allows you to set appointments (events) for creditors (suppliers). You 
may also add notes, etc. and set reminders.

Hours You may use the hours to create invoices for a debtor (customer / client).

For the purpose of this tutorial, the Invoices for hours and Repeating invoices will be discussed here.

Debtor appointments - All events for the six (6) categories are listed in the Appointment tab for a 
selected debtor (customer / client) account. 
Creditor appointments  - All events are listed in the Appointment tab for a selected creditor (supplier)
account. 

292 - TurboCASH5.1 – 2018 – Accounting Made Easy



REPEATING INVOICES

L.2- REPEATING INVOICES

Should you need to invoice a debtor (customer / client) or specific debtors (customers / clients) on
a regular basis (e.g. monthly, etc.), you may use the “Repeating invoices” category to schedule and 
process the repeating invoices with a few mouse-clicks. 

Once the Repeating invoices is scheduled, you need to reopen the Repeating invoices event to set 
your repeating invoices.

To set repeating invoices:

1. Select a date and right-click on a time slot. On the context menu, select the “Add event...” 
option. The “Untitled – Event” screen will be displayed.

2. On the “Untitled Event” screen, enter and / or select the following:
Subject:  Leave blank. If you click on the OK button, “Repeating invoices” will 

be displayed in the “Subject” field.
Category:  Select “Repeating invoices”.
Salesman:  Select “Russell” as the salesperson.
All day event:  Leave blank.
Start time:  Select “2018/05/02”. This is the date and time as selected on the 

Calendar from where the “Untitled - Event” screen was launched. If 
this date is not correct, you may select the correct date.

End time:  Field disabled.
Appointment recurrence:  Select “Monthly by day”.
Repeat until:  The default will be one year as from the “Start time”.  
Reminder:  Leave blank. You may activate it and set the “Minutes, Hours” or 

“Days” to remind you in advance to process repeating invoices.
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3. Click on the OK button to register and save the “Repeating invoices – Event”. 

4. Reopen the “Repeating invoices – Event” to add your debtors (customers / clients). The 
Repeating invoice tab will be added to the “Repeating invoices – Event” screen. Click on 
the Repeating invoice tab. 

5. You may enter a Message (up to 3 lines) to display on the invoice. This message will be 
displayed on the “Message” fields in the “Document entry” screen's header section and 
will be printed on the printed invoice.

6. Select the Invoice date “2018/05/02”; if not correct. This is the date on which, the 
invoice(s) will be created.

7. Click on the New button. 

8. Select the following options:
Type:  Select “Copy invoice” (default option).
Debtors:  Select “Mr. AB Green”.
Documents:  Select “IN000003”. 

If you select the “Copy invoice to group 1” option as the “Type”, you may to select a specific Debtor
reporting group 1. 

9. Click on the OK button. The details of the debtor will be listed in the Process list.

10. Click on the Process selected button. Once the process is finished, a confirmation 
message “Document(s) created!” will be displayed.  
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11. Click on the OK button.  

It the Tax (VAT/GST/Sales tax) rate increased (as in South Africa, from 14% to 15%), make 
absolutely sure that the correct Tax (VAT/GST/Sales tax) rate is selected. 
If the 14% Tax (VAT/GST/Sales tax) rate is still reflecting on the Tax lookup, it is recommended that
the 14% Tax (VAT/GST/Sales tax) rate be set to “Disabled” (once the 14% transactions are 
finalised) in the “Status” field of Accounts on the Action ribbon.

12. Click on the OK button of the Repeating invoices – Event (e.g. “Monthly Invoices”) screen.

13. Click on the Documents – Invoices. The Invoice will be created as IN000009, as per this 
example. Edit the Invoice, if necessary.

This Invoice may then be viewed on the “Document entry” screen as Unposted. 
You may also view and print the Invoice on the Documents tab of the Debtor account (Action 
ribbon). 
Once the Invoice is posted (updated to the ledger), it will be listed as a debit transaction on the 
Transactions tab of the “Debtor account”. 

The Repeating invoice – Event will be displayed in Red colour on the time slot of the scheduled 
day. The Day in the calendar will also be underlined and displayed in a Red font. 

L.3- CREATING INVOICES FOR HOURS

The Calendar (Planner) allows you to schedule appointments with debtors (customers / clients) 
and generate quotes for appointments / services rendered. This combines your electronic dairy 
with the quotes and invoicing features in TurboCASH5. 

You may then send them the quote for the time. Once the appointment is finished / completed, 
you may convert the quote to an invoice and edit it before posting the invoice to the ledger.  

For example, if you have scheduled a 3 hour appointment, and it took only 2 hours, you may edit 
the invoice (converted quote) change the number of hours from 3 to 2 hours.

To create invoices for hours:

1. Select a date and right-click on a time slot. On the context menu, select the “Add event...” 
option. The “Untitled – Event” screen will be displayed.

2. Select the “Hours” category. A field  “Hours” will be added to the “Untitled – Event” 
screen.
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3. Click on the “Hours” field and select a debtor (customer / client) account. 

4. Select “Russell” as the salesperson.

The Debtor code, description and name of the salesperson (and Description, e.g. “Paint House”, if 
entered in the “Subject” field), will automatically be inserted in the “Subject” field.

5. Select the “Start time” and “End time” for the appointment. If this is event is for the whole
day, you may tick the “All day event” field.

Appointment recurrence should be “None”. Trying to select any of the recurring options will 
display an “Error Hours cannot be repeated”.

6. Click on the OK button to register the event and add it to the Calendar. This event will be
may be viewed and if the reminder was set, you will be reminded of the event. 

7. When ready to process the quote, click on the Create invoices for hours button. 

The “Hours between date” screen is displayed: 

8. Select the dates “From date” and “To date”. 

9. Select the Stock item. The Stock code will be displayed. 

10. Click on the OK button. The Quotes will be generated. Once the process is finished, an 
information message “Quote(s) generated!” will be displayed.

11. Click on the OK button. 
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12. Click on the Documents – Quotes. The Quote should be created as “QU000003”, as per 
this example. 

It the Tax (VAT/GST/Sales tax) rate increased (as in South Africa, from 14% to 15%), make 
absolutely sure that the correct Tax (VAT/GST/Sales tax) rate is selected. 
If the 14% Tax (VAT/GST/Sales tax) rate is still reflecting on the Tax lookup, it is recommended that
the 14% Tax (VAT/GST/Sales tax) rate be set to “Disabled” (once the 14% transactions are 
finalised) in the “Status” field of Accounts on the Action ribbon.

13. Edit the Quote, if necessary. You may print these quotes and send them to your debtor 
(customer / client). For the purpose of this tutorial, “2” hours and “1 000,00” is the selling 
price.

This Quote may then be viewed on the “Document entry” screen as Unposted (not converted to an
invoice). 
You may also view and print the quote on the Documents tab of the Debtor account (Action 
ribbon). 
Once the quote is is converted to an invoice and the invoice is posted (updated to the ledger), it 
will be listed as a debit transaction on the Transactions tab of the Debtor account. 

The Hours – Event will be displayed in Magenta colour on the time slot of the scheduled day. The 
Day in the calendar will also be underlined and displayed in a Red font. 
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L.4- CREATING INVOICES FOR DEBTOR APPOINTMENTS

You may also create invoices for any of the six (6) categories of appointments scheduled with 
debtors (customers / clients).

To create invoices for debtor (customer / client) appointments:

1. On the Calendar, select any of the six categories of debtor appointments and right-click.

2. On the context menu, select the “Create Invoices” option. A new “Invoice entry” screen, 
displaying all the information and details for the debtor (customer / client) account will 
be displayed.

It the Tax (VAT/GST/Sales tax) rate increased (as in South Africa, from 14% to 15%), make 
absolutely sure that the correct Tax (VAT/GST/Sales tax) rate is selected. 
If the 14% Tax (VAT/GST/Sales tax) rate is still reflecting on the Tax lookup, it is recommended that
the 14% Tax (VAT/GST/Sales tax) rate be set to “Disabled” (once the 14% transactions are 
finalised) in the “Status” field of Accounts on the Action ribbon.

3. Enter and / or select the following options:
Your reference:  Enter “AP-6/5/2018” for reference to the appointment.
Salesperson:  Select “Russell”; if not already displayed.
Document group 
1/2:  Select “Document group 1A”. 

 Document group 2 cannot be selected as Groups are not added for 
Document group 2 in Groups (Setup ribbon).

Date:  The system date will be displayed. Select “2018/05/03” for the purpose of 
this tutorial.
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Due date:  This date will be automatically be calculated. It is the “Date” plus the 
number of days set in the Accounting information tab of the selected 
debtor account.  

 Press the Enter key until you get to the invoice details screen (skip the 
“Address, Delivery address” and “Message” fields).

Item no.:  Select “4L-PAINT-E”. The description, Quantity (default 1), Tax account, 
Unit selling price (Exclusive of VAT/GST/Sales tax if the F7:Exclusive icon is 
active - or Inclusive of VAT/GST/Sales tax if the F7:Inclusive icon is active) 
will be displayed. 

Order / Ship 
(Quantities):  Leave at the default “1” for 1 hour.

Tax:  The default Output Tax account for the stock item will be displayed.  
Confirm that it is correct by pressing the Enter key.

Discount:  Press the Enter key to keep it at the default 0% discount rate.

4. Click on the OK button. A confirmation screen “Do you wish to print this invoice?” will be 
displayed.

5. Click on the Yes button.

L.5- REMINDERS

The “Reminder” screen is automatically launched at the intervals set (if the Reminder is activated).

If the date and / or time is in the past (earlier than your system's date), the header OVERDUE! and 
the date end time of the event will be displayed.

The options to manage the reminder of an event or appointment are:

1. Dismiss - Click to turn the Reminder option for
the event or appointment off. You may later, at
any time select the event or appointment and
edit it to turn the reminder on.

2. Snooze - Click to be reminded later. You may
also adjust the time intervals to be reminded
later, e.g. 5, 10, 15, 30, 45 minutes, 1 to 8 hours,
1 to 6 days or 1 week, before clicking on this button.

3. Open item - Click to edit the event or appointment. You may finalise or reschedule the 
appointment. You may also deactivate or activate the reminder again. 
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L.6- PRINTING A REPORT FOR EVENTS IN THE CALENDAR

The Hours report for the entries in the Calendar will display a list of all the appointment types for a
selected period or selected date(s).

Repeating invoices will not be included in this report.

To print the calendar report:

1. On the Reports ribbon, select Reports → Calendar. The “Hours” screen is displayed:

2. Select the Categories for the Appointments (events) to include in this report.

3. Select the periods on the Per period tab or date(s) on the Free selection tab. 

4. Click on the OK button. An example of the “Calendar - Hours” report, is as follows:
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L.7- CONTACTS 

Lists all contacts for debtors (customers / clients) as well as contacts for creditors (suppliers).

You may add, edit and or delete contacts in the Calendar.

Contacts can also be added, edited or deleted using the following options on the Action ribbon: 
• Contacts  
• Debtors – Contacts tab.
• Creditors – Contacts tab.

The Print button not implemented. 
Reports for contacts can be printed in the following options on the Reports ribbon: 

• Reports → Contacts - Lists all contacts for debtors (customers / clients) as well as contacts for 
creditors (suppliers).

• Reports → Debtors → Listing - Lists only contacts for debtors (customers / clients).
• Reports → Creditors → Listing - Lists only contacts for creditors (suppliers).

L.8- TASKS 

You may add, edit, or delete tasks (to do list), and set a completion date when the tasks should be 
completed. You may also add some notes to each task to remind you of additional steps, 
procedures, phone numbers, etc. 

All tasks (excluding the deleted tasks, will display as follows:

• Expired tasks - Will display in a red font colour.

• Tasks marked as completed - The field is ticked and
the task displays a stripe through it. The task will also
be displayed in a grey font.
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INTRODUCTION TO THE BANK RECONCILIATION

M.1- INTRODUCTION TO THE BANK RECONCILIATION

TurboCASH allows you to match your Cash-book with your bank statement. You will always find 
that the bank costs and interest paid/received does not appear in your Cash-book. The same 
applies for debit orders and electronic payments as well as moneys paid directly into your bank 
account by your customers or other parties. This bank reconciliation helps you to identify these 
transactions and enter them into your general ledger.  

In this tutorial, the manual bank reconciliation reconciling printed bank statements with the cash-
book (payments and receipt batches) will be discussed. 

BankImport plugin is a commercial plugin.
It allows you to import a valid bank statement file into TurboCASH. It will import bank transactions and 
save you hours of data entry. You can simply link transactions to your debtors, creditors or other accounts. 
And with a simple mouse click, link the payments to the right invoices. (See - BankOnline Plugin).

The bank reconciliation is carried out for a number of reasons, such as:

• It checks to see that the transactions, which you have entered into TurboCASH, are the 
same as the transactions, which went through your bank.

• It checks to see that these transactions which went through the bank are the same as 
those going through your TurboCASH program.

• It checks to see whether you or the bank is, in fact, correct.

• It will list all your outstanding cheques and receipts, thus giving you a reconciled bank 
balance, which would be the actual amount you would have in the bank, had all your 
transactions gone through the bank.

For the purpose of this tutorial, you have received the following bank statement:
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M.2- BANK RECONCILIATION PROCESS 

Hints when doing the Bank reconciliation:

• Check that you have all the pages and that they run sequentially.

• Use the last day of the month and amount as per the bank

 statement - this will be your closing date (include items until) and bank balance.

• Start at the beginning of the bank statement and not in the middle.

• Use a ruler to make it easier to do the reconciliation line by line and "tick" every 
reconciled item on your statement.

• If you find an error, go back to your Cashbook and try to correct it immediately. Do not 
simply carry on doing the reconciliation.

M.2.1- Reconciling your cash-book with bank statements

If you have entered any repeating transactions for your payments and receipts batches, copy them to a 
normal batch to a normal batch, as they will not be reflected in the above list of Cashbook transactions if 
they are not at this stage updated or posted to the ledger. 

To do a bank reconciliation:

1. On the Action ribbon, select Reconciliation (Alt + F2).

2. Select the Cashbook you wish to reconcile, i.e. “ABC - Bank”.

3. Press the Enter key. The “Bank account recon options” screen is displayed:

4. Select and / or enter the following:
Bank account:  Select “ABC – Bank”.
Include items until:  Select “2018/03/31”.
Bank balance:  Enter “8 951,00” (closing balance of your bank statement).

5. Click on the OK button and the “Reconcile bank account” screen displaying the name of 
your current account will be displayed listing all your transactions in this Cashbook for 
the selected period, i.e. “01 to 31 March 2018”. These entries represent your unreconciled 
items.
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Before beginning your bank reconciliation you may set up the following functions:
• Show Statement – The BankOnline Plugin - Not implemented at this stage for 

TurboCASH5. You may use the BankImport plugin - Import Bank statement option 
(if the “Default bank reconciliation method” field is not selected on Setup → 
System parameters. (Setup ribbon).   

• Search – Click on the Search icon and a window will appear at the bottom of the 
“Reconcile bank account” screen. This allows you to locate an item by Date, 
Reference or Amount.

• Reconcile – Click on the Reconcile icon to reconcile all items, or specific items by 
reference or date.

• Unreconcile – Click on the Unreconcile icon to unreconcile all items, or specific 
items by reference or date.

• Process – Click on the arrow of the Process icon to select one of the following:
• Apply reconciled process all items selected (ticked) in the Reconciled column. 
• Transfer unreconciled to batches - This will transfer all items not selected (not 

ticked) in the Reconciled column) to the Payments and / or Receipt batches.
• Report – Print the Bank reconciliation report.

To reconcile items:
1. Type in the reference: D5000 (as per your reference in the Cashbook) and press the Enter

key - The amount (5 000,00) and entry will be highlighted in a different colour. If your 
TurboCASH corresponds with your bank statement, press the Enter key. 

2. You will notice that a tick appears next to the entry. If you can't remember the reference 
number, you can reconcile by amount. Just click to the amount field and enter the 
amount. Ensure that you mark your bank statement accordingly.
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3. You are now ready for the next line on your bank statement.
Reference: 106
Amount: 342,00

4. Press the Enter key to tick. Continue until you get to the bank charges.
5. Once you have “ticked” all possible entries - click on the arrow on the Process button 

and select the “Apply reconciled” option. All reconciled items will disappear from the list 
and you will be left with a list of unreconciled items.

M.2.2- Processing bank charges

You would only know what your bank charges are when you actually receive your bank statement 
from the bank. Any bank charges that have to be paid must be entered into your "Payments 
journal", and only interest received must be entered into your "Receipts journal".

It is always a good idea to use a reference number; such as your Bank statement number; so as 
have a reference to the specific bank statement. 

You now need to go back to your Payments journal and enter your bank charges. Press the Esc 
key to exit the reconciliation. 

Before exiting the batch, make sure that you have clicked on the “Apply reconciled” option on the Process 
button to save the “ticks” and reconcile the ticked items.)

To enter the bank charges and finalise the bank reconciliation:
1. On the Action ribbon, select Batch entry (F2). 
2. Select the ABC-Payments journal and click on the Open button.
3. Enter the Alias (batch name) as “ABC-PaymentsBS5”.
4. Enter the following transaction:

Reference: BS5
Date: 2018/03/31
Description: Bank charges - Bank statement no.5
Account: G200-000 - Bank charges
Tax: Select “No tax” for the purpose of this tutorial. 

VAT/GST/Sales tax may be applicable to some charges on your bank statement, if you 
are registered as a VAT/GST/Sales tax vendor.

Amount: 45,00 DR

In practice, it is easier to enter any bank charges, debit orders, interest, etc. into your 
Payments or Receipts journals before starting the reconciliation.

5. Balance the batch. After entering the transactions and balancing the batch, the Payments 
batch, is as follows:
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6. Post the batch.

7. Exit the “Batch entry” screens. 

M.2.3- Printing the bank reconciliation report

Go back to your bank reconciliation and reconcile your bank charges. (To do this, tick the 
Unreconciled item and click the Process icon and select the “Apply reconciled” option) on the The 
Difference in the bottom right-hand corner of the “Reconcile bank account” screen should now 
reflect a nil balance.

Once you have completed your bank reconciliation, you must check that your Cashbook is, in fact, 
in balance.

1. Click on the Report icon. The “Bank account recon options” screen is displayed. 

All the data of the Bank account, Date, Bank balance, etc. should still be the same as per your 
your previous selection criteria. 

2. Click on the Open or Reconcile button. The “Bank reconciliation report as at 2018/03/31”
is displayed:
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TurboCASH will subtract any unreconciled payments and add any unreconciled receipts from the 
bank balance according to the bank statement, thus giving a reconciled balance.

3. After studying and printing the report, you may close the report. 

4. Click on the Close button of the “Bank account recon options” screen to exit (close) these 
screens).
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M.3- TROUBLESHOOTING DIFFERENCES

If there is a difference between the reconciled balance and the balance according to TurboCASH, there is an 
error, in the “Payments” or the “Receipts” journals. Search for the error and correct it.

A few examples that can possibly cause a difference:

• Your closing bank balance is incorrectly entered on the “Reconcile bank account” screen 
(Reconciliation option (Action ribbon)); or on the “Bank account recon options” screen.

• Incorrect date entered ("Include items until" field) on “Bank account recon options” screen.

• Errors in posting – these errors should have been detected when your bank reconciliation
was done.

If everything else fails you may sometimes have to look at your Cash-book and link up the source 
documents to check if you have entered all your transactions correctly. You could also have 
posted an amount incorrectly e.g. as 64,00 and entered it as 46,00.  

You may need to print the posted batch transactions for the period on the following options to 
trace the errors: 

• Print a “Batch transactions per period” report for the Payments and Receipt batch and the 
(Reports → Batch entry (Reports ribbon)) (select the period of your Bank reconciliation).

• Print a “Batch transactions type report – Posted batches” report for the Payments batch 
and / or Receipts batch (Batch entry - Posted batches tab (Action ribbon)). Select the 
correct batch and double-click on it. Click on the Print button.  

• Print transaction reports for the Bank account. (Reports → Ledger → Transactions / 
Transactions – Standard / Transactions – Extra details (Reports ribbon). 

TurboCASH5.1 – 2018 – Accounting Made Easy - 309



MODULE N - BUDGETING

IN THIS MODULE

MODULE N - BUDGETING......................................................................310
N.1- BUDGETING...........................................................................................................................312
N.2- ENTERING THE BUDGET FIGURES...................................................................................313
N.3- ENTERING A BUDGET FOR SPECIAL EVENTS................................................................315
N.4- PRINTING BUDGET REPORTS...........................................................................................316

N.4.1- Printing budget listing reports......................................................................................316
N.4.2- Printing budget listing report from the T-Ledger viewer..............................................317

N.5- PRINTING BUDGET PERFORMANCE REPORTS............................................................318
N.5.1- Printing the Budget vs actual report............................................................................319

N.5.1.1- Exporting the Budget vs actual report................................................................321
N.5.1.2- Printing the Exported Budget vs actual report....................................................322

N.5.2- Printing the Budget vs actual (3 Periods) report ........................................................325



MODULE N - BUDGETING

N.1- BUDGETING

The budget feature is used to enter and edit budget figures in TurboCASH, which can be 
compared with actual income and expenses. Budgets are a guide as to what you want to achieve; 
for instance what income you expect to generate (sales forecasts and income from other sources) 
and a plan for your expenses you need to incur to achieve that income. Budget figures can be 
flexible so as to take into account seasonal trends in business. 

Budget figures can be added for all accounts, except the following accounts:

1. Main accounts – Budget figures need to be entered for each sub-account.

2. Debtor's control account – Need to enter Credit Limits for each debtor (customer / 
client) account on the Accounting information tab (Debtors (Action ribbon)). 

3. Creditor's control account – Need to enter Credit Limits for each creditor (supplier) 
account on the Accounting information tab (Creditors (Action ribbon)).

Budget figures can be added for the following features (extra columns will be added in the 
Budget tab of the Accounts (Action ribbon):

• Cost centres – Cost centre 1 and 2 added in Groups - Cost centre 1 / 2 (Setup ribbon).

• Projects – Projects added in the Groups – Projects (Setup ribbon), and if activated.

Budget figures are displayed on the following options and / or reports:

• T-Ledger analyser  (Reports ribbon). 

• User reports – If User reports were designed to print budget figures.

For the purpose of this tutorial, we need to enter the following budget:

ACCOUNT ALLOCATION DESCRIPTION ANNUAL MONTHLY
010-000 Sales -120 000 -10 000
100-000 Cost of sales 48 000 4 000
GROSS PROFIT 72 000 6 000
200-000 Bank charges 480 40
205-000 Depreciation 600 50
210-010 Fuel & oil 1 200 100
210-020 Maintenance 1 800 150
210-030 Repairs 2 400 200
220-000 Rent 6 600 550
225-000 Salaries 6 000 500
230-000 Stationery 120 10
TOTAL EXPENSES 19 200 1 600
NET PROFIT -52 800 -4 400
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Cost of sales and Gross Profit are only applicable to Trading stock in MODULE K. 

If you do not deal with Trading stock and do not wish to complete MODULE K, enter the amounts (for the 
purpose of this tutorial) as follows:

• Sales account figure as -72 000 instead of -120 000.  
• Cost of sales account – Do not enter any figure

 Net Profit should still be 52 800 for the year and 4 400 for March. 

The net profit need not be entered, as it will automatically be calculated.

N.2- ENTERING THE BUDGET FIGURES

To enter your budget figures: 

1. On the Action ribbon, select Accounts. 

2. Select the first account, i.e. “Sales” and enter the budget figure. Enter the annual amount 
of –120 000 in the “Total period budget” field.

3. Click on the Set period budget button. A confirmation message ”Delete old budget for 
year 2018?” will be displayed.

4. Click on the Yes button to delete and replace the budget figures for the year. 
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The – sign will display the amounts as credit figures on all reports, etc. 
For a debit amount just insert the annual amount without the “–“. The amount will automatically 
be divided this amount into 12 months in the debit or credit fields, depending on whether a “–“ or 
Credit sign have been entered in the “Amount” field. 

Each month can be overwritten so that the budget can be flexed month by month to 
accommodate seasonal trends and spending patterns of your business. The system will keep a 
running total for you, so that as you are flexing the monthly budget, you can see the effect on the 
annual amount.   
Budget figures can also be entered for Balance sheet accounts (Capital, Liabilities and Assets), 
which may be used as a guideline to control the balances on these accounts.

5. Click on the Save button (next to the “Account no.” field). 

If you do not click on the Save button, any budget figures entered, or changed, will not be saved. 

6. Select the next account and enter the budget figure. 

7. Continue on your own using the budget on the previous page until you have completed 
entering your budget figures. 

8. When you are finished entering all your budget figures, click on the Close button (on the 
titlebar).
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N.3- ENTERING A BUDGET FOR SPECIAL EVENTS

On 31 May 2018 we need to budget 5 000,00 extra sales for a special promotion sale. You may 
enter budget figures for specific dates and / or periods.

To enter budget figures for special events:

1. On the Action ribbon, select Accounts.

2. Select the “Sales” account. On the Budget tab, click on the  button to create a new 
record.

3. The system date will automatically be displayed. Enter or select the date (i.e. 
“2018/05/31”) for the special event.

4. Enter the amount for the  budget (i.e. “–5 000” ) in die “Amount” column.

5. Enter the reference (i.e. “Sale”) in the “Reference” column.

6. Enter the description (i.e. “Special promotion” ) in die “Description” column.

7. Click on the  button to save the new budget for “2018/05/31”.

8. Click on the Save button.

If you do not click on the Save button, these budget figures, or any changes will be lost.

TurboCASH5.1 – 2018 – Accounting Made Easy - 315



MODULE N - BUDGETING

N.4- PRINTING BUDGET REPORTS

Once any budget figures are entered or edited (and saved) (Accounts (Action ribbon)), these 
figures will automatically be updated to the applicable accounts and will be available in the T-
Ledger analyser and any reports which supports budget figures.

Budgets may be viewed, printed and / or exported from the following options:

• T-Account analyser 1 / 2.

• Budget option for the Trial balance, Income statement, Balance sheet and Standard 
column balances.

• Budget vs actual.

• T-account viewer (Budget listing).

• Budget vs actual (3 periods) (Reports ribbon - Reports → Ledger → Budget).

N.4.1- Printing budget listing reports

This option, if selected, will list only the budget figures (Budget listing) in the Trial balance, Income
statement, Balance sheet and Standard column balances report types. 

To view and analyse budget listing:

1. On the Reports ribbon, select T-Ledger analyser 1. 

2. Select the “Budget” option (tick). This option is available for the Income statement, Trial 
balance and Balance sheet report type.
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3. Select the period from 2018/03/01 to 2018/03/31 to view the budget figures for a 
specific period, e.g. “March 2018”.

To view the annual budget figures; select the period from 2018/03/01 to 2019/02/28.

4. Click on the Report button to refresh and generate the budget figures.

To view the budget figures for sub-accounts, e.g. click on the + icon next to G210-000 Motor 
vehicle expenses. This will display the figures for each sub-account.

5. If any of these budget figures need some adjustment, click on the Accounts (Action 
ribbon); select the applicable accounts and edit or enter the necessary figures. 

6. Click on the Print button. 

The example of the Tail balance, listing the budget for March 2018, is as follows:

N.4.2- Printing budget listing report from the T-Ledger viewer

To print a list of budgets in the T-Account viewer:
1. If the Budget option is selected on the Trial balance, Income statement, Balance sheet 

and Standard column balances report types in the T-Ledger analyser 1 or 2, you may 
right-click and click on the Show details option. This will display the budget figures in 
the T-Account viewer. 

2. Select the dates (e.g. from “2018/03/01 to 2019/02/28” from and to to include in the 
budget figures, if necessary. 
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3. Click on the Print button. You may also click on the Export button to export the budget 
figures to a spreadsheet.

N.5- PRINTING BUDGET PERFORMANCE REPORTS

The following two (2) reports are available to print budget vs actual figures:

1. Budget vs actual report (T-ledger analyser 1 / 2). 

2. Budget vs actual (3 periods) report (Reports → Ledger → Budget (Reports ribbon).
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N.5.1- Printing the Budget vs actual report

This report will display the following:
1. Trial balance – The actual figures on the Trial balance - totals of transactions as posted 

(updated to the ledger) in batches (journals), sales documents (i.e. Invoices, Point-of-Sale 
Invoices and Credit notes) and purchase documents (i.e. Purchases and Supplier returns). 

2. Budget – Once any budget figures are entered or edited (and saved), these figures will 
automatically be updated to the applicable accounts and will be available in the T-Ledger
analyser and any reports which supports budget figures.

3. Difference – The difference amount actual trial Trial balance vs the Budget figures. 
4. Percentage – The difference expressed as a percentage. 

To print a budget vs actual report:
1. On the Reports ribbon, select T-Ledger analyser 1 or 2. 
2. Select the “Budget vs actual” report type. This option is available for the Income / 

Expenses, Trial balance and Balance sheet report type.

3. To view the annual budget figures; select “Year” and the period from 2018/03/01 to 
2019/02/28.
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Select the period from 2018/03/01 to 2018/03/31 to view the budget figures for a specific period, 
e.g. “March 2018”.

4. Click on the Report button to refresh and generate the budget figures.

To view the budget figures for sub-accounts, e.g. click on the + icon next to G210-000 Motor 
vehicle expenses. This will display the figures for each sub-account.

5. If any of these budget figures need some adjustment, click on the Accounts (Action 
ribbon); select the applicable accounts and edit or enter the necessary figures. 

6. Click on the Export button. 
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N.5.1.1- Exporting the Budget vs actual report

If you click on the Print button, an error “Type conversion error 'Val':Expression TrpExpression46” will be 
produced when printing the “Budget vs Actual” and “This year vs Last year” report if transactions are posted 
(updated) to the ledger, e.g. HANDYMAN-B. 

These two reports can print on all Sets of Books which does not have any posted transactions, e.g. 
HANDYMAN, HANDYMAN-A.

This will create an “Export.txt” file which you may save with any name, to any location (file or 
folder) on your system.

If your system's default App for Spreadsheets, is configured correctly, it will open the file automatically in the 
default Spreadsheet App, e.g. Excel, OpenOfficeCalc, etc.  

In this example, Notepad, is the Default app for Comma Separated Value (*.csv) files.
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N.5.1.2- Printing the Exported Budget vs actual report

Opening and printing the “Budget vs Actual” report in a Spreadsheet. 

1. Locate the saved file, e.g. “Export.txt” file on your system and right-click.

2. Select “Open with...” and the Spreadsheet App.

3. The selected exported report file will be opened in the selected Spreadsheet, e.g. 
OpenOfficeCalc.

4. On the “Text Import” screen, the “Tab” option in the “Separated by” section should be 
selected. 
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5. The report file should display as follows:

You may wish to edit some formatting. In this case, the amount columns are aligned to the right.

6. Set the print range and print the report. 
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An example of the printed exported "Budget vs actual" report, is as follows:
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N.5.2- Printing the Budget vs actual (3 Periods) report 

The Budget vs Actual (realisation - 3 periods) report lists the Income and Expense account 
balances and budget figures for three (3) periods as comparative figures. 

Only the transactions in documents and batches which are posted (updated) to the ledger will be 
included in this report.

Budget figures are entered and edited in the Accounts (Action ribbon). 

If you have activated Cost centres and have entered the budget figures for Cost centres, you may 
select (tick) the Cost centres to print this report for your Cost centres.    

To print a Budget vs actual (3 periods) report: 

1. On the Reports ribbon, select Reports → Ledger → Budget.  

2. Select the following options: 

a) Period - Select up to three (3) periods on the Per period tabs. You may click on the 
Free selection tab to select a specific date or a range of dates to include balances 
and budget figures in the report. 

b) Include zero balances - If this option is not selected (not ticked), it will list only the 
expense and income accounts which has balances and / or budget figures. Tick this 
option to include all accounts including those with no actual transactions and / or 
budget figures).

c) Balances - If this option is not selected (not ticked), it will list the expense and 
income accounts which has balances and / or budget figures. Tick this option to 
show only the actual transactions totals and / or budget totals of expense and 
income accounts for the selected period or dates.
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d) Cost centre 1 - Will be listed if you have activated Cost centres and created Cost 
centre 1 (Groups (Setup ribbon)). You may select any of these Cost centres, to 
include in the report. 

e) Cost centre 2 - Will be listed if you have activated Cost centres and created Cost 
centre 2 (Groups (Setup ribbon)). You may select any of these Cost centres, to 
include in the report. 

3. Click on the OK button. 

The Budget vs actual (realisation - 3 periods) report, should be displayed as follows:

The details, is as follows: 

1. Header section - Report name and Periods as selected on the Periods in the “Report 
options / parameters” screen.

2. Expenses - A list of the accounts (created as Income and Expense account type and 
linked to the Expenses group / financial category). If the “Include zero balances” field is 
selected (ticked), all expense accounts will be listed (including those accounts with no 
actual transactions and or budget figures. If the “Balances” field is selected (ticked), only 
the “Total - *Expenses” will be displayed.
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3. Income - A list of the accounts (created as Income and Expense account type and linked 
to the Income group / financial category). If the “Include zero balances” field is selected 
(ticked), all income accounts will be listed (including those accounts with no actual 
transactions and or budget figures). If the “Balances” field is selected (ticked), only the 
“Total - *Income” will be displayed.

4. Totals -

a) Net Profit / Net Loss: Actual - This is the total of the Expenses less the Income 
totals for posted batches and documents. A negative figure indicates a Net Profit 
and a positive figure displays a Net Loss for the selected periods (dates). 

b) Net Profit / Net Loss: Budget - This is the total of the Expenses less the Income 
totals for the budget figures as entered / edited (Accounts (Action ribbon)). A 
negative figure indicates a Net Profit and a positive figure displays a Net Loss for the
selected periods (dates).

c) Net Profit / Net Loss: Actual - Budget - This is the total of the Net Profit / Net 
Loss: Actual less the Net Profit / Net Loss: Budget totals. A negative figure 
indicates that the posted batches and documents exceeds (overspend) the budget 
figures for the selected periods (dates).  A positive figure indicates that the posted 
batches and documents is less than the budget figures (available) for the selected 
periods (dates).
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INTRODUCTION TO REPORTS

O.1- INTRODUCTION TO REPORTS

The Tax authorities may impose changes in the VAT (GST/Sales tax) rates. For example, in South Africa, 
the South African Revenue Services (SARS), changed the VAT rate from 14% to 15% on 1 April 2018. 

This MODULE, the reports includes VAT based on 14% tax for taxable transactions up to 31 March 2018 
and 15% for taxable transactions as from 1 April 2018. 

TurboCASH allows you to generate a wide range of standard reports, each with various options to 
select. These reports are an exceptionally powerful tool for use in managing and controlling all 
aspects of your business. Reports are grouped into the various types. All reports are generated on 
the Reports tab. 

O.2- OPTIONS TO PRINT REPORTS

As the principles to generate reports are basically the same on all report option / parameter 
screens, it is a good idea to discuss the output media ("Send report to") in this chapter. To print a 
report, click on the Reports ribbon and select the specific report you wish to print. You can 
generate these any of these reports on the following mediums:

Send report to Brief description
Screen Displays the report on your screen, from where you can page and scroll through the 

report. You may also print the report or save it after you have previewed it.
Printer Prints the report directly to the printer specified in the Printer icon (Setup ribbon).
File TurboCASH Report Export utility allows you to Save the report in a directory and in 

certain formats, you specify. 
E-mail Send the report over the Internet as an e-mail message.
Fax Send the report as a Fax to a specified recipient.
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O.2.1- Send to - Screen

The “Reportman preview” screen is displayed when printing a report to the screen. Reports and 
Documents are stored in the following directories (folders): 

Reports - ...\plug_ins\reports\systemreports 

Documents -  ...\plug_ins\reports/DOCUMENTS/DOCUMENTS 

The icons are grouped into five (5) sections (i.e. Navigation, Output, Settings, Zoom and Search)
and the Close button. These icons are as follows: 

1. Navigation - 

a) First (Home) – Goes to the first page of the report. 

b) Previous (Page up) – Goes to the previous page of the report. 

c) Page number – Displays the page number of the page in the “Report preview” 
screen. You may enter a specific page number and hit the Enter key on your 
keyboard to jump to that specific page. 

d) Next page (Page down) – Goes to the next page of the report. 

e) Last page (End) – Goes to the last page of the report.

2. Output - 

a) Print (Ctrl+P) – This will launch the “Print” screen. You may select another 
printer (than your system's default printer), select a specific page and change 
the number of copies, if necessary. 

b) Save (Ctrl+S) – This will launch the “Save Metafile as” screen. On this screen, you
need to do the following where necessary: 

i) Select the directory (folder) where you need to save this file, if 
necessary. 
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ii) Enter a file name. 

iii) Select a file type if another file type than the default file type (PDF file –
Compressed) is required. The following Report meta file types are 
available: 

- *.rpmf Report Metafile
*.pdf PDF file – Compressed 

- *.pdf PDF file – Uncompressed (default) 
- *.xls Excel file 
- *.xls Excel file (one sheet) 
- *.txt Text file 
- *.bmp Bitmap file 
- *.html Html file 
- *.html Html file (single)
- *.svg Scalable Vector Graphics file
- *.csv Comma Separated Value file 
- *.txt Custom Text file 
- *.rpmf Executable Meta file uncompressed
- *.exe Executable meta file 

Microsoft Excel (Office) required to save reports (Save report as a meta file report from
the “Reportman Print preview” screen) to an Excel spreadsheet or Excel (one sheet) 
spreadsheet (*.xls).

c) E-mail (Ctrl+E) – This will generate a Portable Document Format (pdf) file. It will
also launch a blank E-mail message (using your system's default e-mail 
program) and insert the report (or document) as an attachment. 

The name of the report (or document) is automatically generated (for example, 
REPC526.pdf). It will also automatically be inserted in the “Subject” field and displayed
in the titlebar of the e-mail message. 
It is recommended that you add your own sensible subject to this in the “Subject” field.
You still need to select a recipient (and other recipients, if necessary) and type a 
message before clicking on the Send button. 

3. Settings - 

a) Show report page setup (F11) – This will display a “Dialog” screen on which 
you may do the “Page setup, Print setup” and “Options” (i.e. select the “Preferred 
save format”). 

b) Show report parameters (F12)- This is the selection or options screen, on 
which you may select the options to include or exclude data in the report. 

Should the report have no report parameters (when it prints directly when you click 
on the Print button of the “Reportman” screen), the report has no options to change. 
This icon will then be inactive. 
If the report has an active Report parameters icon, you may click on it to change the 
report parameters. This will change the content of the report. 
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4. Zoom - 

a) Shows the report in real size (F6) – This will display the report in the actual 
size when it is printed.

b) Adjusting the paper to fit the window width (F7) – The report will be 
stretched to fit the entire Preview window. If you resize the report (e.g. click on 
the Maximize button or on the Restore down button of the “Reportman preview”
screen's titlebar), it will automatically be resized. 

c) Scale to full page (F8) – This will display the full page (length and with) in the 
window. 

d) Zooms out the view (- numeric keypad) – Each click will reduce the size. 

e) Zooms in the view (+numeric keypad) – Each click will increase the size. 

5. Search (Ctrl+F3) - 

Enter text, numbers, amounts, special characters, etc. to find the matching results in the 
report. 

To close the “Reportman preview” screen, click on the Close button. Alternatively, click on the 
Close button of the “Reportman preview” screen's titlebar. 

O.2.2- Send to - Printer

If you have selected the  "Send report to" Printer option and you click on the OK button, the 
report will be printed automatically by the printer you have selected in the Printer icon (Setup 
ribbon), without having a chance to preview the report. If you wish to print more than one copy of 
the report, you may select the number of copies to be printed before you click on the OK button. 
For all the other report output options, you cannot select the number of copies, since they will 
only be generated in 1 copy. 

O.2.3- Send to - File

If you have selected the "Send report to" File option and you click on the OK button, the very same
“TurboCASH Report Export” screen as discussed above will be displayed. You will not be able to 
preview the report before you can save it.

O.2.4- Send to - E-mail

If you have selected the "Send report to" E-mail option and you click on the OK button, the 
“Sending E-mail and Fax report “screen will be displayed. Your e-mail should already be set up in 
the Setup → Internet (Setup ribbon). Enter the subject and select the e-mail address from your 
address book and click on the Send button. 
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O.2.5- Send to - Fax

If you have selected the "Send report to" Fax option and you click on the OK button, the “Sending 
E-mail and Fax report” screen will be displayed. Your Fax drivers should already be set up in your 
Windows operating system. 

In addition to these reports, which you can use, you also have the further option as to export these
reports or data in these reports via the Export utility to further analyse your data in spreadsheets, 
word processing, presentation programs, etc. You can use the reports and exported data to draft 
powerful presentations, business plans, etc.

O.3- REPORTS IN THE T-LEDGER ANALYSER

All processed (posted) transactions will be accumulated in the T-Ledger analyser. There are various
ways in which the transactions may be viewed, exported and analysed. 
The options, is as follows:

1. Transactions and balances – These are the balances of transactions as posted (updated 
to the ledger) in batches (journals), sales documents (i.e. Invoices, Point-of-Sale Invoices 
and Credit notes) and purchase documents (i.e. Purchases and Supplier returns). 
There are six (6) report types, which may be selected (i.e. Trial balance, Income statement,
Balance sheet, Standard column balances, Budget vs actual and This year vs last year) 
which may be printed and exported to spreadsheets.
In addition to this, there are 6 report types which may be exported to spreadsheets (i.e. 
Column balances, Column balances Debit/Credit, Column balances debtor, Column 
balances creditor, Column balances debtor Debit/Credit, and Column balances creditor 
Debit/Credit.)

2. Budget – Budget figures as entered in the → Accounts (Action ribbon). This option, if 
selected, will list only the budget figures (Budget listing) in the Trial balance, Income 
statement, Balance sheet and Standard column balances report types. The Budget vs 
Actual is the budget performance report. It will list and compare the budget figures 
versus the actual posted (updated) transactions.

3. T-Account viewer – You may select a specific account, group, etc. to view the 
transactions in the T-Account viewer. To do this, right-click on a selected account, and 
select the “Show details” option on the context menu.

The T-Account viewer may also be selected on the Reports → T-Account viewer menu. When launching it 
from the Reports ribbon, you may select the following: 

• Account – Select a specific account.
• From date and To date – Select a specific date or a range of dates to view data.  
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 You may click on the following to get specific views of transactions:
• Batch number (e.g. 10012, etc. automatically generated). This will list only the transactions for a 

specific batch (journal). 
• Account code (e.g. G010000 Sales, B810000 ABC - Bank, T850010 Input VAT/GST/Sales tax, etc.). 

This will list the transactions for a specific account.
• Date – This will list the transactions for a specific date. If you double-click on a date, the “From 

date” and “To date” will be changed to the selected date.

To print reports in the T-Ledger analyser:

1. On the Reports ribbon, select T-Ledger analyser 1 / 2.

2. Select the following options:

Option Description 

Report type: 1. Trial balance – List of all accounts in the chart of accounts. This will include:

•  - Income / Expense; 

•  - Asset / Liability / Capital accounts; 

•   - Retained earnings / income; 

•   - Debtor's control; and

•   - Creditor's control accounts.

2.  Income /  Expenses  – List only those accounts  which is reported on the 
Income statement.

3. Balance sheet – List only those Accounts, which is reported in the Balance sheet. 
This will include: 

•  - Asset / Liability / Capital accounts; 

•   - Retained earnings / income; 

•   - Debtor's control; and 

•   - Creditor's control accounts).
4. Standard column balances – Lists the debit and credit account balances in the 

Trial balance and the Income statement and Balance sheet accounts in separate 
columns.

5. Budget vs actual – Lists the budget figures entered in the Accounts (Action ribbon)
versus the actual totals of all transactions in posted batches and documents. 

6. This year vs last year – This will list the actual totals of all transactions in posted 
batches and documents in this year periods versus the actual totals of all 
transactions in posted batches and documents posted to last year periods 
(previous financial years). 
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Option Description 

7. Column balances – Lists all accounts in a spreadsheet view. These are the 
Accounts reported in the Trial balance (this includes both the accounts reported in
the Trial balance, Income statement and Balance sheet).

8. Column balances debtors – Lists the balances of all accounts which is created and
maintained in the Debtors (Action ribbon) in a spreadsheet view. The total of 
these accounts are reported in the Debtor's control account on the Trial balance 
and the Balance sheet.

9. Column balances creditors – Lists all accounts which is created and maintained in
the Creditors (Action ribbon) in a spreadsheet view. The total of these accounts 
are reported in the Creditor's control account on the Trial balance and the 
Balance sheet.

10. Column balances D/C – Lists all debit and credit account balances in a 
spreadsheet view. These are the Accounts reported in the Trial balance (this 
includes both the accounts reported in the Trial balance, Income statement and 
Balance sheet).

11. Column balances debtors D/C – Lists the debit and credit account balances of all 
accounts which is created and maintained in the Debtors (Action ribbon) in a 
spreadsheet view. The total of these accounts are reported in the Debtor's control 
account on the Trial balance and the Balance sheet.

12. Column balances creditors D/C – Lists all debit and credit account balances which
is created and maintained in the Creditors (Action ribbon) in a spreadsheet view. 
The total of these accounts are reported in the Creditor's control account on the 
Trial balance and the Balance sheet.

Budget: This will list all accounts for which budget figures were entered (and / or edited) in the 
Accounts (Action ribbon).

Cost centre 1 / 2: The Cost centres (2 Groups) will only be available, if Cost centres are added in Groups (Setup
ribbon); and if activated.

Groups: Select one of the following options:
• None – This is the default. This will list all accounts for the selected Report type 

according to the Account numbers (codes) in numerical order. 
• Reporting group 1 – Lists all accounts according to the Account reporting group 1 

as created in Groups (Setup ribbon). 
• Reporting group 2 – Lists all accounts according to the Account reporting group 2 

as created in Groups (Setup ribbon). 
Reporting group 1 and 2 – The sequence in which the groups and accounts are listed, may 
be changed in Groups. (Setup ribbon).
This is done by selecting the groups on the list and use the Move up or Move down buttons. 

Period: Select “Per period” or “Free selection”
• Per period – Select a period (Month, 2 Months, 3 Months, 4 Months, 6 Months 

or Year.
• Free selection – You may select or enter any date or dates. 
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Option Description 

From:
To:

The periods will automatically filter and display the periods matching the selected option in 
the “Per period” radio buttons.  
On the “Free selection” tab, you may select any date or dates in the “From date” and “To 
date” fields. 

Ignore zero 
balances:

If this field is not selected, all accounts will be listed for the selected reports type. If you select 
(tick) this field; only those accounts with balances will be included in the report.  

Include opening 
balances:

If this option is selected (ticked), it will include the opening balances of those accounts which 
have opening balances.  If this option is not selected; the opening balances will not be 
included in the report.    

Opening balances 
only: 

If the “Include opening balances” option is not selected; this option will not be displayed.  If 
this option is available; you may select (tick) this option to include only the opening 
balances. All other balances will then be ignored. 

Report button: This will generate the report as per your selection of the report parameters. 

Export button: This will export the report to a comma separated value (*.csv) file format. The exported data 
will automatically be opened in your system's default spreadsheet (if configured) e.g. Excel.   

Print button: Click to print the report. 

3. Select a group or account and right-click on it. On the context menu, select the “Show 
details” option. This will launch the T-Account viewer. 

The T-Account viewer may also be selected on the Reports → T-Account viewer menu. 

How to print the trial balance, income statement and balance sheet are discussed in detail. It is a good idea 
to look through each report, making sure that you understand it. 
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O.3.1- Trial balance

The Trial balance will reflect all your accounts (Accounts (Action ribbon)), which were created as 
Balance and Income / Expenses type for the Ledger, Bank and Tax account types.

To print a trial balance:

1. On the Reports ribbon, select T-Ledger analyser 1 or T-Ledger analyser 2. 

2. Select the following options:
Report type:  Select “Trial balance”.
Per period:  Click on the “Month” option and select “2018/03/01 – 2018/03/31”.  

You may also click on the Free selection tab and enter or select the dates in 
the “From date” and “To date” fields.

Groups:  Select Reporting group 1. 
Ignore zero balances:  Select (“tick”) this option, to list only the balances of the accounts we 

have entered for the selected period. 
If this option is not selected (“not ticked”), all accounts listed in your chart of
accounts will be displayed and balances will be listed. 

Viewer Debtors / 
Creditors  Remove the “tick” to list only the totals of the Debtor's and Creditor's 

control accounts. 
If this field is selected, “ticked” it will list the totals of the individual Debtor 
and Creditor accounts.

TurboCASH5.1 – 2018 – Accounting Made Easy - 337



MODULE O - REPORTS

Include opening 
balances:  Do not select (“tick”) this option, to list only the balances of the 

accounts we have entered for the selected period. 
If this option is selected (“ticked”), the opening balances entered in MODULE
H will be included in the report.  

Opening balances 
only:  Do not select (“tick”) this option, to list only the balances of the 

accounts we have entered for the selected period. 
If this option is selected (“ticked”), only the opening balances entered in 
MODULE H will be included in the report.  

3. Click on the Report button. 

4. Click on the Print button. An example of the printed report, is as follows:

Page 1 -
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Page 2 -

The net profit should be as follows if the following MODULES are completed and posted:
MODULE A–J and MODULE M -“Month - 2018/03/01 – 2018/03/31” 6 845,00
MODULE A–K and MODULE M -“Year - 2018/03/01 – 2019/02/28”   9 845,00

The Cost of sales were introduced in this tutorial in MODULE K – April 2018. It will therefore not be included 
in March 2018. It should be included if the report is printed to include April 2018. 

In this tutorial, a Net profit should be printed. 
Should you make a Net loss, the Net profit label will change to Net loss and will be displayed in a Red font 
colour on the screen, as well as the printed report in the “Reportman preview” screen.
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O.3.2- Income statement

The Income and Expenses report will reflect all your accounts (Accounts (Action ribbon)), which 
were created as Income / Expenses type for the Ledger account type.

To print an income statement:

1. On the Reports ribbon, select T-Ledger analyser 1 or T-Ledger analyser 2.

2. Select the following options:
Report type:  Select “Income statement”.
Per period:  Click on the “Month” option and select “2018/03/01 – 2018/03/31”.  

You may also click on the Free selection tab and enter or select the dates in the 
“From date” and “To date” fields.

Groups:  Select Reporting group 1. 
Ignore zero 
balances:  Select (“tick”) this option, to list only the balances of the accounts we have 

entered for the selected period. 
If this option is not selected (“not ticked”), all Income and Expense accounts listed in 
your chart of accounts will be displayed and balances will be listed. 

3. Click on the Report button. 

4. Click on the Print button. 
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An example of the printed report, is as follows:

TurboCASH5.1 – 2018 – Accounting Made Easy - 341



MODULE O - REPORTS

O.3.3- Balance sheet

The Balance sheet will reflect all your accounts (Accounts (Action ribbon)), which were created as 
Balance type for the Ledger, Bank and Tax account types.

To print a balance sheet:

1. On the Reports ribbon, select T-Ledger analyser 1 or T-Ledger analyser 2. 

2. Select the following options:
Report type:  Select “Balance sheet”.
Per period:  Click on the “Month” option and select “2018/03/01 – 2018/03/31”.  

You may also click on the Free selection tab and enter or select the dates in the 
“From date” and “To date” fields.

Groups:  Select Reporting group 1. 
Ignore zero 
balances:  Select (“tick”) this option, to list only the balances of the accounts we have 

entered for the selected period. 
If this option is not selected (“not ticked”), all Balance sheet accounts listed in 
your chart of accounts will be displayed and balances will be listed. 
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Viewer Debtors /
Creditors  Remove the “tick” to list only the totals of the Debtor's and Creditor's 

control accounts. 
If this field is selected, “ticked” it will list the totals of the individual Debtor and 
Creditor accounts.

Include opening 
balances:  Do not select (“tick”) this option, to list only the balances of the accounts we

have entered for the selected period. 
If this option is selected (“ticked”), the opening balances entered in MODULE H 
will be included in the report.  

Opening 
balances only:  Do not select (“tick”) this option, to list only the balances of the accounts we

have entered for the selected period. 
If this option is selected (“ticked”), only the opening balances entered in MODULE
H will be included in the report.  

3. Click on the Report button. 

4. Click on the Print button. 

An example of the printed report, is as follows:

The net profit should be as follows if the following MODULES are completed and posted:
MODULE A–J and MODULE M -“Month - 2018/03/01 – 2018/03/31” 6 845,00
MODULE A–K and MODULE M -“Year - 2018/03/01 – 2019/02/28”   9 845,00

The Cost of sales were introduced in this tutorial in MODULE K – April 2018. It will therefore not be included 
in March 2018. It should be included if the report is printed to include April 2018. 
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In this tutorial, Net profit should be printed. 
Should you make a Net loss, the Net profit label will change to Net loss and will be displayed in a Red font 
colour on the screen, as well as the printed report in the “Reportman preview” screen.

O.4- LEDGER REPORTS

The following reports are available to manage all the accounts in the general ledger:

1. Budget – Budget vs actual (3 periods) This report lists
the Income and Expense account balances and budget
figures for three (3) periods as comparative figures. 

2. Graph - Profit / Loss per week - Net Profit and Loss per
week in a bar chart.

3. Listing - List the General ledger accounts (Chart of
accounts).

4. Transactions - Transactions, Transactions - Standard and
Transactions - Extra details.

O.5- DEBTOR REPORTS

The following reports are available to manage the accounts in the debtor's ledger: 

1. Graph - Debtors per week - Invoices and Debit
transactions, Credit notes and Credit transactions as well
as the difference per week in a bar chart.

2. Age analysis - Various age analysis reports.

3. Listing - Contacts, Listing, List delivery address, List
postal address or List details, Tax and company
registration numbers and the Credit control listing (Credit
limit vs current balance and available balances as at the
date and time of printing) report.

4. Print labels - Postal and delivery address labels.

5. Transactions - Transactions - Open item, Transactions -
Standard and Transactions - Extra details.

6. Outstanding – Debtor statements, Debtor statements – Outstanding, Due date and 
Outstanding at date.
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O.6- CREDITOR REPORTS

The following reports are available to manage the accounts in the creditor's ledger: 

1. Graph - Creditors per week - Purchases and Credit
transactions, Supplier returns and Debit transactions as
well as the difference per week in a bar chart.

2. Age analysis - Various age analysis reports.

3. Listing - Contacts, Listing, List delivery address, List postal
address or List details, Tax and company registration
numbers and the Credit control listing (Credit limit vs
current balance and available balances as at the date and
time of printing) report.

4. Print labels - Postal and Delivery address labels.

5. Transactions - Transactions - Open item, Transactions -
Standard and Transactions - Extra details.

6. Outstanding – Remittance advice, Remittance advice – Outstanding, Due date and 
Outstanding at date.

O.7- BATCH REPORTS

Batch reports for unposted batches may be printed from the F8:List option on the “Batch entry” 
screens. 

Once a batch or a document is posted (updated), batch reports may be printed from the following
options:

• Reports → Batch entry menu (Reports ribbon).

• Batch entry – Posted batches tab (Action ribbon).

• Reverse posted batch/document – Details tab – (Tools → Global processes menu 
(Setup ribbon)).

O.7.1- Batch reports (Reports menu)

The following two (2) reports are available:

1. Batch transactions per period – Print the transactions of posted invoices, credit notes, 
purchase and supplier return documents as well as posted batch transactions (i.e. sales 
journal, purchase journal, payments journals, receipts journals, general journals, etc.) for a
specific selected period and for a selected batch type.

2. Batch type report – Documents - Print the transactions of all posted invoices, credit 
notes, purchase and supplier return documents for a specific selected period.
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O.7.1.1- Batch transactions per period report

Print the transactions of posted invoices, credit notes, purchase and supplier return documents as 
well as posted batch transactions (i.e. sales journal, purchase journal, payments journals, receipts 
journals, general journals, etc.) for a specific selected period and for a selected batch type.

To print a batch transactions per period report:

1. On the Reports ribbon, select Reports → Batch entry. Documents (listing the batch 
transactions generated by documents only) is by default displayed. 

2. Select “Batch transactions per period” report.

3. Select the following options: 
Per period:  Tick on “2 Months” and select “2018/03/01 - 2018/04/30”
Batch entry:  Select “Sales jnl.”
Show balancing entries:  Leave blank. By default, this option is not selected. It will only list 

the transactions entered into batches and / or the totals of 
documents and totals for each amount column. If this option is 
selected, it will list all the balancing entries.  

Each period separately:  Select (tick) this option to print each period on a new page.

4. Click on the OK button. 
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An example of the “Batch transactions per period” report, is as follows: 

Page 1 - 

Page 2 -
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This report will list the following:

1. Batch no. - The batch id or number as automatically generated. 

2. Date – Date of the transaction. 

3. Alias – In the case of documents, the document number will be listed. In the case of 
batch transactions, the Alias as entered on each “Batch entry” screens will be displayed. If 
no Alias is entered on “Batch entry” screens, the Alias (Batch name) will be the same as 
the Batch type).

4. Account – The account which was selected for documents or in the Account lookup on 
“Batch entry” screens.

5. Contra account - The account which was selected as the Contra account on the 
F10:Setup on “Batch entry” screens. 

6. Tax account column – Tax account code.

7. Debit column – Debit transaction amount.

8. Credit column – Credit transaction amount. 

O.7.1.2- Batch type report – Documents

Print the transactions of all posted invoices, credit notes, purchase and supplier return documents 
for a specific selected period.

To print a batch type report - documents report:

1. On the Reports ribbon, select Reports → Batch entry. “Documents” (listing the batch 
transactions generated by documents only) is by default displayed. 

2. Select the following options: 
Per period:  Tick on “Month” and select “2018/03/01 - 2018/03/31”
Show balancing entries:  Leave blank. By default, this option is not selected. It will only list 

the transactions entered into batches and / or the totals of 
documents and totals for each amount column. If this option is 
selected, it will list all the balancing entries.  

Each period separately:  Select (tick) this option to print each period on a new page.

3. Click on the OK button. 
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An example of the “Batch type report – Documents”, is as follows:

This report will list the following:

1. Document heading – Document number, Batch type and Reference (as entered in the 
“Your reference” field of “Document entry” screens).

2. Transaction details - 

a) Batch no. – The batch id or number as automatically generated. 

b) Date – Date of the transaction. 

c) Reference – The document number will be listed. 

d) Description – Document number / Your reference (as entered in the “Your reference”
field of “Document entry” screens).

e) Account – The account which was selected for documents.

f) Contra account – The account for the document type. 

g) Tax account column – Tax account code.

h) Tax – Tax amount.

i) Debit column – Debit transaction amount.

j) Credit column – Credit transaction amount. 
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O.7.2- Batch reports for posted batches

If you have entered the aliases (batch name), it will be easy to identify and view or print the correct
batch transactions. 

For example, if “OpenBalances, DopenBalances, COpenBalances” and “Depreciate1803” were not 
entered in the “Change Alias” field of the General journal, these four (4) batches would have been 
displayed as “General jnl”. As per this example,  it is easy to identify the batches as Opening 
Balances for the General ledger (BatchID10027), Debtor Opening Balances (BatchID10034), 
Creditor Opening Balances (BatchID10035) or Depreciation for “March 2018” (BatchID10037). 

To print a posted batch report:

1. Select the Batch type (F2) and select the General jnl (as per example). 

2. Click on the Posted batches tab. The “Batch entry” screen, will display as follows:

3. Double-click on a selected batch. The transactions for the selected batch will be listed.

4. Click on the Print button to print the Posted batch transactions. 
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O.8- TAX REPORTS

The Tax report (Reports → Tax menu) does not include the Sales batch. It only includes Sales documents 
(i.e. Invoices and Credit notes). Transactions on other Batch types may cause similar errors. 

The reason for this, is the “Consolidate balancing” option on the Standard tab of the F10:Setup on the 
“Batch entry” screen. When setting up the batch and the “Consolidate balancing” option is selected (ticked) 
if Tax is enabled in a batch, the following Information message is displayed:

“Consolidating lines and using tax will mess up your tax report! 
Please make sure you do not use tax or do not consolidate lines”

Click on the OK button and click on the F10:Setup icon and deselect (remove the tick from the “Consolidate
balancing” field on the Standard tab of the “Options for this batch” screen. 
Balance the Batch again.

Before you print tax reports to submit your Tax (VAT/GST/Sales tax) returns, you need to post (update) all 
batch transactions and documents (i.e. invoices, credit notes, purchase and supplier return documents) for 
the tax period. 

The following tax reports are available:

1. Tax per period report – This report is used to complete the Tax (VAT/GST/Sales tax) 
returns. It will list a summary of the Output tax less the Input tax and the total tax payable
/ refundable. 

2. Tax report - Reference / Document no. - This report will list the details of accounts and
transactions of all posted (updated) batch and document transactions, on which Tax 
(VAT/GST/Sales tax is applicable. It will display the Tax code and description as well as the
contra accounts for each transaction. 
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3. Tax list debtor with tax id - This report will list a total exclusive of tax, tax amount and 
inclusive amount of tax) for the Invoices less Credit notes for debtor (customer / client) 
accounts for selected period(s) or date(s). It will also display the Company and Tax 
registration numbers for each for debtor (customer / client) accounts. 

4. Tax list creditor with tax id - This report will list a total exclusive of tax, tax amount and 
inclusive amount of tax) for the Purchase documents less Supplier returns for creditor 
(supplier) accounts for selected period(s) or date(s). It will also display the Company and 
Tax registration numbers for each for creditor (supplier) accounts.

The Tax excluded and Tax amount in the Report total of the Tax report - Reference / Document 
no. report, should balance with the Total - Output tax – Input tax of the Tax per period report, if 
the same periods are selected.

It is recommended that these tax reports are printed and archived (PDF) for record and audit 
purposes.

O.8.1- Tax per period report

To print tax per period reports: 

1. On the Reports ribbon, select Reports → Tax. 

2. Select the Tax per period report. The “Tax list debtor with tax id” report is the default 
report.

3. Select the “Tax per period” report.

4. Select the following:
Per period:  Tick on “2 Months” and select “2018/03/01 / 2018/04/30”.
Show details:  Leave blank. By default, this option is not selected. It will only list the totals 

exclusive of Tax (VAT/GST/Sales tax) for each tax code. 
If this option is selected, it will list all transactions and documents including the 
account code, account description, country and tax reference of the debtor or 
creditor account (if applicable). 

Show tax 
separately:  Leave blank. By default, this option is not selected. If this option is selected, 

each tax code will print on a new page. It is recommended, that this option 
should only be selected, when the “Show details” option is selected. 
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For the purpose of this tutorial, we assume that our tax registration certificate indicates that we 
need to pay Tax (VAT/GST/Sales tax) every 2 months.

5. Click on the OK button. 

An example of the “Tax per period” (no details) report, is as follows:

It is recommended that the details should also be printed and saved for record purposes.

It is important to print the details to check the details of your transactions.

The detailed tax report (“Show details” and “Show tax separately” options selected) for the same 
period, is as follows:

Page 1 – Output tax - 14%
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Page 2 – Input tax – Standard rate -14%

Page 3 – Input tax – Capital goods - 14%

Page 4 – Output tax – 15%
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Page 5 – Input tax – Standard rate -15%

The Tax excluded and Tax amount in the Report total of the Tax report - Reference / Document no. report, 
should balance with the Total - Output tax – Input tax of the Tax per period report, if the same periods are 
selected.

O.8.2- Tax report - Reference / Document no.

This report will list the details of accounts and transactions of all posted (updated) batch and 
document transactions, on which Tax (VAT/GST/Sales tax is applicable. It will display the Tax code 
and description as well as the contra accounts for each transaction. If the same periods is selected 
as on the Tax per period report, the Exclusive and Tax amount totals should balance. 

To print tax list debtor with tax id reports: 

1. On the Reports ribbon, select Reports → Tax. 

2. Select the Tax per period report. The “Tax list debtor with tax id” report is the default 
report.

3. Select the “Tax report – Reference / Document no.” report.

4. Select the following on “2 Months” and select “2018/03/01 / 2018/04/30”.

For the purpose of this tutorial, we assume that our tax registration certificate indicates that we 
need to pay Tax (VAT/GST/Sales tax) every 2 months.

5. Click on the OK button. 
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An example of the “Tax report – Reference / Document no.” report, is as follows:

Page 1 - 

Page 5 – (Last page) Totals

Once again, the Tax excluded and Tax amount in the Report total of the Tax report - Reference / Document 
no. report, should balance with the Total - Output tax – Input tax of the Tax per period report, if the same 
periods are selected.
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This report will list the following for each transaction on which Tax (VAT/GST/Sales tax) is 
applicable:

1. Reference and account detail - 

a) Reference – Document number or reference as entered in batches. 

Balancing entries in batches are indicated as ********  eight (8) asterisks.

b) Code – Account code

c) Description – Name of the account.

d) Country – The name of the country, if selected on debtor (customer / client) and 
creditor (supplier) accounts). 

e) Tax reference – Tax reference number, if entered on debtor (customer / client) or 
creditor (supplier) accounts). 

2. Transactions detail – 

a) Date – Date of the transaction. 

b) Batch no. - The batch id (number) as automatically generated. 

c) Description – Tax account and tax code. 

d) Tax excluded – Amount of the transaction exclusive of Tax (VAT/GST/Sales tax)

e) Tax amount – Tax amount for the transaction. 

f) Code / Description – Contra account code and account name (description).

O.8.3- Tax list debtor with tax id / Tax list creditor with tax id

The following two (2) reports will list the totals of documents for selected periods (as well as the 
registration numbers): 

1. Tax list debtor with tax id - This report will list a total exclusive of tax, tax amount and 
inclusive amount of tax) for the Invoices less Credit notes for debtor (customer / client) 
accounts for selected period(s) or date(s). It will also display the Company and Tax 
registration numbers for each for debtor (customer / client) accounts. 

2. Tax list creditor with tax id - This report will list a total exclusive of tax, tax amount and 
inclusive amount of tax) for the Purchase documents less Supplier returns for creditor 
(supplier) accounts for selected period(s) or date(s). It will also display the Company and 
Tax registration numbers for each for creditor (supplier) accounts.
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To print tax list debtor with tax id reports: 

1. On the Reports ribbon, select Reports → Tax. 

2. Select the Tax per period report. The “Tax list debtor with tax id” is the default report.

3. To print the similar report for creditors, select the “Tax list creditor with tax id” report.

4. Select the following:
Per period:  Tick on “2 Months” and select “2018/03/01 / 2018/04/30”.
Sequence:  Select “Debtor code”

For the purpose of this tutorial, we assume that our tax registration certificate indicates that we 
need to pay Tax (VAT/GST/Sales tax) every 2 months.

5. Click on the OK button. 

An example of the “Tax list debtor with tax id” report, is as follows:
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O.9- REPORTS TO MANAGE AND ANALYSE DOCUMENTS, 
STOCK, SALES AND PURCHASES 

A range of reports are available on the Reports menu to manage, analyse and control your stock 
items, sales and purchases. You may generate these reports to see how the transactions in this 
tutorial will be displayed in the reports.

O.9.1- Stock item reports

The following reports are available to manage the stock items:

1. Reorder - Stock Reorder Report to list only those stock
items that needs to be reordered. The Current Stock
Levels lists all the current stock levels. 

2. Print labels – Print the Barcode or the Yagoda barcodes. 

3. Stock item listing - Print lists of All selling prices report
(Selling price 1 / 2 /3), and the Stock item listing report
listing the Quantities Cost prices. A list of Tax classes may
also be printed. You may select to print extra details for
these reports. 

4. Backorder – Print a list of any stock items that are on
backorder. 

5. Stock In / Out - The following two (2) reports: 

a) Stock In / Out - Documents - Displays a summary
of sales and purchase documents for each stock
item. The “Show details” option will list and display the document dates and 
document numbers for each stock item. 

b) Stock In / Out - Displays a list of the stock items and the quantities in and out as 
well as the total prices. The “Show details” option will list and display the document 
dates and document numbers for each stock item.
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O.9.2- Document listing reports

The following reports are available to print lists of documents:

1. Document listing – Select Invoices, Credit notes, Quotes, Purchases, Supplier returns and
Orders. 

2. Document listing per account 

a) Sales documents – Select to list only posted
or unposted Invoices or Credit notes or
unconfirmed / open / confirmed Quotes.

b) Purchase documents – Select to list only
posted or unposted Purchases or Supplier
returns or unconfirmed / open / confirmed
Orders.

3. Unprinted document listing – This is similar to
the Document listing per account reports. It will list
all documents which have not yet been printed for
each debtor (customer / client) account. 

O.9.3- Sales reports

Various reports are available on the Reports → Sales menu
to analyse each of the sales documents (i.e. Quotes,
Invoices and Credit notes). The reports for Invoices are as
follows:

1. Graphs – Invoices per week – Quantities and
Invoices per Week – Turnover.

2. Debtors – Debtor – Invoices per period –
Quantities. 

3. Sales – Invoices per period – Quantities and
Invoices per period – Turnover.

4. Items  - Items per period. 
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O.9.4- Sales analysis reports

Various reports are available on the Reports → Sales
analysis menu to analyse sales documents.  

Sales documents per period (Reporting groups):

Five (5) reporting groups (i.e. Debtor group 1, Debtor group
2, Document group 1, Document group 2 and
Salespersons): 

1. Quotes per period – This will list the transaction
details of confirmed (posted) quotes only for a
selected period or date(s).  

2. Credit notes per period – This will list the
transaction details of posted credit notes only for a
selected period or date(s). 

3. Invoices per period – This will list the transaction
details of posted invoices only for a selected
period or date(s). 

4. Sales per product – Stock group 1 and Stock
group 2 are also available to analyse the sales and
returns of trading stock items (default stock type).

5. Sales per period – This will list both the
transaction details of posted invoices and credit
notes for a selected period or date(s). 
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O.9.5- Purchases reports

Various reports are available on the Reports → Purchases  menu to analyse each of the sales 
documents (i.e. Purchases, Supplier returns and Orders).
The reports for Purchases are as follows:

1. Graphs – Purchases per week – Quantities and
Purchases per Week – Cost.

2. Creditors – Creditor – Purchases per period –
Quantities 

3. Items  - Items per period. 

4. Purchases – Purchases per period – Quantities
and Purchases per period – Cost.
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O.9.6- Purchase analysis reports

Various reports are available on the Reports → Purchase analysis menu to analyse purchase  
documents. 

Purchase documents per period (Reporting groups):

Five (5) reporting groups (i.e. Creditor group 1, Creditor
group 2, Document group 1, Document group 2 and
Salespersons): 

1. Orders per period – This will list the transaction
details of confirmed (posted) orders only for a
selected period or date(s). 

2. Purchases per period – This will list the
transaction details of posted purchases only for a
selected period or date(s). 

3. Supplier returns per period – This will list the
transaction details of posted supplier returns only
for a selected period or date(s). 

4. Purchases per product – Stock group 1 and
Stock group 2 are also available to analyse the
purchases and supplier returns of trading stock
items (default stock type). 

5. Purchases and supplier returns per period –
This will list both the transaction details of posted
purchases and supplier returns for a selected
period or date(s).
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INTRODUCTION TO OPEN ITEM PROCESSING

P.1- INTRODUCTION TO OPEN ITEM PROCESSING

TurboCASH allows two basic methods of age processing of Debtor and Creditor transactions. 
These age type processing methods are:

• Balance brought forward -

• Debtor (customer / client) accounts - The credit transactions (payments 
received, debtor allowances, credit notes or any other credit transaction) are 
allocated to the oldest outstanding debit transaction (opening balances, 
invoices, etc.) amount.

• Creditor (supplier) accounts - The debit transactions (payments made to 
creditors, creditor allowances or supplier returns documents or any other debit 
transaction) are allocated to the oldest outstanding credit transaction (opening 
balances, purchases, etc.) amount.

• Open item -

• Debtor (customer / client) accounts - Open item is by default not activated. 
To activate Open item processing for a debtor (customer / client) account, select
(tick) the “Open item” field on the Accounting information tab of a selected 
debtor (customer / client) account.  

The credit transactions (payments received, debtor allowances, credit notes or 
any other credit transaction) may be linked to any selected outstanding debit 
transaction (opening balances, invoices, etc.) amount. 

• Creditor (supplier) accounts - Open item is by default not activated. To 
activate Open item processing for a  creditor (supplier) account, select (tick) the 
“Open item” field on the Accounting information tab of a selected creditor 
(supplier) account.  

The debit transactions (payments made to creditors, creditor allowances or 
supplier return documents or any other debit transaction) may be linked to any 
selected outstanding credit transaction (opening balances, purchases, etc.) 
amount. 

• General ledger accounts - Accounts (Action ribbon) “Open item account” field 
– Default is No. You may set it to Yes. 

The “Open item account” option is not available for the Retained earnings / income,  
Debtor's control and Creditor's control accounts. 

You may link debit transactions to credit transactions or credit transactions to 
debit transactions.
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Open item linking relates debit transactions posted to an account to credit transactions which are 
posted to the same account.

TurboCASH stores two amounts for transactions to open-item accounts; the amount of the 
transaction as well as an "outstanding amount". 

When you process the receipts journal and enter the amount for an Open item debtor, the “Open 
item selection” screen will be displayed, where you may select to link a receipt to a specific 
transaction or outstanding amount. 

When you process the payments journal and enter the amount for an Open item creditor, the 
“Open item selection” screen will be displayed, where you may select to link a payment to a 
specific transaction or outstanding amount. 

You may also edit or unlink the existing links, or even convert a specific account to the “Balance 
brought forward” method, where any payment or receipt will be set off against the oldest 
outstanding amount.

P.2- OPEN ITEM PROCESSING - FILTER / SELECT ACCOUNTS

There are various options to filter and manage the details, totals and transactions of open item 
accounts. To access the Open item link feature, click on the Open item link icon (Action ribbon).

There are three (3) tabs, i.e.  Totals, Transactions and Unposted batches to manage open item 
accounts.

P.2.1- Totals tab - Select / Filter accounts 

To edit open item links:

1. On the Action ribbon, click on the Open item link icon. The Totals tab will be displayed.

2. Click on the Filter button to list all those accounts for which Open item is activated and 
for which transactions are posted.

3. If an account is in white or gray rows, the accounts have no outstanding or unlinked 
transactions. 
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Accounts displayed in orange, indicates that there may be transactions which is not linked. 
These accounts may need some actions in the Open item link processing. 

4. Filter options - You may select (tick) or deselect (remove the tick) to list only Ledger, 
Debtors or Creditor accounts.  

Account type
1 - Debtor accounts - Open item account field selected (ticked) in Debtor  - Accounting 
information tab.
2 - Creditor accounts - Open item account field selected (ticked) in Creditor  - Accounting 
information tab
0 - General ledger - Open item account field set to Yes in Accounts.
3 - Bank accounts - Open item account field set to Yes in Accounts.
4 - Tax accounts - Open item account field set to Yes in the Accounts.

P.2.2- Transactions tab 

The Transactions tab will list the transactions for open item accounts. 

Filter options: 

1. Search by - Select any of the column headings and an operator (e.g. Like (default), =, <, 
>, <=, =>, or <> ) and enter a value. Click on the Filter button. Only those transactions 
matching your specified values will be listed. To clear the values, click on the Clear 
button.
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2. Account type - Select (tick) or deselect (remove the tick) to list the accounts for the 
selected account type(s) (Ledger, Debtors or Creditors).

3. Open transactions only - By default, this option is not selected and will list all 
transactions, including those with a 0,00 balance. If this field is ticked, it will list only those
transactions with a value of more than 0,00 in the "Due" column. 

4. Group - Click on the group button to group the transactions on the list by "Month, From
today, By date" and "By year".

You may also drag columns to the "Use your mouse to pull a column here to group on that 
column" row. 

5. Limit rows - 200 rows is the default number of rows or transactions to be listed. The 
number of rows may be specified (decreased or increased). 

6. Export - This button will create an Export.txt (Text files), which you may change the name
and folder and save it. A Comma separated (CSV) file format is also available. Exported 
files can be used in a spreadsheet.

P.2.3- Unposted batches

The Unposted batches tab will list all transactions linked to open item accounts (i.e. ledger, 
debtors and creditors) in batches, which have not yet been posted (updated) to the ledger.

If any transactions are processed for open item accounts, and is not linked, these transactions will 
not be listed on the Unposted batches tab.  

When processing transactions in batches and an open item account is selected, the “Open item 
selection” screen list all the outstanding transaction. For example, if a payment is received, you 
may select to link the receipt to outstanding amount(s) in batches as well as documents. 

If a transaction in unposted batches is linked to outstanding amounts in the “Open item selection” 
screen the transaction line will be displayed in a yellow background.

You may remove linked transactions (right-click on selected transaction(s)) and select Remove on 
the context menu. A confirmation message "Continue action Unlink transaction?" will be displayed.
Click Yes to remove the link. This will clear the links in the “Batch entry” screen.

368 - TurboCASH5.1 – 2018 – Accounting Made Easy



Unposted batches

P.3- OPEN ITEM PROCESSING - SELECTED ACCOUNTS

After selecting and double-click on a selected account on the Totals or Transactions or 
Unposted batches tabs, the “Open item link” screen for the selected account will be displayed.

Since the Creditor – Open item processing is basically similar to the Debtor open item processing, the 
Creditor open item processing will not be discussed in this tutorial. 
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P.3.1- Selected account – Default view

If no transactions are linked for the open item debtor account, all the transactions will be listed.

If the payment received transaction are linked for the open item debtor account, only the 
transactions with outstanding amounts will be listed.
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See – Chapter I.5 of MODULE I - RECEIVING PAYMENTS FROM YOUR DEBTORS - Entering payments from 
your debtors (customers / clients)
Mr. AB Green paid 2 000,00 (1 140,00 for INV001 and 860,00 for INV003), -  

• Deposit D5001 – 2 000,00 - Outstanding amount = 0,00
• Invoice INV001 – 1 140,00 - Outstanding amount = 0,00  
• Invoice INV003 – 1 140,00 - Outstanding amount = 280,00 (Invoice amount 1 140,00 less 860,00 

partial settlement = 280,00).

The following icons are available to process and manage Open item links:

1. Clear links - This option will clear the open item links for a selected debtor or creditor 
account.  

2. Gen BB/F - This option will clear all the open item links, and generate the ageing as 
balance brought forward account for a selected debtor or creditor account.

3. Unlink - This option allows you to unlink a selected transaction (a receipt or credit note, 
which is linked to an invoice in the case or a debtor, or a payment or supplier return 
linked to a purchase transaction in the case of a creditor).

4. Process - Select (tick) the debit and credit transaction(s) to be linked. You then need to 
click on the Process icon. A screen “Enter amount” may be displayed on which you need 
to over-type the amount, if necessary. 

Any linked transaction(s) will be removed from the debit or credit sections of the “Open 
item link” screen.  

5. Statement - Click to view the selected debtor or creditor account in a statement layout 
with the ageing labels (e.g. Current, 30 days, 60 days, etc.).

6. Export – This will export the transactions in a Text (Export.txt)  file or a Comma separated
value (Export.csv) file.

7. Close – The “Open item link” screen will be closed for the selected account.
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P.3.2- Statement view 

If you click on the Statement icon, it will list all the transactions, including those transactions with 
a 0,00 balance, as well as any outstanding amount(s) which is not the same value as in the Amount
column. 

Select the dates “Include items since” and the “Current date” to view the transactions for specific 
dates or periods. 

Select a transaction (with Outstanding amounts of 0,00 or any outstanding amount which is not 
the same as the Amount (transaction amount). If you click on the + icon, the details of the linked 
transaction(s) will be displayed. 
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P.3.3- ADJUST PAYMENT DATES / RECEIVE PAYMENT

P.3.3.1- Adjust payment date

The Payment date (due date) is automatically calculated by adding the number of days (entered in
the “Due date” field on the Accounting information tab of Debtor/ Creditor accounts) to the date
of the document (i.e. invoices, credit notes, purchase and supplier return documents) and the 
transaction dates entered in batches.  

P.3.3.2- Receive payment 

The Receive payment feature, will automatically generate the transactions to the receipts batch for
a selected transaction and print a combined receipt / payment advice (if selected). The transaction 
will automatically be posted updated to the ledger. 

P.4- OPEN ITEM REPORTS 

P.4.1- Open Item reports summary

P.4.1.1- Debtor reports

The following reports for Open item processing is available:

• Debtors → Transactions – Transaction list – Open item 

• Debtors → Age analysis – Balances detail history (open item) 

• Debtors → Outstanding – Debtor statements – Outstanding 

• Debtors →  Outstanding – Due date

• Debtors → Outstanding – Outstanding at date 

P.4.1.2- Creditor reports

The following reports for Open item processing is available:

• Creditors → Transactions – Transaction list – Open item  

• Creditors → Age analysis – Balances detail history (open item)

• Creditors → Outstanding – Creditor remittance advice – Outstanding 

• Creditors → Outstanding – Due at date 

• Creditors → Outstanding – Outstanding at date  

Since the Creditor – Open item reports is basically similar to the Debtor open item reports, the Creditor 
open item processing will not be discussed in this tutorial. 
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P.4.2- Debtor age analysis reports

You may need to analyse your debtors (customers / clients) accounts on a regular basis. It is 
recommended that the age analysis reports are printed after all batches and documents are 
posted (updated). 

P.4.2.1- Balances detail

The Debtors → Age analysis → Balances detail report will list - All the Debit and Credit 
transactions (irrespective of Open item transactions processed (Credit transactions linked to Debit 
transactions)). 

To print debtor age analysis details reports:

1. On the Reports ribbon, select Reports → Debtors → Age analysis. The Balances detail 
report options is displayed:

2. Enter or select the following:
Date of ageing:  Select the date i.e. “2018/04/30”.
Days overdue:  Enter “30”.
Number of days overdue:  Enter “30”.
From account:  Select the first account on the list.
To account:  Select the last account on the list.
Sequence:  Select “Description”.
Show transactions:  Leave blank. Only the totals will be printed. To print the 

transactions, you may select this option.
Show contact details:  Leave blank.
New page per account:  Leave blank.

3. Click on the OK button. 
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Balances detail

An example of the “Debtor age analysis – Balances detail” report, is as follows:
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P.4.2.2- Balances detail history (Open item) 

This report is basically similar to the Balances detail report. The balances detail (Open item) report 
will list all the transactions as well as the Outstanding amount. It will list the details of transactions 
linked (e.g. fully paid invoices) with an outstanding amount of 0,00. 

To print debtor age analysis details (open item) reports:

1. On the Reports ribbon, select Reports → Debtors → Age analysis. The Balances detail 
report options will be displayed.

2. Select the Balances detail history (open item) report. 

3. Enter or select the following:
Date of ageing:  Select the date i.e. “2018/04/30”.
Days overdue:  Enter “30”.
Number of days overdue:  Enter “30”.
From account:  Select the first account on the list.
To account:  Select the last account on the list.
Sequence:  Select “Debtor code”.
Show transactions:  Leave blank. Only the totals will be printed. To print the 

transactions, you may select this option.
Show contact details:  Leave blank.
New page per account:  Leave blank.

4. Click on the OK button. 
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P.4.2.3- Transactions - Balances detail vs Balances detail (open item) reports

Balances detail report – Transactions

All the Debit and Credit transactions will be listed (irrespective of Open item transactions 
processed (Credit transactions linked to Debit transactions)). 

Balances detail history (open item) report – Transactions

All the Debit and Credit transactions will be listed. The outstanding amounts will be displayed 
including 0,00 for transaction that is fully settled.

See – Chapter I.5 of MODULE I - RECEIVING PAYMENTS FROM YOUR DEBTORS - Entering payments from 
your debtors (customers / clients)
Mr. AB Green paid 2 000,00 (1 140,00 for INV001 and 860,00 for INV003), -  

• Deposit D5001 – 2 000,00 - Outstanding amount = 0,00
• Invoice INV001 – 1 140,00 - Outstanding amount = 0,00  
• Invoice INV003 – 1 140,00 - Outstanding amount = 280,00 (Invoice amount 1 140,00 less 860,00 

partial settlement = 280,00).
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P.4.2.4- Show contact details option 

You may select the “Show contact details” option to view the details for each debtor included in 
the report. 

P.4.3- Debtor statements

You may send debtor statements to your debtors (customers / clients) on a regular basis. It is 
recommended that the statements are printed after all batches and documents are posted 
(updated).  The following two (2) debtor statements may be printed:

• Debtor statements – All the Debit and Credit transactions are listed (irrespective of 
Open item transactions processed (Credit transactions linked to Debit transactions)). 

• Debtor statements – Outstanding – Only the outstanding Debit and Credit transactions 
are listed.
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P.4.3.1- Debtor statements - Outstanding

To print debtor statements:

1. On the Reports ribbon, select Reports → Debtors → Outstanding. Debtor statement 
(default report) will automatically be selected.  This default debtor statement will print all 
transactions debits and credits. 

2. Select the Debtor statement – Outstanding report to print only the outstanding 
amounts of transactions not linked in Open item processing. 

3. Enter or select the following:
Date of ageing:  Select the date i.e. “2018/04/30”.
Days overdue:  Enter “30”.
Number of days overdue:  Enter “30”.
From account:  Select the first account on the list.
To account:  Select the last account on the list.
Sequence:  Select “Description”.

4. Click on the OK button. 
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An example of the “Debtor statement”, is as follows:

The information, is as follows:

1. Header (Left) - Debtor information as entered / edited on the debtor account - Debtors 
(Action ribbon).

2. Header (Right) - Company information as entered / edited on Company info (Setup 
ribbon). 

If the Company logo is loaded in the “Options” screen of Company info (Setup ribbon), the logo 
will be displayed instead of the Company name, Address (4 lines) and Telephone and Fax 
numbers. 

3. Statement to - The date as entered (selected) on the “parameters” screen. The periods 
number of days specified on the “parameters” screen is displayed. The outstanding totals 
for each period is displayed as a summary for the periods at the end of the transaction 
section. 
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4. Transactions - This displays the date, reference, description and amount for each 
transaction. The payment date for each transaction is the date of the transaction plus the 
number of days entered in the “Due days” field on the Accounting information tab of 
the debtor account. 

5. Credit limit - The amount as entered in the “Credit limit” field on the Accounting 
information tab of the debtor account. The Balance at is the current balance of the 
debtor account of all posted transactions and documents as at the date of printing of the
Debtor statements. The Available amount is calculated the Credit limit less the Balance 
at amount as at the date of printing of the Debtor statements.

6. Statement message - This consists of two (2) sections:

a) Statement message (Left) - Up to three (3) lines as entered on the Delivery 
address tab of the debtor account.

b) Statement message (Right) - Up to three (3) lines as entered on the Statement 
setup tab on the Documents setup (Setup ribbon).

7. Due amount, Due date and Banking details - The amount payable and the date on 
which the payment is due. The Banking details (Bank account 1 ) as entered on Company
info (Setup ribbon) will be displayed on the Debtor statement. 

The Banking details (as entered in the Company info (Setup ribbon) is not available in Creditor 
remittance advices. 
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P.4.3.2- Debtor statement vs Debtor statement – Outstanding 

Debtor statement - All the Debit and Credit transactions are listed (irrespective of Open item 
transactions processed (Credit transactions linked to Debit transactions)). 

Debtor statement – Outstanding – Only the outstanding Debit and Credit transactions are listed.

See – Chapter I.5 of MODULE I - RECEIVING PAYMENTS FROM YOUR DEBTORS - Entering payments from 
your debtors (customers / clients)
Mr. AB Green paid 2 000,00 (1 140,00 for INV001 and 860,00 for INV003), -  

• INV001 – 1 140,00 - Will not be listed, as invoice INV001 is fully settled. 
• INV003 – 1 140,00 - Will be listed, as invoice INV003 is not fully settled.  An amount of 280,00 

will be outstanding (Invoice amount 1 140,00 less 860,00 partial settlement = 280,00).
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MODULE Q - REPORTMAN

Q.1- REPORTMAN INTERFACE

All document layout files and reports are installed and stored in the ...\plug_ins\reports folder of 
your installation directory. 

To access the Report designer:

Select the Report designer on the Reports ribbon; or on the Setup ribbon. The “Report designer” 
will list all layout files and report folders as follows: 

The buttons and options, is as follows: 

1. Copy report – If you need to edit a layout file or report, you need to select a file.  If you 
click on a report or layout file, and you click on the Copy report button, it will create an 
exact copy (e.g. Copy of Reportname) of the report *.rep and the parameters *.dfm (if the 
report has parameters) file(s).     

It is recommended that you do not edit an existing layout file or report, but create a copy and 
edit the copy until you get the required results.

You may then rename the report. If you have any customised reports, you may create folders in 
the ...\plug_ins\reports\userreports\ folder and copy your reports to your folder. These reports 
may then be accessed from User reports (Reports ribbon).
Document layout files cannot be printed from any other folder than the 
...\plug_ins\reports\DOCUMENTS\DOCUMENTS folder.
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2. Edit – Launches the “Report manager designer” screen, where you may edit an existing 
report or layout file or create or edit a new report or layout file. 

3. Delete – This will delete a selected layout file or report (*.rep) file (and the parameter 
(*.dfm) file, if applicable).

Please make sure that the correct report is selected. Deleting the incorrect report, the report will 
be permanently lost. 

4. New report – This will launch a blank report with no datasets using the 
...\plug_ins\reports\New.rep template file. When you save the New.rep file, it will save it as
New.rep in the folder in which the New report button was clicked on. 

You may click on the New.rep and click again to rename the report.
If the New.rep is in the “Reportman designer” screen, you may use the File → Save as menu to 
save the report with your own name. 

5. New folder – This will create a New folder in the selected folder. You need to double-
click to rename the New folder.

6. Explorer folder - If a report is selected it and you click on this button, the folder 
containing that report will be launched in Windows Explorer or your system's default file 
browser. 

7. Refresh - This will refresh the display (list of folders and files) in the “Reportman” screen. 

The “No refresh after save” option is by default selected (ticked). If this ticked is removed, it will 
automatically refresh the “Reportman” screen when a report or layout file is selected. This may 
slow down your system.

8. Help - This button is inactive. The off-line Reportman help can be accessed from the 
.../plug_ins/reportman/doc/indexes.html file in the TurboCASH5 installation directory. 

You may access the online help at http://reportman.sourceforge.net/ 
If you focus on a specific area of the “Reportman designer” screen, a “?” will be added to the 
cursor, it will launch the specific topic at sourceforge (e.g. 
http://reportman.sourceforge.net/doc/refcommon.html).

9. Parameters - If a report has parameters, and you click on the Parameters button, the 
“Parameters” screen for the selected report will be launched.

10. Create parameters and open – This will launch the “Reportmanager designer” screen on 
which you may edit the parameters (Report → Parameter definition menu) and 
Datasets (Report → Data access configuration menu). 

If a report has no parameters and you click on this button, it will display an error message, e.g. 
"No params found. create one first C:\TCASH5\plug_ins\reports\userreports\Custom 
Reports\New.dfm"
You then need to close this message and click on the Parameters button to create parameters.  If 
you find another report with similar parameters, you may copy the parameter *.dfm file to the 
folder of your report and rename it to the name of your report.
You then need to edit the parameters and report.
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11. Preview - Click to preview a document layout file or a report. If a report has parameters, 
it will launch the report “parameters” screen on which you may select the options to 
preview the data in the report.

While editing a document layout file or a report, you may click on the Preview  icon of the 
Report manager designer screen.

12. Select test document id - If you click on the Preview button if document layout files (in 
the ...\plug_ins\reports\DOCUMENTS\DOCUMENTS folder) are selected the last document 
processed or printed will be previewed. If you click on this button you may select any 
other posted or unposted document to preview.  

Q.2- REPORTS FILES AND FOLDERS 

All document layout files and reports are installed and stored in the ...\plug_ins\reports folder of 
your installation directory.

When launching the Report designer, all report folders are displayed as follows:

 

The directories (folders and files are as follows):

1. Document printing – All the layout files for printing documents are stored in the 
...\plug_ins\reports\DOCUMENTS\DOCUMENTS folder.
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Press the F1 key and search (Search titles only) for layout files. See “Layout files for Sales 
documents” and “Layout files for Purchase documents”.    

Press the F1 key and search (Search titles only) for “Working with Reportman”. This will introduce
you to the Reportman interface and to customise document layout files. 

2. Reports → Reports menu – These reports are stored in the systemreports folder.
3. Reports → User reports menu – These reports are stored in the userreports folder. Users

are encouraged to create and / or edit existing reports, but it is recommended that these 
be copied and stored in the ...\plug_ins\reports\userreports\ folder. 

4. Reports → T-Ledger analyser and Reports → T-Account viewer – Seven (7) reports are 
stored in the ...\plug_ins\reports\GENERAL\ledgerview folder. These are:

a) budgetvsactsimple – Budget vs actual and This year vs last year reports.
b) colbal – Not used.
c) colbalopen – Not used. 
d) colbalopenonly – Not used.
e) colbalsimple – Standard column balances report.
f) detail – Trial balance, Income statement and the Balance sheet. 
g) ledgerdetail – Print button on the T-Account viewer.

5. Reports generated from inside the TurboCASH5 program on various screens are 
stored in the ...\plug_ins\reports\GENERAL\documents folder. These are: 

a) Batch processing - Batch entry (F2) (Action ribbon): 
i) abbreviations – Abbreviation definitions as set in the Batch entry – 

F9:Process option (Action ribbon). If you click on the Print button of the 
Abbreviation screen, a list of Abbreviation definitions will be printed. The 
abbreviations listed on this report, may be used to automatically fill the 
description column in the document lines when processing documents 
(invoices, credit notes, quotes, purchases, supplier returns and orders). 

ii) batch – Batch Listing on the Batch entry – F8:List – This will print a list of 
all transactions in an unposted batch. 

iii) postedbatch - Batch Listing on the Batch entry – Posted batches – 
Details tab – Print button - This will print a list of all transactions in a 
posted batch.

iv) paycreditor - Prints the Creditor payments report when clicking on the 
Print button in the “Payments Debtors / Creditors” option (Batch entry – 
F9:Process). 

v) paydebtor – Prints the Debtor payments report when clicking on the 
Print button in the “Receive Payments / Creditors” option (Batch entry – 
F9:Process). 
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vi) receipt – Prints a receipt if the “Create receipt” option is selected for 
Receipt batches in the Batch entry – F9:Process (and if the “Print” option is
ticked).

vii) recon – Prints the Bank reconciliation report when clicking on the Report 
icon of the Reconcile bank (Reconciliation (Action ribbon)).

b) Documents (Documents (F6)) (Action ribbon):
i) barcodes – Context menu - Quick link to print the barcodes of the stock 

items selected on documents. 
ii) labels - Context menu - Quick link to print the postal address labels (and 

Contact name) of the debtors (customers / clients) selected on sales 
documents or creditors (suppliers) selected on purchase documents.

iii) labelsdelivery – Not implemented yet. This is similar than the labels report,
but should print delivery addresses in stead of postal addresses. 

c) Point-of-Sales (Standard)  - Input → POS Invoice (Ctrl + F6) (Action ribbon):
i) oldpossales – This sales report prints from the Process - Reports or 

Cashup option on the POS Invoicing screen.
ii) oldposcashup - This cashup report prints from the Process - Reports or 

Cashup option on the Input → POS Invoicing screen (Action ribbon).
d)  Others

i) datacheck – Prints the Data integrity check report from the Tools → Data
integrity check menu (Setup ribbon).

ii) groups – Prints the list of the Account group 1 / 2, Debtor group 1 / 2, 
Creditor group 1 / 2, Stock group 1 / 2, Document group 1 / 2, etc. when 
clicking on the Print button of a selected group on Groups (Setup ribbon). 

iii) payments – Prints a Receipts / Payments advice when the Receive 
payment context menu option is selected (and the “Print” option is ticked) 
on the Open item link - Transactions tab (Action ribbon) or on the “Open
item link” screen for a debtor (customer / client) or creditor (supplier) 
account. 

iv) Userlog – Prints the Userlog report when clicking on the Log report 
button on the Access control (Setup ribbon).

6. REPORTS  
a) CREDITOR – (Action – Creditors (F5) menu) – Selected creditor label (Postal 

address) and Selected creditor delivery label (Delivery address). Print when you 
right-click on a selected creditor (supplier) account from the list.  

b) DEBTOR – (Action – Debtors (F4) menu) – Selected debtor label (Postal 
address) and Selected debtor delivery label (Delivery address). Print when you 
right-click on a selected debtor (customer / client) account from the list.
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c) STOCK – (Action – Stock items (F12) menu) – Barcode and Yagoda barcode. 
Print when you right-click on a selected stock item or stock items from the list.

d) PROJECTS –  If projects have been activated and transactions have been 
entered in batches and documents, you may print five (5) reports (i.e. 
Transactions, Hours, Stock items, Statements and the Total report). Budgets can 
also be entered for Projects, but it needs to be added to these reports.

e) HORECAPOS – This folder contains the reports for the HORECAPOS and 
RETAILPOS Plugins.

f) SUBSCRIPT – This folder contains the Subscriptions report. (See the 
Subscriptions folder – This folder contains the report, emailtemplates, layouts 
and Sql for the Subscriptions Plugin).

g) REPORTS FOLDER (Discontinued Reports) -  The BATCHREPORT, CONTACTS, 
COSTCENTER, GL and TAX folders contains old reports not used in TurboCASH5.

7. Folders and reports for Plugins 
a) EmailInvoice and debcred folders are used for the E-MailPro Plugin
b) parcel – This is not used at this stage – It is reserved for a Send Parcel Plugin. 
c) remittance – This contains the list report, emailtemplates and layouts for the 

Reminders Plugin. 
d) Subscriptions – This folder contains the report, emailtemplates, layouts and Sql 

for the Subscriptions Plugin.

Q.3- LAYOUT FILES

The layout files selected for each document type on the Documents setup are the global default 
layout files that will be used to print documents.

Specific layout files may also be selected for:

• Each debtor (customer / client) account by selecting a different layout file in the Layout 
file 1 (Invoices), Layout file 2 (Credit notes), Layout file 3 (Quotes) - Debtors (Action 
ribbon).   

• Each creditor (supplier) account by selecting a different layout file in the Layout file 1 
(Purchases), Layout file 2 (Supplier return), Layout file 3 (Orders) - Creditor (Action 
ribbon).

The global settings will be over-ruled.
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In addition to these settings, you may also select a different layout file when printing documents 
on the “Layout file” fields of the following options in the (Action ribbon):

• Document menu - Selection screen (Print button)

• Debtors (Documents tab)

• Creditors (Documents tab)

Layout files are stored in the ...\plug_ins\reports\DOCUMENTS\DOCUMENTS directory. These may 
be edited using the Reportman (accessed from the Report designer on the Reports ribbon or on 
the Setup ribbon). 

Layout files have been designed to be displayed in the Language file (Switch language (Start 
ribbon)). If you change the language, the layout file will be displayed in the selected language.

Should the correct tax terminology (e.g. Sales tax, VAT, GST) not be displayed on layout files, you need to 
select the correct language / country file.

For your convenience, the names of the layout files as well as the internal translation languageID 
are listed.

Q.3.1- LAYOUT FILES FOR SALES DOCUMENTS

All layout files are translatable via the language files, except the following available in English 
language only:

Debtor (customer / client) layout files – English only
Name LanguageID
Invoice English (no codes) TRN_906262
Invoice English (10 code) TRN_906261
Invoice English (15 codes) TRN_906191

These layout files will display TAX instead of VAT/GST/Sales tax. 

The rest of the layout files are translatable via the language files. It will display the tax terminology 
for the selected country e.g. en-South-Africa will display VAT, af-Afrikaans will display BTW, en-
Australia and en-New-Zealand will display GST, en-American will display Sales tax, etc. 

The language in which these layout files can be printed, may be set in the “Language” field - 
Debtors (Action ribbon).
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Q.3.1.1- Print no stock codes 

If you do not wish to print stock codes on documents, you may select the following layout files:

Debtor (customer / client) layout files - No stock codes

Normal A4 Format A4 Plain format

Name LanguageID Name LanguageID Name LanguageID

Invoice (no codes) TRN_906194 Invoice A4 (no codes)  TRN_906212 Invoice A4 Plain (no 
codes)

TRN_906230

Credit note (no 
codes)

TRN_906195 Credit note A4 (no 
codes)

TRN_906213 Credit note A4 Plain (no 
codes)

TRN_906231

Quote (no codes) TRN_906196 Quote A4 (no codes) TRN_906214 Quote A4 Plain (no codes) TRN_906232

If you need to display your Banking details on an Invoice, you may select the Invoice Bank details (no 
codes) - (TRN_906192) layout file.

If you need to print a Delivery note, you may select the Delivery note (no codes) - (TRN-906181) layout file.

Q.3.1.2- Print stock codes (up to 10 characters)

If you enter less than 10 characters in the “Stock code” field and less than 25 characters in the stock
“Description” field on Stock items (Action ribbon), you may select the (10 code) - series of 
document layout files:

Debtor (customer / client) layout files - 10 digit stock codes

Normal A4 Format A4 Plain format

Name LanguageID Name LanguageID Name LanguageID

Invoice (10 code) TRN_906200 Invoice A4 (10 code) TRN_906218 Invoice A4 Plain (10 code) TRN_906236

Credit note (10 code) TRN_906201 Credit note A4 (10 code) TRN_906219 Credit note A4 Plain (10 
code)

TRN_906237

Quote (10 code) TRN_906202 Quote A4 (10 code) TRN_906220 Quote A4 Plain (10 code) TRN_906238

If you need to display your Banking details on an Invoice, you may select the Invoice Bank details (10 code) 
- (TRN_906260) layout file.

If you need to print a Delivery note, you may select the Delivery note (15 code) - (TRN-906182) layout file.
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Q.3.1.3- Print stock codes (up to 15 characters) 

If you enter up to 15 characters in the “Stock code” field and up to 35 characters in the stock 
“Description” field, on Stock items (Action ribbon), you may select the (15 code) - series of 
document layout files:

Debtor (customer / client) layout files - 15 digit stock codes

Normal A4 Format A4 Plain format

Name LanguageID Name LanguageID Name LanguageID

Invoice (15 code) TRN_906206 Invoice A4 (15 code) TRN_906224 Invoice A4 Plain (15 code) TRN_906242

Credit note (15 code) TRN_906207 Credit note A4 (15 code) TRN_906225 Credit note A4 Plain (15 
code)

TRN_906243

Quote (15 code) TRN_906208 Quote A4 (15 code) TRN_906226 Quote A4 Plain (15 code) TRN_906244

If you need to display your Banking details on an Invoice, you may select the Invoice Bank details (15 code) -
(TRN_906193) layout file.

If you need to print a Delivery note, you may the select Delivery note (15 code) - (TRN-906182) layout file.

Q.3.1.4- Layout files no tax 

Layout files have been designed to be displayed in the Language file (Switch language (Start 
ribbon)). If you change the language, the layout file will be displayed in the selected language 
(including the Tax (VAT/GST/ Sales tax) terminology.

Should the correct tax terminology (e.g. Sales tax, VAT, GST) not be displayed on layout files, you need to 
select the correct language / country file.

We have also included a set of document layout files which does not contain the tax terminology if you are
not registered as a VAT/GST/Sales tax vendor.

Debtor (customer / client) layout files - No Tax (VAT/GST/Sales tax)

No stock code Stock code (15 digits)

Name LanguageID Name LanguageID

Invoice No Tax (no codes) TRN_906248 Invoice No Tax (15 code) TRN_906254

Credit note No Tax (no codes) TRN_906249 Credit note No Tax (15 code) TRN_906255

Quote No Tax (no codes) TRN_906250 Quote No Tax (15 code) TRN_906256

If you need to print a Delivery note, you may select the Delivery note (no codes) - (TRN-906181) or 
Delivery note (15 code) - (TRN-906182) layout files.
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Q.3.1.5- Point-of-Sale (POS) layout files

The following layout files are available for Point-of-Sales:
1. POS-STARTSP100 - (TRN_906183) - Prints on till slip printers.
2. POS - (TRN_906184)
3. POS 2 - (TRN_906185)
4. POS A4 - (TRN_906186) 

Q.3.2- LAYOUT FILES FOR PURCHASES

All of these layout files are translatable via the language files. The language in which these layout 
files can be printed, may be set in the “Language” field – Creditor (Action ribbon).

Q.3.2.1- Print no stock codes 

If you do not wish to print stock codes on documents, you may select the following layout files:
Creditor (supplier) layout files - No stock codes

Normal A4 Format A4 Plain format

Name LanguageID Name LanguageID Name LanguageID

Purchase (no codes) TRN_906197 Purchase A4 (no codes) TRN_906215 Purchase A4 Plain (no 
codes)

TRN_906233

Supplier return (no 
codes)

TRN_906198 Supplier return A4 (no 
codes) 

TRN_906216 Supplier return A4 Plain (no
codes)

TRN_906234

Order (no codes) TRN_906199 Order A4 (no codes) TRN_906217 Order A4 Plain (no codes) TRN_906235

Q.3.2.2- Print stock codes (up to 10 characters)

If you enter less than 10 characters in the “Stock code” field and less than 25 characters in the stock
“Description” field on Stock items (Action ribbon), you may select the (10 code) - series of 
document layout files:

Creditor (supplier) layout files - 10 digit stock codes

Normal A4 Format A4 Plain format

Name LanguageID Name LanguageID Name LanguageID

Purchase (10 code) TRN_906203 Purchase A4 (10 code) TRN_906221 Purchase A4 Plain (10 
code)

TRN_906239

Supplier return (10 
code)

TRN_906204 Supplier return A4 (10 
code) 

TRN_906222 Supplier return A4 Plain 
(10 code)

TRN_906240

Order (10 code) TRN_906205 Order A4 (10 code) TRN_906223 Order A4 Plain (10 code) TRN_906241
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Q.3.2.3- Print stock codes (up to 15 characters) 

If you enter up to 15 characters in the “Stock code” field and up to 35 characters in the stock 
“Description” field on Stock items (Action ribbon), you may select the (15 code) - series of 
document layout files:

Creditor (supplier) layout files - 15 digit stock codes

Normal A4 Format A4 Plain format

Name LanguageID Name LanguageID Name LanguageID

Purchase (15 code) TRN_906209 Purchase A4 (15 code) TRN_906227 Purchase A4 Plain (15 code) TRN_906245

Supplier return (15 
code)

TRN_906210 Supplier return A4 (15 
code) 

TRN_906228 Supplier return A4 Plain (15 
code)

TRN_906246

Order (15 code) TRN_906211 Order A4 (15 code) TRN_906229 Order A4 Plain (15 code) TRN_906247

Q.3.2.4- Layout files no tax 

Layout files have been designed to be displayed in the Language file (Switch language (Start 
ribbon)). If you change the language, the layout file will be displayed in the selected language 
(including the Tax (VAT/GST/ Sales tax) terminology.

Should the correct tax terminology (e.g. Sales tax, VAT, GST) not be displayed on layout files, you need to 
select the correct language / country file.

We have also included a set of document layout files which does not contain the tax terminology if you 
are not registered as a VAT/GST/Sales tax vendor.

Creditor (supplier) layout files - No Tax (VAT/GST/Sales tax)

No stock code Stock code (15 digits)

Name LanguageID Name LanguageID

Purchase No Tax (no codes) TRN_906251 Purchase No Tax (15 code) TRN_906257

Supplier return No Tax (no codes) TRN_906252 Supplier return No Tax (15 code) TRN_906258

Order No Tax (no codes) TRN_906253 Order No Tax (15 code) TRN_906259
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Q.3.3- UNIVERSAL LAYOUT FILES

These three (3) Layout files can be used for both sales documents (i.e. Invoices, Credit notes and 
Quotes) for debtors (customers / clients) as well as purchase documents (i.e. Purchases, Supplier 
returns and Orders) for creditors (suppliers). 

Universal layout files

No codes 10 codes 15 codes

Name LanguageID Name LanguageID Name LanguageID

Document layout (no 
codes)

TRN_906278 Document layout (10 
code)

TRN_906276 Document layout (15 
code)

TRN_906277

If you need to print the Universal - Document layout files (One (1) Layout file for all document types), it is 
recommended that these document types are edited and / or translated to the singular on the Types tab of 
Setup → Tools → Customise language. (Setup ribbon). These Document layout files will print the document 
type in the plural (if it is not changed to the singular).

For example, if you print an Invoice, it should display Invoice and not Invoices on the printed 
layout file. 

If you need to print the Universal - Document layout files (One (1) Layout file for all document types), the 
Banking details of your Company as entered in Company info  (Setup ribbon) will be printed on purchase 
documents (i.e. Purchases, Supplier returns and Orders) for creditors (suppliers). 
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Function keys - TurboCASH main program

R.1- Function keys - TurboCASH main program

Key Description Menu (Ribbon) Function
F1 Help Help → Help  (Action) Access the Help file. 
F2 Batch entry Batch entry (Action) Enter transactions in your respective batch types.
F3 Update ledger Update ledger (Action) Update invoices, credit notes, purchases and 

supplier returns.
F4 Debtors Debtors (Action) To create, edit, delete debtor (customer / client) 

accounts. 
F5 Creditors Creditors (Action) To create, edit, delete creditor (supplier) accounts. 
F6 Invoices Documents (Action) The Invoicing screen will be displayed on which 

you may start processing invoices. You may also 
select to process any of the following documents: 

• Credit notes
• Purchases
• Supplier returns
• Quotes
• Orders

The last accessed Document type will be launched 
(if the Set of Books is not re-opened).

F10 Creation wizard Create Set of Books (Start) Launches the Creation wizard screen on which you
may select an option to create or copy a Set of 
Books.

F12 Stock items Stock items (Action) Maintain stock items.

R.2- Alt + Other keys 

Key Description Menu (Ribbon) Function
F2 Reconciliation Reconciliation (Action) Do a bank reconciliation and to print the 

bank reconciliation report.
O Open Open (Start) Open a Set of Books.
Q Exit TurboCASH Exit TurboCASH (Start) Exit your TurboCASH program.
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R.3- Ctrl + Other keys 

Key Description Menu (Ribbon) Function
F4 Calculator Calculator (Setup) Access the calculator.
F5 Company Info Company Info (Setup) Enter or edit information regarding the 

company and to set defaults for the 
company.

F6 POS Invoice Input → POS Invoice (Action) To start processing Point-of-Sale invoices.
L Open item link Open item link (Action) Options to link receipts to specific invoices for

debtors and payments for creditors to certain
supplier invoices or purchases. 
Open item link processing are also available 
for general ledger accounts.

R.4- Function keys - Batch entry screens

Key Description Function
F5 Balance Balance the batch
F6 Post Post the batch
F7 Exclusive / Inclusive Enter VAT/GST/Sales tax Exclusive or Inclusive
F8 List List the batch
F9 Process Process the batch
F10 Setup Setup entry defaults for the batch.

 

R.5- Function keys - Document entry screens

Key Description Function
F7 Exclusive / Inclusive Enter VAT/GST/Sales tax Exclusive or Inclusive
F8 Discount To enter discount 
F9 Comment Insert a comment.
F10 Delete all Delete all the transactions and comments entered in the document.
F11 Copy Copy the transactions from a selected invoice.
F12 Delete line Delete selected transaction(s) and / or comment(s) entered in the document.
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